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Using This Book

Audience

SAS Strategy Management is designed for the following users:

Scorecard modeler
Designs and builds strategy models in SAS Strategy Management. This
entire User's Guide provides useful information for scorecard modelers.

Business user and analyst
Navigates through and views strategy content and information.

Business users should read “Part 5. Viewing and Navigating Content in
Portlets.” Depending on the business user's organization, “Part 7. Creating
Reports” might be of interest.

Data entry user
Enters strategy data and other information into a SAS Strategy Management
project.

Data entry users should read “Part 6. Entering Data.”
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What's New

What's New in SAS Strategy
Management 5.6

Overview

SAS Strategy Management 5.6 provides the following changes and
improvements:

improved integration with the SAS Visual Analytics home page
improvements to the Import wizard

new override option in the Manage Rules wizard

new way to create SAS Strategy Management reports for Microsoft Office
improvements to the Data-Entry Forms feature

improvements to the Create Mobile Reports feature

new MIXPER formula function

Improved Integration with the SAS Visual
Analytics Home Page

From the SAS Visual Analytics home page, you can now select a data-entry
form and open its portlet in order to work with the form. You can also make
mobile reports available on the home page.

Improvements to the Import Wizard

SAS Strategy Management provides the following improvements to the Import
wizard:
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non-metric attributes: The Import wizard provides a new configuration
feature that imports elements, their non-metric attributes, and their period
types.

relationships: You can create relationships during an import by associating
element types.

element descriptions: You can import element descriptions.

element start and end dates: You can specify the start and end dates for
elements in a configuration.

link elements option: You can create a link between newly created
elements. The elements must have identical names, must be the same
element type, and the scorecard of one of the elements must be a direct
descendant of the other element’s scorecard.

New Override Option in the Manage Rules
Wizard

The Manage Rules wizard provides an option that enables users to enter a value
that does not conform to the rule’s restrictions. Although a warning appears in
the affected data-entry form, users can save and submit the form even though
the input fails validation.

New Way to Create Strategy Management
Reports for Microsoft Office

SAS Strategy Management provides a new way to create reports that you can
view in Microsoft Office when SAS Add-in for Microsoft Office is installed. This
feature replaces the Save As SAS ROM Report option in the SAS Strategy
Management Builder.

Improvements to the Data-Entry Forms
Feature

SAS Strategy Management provides the following improvements:

required cells are labeled for quick identification: Cells that require an
entry display This cell is required.

Read-Only text is identified: When you click in a Read-Only cell, the text in
the cell appears gray.

column width adjustments persist: \When you change a column width, the
layout persists. The setting is used for the current scorecard and any other
scorecard to which you navigate.



New MIXPER Formula Function XVii

the Period type list is filtered: This list now provides only the period types
that are valid for the elements in the form.

Improvements to the Create Mobile
Reports Feature

The Create Mobile Reports feature of the enhanced SAS Strategy Management
portlet enables you to specify layout options that are optimized for the SAS
Mobile Bl app.

New MIXPER Formula Function

SAS Strategy Management provides a new formula function that returns a list of
values from a time period that is different from another time period.
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Accessibility

For information about the accessibility of this product, see Accessibility Features
of SAS Strategy Management 5.6 at support.sas.com.


http://support.sas.com/documentation/solutions/stm/5.6/en/accessibility/HTML/spma11y.htm
http://support.sas.com/documentation/solutions/stm/5.6/en/accessibility/HTML/spma11y.htm
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About SAS Strategy Management

What Is SAS Strategy Management?

What Is a Performance Management Framework?
Why Use a Performance Management Framework?
Benefits of Using SAS Strategy Management

Why Use SAS Strategy Management?

SAS Strategy Management Users

SAS Strategy Management Features
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Accessing Help and Documentation for SAS Strategy Management

What Is SAS Strategy Management?

SAS Strategy Management enables you to describe your strategy, regardless of
the performance management framework that you have chosen. SAS Strategy
Management aligns the actions of an organization to optimize strategic
outcomes. You can define, plan, execute, and validate your strategy—all using
SAS Strategy Management.

Define: Formalize strategy and goals and the relationships between key
performance indicators using strategy maps and diagrams.

Plan: Set targets, thresholds, priorities, and weights associated with strategic
objectives and metrics. Align strategies to support those of the organization.

Execute: Monitor progress toward targets and goals. Receive alerts to areas
of underperformance. Visually depict impact between leading and lagging
indicators. Share feedback and commentary.

Validate: Prove that a strategy delivers expected results. Statistically
quantify impact, priorities, and relationships and perform what if analysis.

What Is a Performance Management
Framework?

A performance management framework is a system that is supported by
measures of performance. The framework enables you to combine financial and
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nonfinancial measures of performance, as well as leading and lagging
indicators. Such measures can help your organization:

Optimize your strategy and manage organizational activities.
Test strategies before you implement them.

Evaluate results and accomplishments.

Correct your strategy to reflect lessons learned.

A performance management framework, for example—a balanced scorecard,
can be used to evaluate an organization's impact from several perspectives,
including:

customers
learning and growth of employees
internal business processes

financial results

Why Use a Performance Management
Framework?

A performance management framework can help your organization achieve the
following goals:

Reverse a losing competitive position.

Keep pace with new technological advances.
Respond to changing labor markets.

Adjust to changes in your employees and staff.

Comply with government management reforms.

Benefits of Using SAS Strategy
Management

Improve governance, focus, and alignment. Your organization can
collaboratively gain agreement, direction, and priorities for the short, medium,
and long term of key initiatives and goals. You can translate this
understanding through a series of connected strategy maps, themes,
objectives, and metrics that guide and align the strategic activities of an
organization.

Share fact-based information quickly. Managers can cascade information
about current performance and overall strategy within their own teams, and
then allocate the right mix of resources—people, money and technology—to
achieve strategic goals regardless of the timeline.

Show visual connections of objectives and metrics. You can monitor
performance and visually identify opportunities and threats through cause-
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and-effect strategy maps and diagrams. Automated alerts ensure that actions
are taken in a timely manner. You can share feedback and commentary on
results to improve understanding and document various actions and
expectations.

Identify and quantify potential strategic flaws. You can apply embedded
statistical routines within the solution to validate the strategy and perform ad
hoc what-if analysis. Where necessary, you can update the strategy based
on the results, and cascade the updates to managers and employees.

Improve accuracy, consistency, and timeliness of information. You can
automate and schedule the extraction, cleansing, and transformation of data
used to populate the various metrics. SAS provides web-based, manual data
entry for metrics that are not currently captured electronically.

Why Use SAS Strategy Management?

You can use Strategy Management to make sure your organization is executing
the right activities in the right way. Strategy Management enables organizations
to communicate and measure their progress. Doing so means you can make
sure your organization has accomplished what it set out to do. Strategy
Management helps employees and teams understand their goals and priorities.
With this understanding, it is easier to translate goals into activities that the
organization can execute.

You can use SAS Strategy Management to accomplish the following tasks:

Focus on key indicators of success. You can uncover information clearly,
accurately, and quickly.

Expose relationships between activities and how these relationships affect
shareholder value.

Understand which activities drive others and what impact these activities
have on your organization's performance.

Identify potential problems by understanding root causes.

When you can uncover information and relationships to make cause and effect
clear, you can understand why certain activities are more important than others.
You can then use time and resources more efficiently.

SAS Strategy Management Users

SAS Strategy Management serves the following users:

The builders, or scorecard modelers, that are technical users of Strategy
Management.

The viewers, or business users, that use the views created by the scorecard
modelers in Strategy Management.

The data-entry users that enter data into a project in Strategy Management
by using data-entry forms created by scorecard modelers.
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SAS Strategy Management Features

SAS Strategy Management provides the following features:
SAS Strategy Management Builder

1 Portal ( Back sdermo | Preferences Help=
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By using the Builder, scorecard modelers can create and model their
organization's strategy in SAS Strategy Management.

For information about building a strategy, see Chapter 2, “How Do You
Describe a Strategy?,” on page 9. Also, see “Part 2. Describing and
Building Your Strategy.”

SAS Strategy Management views
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By creating views, scorecard modelers provide strategy data to their
business users. For detailed information about views, see Chapter 3, “What
Is a View?,” on page 21. Also, see “Part 3. Navigating Data and Creating
Views in SAS Strategy Management Builder.”

Note: Strategy Management information can also be viewed in SAS Bl
Dashboard. For more information, see Appendix 3, “View SAS Strategy
Management Data in SAS Bl Dashboard,” on page 403.
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Accessing Help and Documentation for
SAS Strategy Management

SAS Strategy Management provides the following types of documentation:

SAS Strategy Management: User's Guide

This document, available as a web document and as a PDF file, provides
detailed information about the concepts and tasks that are related to using
Strategy Management. To access this document, click Help » Help
Contents in the SAS Strategy Management Builder application. The SAS
Documentation window appears.

SAS Documentation Gsas

Quick Search O] =}

Contents | Index | Search
2 Help > SAS Strategy Management

E-@ SAS Strategy Management 5.3: Documentation Previous Page Mext Page E-mail This Page Add to Favorites
[ sAS strategy Management Help

-] SAS Strategy Management 5.3: User's Guide About SAS Strategy Management

SAS Strategy Management helps your organization manage strategy and
the measures and initiatives that support that strategy. Using a managed
strategy, your organization can better align and execute its goals and
objectives.

With SAS Strategy Management, business managers can:
« track progress against your organization's objectives
« understand underperformance and its impact on your organization
« take action now to prepare for the future

« design, build, and manage scorecards, diagrams, and strategy
maps

SAS Strategy Management offers these benefits:

« Focus on today's needs and take appropriate action.

“  GAS Strategy Management 5.3: Documentation > SAS Strategy Management

In the left pane, on the Contents tab, expand SAS Strategy Management
SAS Strategy Management User's Guide. Click View as PDF to access
the PDF file. Click and expand any of the remaining topics or folders to view
the web document version of the User's Guide.

Embedded help

Help pop-ups and tooltips provide brief descriptions of various tasks and
fields to help you use the Strategy Management enhanced portlet effectively.

To access Help pop-ups for more information about a current topic, click @
when it appears next to a field or area in the user interface. You can also
place the mouse pointer over an element in the user interface to view the
associated tooltip for more information.

SAS Strategy Management: Enhanced Portlet Quick Start Guide

This document, available as a web document and a PDF file, provides
detailed information about the tasks that are related to using the Strategy
Management enhanced portlet. You must be in the enhanced portlet to

access this document. In the portlet toolbar, click (.

Note: The information contained in this document is also available in the
SAS Strategy Management: User's Guide.
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Help
Help topics about tasks and concepts are available in the SAS Strategy
Management Builder. To access this help, click Help » Help Contents or
Help » Help on This Page. If you are in a list or wizard, click Help.

You can also find information about SAS Strategy Management on the SAS
Customer Support site at http://support.sas.com/documentation/
onlinedoc/stm/index.html. The product page includes the documentation
for the current version of SAS Strategy Management.

Note: You must have a password to access the documentation on this web
page. If you do not have the password, contact SAS technical support.


http://support.sas.com/documentation/onlinedoc/stm/index.html
http://support.sas.com/documentation/onlinedoc/stm/index.html

How Do You Describe a Strategy?

The Parts of a Strategy 9
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Predefined Templates 11
Projects 12
Scorecards 13
Elements and Attributes 15
Ranges 17
Column Selections 18
Forms 19

The Parts of a Strategy

A strategy created in SAS Strategy Management consists of the following parts:

Templates
Describe the type of strategy that you are creating. Defining a template is the
first step in creating your strategy in SAS Strategy Management. You can
create a template or use a predefined template.

Projects
Store and manage the content for your strategy. You can have one or more
projects associated with a template.

Scorecards
Collect content or information about a specific topic, such as a business unit
or product. You can have one or more scorecards in a project. Scorecards
are arranged hierarchically.



10 Chapter 2 / How Do You Describe a Strategy?

Templates

Overview

In SAS Strategy Management, your first step is to define a template. The
template defines the type of strategy that you are creating by describing the key
parts of the strategy.

Examples of Templates

Before defining your template, you must identify your methodology. There are
many models and methodologies that can describe a strategy. The following
methodologies are examples:

A customized model that you create or that your organization creates
Balanced scorecard

Business process

European Foundation for Quality Management (EFQM)

Governance, Risk, and Compliance (GRC)

Six sigma

Parts of a Template

The Element Types

After you determine your methodology, you must describe the parts of the
strategy in the template.

First, you must define what types of information you want the strategy to store.
For example, you might want your strategy to include goals and measures. This
type of information is called element types. You can have project element types
and scorecard element types:

Project element types are available to all projects (and the scorecards
contained in a project) that are associated with a template. For example, a
project element type might be named “Contacts,” and contains data that are
employee names. The labels and values for a project element type are
exactly the same for all of the scorecards contained in a project.

Scorecard element types are available to one or more scorecards. For
example, a scorecard might include an element type named “Strategic
Objectives,” and contains data that are names of a company's strategic
objectives. The labels and values for scorecard element types are different
for each scorecard in a project.

The Metric Attributes

Next, you must describe types of values that help you to measure, group, or
track your strategy results. Each value type is a standard of measurement for
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the strategy to use as a basis for evaluation or comparison. This type of value is
called a metric attribute. Actual and Target are examples of metric attributes.

TIP Every metric attribute that you define in a template is available to all of
the scorecards and projects that are based on the template.

The Language Setting

Last, you specify the language for your strategy to use to display information in
SAS Strategy Management. The user-defined language setting enables you to
localize your custom-defined content in the strategy. You might use the user-
defined language setting in the following ways:

To display a different language depending on which locale is using SAS
Strategy Management

To display terminologies that are used in different parts of the same company
or in separate divisions of recently merged companies

To display short and long versions of labels

TIP If you do not specify a language in the Strategy Management template, a
default language is automatically used. Template content is displayed in the
default language that is set in the Information Delivery Portal preferences.

The language setting enables the use of another language set, but does not
perform translation. When you specify another language, the default language
text is not translated. You must provide the text in the language that you
specified by entering the text in SAS Strategy Management.

Note:

The SAS Strategy Management program interface, such as menus and
message text, are translated based on language localization settings.
Contact your SAS representative to determine which languages are shipped
with SAS Strategy Management.

Data in a template is displayed in different languages, depending on the
scorecards that are in an associated project.

Date and number formatting is not affected.

Predefined Templates

Overview

SAS Strategy Management provides the following predefined templates:
Balanced Scorecard template and key performance indicator (KPI) template. If
you have chosen either of these methodologies to describe your strategy, these
templates enable you to define your strategy in SAS Strategy Management
quickly.

Note: The user-defined template selection enables you to describe an entirely
custom strategy. This selection does not provide any components that are
already defined.
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Balanced Scorecard Template

The Balanced Scorecard template reflects the Balanced Scorecard methodology
for measuring performance. The Balanced Scorecard template contains the
following components:

A project element type named Contacts

Scorecard element types named Objective, Measure, Initiative, Perspective,
Vision, and Mission

Metric attributes named Actual, Target, Status, and Performance

A language named U.S. English.

KPI Template

The KPI template is used to measure key performance indicators. The KPI
template contains the following components:

A scorecard element type named KPI
Metric attributes named Performance, Actual, and Target
A language named U.S. English.

Projects that are created by using the KPI template do not provide the following
features and functions:

the following features cannot be displayed:
association table in the Builder
classic-style association portlet
association tile in the enhanced portlet

diagrams cannot show relationships

regression analysis is not available

TIP If you copy the predefined KPI template, you can create projects by using
the template copy that provide the missing features and functions.

Projects

As you work with SAS Strategy Management, you must organize
complementary information and content about your strategy. This organization is
accomplished by using projects. A project is a top-level container to store and
manage all the content in your strategy. The project also provides global settings
for your strategy.

Each project is associated with one template. Associated projects are the
projects that are associated with the current template. Associated projects share
the same project element types, scorecard element types, metric attributes, and
languages.
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4 Portal ¢ Back

Template and Project Manager - Annual Strategy

Template™ ) New Project

= predefined Templates ¢

=-E3 User-defined Templates O Name Last Recalculated %
‘B E
-[3 critical Initia s |2 8 2009 strategy . =l
~[3 Future growth 5] € 2010 Strate ]
The projects
associated with
A ——  the template

The user-defined
template

Within the project, you can create and manage the following content:
Scorecards
Ranges
Column selections
Forms

The following tasks are examples of the work that you can do when you are in a
project:

Create a data entry form and enter data by using that form
Perform calculations
View data in the following ways:

Tables

Aggregate tables

Association tables

Gauges (also called dashboards)

Diagrams

For more information about views and viewing data, see Chapter 3, “What Is a
View?,” on page 21.

Scorecards

A scorecard is a collection of content or information about a specific topic. You
can have one or more scorecards in a project. The scorecards can be at a single
level or can be arranged in a hierarchical structure. A project can have one or
more root-level scorecards. Each root-level scorecard can have child scorecards
that are arranged in a hierarchy. For example, a root-level scorecard might
represent a corporation's balanced scorecard. At successively lower levels of
the hierarchy, there might be scorecards for geographical areas, divisions, or
departments.



14 Chapter 2 / How Do You Describe a Strategy?

Figure 2.1 A Project and lts Scorecards
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Figure 2.2 A Parent Scorecard Selected in the Scorecard Hierarchy
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A scorecard tracks internal business processes and external outcomes so that
you can plan a strategy for your organization. You can use a scorecard to
document strategic objectives, targets, initiatives, or any other measurement of
your organization's progress.

TIP You can expand and contract the levels of the hierarchy by clicking the
arrow that is next to the name of a parent scorecard.

P23 Balanced Scorecard

=2-8aq1
=2-8EiAtlantic Coast Region

~EaNorth Carolina

""" BiSouth Carolina
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After you define the type of information that you want the strategy to store
(element types), you can specify detailed information by defining elements. An
element is a unit of data that is represented by a row in a scorecard table. Each
element belongs to an element type that is defined in the template that is
associated with the project. Typically, there are multiple elements associated

with an element type.

Figure 2.3 The Element Type in a Scorecard

Element Type

Objective

04 Mame =R actual & status & ET
5 @& Revenue & 515,090,000 2 [
5 @& Expenses = ¥ 59,973,000 @ r
5 @& Pprofitability 5 = $5,117,000 4 r
= @& customers =] 98 @ r
5 @& cCustomer Satisfaction [ 5 78% A [

Figure 2.4 An Element Is a Row in a Scorecard Table

Element

Objective

0 Mame agp=HIE" actual & status E ET
5 @& Revenue = & 515,090,000 [
5 @ Expenses H = ¥ $9,973,000 ] r
& @ Profitability = 5,117,000 < r
5 @ Customers H = 98 @ r
5 @ cCustomer Satisfaction = 7BE [

The following table provides examples of element types and the elements that

belong to each type.

Element Type Example

Goals

Element Examples

Reduce inspection costs
Reduce overall cost per product
Provide accurate, on-time, delivery service
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Element Type Example Element Examples

Measures Average number of failed inspections
Average cost of each product
Average number of packages tracked online

For example, an employee name might be an element that belongs to the
Contacts project element type. “Create New Products” might be an element that
belongs to the Objectives scorecard element type.

An element value can be either periodic or non-periodic:

Periodic values are values that can vary depending on the period of time in
which the measurement took place. For example, sales numbers can vary by
month. In Strategy Management, periodic values are called metric attributes.
A metric attribute is a value residing in a cell of the scorecard row.

Figure 2.5 A Metric Attribute in a Scorecard Table

Metric Attribute

Objective

O Marne = Actual & status & BT
5 @ Revenue B = 515,090,000 £ r
5 & Expenses = ¥ 49,973,000 @ r
5 & Profitability H & $5,117,000 % r
5 @& customers = 98 ¥ r
5 @& Customer Satisfaction & & Tan £, r

You can enter these values in the following ways:
by entering values one cell at a time
by specifying a formula
by entering data using a data entry form
by importing data
by loading a batch of data
For more information, see “Part 6. Entering Data.”

Non-periodic values are a second type of data that might be included in a
strategy. This data is informational and typically does not change over time.
For example, a website address or a contact name can be displayed in the
strategy. This information does not change from month-to-month. In Strategy
Management, non-periodic values are called element attributes.

Note: Element attributes are defined in the template for each element type.
Element attribute values are set when specifying properties for each element.
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Figure 2.6 An Element Attribute in a Scorecard Table

Element
Attribute
Objective
0 Mame Date Wwiehsita Email =T
]| Q Revenue 1273172010 www.535.C0M finance@sas.com r
El @& Expenses 1273172010 www.535.c0m finance.sas.com I
E & Profitability 12/31/2010 www.535.Cc0Mm sales.sas.com r
IE]| ﬁ.‘ Customers 1273172010 www.welovecustomers.com  sales@sas.com r
[El @ customer Satisfaction 12/31/2010 www.ourhappycustomers,com www.sales,com I

The following display shows a scorecard and all its attributes, both periodic and
non-periodic.

Figure 2.7 A Scorecard and All Its Attributes, Both Periodic and Non-Periodic

Objective
[ Mame fctual = Target = Performance = Oate website Email | =7
= @ Revenus 515,090,000 56,000,000 2625 12032010 weant, 535, 00T finance@®=as. com r
& @ Expenses WS, 9Y3,000 54,200,000 AZ% 12432010 wewrw, 535, 00M finance. sas.com r
& @ Profitability 55,117,000 51,800,000 ZB4RE 1243102010 whanw. 53500 sales.sas.com r
= | @ Customers 98 170 58% | 12,2 /2010 www. o welovecustomers.com  sales®sas, com r
= i Custemer Satisfaction TRE BT 90% | 1273172010 www, OUMADPYCUSTOMETS, N wiwiw, 5ales.com -

Ranges

A range is a defined interval with distinct upper and lower boundaries. Using a
range, you can control how data values are displayed. For example, you can plot
results against a color-coded scale that indicates how close your actual results
are to your desired results. Ranges can be composed of intervals, each of which
can be associated with a normalized value, a grade, an icon, a label, and a
color. When you define a range, you specify the lower bound, upper bound and
one or more range intervals. SAS Strategy Management uses the lower bound
and upper bound to draw the lowest and highest values in a graph. The range
intervals are drawn as segments in the graph between the low and high bounds.

Figure 2.8 Example of a Table Displaying Ranges

Name B | Period | Actual | Status | Icon

Revenues g 5 ausziin $24,655,000 s
Expanses 2 & ausziin ¥ §16,461,740 o
Frofitability g 5 ausz010 $8,193,250 *
Customers g 5 auszoin ag b |
Custorner Satist B G AUGZ010 78% N
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Figure 2.9 Example of a Gauge Displaying the Same Ranges

Revenues Customers Customer Satisfaction

P a L

For more information, see “Create a Range” on page 136.

Column Selections

When your strategy contains a lot of data, it can be difficult to understand. You
can use column selections to group metric attributes, which appear in columns,
to create specific views of your data. A column selection specifies the columns
that are displayed with an element type in a table view, aggregate view,
association view, data-entry form, or element details report.

You can apply column selections to element types within a project. When you
create a project that is based on a template that defines metric attributes,
column selections for the new project are automatically generated from the
metric attributes. Column selections are also generated for the element types.

Figure 2.10 Example of a Table Displaying All Metric Attributes

Name |7 | & | period | Actual | Target | Performance | Trend

Revenues B, & AUG010 $24,855000 10,000,000 Jo 18% &
Expenses 26 AUG010 ¥ $16,461,750 $5,000,000 Jiov 137% r
Profitability B & AUG010 $8,193,250 $3,000,000 Jo s0% P
Customers B & aUG2010 as 170 Jo 58% P
Custorner Satisf B & AUG2010 78% 87% Jor 0% &
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Figure 2.11 Example of a Table Displaying Only Selected Columns

Name |=gu | (=] | Period | Actual | Status | Icon

Revenues 2 & ausziio §24,655,000 s
Expanses 2 5 auszoio ¥ $16,461,750 o
Profitability % @ ALGZIM0 8,193 250 &
Customers g 5 auszoin e} b |
Custorner Satist B G AUGZ010 78% N

For more information, see “Create a Column Selection” on page 142.

A form enables you to enter data or information into a strategy. Using SAS
Strategy Management Builder, you can create a form to enter data into your
Strategy Management project.

For more information, see Chapter 33, “Creating and Managing Forms,” on page
329.
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What Is a View?

Overview

Overview 21
Table 22
Aggregate 23
Association 23
Diagram 24
Gauge (Also Called Dashboard) 25
Trend Analysis 26

SAS Strategy Management provides different ways to display and explore
strategy content and data. These are called views. Depending on your strategy,
data might be easier to understand in one type of view compared to another
type. The following views are available:

Table
Aggregate
Association
Diagram
Gauge (also called dashboard)
Trend analysis
You can use these views in the following ways:

You can navigate and explore your data using different views in SAS
Strategy Management Builder. You can use only one view at a time. Some
business users might access a view in the Builder to adjust the view, but the
Builder is primarily used by scorecard modelers. For detailed information,
see “Part 3. Navigating Data and Creating Views in SAS Strategy
Management Builder.”

You can create a portlet that is displayed on a portal page in the SAS
Information Delivery Portal. Scorecard modelers create portlet views for their
business users. Because you can have multiple portlets on a portal page,
you can display and use multiple views at a time. Also, the new Strategy
Management enhanced portlet can display one or more tiles. A tile is like a
window, but it exists within the boundaries of a portlet. In Strategy
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Table

Management, a tile displays a view. For detailed information, see “Part 4.

Creating Portlet Views for Business Users.”

Note: Strategy Management information can also be viewed in SAS Bl
Dashboard. For more information, see Appendix 3, “View SAS Strategy

Management Data in SAS Bl Dashboard,” on page 403.

The views are available in the following ways:

View Builder
Table Yes
Aggregate Yes
Association Yes
Diagram Yes
Gauge No
Trend Yes'

1 Links to the Trend Analysis page that provides the classic style dynamic analysis

features.

2 Provides the trend analysis tile with enhanced dynamic features and a static trend

chart option.

Classic-style
Portlet

Yes
Yes
Yes
Yes
Yes

Yes'

Tables display data in rows and columns.

Figure 3.1 Table Example

Revenues 2 & ausziio
Expenses 2 5 auszoio
Frofitability % 5 AUGZ0MD
Custormers g 5 auszoin
Custorner Satist B G AUGZ010

$24,655,000
¥ $16,461,750
$8,193,250

Enhanced-portlet

Tile

Yes

Yes

Yes

Yes

Yes

Yes?

P & ¢ @ P

The columns in the table are determined by the template with which the project
is associated. The elements are displayed in rows. You can create elements in a

table.

In a table, you can perform the following tasks:

Display data that is organized by element type, attribute, and date.
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Create, copy, move, and delete elements.

Customize the rows, columns, and types of links that are displayed in the
table.

Format columns and cells.

Apply formulas and ranges to columns.
Set global and personal threshold options.
Display history.

View and add comments.

Aggregate
An aggregate table shows data from the selected scorecard and all of its
children. You can choose to view the aggregated data by scorecard or by metric
attribute.
Note: If a scorecard does not contain child scorecards, the aggregate table is
not displayed.
Figure 3.2 Aggregate Example
Status
Name , : ) [ - | . | -
Asia Pacific China | Asia Pacific India China
Revenues §7,390,000 $4,500,000 $2,830,000 Fi FaN FaN
Expenses $5,118,500 $3,240,000 §1,878,500 L] @ =]
Profitability $2,271,500 $1,260,000 §1,011,500 W v ¥
Customers ag 98 28 ] ] ]
Customer Satisfa 78% 78% 78% Y Y Y
Association

An association displays relationships between scorecard element types and their
associated element type attributes in a project. The elements are displayed in a
hierarchy to reflect their association.
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Diagram

Figure 3.3 Association Example

Target | |Pem:|rman...| | Trend

v ') Guality management B |G
& Profitakility B & $8,193,250 $3,000,000 50% &

v ' Customer loyalty program B &
¥ & Revenues B & $24,655,000  $10,000,000 18% &
¥ Market share =] §45 75 59% P
¥ & Customers =NIc] 98 170 53% &
New Customers B2 & $89 150 58% a
¥ & customer Satisfaction & G 7% 87% 90% A
&Producti\riw % = §74 95 79% Ll
¥ Hours spent with cL B 45 65 £9% W

A diagram is a graphical way of representing elements, their relationships to one
another, and their respective scores. A diagram is a way to present information
found in tables, but in a more intuitive way. When you use a diagram, you can
display results in the context of the strategy and provide answers about how well
the organization is performing and why certain data or a certain relationship is
important.

A diagram enables users to see the relationship between strategy elements.
These relationships are sometimes difficult to convey in a table. You can create
diagrams that illustrate the relationships between scorecard elements or project
element types.

Note: A diagram is often used to present the strategy map, which is a layered
representation that conveys the drivers and relationships.
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Figure 3.4 Example of a Diagram View Displayed in a Classic-Style Portlet

Project: 2010 Strategy Date: 08/12/2010
Scorecard: Worldwide Zoom: OAELE
Ciagram: 2010 Strategy &
Objective Measure
Customer Satisfaction Hours spentwith customer Productivity
Actual TE% L Actual 45 Actual £75.00
£ Targat 87% [ & Targat 65 & Target a5
Status Status 5 Status s
Performance 0% Performance  69% Performance  79%
Cuslomers Mew Customers
Actual ] 3 Actual $80.00
£ Tagar 170 o Target 150
Status 2 Status .
Perfarmante  58% Performance  59%
Eqenses FTE Headcount
Actual §16,461,75000 & ¥ Actual $170.00 Actual $170.00
£ Target $5,000,000.00 & Target 170 o Target 150
Status 3 Stalus & Status .
Peformance  137% Ferformance  100% Performance  113%
[T Market share
Actual $24655000.00 Actual $44.50
& Target $10,000,000.00 o Target 75
Stalus . Status :
Performance  18% Pefformance  50%

Gauge (Also Called Dashboard)

A gauge (also called dashboard) displays ranges of data in a graphical format.
You can display key performance indicators or any SAS Strategy Management
elements by using the gauge view. Each element is represented by a gauge that
displays the data ranges that are defined. In addition to displaying ranges, you
can provide links to comments, trend data, and element properties.

Gauges can be displayed as a dial, a slider, a traffic light, a speedometer, a
thermometer, or a bullet.
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Figure 3.5 Example of a Gauge Dial

Revenues

Trend Analysis

Customers Customer Satisfaction

PE e

An element's trend is its performance over time. You can view a trend analysis
that displays the trend of an element's data. SAS Strategy Management
provides different trend view implementations depending on the product feature.

Product Feature

Builder

Classic-style
portlet

Enhanced-portlet
tile

Enhanced-portlet
option

Trend Implementation

When you are working in the Builder using the table or association
views, the Trend Analysis button is available. When you click this
button, the Trend Analysis page appears.

When you are working in the table, association, or dashboard
views in a classic-style portlet, the Trend Analysis button might be
available, depending on how the portlet is customized. When you
click this button, the Builder opens and the Trend Analysis page
appears.

The Strategy Management enhanced portlet can be customized to
include a trend analysis tile. You can drag a value or an element
from one or more table, aggregate, association, or gauge tiles
onto the trend analysis tile. You can manipulate the resulting
graph to further explore the trend analysis. You can also add or
remove more data from other tiles. See Figure 3.6 on page 27.

The enhanced-portlet tiles for the table, association, diagram, and
gauge views provide an option to display a static trend chart. If the
tile is customized to use this option, you can click an icon that
opens a trend chart. The data is static although you can change
the date range using the date slider. See Figure 3.7 on page 28.

With the Trend Analysis page, the initial analysis uses the element whose row
you clicked to open the Trend Analysis page. However, you can dynamically add
to or change the analysis after it opens. For more information, see Chapter 22,
“Creating and Editing Trend Analysis Views,” on page 237.
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For more information about the enhanced-portlet implementations of trend
analysis, see the following sections:
“Edit the Trend Analysis Tile Properties” on page 281
Chapter 30, “Navigating and Viewing the Strategy Management Enhanced
Portlet and Its Tiles,” on page 305

Figure 3.6 Example of a Dynamic Trend Analysis in an Enhanced Portlet Tile

GHBE B E&EH -~

-

o Target- Customers dWorldwide)
@ Actual - Customers (Woarldwide)

@ Performance - Customers (Woarldwide)

160
a
150
180 o o
140
a
130
o
120
Q 115
110 o 110
@ 102 2
100
_ =1 a7
100 =} pid
a8
o
7 7
Q o
a0
wE 30% a5% 5% a2% 3% 4%
0 @ @ d d d @ @
T T T T T T T
01Jan10 01Feb10 01Mar10 31Mar10 304pr10 JMayl0 30Jun1n
BB § B B § %
|: - - - M - - - :I
01Jan10 01Feh10 01Mar10 31Mar10 30&pr10 I May10 30Jun1n

Start date: | 01/01/2010 |7 End date: |07/21/2010 7]
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Figure 3.7 Example of a Static Trend Chart in the Enhanced Portlet

Trend Chart of Customers (Worldwide) ®

175
140
125
100

74

50

Marog  May09  Juiog Sep09  Mov09  Jant0 Marid May10  Julo

& Target & Actual

Close
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Starting SAS Strategy Management Builder
Using a Link

Overview

You can create a shortcut link that opens SAS Strategy Management Builder in
your web browser by using the web address of the SAS Strategy Management
web application (the Builder).

Create the Shortcut Link
To create the shortcut link that opens SAS Strategy Management Builder:

1 Right-click your Windows desktop and click New » Shortcut. The Create
Shortcut wizard appears.

2 Inthe Type the location of the item field, enter the web address for the
SAS Strategy Management web application.

Note: To obtain the web address, contact your system administrator.

3 Click Next.
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4 In the Type a name for this shortcut, enter a short, descriptive name for
this shortcut.

5 Click Finish. The shortcut appears on your Windows desktop.

Log On
To log on to the SAS Strategy Management web application (the Builder):

1 Click the shortcut on your desktop. The Log On page appears.

Log On to SAS®

nstitute Inc., Cary, NC USA

2 Enter your user ID and password.

3 Click Log On. The SAS Strategy Management Builder appears and the
Template and Project Manager page is displayed.

Starting SAS Strategy Management Builder
from a Portlet

Overview

Before you access SAS Strategy Management Builder, you must log on to the
SAS Information Delivery Portal and create a portal page. Then you can add a
Collection portlet from which to start SAS Strategy Management Builder.
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Log On
To log on to the SAS Information Delivery Portal:

1 Open your browser and enter the web address for the portal. The Log On
page appears.

Note: To obtain the web address, contact your portal administrator.
2 Enter your user ID and password.

3 Click Log On. Your personal portal opens. Initially, the portal contains no
pages or portlets.

Create a Page

To create a new portal page to contain the SAS Strategy Management Builder
portlet:

1 Click Customize » Add Page. The Add Pages to Profile page appears.

Add Pages to Profile Ggsas

Create Search

# Name:
Description:
Keywords:
Page rank: 100 Pages are ordered by rank from lowest to highest.

Add

Done

2 On the Create tab, type descriptive information about the page:

Name
a short name that appears in the page tab in the navigation bar.

Description
a short description that appears along with the page title in search results.

Keywords
single words that you or other users can use to search for this page. Use
spaces to separate keywords from one another.

Note: To ensure efficient searching, develop a list of standard keywords
and use these keywords consistently.

Page rank
a number that indicates the importance of this page as compared to other
pages. The default value is 100.

This number determines the order in which pages are listed in the
navigation bar. The pages are ordered by rank from lowest to highest.
Pages that have equal rank are listed in the order in which they were
created.
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Location (group)
Note: This list appears only if you are a group content administrator.

specifies the group with which to share the page. If you select a value in
the Location (group) field, the Share type field appears.

TIP This selection supports sharing with only one group at a time. To
share with more than one group, you must have authorization manager
capability in the SAS Management Console. In SAS Management
Console Permissions, expand Authorization Manager » By Type
PSPortletPage. Click your new portal page. In the View Properties list,
on the Authorization tab, add any users and groups to share. Click OK.

TIP To share with everyone, select Public from the list.

Share type
Note: This list appears only if you are a group content administrator and
have made a selection in the Location (group) list.

indicates how the page is shared with users. This list provides the
following options:

Option Description

Available Users in the group can find the page using Search. They can add
the page if needed.

Default Users in the group automatically see the page the next time they
log on to the portal. Users can remove the page from the
navigation bar if the page is not needed.

Persistent Users in the group automatically see the page the next time they
log on to the portal. However, users cannot remove the page from
the navigation bar.

3 Click Add.

4 Click Done. The new, empty page appears in the portal.

Add a Portlet to the Page

A Collection portlet can contain links to the content and applications that you
frequently use. Your portal might contain several of these portlets, each
containing its own set of links. For SAS Strategy Management, these portlets
can contain a task link that starts SAS Strategy Management Builder.

To add a portlet to a page:

1 Navigate to the Information Delivery Portal page to which you want to add a
portlet.

2 Click Customize » Edit Page » Edit Page Content. The Edit Page Content
page appears.
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Edit Page Content » Home

Layout: @ Bycolumn  © By grid
Mumber of columns: ©) 4 @ 2 @ 3
Column width: B0 % 1T 1
Portlet layout:
Column 1 Column 2
My Collection | 4 Finance Results -
Bookmarks
4
s
@
<% «|*
Add Portlets. ..
Ok | | Cancel
3 Click Add Portlets. The Add Portlets to Page page appears.
4 From the Portlet type list, select Collection.
5 Enter the name, description, and keywords, if any.
6 Click Add.

7 Click Done.

8 On the Edit Page Content page, click OK. The new portlet appears on the
page.

Add Links to the Collection Portlet

You can add links to the Collection portlet that open a limited set of features in
Strategy Management Builder. You can also add a link that opens a specific
project or scorecard.

Complete the following steps in the My Collection portlet:

1 On the My Collection portlet toolbar, click Edit Content. The Edit Portlet
Content page appears.

2 Click Add Items. The Add Items to Portlet page appears.

3 To add a predefined link to the portlet, complete the following steps:
a Click the Search tab.
b In the Keywords field, type strategy.
c Inthe list, click Application.

d Click Search. In the right pane, the search results appear. Any
application link that includes the word strategy is displayed.
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e

f

Select one or both of the following results:
Manage Strategy Management Scorecard Projects and Templates

New Strategy Management Scorecard Project

Click Add.

4 To add a custom link to the portlet, complete the following steps:

d

Click Application. Doing so makes sure that you do not have to log on to
the portal again.

On the Create tab, in the Name field, enter the name that you want to use
to label the link.

In the URL field, type or paste the web address for the SAS Strategy
Management project or scorecard that you want the link to open.

Note: To obtain the web address, navigate to the project, scorecard, or
any other location within the Strategy Management Builder that you want
to open. Then, copy that web address from your web browser address
field.

Click Add.

5 Click Done to exit the Add Items to Portlet page.

6 On the Edit Portlet Content page, click OK. The portlet now contains the links
that you added. For information about starting the Builder, see “Start the
Strategy Management Builder” on page 36.

Start the Strategy Management Builder

To start the Strategy Management Builder from a Collections portlet, click the
link label that you specified for the Strategy Management Builder web address.
The Builder appears.
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+ Portal « Back ¥ o | Preferences Help=

Template and Project Manager - Balanced Scorecard §sas

| Template~ 3_»‘3] Mewe Project
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For a detailed description of the Builder interface, see Chapter 5, “The SAS
Strategy Management Builder Interface,” on page 39.

Using SAS Strategy Management and SAS
Visual Analytics

If you have SAS Visual Analytics 6.4 installed in your environment with SAS
Strategy Management 5.6, the SAS Visual Analytics home page provides the
following ways to access SAS Strategy Management:

Projects: If you select a project on the home page, the SAS Strategy
Management Builder opens and you can edit the content. The home page
also includes a Manage Strategy option in the Create Content section.

Data-entry forms: If you select a data-entry form on the home page, the
data-entry form portlet opens and you can work with the form.

Mobile reports: When you generate a mobile report from a SAS Strategy
Management enhanced portlet, you can add the report to the home page by
using the Manage My Content window. When you open the report from the
home page, the SAS Strategy Management portlet from which the report was
generated opens.

Note:
You must have access to the folder in which the report is saved.
The data in the report is filtered based on your user permissions.

To use SAS Visual Analytics and SAS Strategy Management together,
remember the following considerations:

You must be a SAS Visual Analytics user in order to access the home page.
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You must be a SAS Strategy Management user in order to open projects,
data-entry forms, and reports. The degree of access that you have is
determined by your user permissions.

Log Off from SAS Strategy Management
Builder

To log off from SAS Strategy Management Builder, click Log Off in the upper
right corner of the user interface.

Note: If your session is inactive longer than the SAS Information Delivery Portal
time-out value, you are automatically logged off.
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Your First Look at the Strategy
Management Builder

The following display shows the SAS Strategy Management interface and its
major parts:

Enrtal. 1 Back Log Off zazdetmo | Preferences Help=

Template and Project Manager - Balanced Scorecard Gsas
2 —| | Template i3] Maw Project

F-E predeflined Templates

EllEalanced Scorocard B
B KPI Tamphate [1 Marne Last Recalculated r
L% User-defined Templates Ell4d 2010 strategy 06./06/2010 O




40 Chapter 5 / The SAS Strategy Management Builder Interface

banner
toolbar

navigation pane

A O N =

content pane

About the Banner
The following display shows the banner interface and its features:

1 2 3 4

Log Off sasdemo | Preferences | Help=

Template and Project Manager - Balanced Scorecard gsas

1 Title

Identifies the current page in SAS Strategy Management and the currently
selected template, project, or scorecard. In this example, the selected
template name is displayed.

2 Log Off
Click to log off from SAS Strategy Management.
3 Preferences

Click to view and set preferences for the SAS Information Delivery Portal, its
pages, and its portlets.

4 Help

Displays the Help menu that provides help for SAS Strategy Management,
the SAS Information Delivery Portal, and any other products installed in the
portal.

Note: Depending on where you are in SAS Strategy Management, the Back
link appears next to the Portal link. Click Back to return to the previous page.

About the Toolbar

The toolbar provides buttons for frequently used tasks in the Builder. The
buttons that are displayed vary depending on selections that you made in the
Builder. The following display shows the toolbar when you first open SAS
Strategy Management Builder:

Figure 5.1 Initial Toolbar in the Builder

Templatew ] New Project thanage Time Periods Wiew &udit Records ] tanage Mobile Applications

When you open a project or scorecard, the toolbar displays one set of buttons
above the navigation pane and another set of buttons above the content pane.



About the Toolbar 41

Figure 5.2 Toolbar above Navigation Pane

2
|

3
|

] F'rclljec:tv B Scnrnlacard' =

1 Displays the Project menu. For more information, see Chapter 7, “Working
with Projects,” on page 63.

2 Displays the Scorecard menu. For more information, see Chapter 8,
“Working with Scorecards,” on page 87.

3 Prints the current view in the content pane. For more information, see “Print a

View” on page 245.

The content pane buttons include buttons that are always available and other
buttons that vary depending on the type of content that appears in the pane.

Figure 5.3 Buttons That Are Always Available above the Content Pane

B | H| = =P (%]
Button Name Description
i Table view Displays the table view. This is the default view. For more
information, see Chapter 17, “Creating and Editing Table
Views,” on page 163.
E‘-j; Aggregate Displays the aggregate view. For more information, see
view Chapter 18, “Creating and Editing Aggregate Views,” on
page 169.
@ Association Displays the association view. For more information, see
view Chapter 19, “Creating and Editing Association Views,” on
page 171.
Diagram view Displays the diagram view. For more information, see
Chapter 20, “Creating and Editing Diagram Views,” on page
177.
"|:| Add to portlet  Provides a way to save a view to a portlet. For more

%

Save as a
SAS
Information
Map

Copy web
address

Refresh

information, see “Save a View to a Portlet” on page 244.

(Table view only) Provides a way to save the scorecard as
a SAS Information Map. For more information, see “Save a
Scorecard as a SAS Information Map” on page 89.

Provides a way to copy the web address of the view. For
more information, see “Link to a View Using a Web
Address” on page 245.

Refreshes the current view.

Note: The buttons that are displayed depending on the current content are
described in the chapters related to that content.
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About the Navigation Pane

The navigation pane, located on the left side of the SAS Strategy Management
Builder interface, enables you to navigate the following hierarchies:

If you are working on the Templates and Project Manager page, it provides
the available templates.

If you are working in a project or scorecard, this pane provides the
scorecards in the project.

About the Content Pane

The content pane, located on the right side of the SAS Strategy Management
Builder interface, enables you to view lists of available content or to view the
currently selected content.
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Overview

For a description of templates, projects, and scorecards, and how they relate to
each other, see Chapter 2, “How Do You Describe a Strategy?,” on page 9.

List Templates

Templates are listed in the Template and Project Manager. For more
information, see “Display the Template and Project Manager Page” on page
147.

Create a Template

To create a template:

1

Display the Template and Project Manager page. For more information, see
“Display the Template and Project Manager Page” on page 147.

Click Template » New Template. The New Template page appears.

Enter a name for the new template in the Template name field.

Note: The name must be unique among the user-defined templates.

Click OK. The Template Editor page appears.

Template Editor - Mobile outreach

mplate~r %5 New Project Element Type
Iz loroject Element Typesjilied
B Scorecard Element Types [ Name Description =50
£Metric Attributes Mo values were returned for this table.

-4BUser-defined Languages

To define the project elements, select Project Element Types from the list
on the left and complete the following steps:

a Click New Project Element Type. The New Project Element Type page
appears.
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New Project Element Type

— General settings

* Elernent type name: Tablets
Description: Campaign on tablet devices.
Image: W@

—Diagram settings

Font color: _@ Shape: MNone -
Background color: @

OK Cancel

In the General settings section, enter a name for the element type. You
can also enter a description.

Note: The name must be unique among the project element types and
the scorecard element types in the template.

Click the icon that is next to Image and select an image to represent the
element type.

Note: When you view a scorecard later, if the image that is specified
here is missing, no image is displayed for that project element type. An
image might be missing because the previously assigned image has been
removed.

In the Diagram settings section, click the icon that is next to Font color
and select a font color to be displayed with the element type in a diagram.

Click the icon that is next to Background color and select a color to be
displayed in the background of the element type in a diagram.

From the Shape list, select a shape to be displayed with the element type
in a diagram.

Click OK.

To define a scorecard element type, select Scorecard Element Types from
the list on the left and complete the following steps:

Click New Scorecard Element Type. The New Scorecard Element Type
page appears.
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New Scorecard Element Type

— General settings

*k Element type name: Android|

Description:

Image: WE

Allow Suggested Elements: =

—Diagram settings

Font color: _@ Shape: None -
Background color: @

OK Cancel

b Inthe General settings section, enter a name for the element type. You
can also enter a description.

c Click the icon that is next to Image and select an image to represent the
element type.

Note: When you view a scorecard later, if the image specified here is
missing, no image is displayed for that scorecard element type. An image
might be missing because the previously assigned image has been
removed.

d To enable users to suggest elements, select Allow Suggested
Elements.

e In the Diagram settings section, click the icon that is next to Font color
and select a font color to be displayed with the element type in a diagram.

Note: The diagram settings are applied only when a diagram is created.
The settings do not affect existing diagrams.

f Click the icon that is next to Background color and select a color to be
displayed in the background of the element type in a diagram.

g From the Shape list, select a shape to be displayed with the element type
in a diagram.

h Click OK.

7 To define a metric attribute, select Metric Attributes from the list on the left
and complete the following steps:

a Click New Metric Attribute. The New Metric Attribute page appears.
b Enter a name for the metric attribute.
c Click OK.

8 (Optional) To define a language, select User-defined Languages from the
list on the left and complete the following steps.

Note: For more information, see “Working with Language Settings” on page
55.

a Click New Language. The New Language page appears.
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b Enter a name for the language.

c Click OK.

Open a Template

You can open a template for editing and viewing. Element types, metric
attributes, and languages that you add to a template after you have created a
project are reflected in the project. If you delete element types, metric attributes,
or languages from a template, those items are deleted from the project, whether
or not they contain data.

To open a template, complete the following steps on the Template and Project
Manager page:

1 Select a template name in the list of templates.

2 Click Template » Edit Template. The Template Editor page appears.

Template Editor - Strategy

Template~ 1@ New Project Element Type
oject Element Types
i~ Scorecard Element Types 0 Name  Description 20
S Metric Attributes [l & Contacts Persons who are responsible for or can answer questions about an element. B

E---@u;er-defined Languages

Working with Project Elements

Overview

You define a project element type when you create a template. For more
information, see “Create a Template” on page 44.

To list the project element types that are in a template, open a template and click
Project Element Types.

The Project Element Types table displays the element types that you have
created for the selected template. From this table, you can create new element
types, edit the properties of element types, and copy and delete element types.

Edit Project Element Type Properties

To edit project element type properties in a template, complete the following
steps in an open template:

1 Select Project Element Types from the list on the left.

2 Next to an element type in the table, click [5] and click Properties. The
Project Element Type Properties page appears.



48 Chapter 6 / Working with Templates

Project Element Type Properties - Contacts 9sas
o General
—General settings
Element type: Project
# Element type name: [Contacts
Description: Persons who are responsible for or can answer
questions about an element.
Image: EE
—Diagram settings
Font color: _@ Shape: Rectangle -
Background color: E
w Attribute Definition
0K | Cancel | Apply |

3 To change the general properties of a project element type, complete the
following steps:

In the General section, enter a new name in the Element type name
field.

(Optional) Change the description in the Description field.

To change the image to be displayed with the element type, click the icon
that is next to Image and select an image.

Note: If an image does not exist, no image is displayed for that element
type. Images might be missing because a previously assigned image has
been removed without updating the element type properties.

In the Diagram Settings section, click the icon that is next to Font color
to change the font color to be displayed with the element type in a
diagram.

Click the icon that is next to Background color to change the color to be
displayed in the background of the element type in a diagram.

From the Shape list, change the shape to be displayed with the element
type in a diagram.

To define an attribute for a project element type, complete the following

steps.

Note: An attribute definition describes the types of information that can be
displayed with project element types. You can define more than one attribute
for an element. An attribute can belong to one of the following categories:

Text

E-mail

Date

URL (web address)
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Element type

a Expand the Attribute Definition section.

5 Attribute Definition
Add and define the attributes that describe the information you want to display in scorecards.

Attribute settings:

Attribute 1 % Attribute 2 P
Label: Label:

Email Address Phone

Description Description

Attribute category: Attribute category:

Email A Text -

Add Attribute

b Click Add Attribute. A new attribute is added to the right-most column.

o Attribute Definition
Add and define the attributes that describe the information you want to display in scorecards.

Attribute settings:

Attribute 1 » Attribute 2 | Attribute 3 X
Label: Label: Label:

Email Address Phone Attribute 3

Description Description Description

Attribute category: Attribute category: Attribute category:

Email hd Text - Text v

Add Attribute

c In the Label field, enter a new label such as User ID for the attribute.
d (Optional) In the Description field, enter a description of the attribute.
e From the Attribute category list, select a category.

f If you select Element Type as the category, select an element type from
the Element type list. Doing so associates the attribute to an element

type.

TIP To associate the attribute with more than one element type, click
Allow multiple selections.

g To edit an attribute definition, enter a new label or a new description, or
select a different category for the selected attribute in the Attribute
Settings window.

h To delete an attribute, click X that is next to the attribute name in the
Attribute Settings window.
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5 When you are finished editing the project element type properties, click OK.

Copy Project Element Types or Scorecard
Element Types

To save a project element type or a scorecard element type under a different
name in the same user-defined template, complete the following steps in an
open user-defined template:

1 Select Project Element Types or Scorecard Element Types from the list
on the left.

2 Next to an element type in the table, click [] and click Copy. The Copy page
appears.

3 Enter a name for the copy of the element type.

Note: By default, the name is element-type-namecopy.

4 Click Copy.

Delete Project Element Types

To delete a project element type, complete the following steps in an open
template:

1 Select Project Element Types from the list on the left.
2 Next to an element type in the table, click [=] and click Delete.

3 To delete more than one element type, perform one of the following steps:

Click the check box to the right of each element type that you want to
delete. Then, click [z for the column and click Delete.

To delete all element types, click the check box at the top of the right-
most column, click [E] for the column and click Delete.

Change the Order of Element Types

You can change the order in which element types are displayed within SAS
Strategy Management.

To change the order of element types, complete the following steps in an open
template:

1 On the left, select Project Element Types or Scorecard Element Types.

2 To the left of an element type, click [l and click Reorder. The Reorder
Element Types page appears.
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Reorder Element Types

Element Types

Perspective | 42 sort Ascending
Objective 7
Measure 34 sort Descending
Initiative _
Theme iy
Mision J

r

¥

3 To sort in ascending or descending alphabetic order, click Sort Ascending
or Sort Descending.

4 To move items, select one or more items and use the following icons:
Icon Action
}' Moves the selected item to the beginning of the list.
iy Moves the selected item up.

L

Moves the selected item down.

4=

Moves the selected item to the end of the list.

Working with Scorecard Element Types

List Scorecard Element Types

To list the scorecard element types in a template, open a template, and select
Scorecard Element Types from the list on the left. The table displays the
scorecard element types that have been created for the selected template. From
this table, you can create new scorecard element types, edit the properties of
scorecard element types, and copy and delete scorecard element types.

Edit Scorecard Element Type Properties

To edit scorecard element type properties, complete the following steps in an
open template:

1 Select Scorecard Element Types from the list on the left.

2 Next to an element type in the table, click [] and click Properties. The
Scorecard Element Type Properties page appears.
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Scorecard Element Type Properties + Measure

= General

— General settings

Element type: Scorecard
* Element type name: Measure
Description: An indicator that shows how close actual results

are to targeted results in support of an
organization's strategy.

Image: @E

Allow Suggested Elements: [7]

—Diagram settings

Font color: _@ Shape: Rectangle -
Background color: @

m Attribute Definition

OK| Cancel| Applyl

3 To change the general properties of a scorecard element type, complete the
following steps:

In the General section, enter a new name in the Element type name
field.

Change the description in the Description field.

To change the image to be displayed with the element type, click the icon
that is next to Image and select an image.

Note: If an image does not exist, no image is displayed for that element
type. Images might be missing because a previously assigned image has
been removed without updating the element type properties.

In the Diagram Settings section, click the icon that is next to Font color
to change the font color to be displayed with the element type in a
diagram.

Click the icon that is next to Background color to change the color to be
displayed in the background of the element type in a diagram.

From the Shape list, change the shape to be displayed with the element
type in a diagram.

4 To define an attribute for a scorecard element type, complete the following
steps:

Expand the Attribute Definition section.
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o Attribute Definition
Add and define the attributes that describe the information you want to display in scorecards.

Attribute settings:

Attribute 1 > Attribute 2 b
Label: Label:

Email Address Phone

Description Description

Attribute category: Attribute category:

Email A Text A

Add Attribute

b Click Add Attribute. A new attribute is added to the right-most column.

= Attribute Definition
Add and define the attributes that describe the information you want to display in scorecards.

Attribute settings:

Attribute 1 X Attribute 2 X| Attribute 3 X
Label: Label: Label:
Email Address Phone Aftribute 3

Description Description Description

Attribute category: Attribute category: Attribute category:
Email - Text - Text -

Add attribute

c In the Label field, enter a new label for the attribute, such as Vision.
d In the Description field, enter a description of the attribute.
e From the Attribute category list, select a category.

f If you select Element Type as the category, select an element type from
the Element type list.

This action associates the attribute to an element type. Associated
elements are affected by formula functions that calculate the mean, max,
min, or sum of all elements that are associated. Associations show
relationships between elements that have been defined. For more
information, see “Association” on page 23.

To associate the attribute to more than one element type, click Allow
multiple selections.

To edit an attribute definition, enter a new label or a new description, or select a
different category for the selected attribute.

To delete an attribute, click b S that is next to the attribute name.
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Copy Scorecard Element Types

To copy a scorecard element type in the same template, complete the following
steps in an open template:

1 Select Scorecard Element Types from the list on the left.

2 Next to an element type in the table, click [] and click Copy. The Copy page
appears.

3 Enter a new name for the copy of element type.

Note: By default, the name is element-type-namecopy.

Delete Scorecard Element Types

To delete a scorecard element type, complete the following steps in an open
template:

1 Select Scorecard Element Types from the list on the left.

2 To delete a single element type, next to an element type in the table, click =
and click Delete.

3 To delete more than one element type in a user-defined template only,
perform one of the following steps:

Select the check box to the right of each element type, click = for the
column and click Delete.

To delete all element types, click the check box at the top of the right-
most column, click [= for the column and click Delete.

Working with Metric Attributes

List Metric Attributes

To list metric attributes, in an open template, select Metric Attributes from the
list on the left. The Metric Attributes table displays the metric attributes that you
have created for the selected template.

Template Editor - Strategy

Template- B New Metric Attribute

“®

Scorecard Element Types [0 Name
IMetric Attribute 5 & Actual
[zl & Performance
[l &8 Target

.4g@User-defined Languages




Working with Language Settings 55

Rename a Metric Attribute
To rename a metric attribute, complete the following steps in an open template:
1 Select Metric Attributes from the list on the left.

2 Next to a metric attribute in the table, click =] and click Rename. The
Rename Metric Attribute page appears.

3 Enter a new name in the New name field.

4 Click OK.

Delete Metric Attributes

To delete a metric attribute from a template, complete the following steps in an
open template:

1 Select Metric Attributes from the list on the left.

2 Next to a metric attribute in the table, click =] and click Delete.

Working with Language Settings

Overview

You can define a language when you create a template. This language is an
alternative to the default language and is available to any user of the affected
template and its projects. For more information, see “Create a Template” on
page 44.

Create and Edit a User-Defined Language

Note: The following procedure presumes that the template content has already
been created in the default language.

To create a user-defined language to use when working in a template and its
projects, complete the following steps in an open template:

1 In the left pane, click User-defined Languages. The list of available
languages appears in the right pane.

Template Editor - Strategy

Template~ % MNew Language

. “Project Element Types 4

.-EyScorecard Element Types 00 Name E O
[l 42 English

ZaMetric Attributes

2 Click New Language. The New Language page appears.
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3

In the Language name field, enter the name of the language and click OK.
The new language appears in the language list.

Click Template » Select Template Edit Language. The Edit Template in
This Language page appears.

Select the new language that you created from the Language list and click
OK.

In the left pane, click Project Element Types. For each element type in the
right pane, complete the following steps:

a Next to the element in the table, click =] and click Properties. The
Properties page appears.

b In the Element type name field, enter the name in the new language and
click OK. The translated element name appears in the list.

c Repeat step 3 for the Scorecard Element Types and the Metric
Attributes lists.

Note: If a name is not translated and you set the user-defined language
to be the default language, whenever the untranslated name is supposed
to appear in the interface, the following label appears instead: Not
defined in current or default language.

Set a User-Defined Language as the Default

Language

Note: The following procedure requires that the user-defined language is
already created. For more information, see “Create and Edit a User-Defined
Language” on page 55.

To set a user-defined language as the default language for a template:

1

On the Template and Project Manager page, select the template in the left
pane.

Click Template » Properties. The Template Properties page appears.

From the Default language list, select the user-defined language that you
want to use and click OK.

Note: If a name is not translated and you set the user-defined language to
be the default language, whenever the untranslated name is supposed to
appear in the interface, the following label appears instead: Not defined
in current or default language.

List Defined Languages

To list languages, open a template and select User-defined Languages from
the list on the left. The Languages table displays the languages that are defined
for the selected template.
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Rename a Language

You can change the name of a language.

To rename a language, complete the following steps in an open template:

1

2

Select User-defined Languages from the list on the left.

Next to a language name in the Languages table, click [=] and click Rename.
The Edit Language page appears.

Enter a new name in the New name field.

Note: The name must be unique in the template.

Click OK.

Delete a Language

To delete a language from a template, complete the following steps in an open
template:

1

2

3

Select User-Defined Languages from the list on the left.
Next to a language in the table, click =] and click Delete.

To delete multiple languages, click the check mark that is next to each
language, Then, click =l that is at the top of the right-most column and click
Delete.

Note: You cannot delete the default language.

List Associated Projects

You can view the projects that are associated with a template.

To view associated projects on the Template and Project Manager page:

1

Display the Template and Project Manager page. For more information, see
“Display the Template and Project Manager Page” on page 147.

Select the template. The projects that are associated with the selected
template are displayed on the right.

[ Name Last Recalculated

OO m

[El % 7013 Strategy 5/21/13

To open a project, click the project name.
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Edit User-Defined Template Properties

You can edit some properties in a user-defined template such as the name,
default language, and the users and groups who have access to the template.

To edit template properties, complete the following steps on the Template and
Project Manager page:

1

2

Select a user-defined template.

Click Template » Properties. The Template Properties page appears.

Template Properties - Strategy 9sas

= General Settings

General properties of a template.

* Template name: Strategy

Description: Mot defined in current or default language

Internal template ID: f27ee433-0a15-0b90-08bf-66a17b3b992e

Owner email:
Default language: English «

@ Permissions

To change the name of the template, enter a new name in the Template
name field.

(Optional) Enter a description.

To specify the owner of the template, click Select Owner. For more
information about selecting an owner, see “Select the Owner of a Template,
Project, Scorecard, or Element” on page 147.

To change the default language, select a language from the Default
language list. For more information, see “Create a Template” on page 44.

Note: After you change the language, the SAS Strategy Management labels
for the template, and all of the scorecards based on the template, change to
the specified language, if labels exist in that language.

Expand the Permissions section.
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= Permissions

Permissions define the type of access granted to a user or group for an object.

&  MName Read Write Delete Administer
&  sasdemo

| Add Users & Groups... |

8 Click Add Users & Groups. For more information, see “Add Users and User
Groups” on page 148.

9 Inthe Permissions table, select the appropriate Read, Write, Delete, or
Administer access permissions for each user or group. For more
information, see“Working with Access Permissions” on page 150.

10 To remove the user or group name from the list, click ¥ to the right of the
check boxes.

11 When you are finished editing the template properties, click OK.

Edit Predefined Template Properties
You can edit the default language of a predefined template such as the
Balanced Scorecard template or KPI template.

Note: For projects and data created using the KPI template, you can display
KPI data only in the following ways:

the table view in SAS Strategy Management Builder

the table portlet (classic style)

the dashboard portlet (classic style)

the table tile in the Strategy Management enhanced portlet

the aggregate tile in the Strategy Management enhanced portlet
the gauge tile in the Strategy Management enhanced portlet

the trend analysis tile in the Strategy Management enhanced portlet

To edit predefined template properties, complete the following steps on the
Template and Project Manager page:

1 Select a predefined template.

2 Click Template » Properties. The Template Properties page appears.

Template Properties - Balanced Scorecard Gsas

Template name: Balanced Scorecard
Internal template ID: 893207de-9b74-40bf-bb59-63625d7845d9
Default language: U.S. English ~
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3 To change the default language, select a language from the Default
language list. For more information, see “Create a Template” on page 44.

Note: After you change the language, the SAS Strategy Management labels for
the template, and all of the scorecards based on the template, change to the
specified language, if labels exist in that language.

Copy a Template

When you copy a template, even a predefined template, the copy appears in the
User-defined Templates list. To save a copy of a template under a different
name, complete the following steps on the Template and Project Manager page:

1 Select the template.
2 Click Template » Copy. The Copy page appears.

3 Enter a name for the copy of the template in the Template name field.

Note: By default, the name is template-namecopy.

4 Click Copy.

Delete a Template

You cannot delete a predefined template; you can delete only a user-defined
template. To delete a user-defined template, on the Template and Project
Manager page, select a template and click Template » Delete.

Manage Time Periods

For information about managing time periods for a template, see the SAS
Strategy Management: System Administration Guide.

View Audit Records

For information about viewing audit records, see the SAS Strategy Management:
System Administration Guide.

Manage Mobile Applications

SAS Strategy Management provides a feature that saves the content of a
Strategy Management enhanced portlet as a mobile report. Because SAS
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Strategy Management users can now use mobile devices, the ability to enable
and disable access to the mobile reports server is provided by the Manage
Mobile Applications option. For information about managing mobile
applications, see the SAS Strategy Management: System Administration Guide.
For information about mobile reports, see “Save the Portlet as a Mobile Report”
on page 318.
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Overview

For a description of templates, projects, and scorecards, and how they relate to
each other, see Chapter 2, “How Do You Describe a Strategy?,” on page 9.

Create a Project

The New Project Wizard specifies the location, template, and other aspects of
the project. You can start the New Project Wizard from the portal or from the
Template and Project Manager, or from within another project. To create a
project, you must be a scorecard modeler, and you must have the appropriate
access permissions.

1 Start the New Project Wizard using one of the following ways:

From an open project or scorecard, click Project » New Project. The
New Project Wizard appears.

From the Template and Project Manager page, click New Project. The
New Project Wizard appears.

For more information, see “Display the Template and Project Manager
Page” on page 147.

From the portal. In the Collections portlet, click New Strategy
Management Scorecard Project. Then click New Project. The New
Project Wizard appears. For more information, see “Add Links to the
Collection Portlet” on page 35.

2 To specify the storage location for the project, complete the following steps:

b

Click on the folders to expand the Save in tree, and select a folder as the
location for the project.

Click Next.

3 To specify the project properties, complete the following steps:

a

C

Type the name of the project in the Project name field.

Note: The project name cannot contain a caret (*) or vertical bar (|). If
you type a caret, it is converted to a tilde (~). If you type a vertical bar, it is
converted to a percent sign (%).

If more than one time hierarchy has been defined, expand the Time
hierarchy tree and select a hierarchy for the project.

Click Next.

4 To specify the template on which the new project is based, select a template
from the list of predefined or user-defined templates and click Next.

For more information, see Chapter 2, “How Do You Describe a Strategy?,”
on page 9.
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5 Review all of the options that you have selected for the project. To make
changes, click Previous to return to the page that you want to change. If you
do not want to make any more changes, click Finish to complete the creation
of the new project.

Open a Project

You can open a project in the following ways:

If you have added a project name to a portlet in the portal, click the project
name in the portlet.

To open a project from the SAS Visual Analytics home page, click Manage
Strategy in the Create Content section or select a link to a project in the My
Content section.

To open a project, complete the following steps on the Template and Project
Manager page:

1 Select the template with which the project is associated.

2 Click the project name in the list of projects that are associated with the
template.

By default, the project opens with the table view on the right and the scorecard
hierarchy on the left.

Scorecard Project - 2013 Strategy

& project= B scorecard~ & P New Element % Edit Elements [® customize B HE = G - %)
T «
BR222013 Strategy] Element type: Column selection: Date:
E-&aworldwide Contacts =  No column selection v 52213 & | e

Contacts
O (Name [A |& & Period
HNo values were returned for this table.

Note: If a project no longer exists in the database or if you do not have the
appropriate access permissions, you cannot open the project.

Register a Project

To work with a project that was imported (such as a migrated project) or created
with the %SPMBMF macro, you must register the project. A project that is
created with the New Project wizard is automatically registered. For information
about the %SPMBMF macro, see the SAS Strategy Management: System
Administration Guide.

When a project is registered, it is available to other applications. One such
application, SAS Visual Analytics, provides access to SAS Strategy
Management from the SAS Visual Analytics home page.

To register a project, complete the following steps in an open project:

1 Click Project » Register. The Register Project page appears.
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2 Select the location of the project that you want to register.

Edit Project Properties

Project properties define the name, project and scorecard hierarchy, time and

dimension, image location, and access permissions for the project.

Note: Depending on your access privileges for the project, you might be able to
change the project name, owner, and access permissions. Access permissions
that you cannot change are unavailable.

To view or edit a project's properties, complete the following steps in an open
project:

1 Click Project

2

Properties. The Project Properties page appears.

Project Properties « 2013 Strategy

= General Settings
General properties of a project.

* Project name:

Description:

Location:
Associated template:
Internal project ID:

Owner:
Owner email:
m Time
m Image Location

w Permissions

| OK | | Cancel| |Apply|

2013 Strategy

Mot defined in current or default language

Strategy
48b39269-0a10-1105-37b0-33a11050c%a7

SAS Demo User

lillian. ekker@sas.com

If the project is not registered, a message appears. For more information,
see “Register a Project” on page 65.

In the General Settings section, you can edit the following settings:

a To change the project name, type a new name in the Project name field.

Note: The project name cannot contain a caret (*) or vertical bar (|). If
you type a caret, it is converted to a tilde (~). If you type a vertical bar, it is
converted to a percent sign (%).

b Type text in the Description field.
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c To change the project owner, click Select Owner. The Owner page
appears. For more information about selecting an owner, see “Select the
Owner of a Template, Project, Scorecard, or Element” on page 147.

3 To review the time properties, expand the Time section.

g Time
Time properties of the project.

Time dimension: Strategy Management Time Standard (Predefined) (STM_TIME_STD)
Time hierarchy: StM Time Hierarchy (Stm_Time_Hierarchy)

4 To review where images are located, expand the Image Location section.

5 Image Location
Location of images.

Common image library: images/customer
Project image library: images/customer/48b39269-0a10-1105-37b0-33a11050c%a7

5 To set access permissions, expand the Permissions section. This section
displays user names and their access permissions for the project.

5 Permissions

Permissions define the type of access granted to a user or group for an object.

& Name Read Write Delete Administer

& sasdemo

& Strategy Management Data Entry Approver Group [ 0 o
& strategy Management Data Entry Group ] ] <

Add Users & Groups... |

6 Click Add Users & User Groups. For more information, see “Add Users and
User Groups” on page 148.

7 Click the check boxes below Read, Write, Delete, and Administer to add or
remove that access permission for the listed user or user group.

Note: To delete a user or user group, click 2 to the right of the check
boxes.

8 When you have finished editing properties, click OK.

Suggest a New Element to Be Added to a

Project

You can suggest a new element to be added to a project. You might suggest a
new element that supports achieving a goal or objective, or that improves
performance.

As business users suggest new elements, your organization's scorecard
modeler then reviews and approves all suggested elements.
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Note: The scorecard modeler might customize a portlet to not accept element
suggestions.

To suggest a new element, complete the following steps:

1 At the bottom of a SAS Strategy Management portlet (classic style), click

a h @ N

o

Suggest New Elements.
Note:

In a SAS Strategy Management enhanced portlet, click “ in the toolbar
to suggest a new element. However, a scorecard modeler might
customize the portlet to not display the toolbar. If the toolbar is not
available, neither is the Suggest New Elements icon. Also, if the
scorecard modeler has customized an enhanced portlet to not accept
element suggestions, the icon does not appear in the toolbar.

If the scorecard modeler has customized a classic style portlet to not
accept element suggestions, a message is displayed that suggestions are
not accepted. Click Close to return to the portlet.

If a portlet is customized to accept element suggestions, the Suggest New
Elements page appears.

Note: If a portlet does accept element suggestions, the affected scorecard
element types might not. If so, a message is displayed. Click Close to return
to the portlet.

Suggest New Elements - MT Table §sas
2 Moasure
Element Name Description Scoracard Perind Type Start Pericd End Pericd
f [ [ =L H|l H H
[ [ [in curent scorecard only =] [Mutiyear =] [Float =] [Float =] &

Closa

Type a name and, if needed, a description.

Select the scorecards in which you want to include the element.
Select the type of period, the start period, and the end period.
Click =£. A new row is added to the table.

To suggest more elements, repeat steps 2 through 5.

When you are finished suggesting elements, click Save.

Manage Suggested New Elements for a

Project

After business users have suggested new elements to be added to a project, a
scorecard modeler then reviews, and approves all suggested elements.

To manage suggested new elements, complete the following steps in an open
project:
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1 Click Project » Manage Suggestion Elements. The Manage Suggestion
Elements page appears.

Manage Suggestion Elements

# Sales Retention

Mame Element Narme Description Scorecard Period Type Start Period  End Period | !

[El 5A5 Demo User | |Recycle Rain Water " Scorecard - 1 [Multiyear j |Flual j |F\ual j ©

Save ‘ Close ‘

2 For each suggested element, click (=] to the left of the element and click an
action. Clicking Send Notification invokes your default e-mail application so
that you can alert the business user who submitted the suggestion.

To view properties associated with a suggestion element, click =l next to the
suggestion that you want to view and then click Properties. The Properties
window appears. You can only view this window. You cannot edit the properties.

Note: If Properties is the only selection available on the menu, the role and
capability settings associated with your user name are limited to viewing only. If
you require expanded access to SAS Strategy Management, contact your SAS
Strategy Management administrator.

Customize Project Content Displayed by
Default

About Project Options

You can customize how and what project content is displayed by default. The
options include the default scorecard, date, and type of view to use. When you
open a project in SAS Strategy Management Builder, the project appears with
the default scorecard selected in the scorecard hierarchy. The default scorecard
content appears in the selected type of view for the selected date.

You can also customize the default content that is displayed for each type of
view: table, aggregate, association, diagram, and trend. Then, when you change
the view type in the open project, the projects appear using the settings for that
view.

Note: (Diagram view only) The default diagram settings apply to all projects to
which a user has access. If you specify default diagram settings in one project
and then specify default diagram settings in a second project, the default
settings of the second project replace those of the first project. This replacement
also occurs when you select the Save these settings for all users option.

Save Settings for All Users

The Project Options page contains sections for general settings and view-
specific settings. In each section, you can select Save these settings for all
users. Use this selection to specify that the settings in the affected section be
used for every user that can access the project and its views.

If you do not make this selection, the settings apply only to yourself.
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Specify the Default View and Default Scorecard
to Use for the Project

In an open project:

1 Click Project » Options. The Project Options page appears and displays
the General Settings section.

Project Options - 2013 Strategy gsas

4 General Settings

—Default view and scorecard

Select the view and scorecard to open when you first open the project.

View: Table A
Scorecard: =ER[2013 Strategy]
E-EwWorldwide

o Buamericas
0 Bunsia
B Europe

—Default content language
@ Use the default language: English
) Use the following language: English

—Default date for views
Set the default period for all views - scorecard table, aggregate table, association, and diagram.
@ Ccurrent date

) specific date: | 5/22/13

[T] save these settings for all users

y Table Options

yw Aggregate Table Options
y Association Table Options
y Diagram Options

y Trend Chart and Trend Analysis Options

| OK | |Cancel| |Apply|

2 From the View list, select the default view to display.

3 Inthe Scorecard tree, select the default scorecard.

Note: You cannot select a scorecard for which you do not have access
permissions. If you require access, contact your SAS Strategy Management
administrator.
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4 Click OK.

Specify the Dates to Use

You can specify the default date that is used by the views of this project. You
can specify a date or you can have the view use the date that is current when
the view is opened. However, the default date is not used by the trend chart and
trend analysis views. See “Specify the Date Range to Use in the Trend Chart
and Trend Analysis Views” on page 75.

1 In an open project, click Project » Options. The Project Options page
appears and displays the General Settings section.

2 In the Default Date for Views section, perform one of the following steps:
To use the current date, select Current date.

To use a specific date, select Specific date and click [E] to select a date.

3 Click OK.

Specify the Default Language

A template can provide additional languages. If the project is based on a
template that provides additional languages, you can change the default
language for the project. For more information, see“Working with Language
Settings” on page 55.

In an open project:

1 Click Project » Options. The Project Options page appears and displays
the General Settings section.

2 In the Default Content Language section, perform one of the following
steps:

To display the scorecard in the default language, select Use the default
language.

To display the scorecard in another defined language, select Use the
following language and then select a language from the list.

Note: Selecting another language does not affect the display of dates or
numbers.

3 Click OK.

Customize the Table View

You can specify the appearance and content of the table view. When a user
opens a table view of the project, the view uses your settings.

On the Project Option page:

1 Expand the Table Options section.
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# Table Options

Element type: Contacts ~

Column selection: Mo column selection -
Select what type of information you want to see on elements. Mote, this setting applies to all projects not just the current project,
fo [# show formula icon

Save these settings for all users

2 From the Element type list, select the default element type to display in the
scorecard.

3 From the Column selection list, select the default column selection to
display in the scorecard.

4 To display the formula icon for an element, click Show formula icon.

TIP If the element is calculated by a formula, the formula icon f.is
displayed in the view.

5 Click OK.

Customize the Aggregate Table View

You can specify the appearance and content of the aggregate table view. When
a user opens an aggregate table view of the project, the view uses your settings.
By selecting a column selection, you control which metric attributes are
displayed in the aggregate table. For more information, see “Create a Column
Selection” on page 142.

On the Project Option page:
1 Expand the Aggregate Table Options section.

» Aggregate Table Options
Select the metric attribute to aggregate.
Element type: Perspective
Column selection: Actual -

Select the information that you want to see.

% Show personal thresholds
v Show global thresholds

Save these settings for all users

2 Select an element type from the Element type list.

3 Select a column selection from the Column selection list.

4 To display only personal thresholds, click Show personal thresholds.
5 To display only global thresholds, click Show global thresholds.

6 Click OK.
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Customize the Association Table View

You can specify the appearance and content of the association table view.
When a user opens an association table view of the project, the view uses your
settings. By selecting a column selection, you control which metric attributes are
displayed in the table. For more information, see “Create a Column Selection” on
page 142.

On the Project Option page:

1 Expand the Association Table Options section.

A Association Table Options
Association name: Focus Areas -

Column selection: Forecast -

[C] save these settings for all users

2 Select a name from the Association name list.
3 Select a column selection from the Column selection list.

4 Click OK.

Specify the Default Diagram and Format to View

You can specify the diagram to open and the type of file format to use for the
diagram. When a user opens a diagram view of the project, the view uses your
settings. You can choose between a static format (PNG) and a somewhat
interactive format (SVG).

Note: The default diagram settings apply to all projects to which a user has
access. If you specify default diagram settings in one project and then specify
default diagram settings in a second project, the default settings of the second
project replace those of the first project. This replacement also occurs when you
select the Save these settings for all users option.

On the Project Option page:

1 Expand the Diagram Options section.

» Diagram Options

Diagram name: None

—Diagram Format
A diagram can be viewed using two formats: PNG or SVG. PNG is a static format while 5VG allows for more interactivity.

@ Show diagrams in PNG format
() Show diagrams in SVG format

2 Select a diagram from the Diagram name list.

Note: When there are no diagrams, the list is replaced with the word None.
3 Select a diagram format.

4 Click OK.
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Specify If Diagrams Are Saved

When you view a diagram, that instance of the diagram is saved in the diagram
cache. When you view the diagram again, it can be displayed quickly by loading
the diagram from the cache. However, if the diagram or its underlying data has
been changed since the last viewing, loading the diagram from the cache does
not display the latest changes. You can make sure that you see the latest
version of a diagram in the following ways:

Refresh each diagram as it is viewed. In the diagram view, click 3.

Clear the diagram cache. This option forces a diagram to be rebuilt when it is
next viewed.

If you want to view the latest version of all diagrams at all times, disable the
diagram cache.

On the Project Option page:

1 Expand the Diagram Options section.

— Temporary Diagrams

Diagrams you view are cached in a special area to allow for quicker viewing. You can
clear this cache to free disk space on the server and also ensure that you will see any
new changes the next time you view the diagram.

Your diagram cache currently takes 2333372 bytes.

[ Clear Diagram Cache... ]

[“I pisable diagram caching

2 To clear the cache of previously viewed diagrams, click Clear Diagram
Cache.

3 (Optional) If you want to force all diagrams to be rebuilt each time they are
viewed, select Disable diagram caching.

TIP Because diagrams are not cached, this setting causes diagrams to
take longer to open.

4 Click OK.

Note: The diagram cache is located in a user's DAV folder on the DAV server.

Specify the Metric Attributes to Use in the Trend
Chart and Trend Analysis Views

You can specify the content of the trend chart and trend analysis views. When a
user opens one of these views for a project, the view uses your settings. For
information about the difference between trend chart and trend analysis, see
“Trend Analysis” on page 26.

Note: The selected metric attributes provide the Y-axis labels in the view.
However, if you make more than one selection and the selections are not the
same data type, the labels are not formatted. For example, one selection might
be a currency and another might be a percentage.

On the Project Option page:

1 Expand the Trend Chart and Trend Analysis Options section.
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4 Trend Chart and Trend Analysis Options

—Metric attribute defaults

Select the metric attributes to chart.

Metric Attribute
Actual

Target
Performance

oooO

—Start and end date defaults
Set the previous and future periods to chart. The selected date is the starting point.
Start date: hj22{12 &
End date: 5j22§13 i

[C] save these settings for all users

2 In the Default Metric Attributes section, select one or more metric attributes
to include in the chart:

To include specific metric attributes, select the check box that is next to
the attribute.

To include all metric attributes, select the check box that is at the top of
the table.

3 Click OK.

Specify the Date Range to Use in the Trend Chart
and Trend Analysis Views

You can specify the date range of the trend chart and trend analysis views.
When a user opens one of these views for a project, the view uses your settings.

Note: The default date specified in the General Settings section is not used by
the trend chart and trend analysis views.

On the Project Option page:
1 Expand the Trend Chart and Trend Analysis Options section.

2 In the Default Start and End Date section, specify a start date and an end
date.

3 Click OK.

Copy a Project

To copy a project to another location, complete the following steps on the
Template and Project Manager page:

1 Select a template name in the list of templates.

2 Next to the project that you want to copy, click = and click Copy To.
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Note: If the project is not registered, a message appears stating that you
must register the project before it can be copied. For more information, see
“Register a Project” on page 65.

The Copy To page appears.

Copy To + 2013 Strategy 9sas

Repository: Foundation
Copy: 2013 Strategy

* Location:
--D Products -

--D Shared Data

w1 User Folders

--D System

--D Portal Application Tree
07 My Folder

Fl [}

Project name:  Copy: 2013 Strategy

— Copy Options
Scorecards are automatically copied for you, but you may also want to include:
Elements and attributes

[7] select all options below
[T] Metric attribute values
[C] Formulas
[l Ranges
[C] Thresholds
[T Links
[C] Rules
[7] pata Entry Forms

Copy Cancel

3 In the Location tree, select the location in the project hierarchy to which you
want to copy the project.

4 Type a name for the project in the Project name field. By default, the copied
project is named Copy : project-name.

Note: The project name cannot contain a caret (*) or vertical bar (|). If you
type a caret, it is converted to a tilde (~). If you type a vertical bar, it is
converted to a percent sign (%).

5 To copy elements and attributes that are associated with the current project,
click Elements and attributes.

6 To copy all other information, click Select all options below. If you want to
copy only some of the information, click one or more the applicable options:
Metric attribute values, Formulas, Ranges, Thresholds, Links, Rules,
Data Entry Forms.
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Add a Project to a Classic-Style Portlet

To add a project to a classic-style portlet, complete the following steps in an
open project:

1 Click ¥5. The Add to Portlet page appears.
Add to Portlet 9sas

Portlet: <Create a New Portlet= -

—Mew Portlet Details
Portlet type: Performance Table
Portlet name: Finance Results
Partlet description:

Keywords:
Add to page Home v

2 To add to an existing portlet, select the portlet from the Portlet list.

Note: The list includes only those portlets that are of the same type of view
as the current view. For example, when you add a portlet from the table view,
the Portlet list includes only Performance Table portlets.

3 To create a new portlet and add to that portlet, complete the following steps:
a Click <Create a New Portlet> from the Portlet list.
b Specify the portlet name, description, and keywords.

c To specify the page on which the portlet appears, click Add to page and
select a page from the list.

Note: If you do not click Add to page, the portlet is created but is not
added to a page. You can search for the portlet later and add it to a page.

4 Click OK.

Delete a Project

To delete a project from the Template and Project Manager page, complete the
following steps on that page:

1 Click Manage Scorecard Projects in the portal, or open a project and click
Project » Manage Templates and Projects. The Template and Project
Manager page appears.
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2 Click the template that is associated with the project that you want to delete.

3 Click the check box that is next to one or more project names.

4 Click =l that is at the top of the right-most column and click Delete.

Note: Alternately, to delete a single project, click =l for the row and click

Delete.

Managing Link Definitions

About Link Definitions

Ways to Use Links

You can define a link once on the New Link page and then use that link in
multiple places in a project and in its scorecards. You select which link
definitions to use when you specify properties for elements and metric attributes.
You can also use these links in forms, diagrams, the Batch Maintenance Facility
(BMF), and the Import wizard.

For more information, see the following documentation:

“Edit Metric Attributes” on page 99

“Edit Multiple Elements” on page 104

“Interactive Features in Diagrams” on page 217

Chapter 33, “Creating and Managing Forms,” on page 329

Chapter 35, “Importing Data into a Strategy Management Project,” on page

343

information about the Batch Maintenance Facility (BMF) in the SAS Strategy
Management: System Administration Guide.

Types of Links That You Can Define

You can define links of the following types:

Link type
External link

Element details

File

SAS Financial
Management report

Description
Opens a web page or an external document.

Opens a view of the metric attributes and non-metric attributes
associated with the project that is open.

Opens any type of file that is registered as DAV content in the

SAS Content Server. For information about importing a file into
the SAS Content Server, see “Importing a Document” on page
84.

Opens an associated form if SAS Financial Management is
installed in your environment.



Link type

SAS Information
Map

SAS Portal page

SAS Stored Process

SAS Web Report
Studio report

SAS Strategy
Management project

Directive

Define a Link
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Description

Opens a SAS Information Map.

Opens a SAS Portal page. By using this link type, you can
open a pre-existing portal page that can contain dashboards,
reports, and other information.

Runs a SAS Stored Process.

Opens a report that was created by using SAS Web Report
Studio.

Opens a SAS Strategy Management project.

Processes instructions for other SAS software.

Note: This option is provided for migrating from SAS Strategy
Management 5.2 and earlier. For version 5.3 and later, use the
other link options.

To define a link, complete the following steps in an open project:

1 Select Project

Manage Links. The Manage Links page appears.

Manage Links gsas
Define a link and its properties. You can define a link once and apply that definition in multiple places in Strategy Management. Click
Mew to create a new link definition. Any links that you defined appear on this page. To edit a link, click the link name to open its
definition.
Listby: Al link types -
Name Description Type EE
[El Data Entry Portal Page Link SAS Stored Process =
E Info Map Link SAS Web Report Studio report =
[El saAsS Global Forum Twitter Link External link [}
[E SAS Twitter Link External link =
5l Strategy Fact Sheet (PDF Link) External link [E
El WRS Link SAS Web Report Studio report =
5] ¥TD Budget Report (Web Report Studio) Link External link =
[=] YTD Sales Report (Stored Process) Link SAS Stored Process ]
New...

2 Click New to open the New Link page.
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Link type

Element details

External link

3

New Link §sas

# General Settings

Enter identifying information for this link.

Project: 2013 Strategy
*#Link name: External stock page
Description:
*Link type: External link -
*Link target: @ New window
© This window
*Link content: hittp:/fwww.stocks. org| l:l

y Parameter Definitions

w Advanced Parameters

In the General Settings section, complete the following steps:
a Enter a name in the Link name field. A description is optional.

b From the Link type list, select the type of link that you want to define. For
more information, see “Types of Links That You Can Define” on page 78.

c If you want the link to open in a new window, select New window.
Otherwise, if you want the link to open in the same window that contains
the SAS Strategy Management scorecard, select This window.

Note: If you are opening a Microsoft Office document, you must select
New window.

Note: If you subsequently select a link definition for use in a data-entry
form, the link will open only in a new window. Data-entry forms do not
support opening a link in the same window as the form.

d Specify the link content by using the applicable steps.

Steps

1 Click Select to open the Select Column Selection page.

2 Select the type of column selection to use from the Column selection type
list.

3 Select the column selection from the Column selection list. Information
about your selection appears, including a Preview table so that you can
verify that you made the correct selection.

4 Click OK to save the link content.

In the Link content field, enter the location that you want to use for the
external link.
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Link type Steps

File Click Select to open the Select Link Location page.

SAS Financial Management Select the file to use from the Link content list. The location appears in the
report Location field.

SAS Information Map
SAS Portal page
SAS Stored Process

Click OK to save the link content.

SAS Web Report Studio

report
Directive

SAS Strategy Management Click Select to open the SAS Strategy Management page.

project

Select the project from the Project list. Its location appears in the Location
field.

(Optional) Select the scorecard to use from the Scorecard list. Its path
appears in the Scorecard path field.

(Optional) Select the element type from the Element type list.
(Optional) Select the column selection from the Column selection list.

Select the type of view in which you want the content appear from the View
list.

Choose whether to use a display date or a specific date.

Click OK to save the link content.

4 Expand the Parameter Definitions section.

In this section, define one or more parameters that are passed as part of the
link. When you open a link in SAS Strategy Management, the parameter can
pass information that controls how data appears at the link destination. For
example, if you define the parameter to pass Scorecard name, the
information located at the link destination is filtered by the name of the
scorecard from which the link originated.

a From the Parameter list, select the type of SAS Strategy Management
information that you want the parameter to pass. Then, in the field next to
the list, enter the source parameter (target).

4 Parameter Definitions

Select the type of Strategy Management information that you want the parameter to pass. Then click Add Parameter.

Parameter: Projectname + PROJECT Add Parameter

For examples, see the Strategy Management User's Guide.

When you open a link in Strategy Management, the parameter value can pass information that controls how data appears at the link destination,]

b Click Add Parameter to add the parameter definition to the table that is
below the list.

4 Parameter Definitions

Select the type of Strategy Management information that you want the parameter to pass. Then click Add Parameter.

Parameter: (none) -

For examples, see the Strategy Management User's Guide.

Name Value Delete
PROJECT {PROJECT} X

When you open a link in Strategy Management, the parameter value can pass information that controls how data appears at the link destination,]
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TIP A default parameter name is selected for you. However, you can
change the name to match the name that is expected by the link target.

Note: For more information, see “Examples of Link Definitions” on page
82.

5 Expand the Advanced Parameters section.

In this section, specify one or more parameters that can control how
information appears at the link destination. These parameters pass static
information that you set in this section. The target link location takes the
static value from the parameter to affect the information displayed.

Note: Refer to the documentation for the link target software in order to
determine which parameters it supports. SAS Strategy Management passes
the specified parameters without verifying that the link target can use the
parameters. If the link target does not use the parameters, unexpected
behavior might occur.

In the Parameter field, enter a description of the parameter.

Suppose, for example, that you specify an external link called
finance.yahoo.com/q. In the Parameter field, you specify s=AAPL, GOOG. This
parameter causes the website to display stock quotes for Apple Inc. and
Google Inc.

6 Click OK to save the link definition.

Examples of Link Definitions

Example: Define a Link That Opens a Web Page
In this example, a link that opens the Google web page is defined.

In the New Link page, complete the following steps:

1 In the General Settings section, complete the following steps:
a Enter a name in the Link name field. A description is optional.
b From the Link type list, select External link.
c Select New window for the link target.

d In the Link content field, type www.google.com/search after the
provided http://.

Note: The link location must include http:// at the beginning of the
web address.

2 Expand the Parameter Definitions section and complete the following steps:
a From the Parameter list, select Element name.

b In the field next to the list, change ELEMENT to q.

Note: The Google website requires a lowercase parameter.

c Click Add Parameter to add the parameter definition to the table that is
below the list.
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The value passed by this parameter is derived from the element name in the
Strategy Management project. The Google website uses the parameter value
as a search value.

Expand the Advanced Parameters section. In the Parameter field, enter the
following parameters:

&start=0&num=10&cr=countryCA&lr=lang fr
Note: You cannot include blanks when you enter the parameter.

These parameters limit the search output to the first ten results that are
located in Canada and that are in French.

Click OK to save the link definition.

Example: Define a Link That Runs a SAS Stored Process

In this example, a link is defined that runs a SAS Stored Process and displays its
output.

In the New Link page, complete the following steps:

1

In the General Settings section, complete the following steps:

a Enter a name in the Link name field. A description is optional.
b From the Link type list, select SAS Stored Process.

c Select New window for the link target.

d For the Link content field, click Select and navigate to the file location of
the stored process.

Expand the Advanced Parameters section. In the Parameter field, type the
following parameters:

&GENDER=M&AGELIMIT=14

These parameters, which are already defined in the stored process, cause
the stored process to filter its data by male gender and individuals no older
than 14.

Click OK to save the link definition.

To edit a link, complete the following steps in an open project:

1

2

Select Project » Manage Links. The Manage Links page appears.

Click the name of the link that you want to edit. The Link Properties page
appears.

Change the applicable settings in the link definition as described in “Define a
Link” on page 79.
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View Link Properties

Copy a Link

To view properties and settings associated with an item, click =l next to the item
that you want to view, and then click Properties. The Properties window
appears. You can only view this window. You cannot edit the properties and
settings.

Note: If Properties is the only selection available on the menu, the role and
capability settings associated with your user name are limited to viewing only. If
you require expanded access to SAS Strategy Management, contact your SAS
Strategy Management administrator.

To copy a link, complete the following steps in an open project:

1 Select Project » Manage Links. The Manage Links page appears.

N

Click [=] next to the link definition that you want to copy and then click Copy.

w

The wizard appends Copy to the link name. In the New link name field, edit
the name to describe the new link definition that you are creating.

H

Click Copy. The copied link definition appears in the Manage Links
selection list.

a

To edit the copied link definition, click its name. The Link Properties page
appears.

o

Change the applicable settings in the link definition as described in “Define a
Link” on page 79.

Delete a Link

To delete a link, complete the following steps in an open project:
1 Select Project » Manage Links. The Manage Links page appears.

2 Click [=] next to the link definition that you want to delete and then click
Delete.

3 A confirmation message appears. Click Yes to delete the link.

Importing a Document

Document Types That You Can Import

You can import a document for use in SAS Strategy Management. Importing a
document registers the document as DAV content in the SAS Content Server.
After you import a document, you can use it as a target when you define a link
using the link type File.
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This feature supports importing the following types of files.

Microsoft Excel (XLS, XLT, WKS, CSV, XLSX, XLTX)
Office PowerPoint (PPT, PPS, PPTX, PPSX)
Word (DOC, DOCX)

Graphics BMP
GIF
JPEG, JPG, JPE
PNG
TIFF, TIF

Video AV
MPEG, MPG, MPE

Other ASCII text (TXT, TEXT, ASC)

document HTML, HTM
types
PDF

PostScript (PS, Al, EPS)
RTF
WordPerfect (WPD, WP)
XML

Import a Document

To import a document, complete the following steps in the SAS Strategy
Management Builder:

1 On the Template and Project Manager page, select the template that
contains the project in which you want to import a document.

2 Click the project name.
3 On the Project page, select Project » Import a Document.

4 On the Import a Document page, click Browse and navigate to the file that
you want to import.

5 Inthe Save in tree, navigate to the folder in which you want to save the file
that you are importing.

6 If the file already exists and you want to replace it, select Overwrite existing
document.

7 Click OK. The document is imported and saved.
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Working with Scorecards

Overview

Overview

Create a Scorecard

Open a Scorecard

Calculate a Scorecard

Save a Scorecard as a SAS Information Map
Change the Order of Scorecards

Edit Scorecard Properties
Open the Scorecard Properties Page

Add a Scorecard to a Classic-Style Portlet
Move a Scorecard

Copy a Scorecard

Delete a Scorecard

Set Default Scorecard Preferences
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88
88
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91
91

92
93
93
95
95

For a description of templates, projects, and scorecards, and how they relate to

each other, see Chapter 2, “How Do You Describe a Strategy?,” on page 9.

Create a Scorecard

Before you can create a scorecard, you must create a project to contain the
scorecard. For more information, see “Create a Project” on page 64.

To create a scorecard, open a project and complete the following steps:

1 Click Scorecard » New Scorecard.

2 On the Properties page, complete the following steps:

a Type the name of the scorecard in the Scorecard name field.
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Note: The scorecard name cannot contain a caret (*) or vertical bar (|). If
you type a caret, it is converted to a tilde (~). If you type a vertical bar, it is
converted to a percent sign (%).

b Click Next.

3 Each scorecard that you create is in a scorecard hierarchy. A parent can be
either another scorecard or the project that contains the new scorecard. A
parent is above other scorecards in the hierarchy. Child scorecards are
below a parent.

On the Location page, complete the following steps:

a Click the project or scorecard name in the hierarchy that you want to
designate as the scorecard's parent.

b To cause the new scorecard to inherit elements that exist in a parent
scorecard, click Inherit existing elements from parent scorecard.

Note: If the parent of the scorecard is a project, the scorecard cannot
inherit elements.

c Click Next.

4 On the Summary page, review the scorecard options that you have selected.
To change an option, click Previous to return to a preceding page.

5 When you are satisfied with your selections, click Finish.

Open a Scorecard

You can open a scorecard in the following ways:

To open a scorecard from within a project, open a project and click on the
name of the scorecard.

To open a scorecard from the portal, create a link to the scorecard from a
portlet and click on the link.

Calculate a Scorecard

Note: The following task calculates only one scorecard in a project. To calculate
all scorecards, see “Calculate a Project” on page 133.

To calculate a scorecard, complete the following steps:

1 Click Scorecard » Calculate. The Calculate page appears.
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| Help~

Calculate - Worldwide gsas
@ select by date range:

Start date: 211114

End date: 2111114
() Select by period:

Period type: Month -

Period: Feb2014 ~
[ Include child scorecards
| Calculate | | Cancel ‘

2 Specify either the date range or the period.
3 (Optional) Click Include child scorecards.

4 Click Calculate.

Save a Scorecard as a SAS Information
Map

To save a scorecard as a SAS Information Map:

1 Select Scorecard » Save As Information Map. The Save As SAS
Information Map page appears.

2 Click Add to select a storage location for a new information map or to select
an existing information map. The SAS Information Map window appears.

3 Navigate the hierarchy and select a folder or an information map. Then click
OK.

4 Enter the name and, optionally, a description of the information map.

Note: If you select an existing information map and do not change the name,
the existing information map is overwritten.

5 In the Data Options section, set the options for the scorecards, time periods,
and the element types that you want to include in the information map.

TIP To create an information map that includes all scorecards in the
project, select All scorecards.

6 Click OK.

Note: If the information map either fails to display or fails to display correctly,
contact your system administrator. For more information, see the SAS Strategy
Management: System Administration Guide.
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Change the Order of Scorecards

You can change the order in which scorecards are displayed within a scorecard

hierarchy. However, you cannot change the order of scorecards that are based
on a dimension hierarchy.

Note: This scorecard order is used in the Manage Data Entry Forms wizard
when it displays scorecards.

To change scorecard order, complete the following steps in an open scorecard:
1 Click Scorecard » Reorder. The Reorder Scorecards page appears.

Reorder Scorecards

Scorecards:

- a .
Arr]erlcas “| 4% sort Ascending
Asia z

Europe ag

=

ort Descending

ke e 5 sl

2 In the Scorecards list, click a scorecard.

3 To sort in ascending or descending alphabetic order, click Sort Ascending
or Sort Descending.

4 To move items, select one or more items and use the following icons:
Icon Action
F Moves the selected item to the beginning of the list.
& Moves the selected item up.

e

Moves the selected item down.

. 4 Moves the selected item to the end of the list.
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Edit Scorecard Properties

Open the Scorecard Properties Page

To edit the scorecard properties, complete the following steps in an open
scorecard:

1 Click Scorecard » Properties. The Scorecard Properties page appears.

Scorecard Properties - Worldwide gsas

= General Settings

General properties of a scorecard.

* Scorecard name: Worldwide

Description: Not defined in current or default language

Internal scorecard ID: 48e1723a-0a10-1105-37b0-33a12824c981

Scorecard code:

Associated project: 2013 Strategy

Parent scorecard: None

Owner: SAS Demo User
Owner email: " @sas.com

w Permissions

| OK | | Cancel| |Ap|:|ly|

2 In the General Settings section, complete the following steps:

a Change the scorecard name by typing a new name in the Scorecard
name field.

Note:

The name cannot contain a caret (*) or vertical bar (|). If you type a
caret, it is converted to a tilde (~). If you type a vertical bar, it is
converted to a percent sign (%).

You cannot change the name of a scorecard in a project that is based
on an existing hierarchy.

b (Optional) Type a description.

c To specify the owner of the scorecard, click Select Owner. The Owner
page appears. For more information about selecting an owner, see
“Select the Owner of a Template, Project, Scorecard, or Element” on
page 147.

3 To assign access permissions, complete the following steps:

a Expand the Permissions section.
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o Permissions

Permissions define the type of access granted to a user or group for an object.

& Name Read Write Delete Administer

&  sasdemo

{3 Strategy Management Data Entry Approver Group ] [ by
A strategy Management Data Entry Group ] b s

| Add Users & Groups... |

b Click Add Users & Groups. For more information, see “Add Users and
User Groups” on page 148.

c In the Permissions table, click Read, Write, Delete, or Administer
access permissions for each user or group. For more information about
access permissions, see “Working with Access Permissions” on page
150.

d To remove a user's name from the list of users who have access to the
scorecard, click ¥ to the right of the check boxes.

4 When you are finished editing the properties, click OK.

Add a Scorecard to a Classic-Style Portlet

To add a scorecard to a classic-style portlet, complete the following steps in an
open scorecard:

1 Click ¥5]. The Add to Portlet page appears.
Add to Portlet gsas

Portlet: <Create a New Portlet> «

—Mew Portlet Details
Portlet type: Performance Table
Portlet name: Finance Results
Portlet description:

Keywords:
Add to page Home -

2 To add to an existing portlet, select the portlet from the Portlet list.

Note: The list includes only those portlets that are of the same type of view
as the current view. For example, when you add a portlet from the table view,
the Portlet list includes only Performance Table portlets.

3 To create a new portlet and add to that portlet, complete the following steps:

a Click <Create a New Portlet> from the Portlet list.
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b Specify the portlet name, description, and keywords.

c To specify the page on which the portlet appears, click Add to page and
select a page from the list.

Note: If you do not click Add to page, the portlet is created but is not
added to a page. You can search for the portlet later and add it to a page.

4 Click OK.

Move a Scorecard

You can move a scorecard to a different location in the scorecard hierarchy
within the same project or to another project that is associated with the same
template.

Note:

You cannot move a scorecard that is in a hierarchy that is based on a
dimension.

If a back-end data feed is set up for extracting, translating, and loading
(ETL), moving a scorecard can disrupt the ETL. Be sure to adjust the ETL.

To move a scorecard, complete the following steps in an open scorecard:
1 Click Scorecard » Move To. The Move page appears.

2 Inthe Location tree, select the location that you want to designate as the
parent of the selected scorecard.

3 Click Move.

Copy a Scorecard

You can copy a scorecard to the following locations only:
to a location within the same project

to another project that uses the same template as the project that originated
the scorecard

To copy a scorecard, complete the following steps in an open scorecard:

1 Click Scorecard » Copy To. The Copy To page appears.
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Copy To - Worldwide Ggsas

Copy: Worldwide

* Location:
=4#12013 Strategy -

= Eaworldwide

Y ericas

i-BhLatin America

----- ELUnited States
= Easia

m

Scorecard name:  Worldwide Copy

[Tl Include all scorecards under the current scorecard

— Copy Options
Elements are automatically copied for you, but you may also want to
include:

[T] ttribute selections
[T] select all options below
[T] Metric attribute values
[T Formulas
[CIRanges {Only applicable if copying within the same project)
[T] Thresholds
[T Links
[ Rules
[Tl automatic creation of links batween elements

2 In the Location tree, select the location in the project hierarchy to which you
want to copy the scorecard.

3 Type a name for the scorecard in the Scorecard name field. By default, the
copied scorecard is named scorecard-name copy.

Note: The scorecard name cannot contain a caret (*) or vertical bar (|). If
you type a caret, it is converted to a tilde (~). If you type a vertical bar, it is
converted to a percent sign (%).

4 If you want to copy all of the child scorecards under the current scorecard to
the same location, click Include all scorecards under the current
scorecard.

5 If you want to copy attribute selections that are associated with the current
scorecard, click Attribute selections.

6 If you want to include one or more types of other information with the copied
scorecard, click Metric attribute values, Formulas, Ranges, Thresholds,
Links, Rules, or Permissions.

7 If you want to copy all values, click Select all options below.
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8 If you want to retain existing links between elements (if this option is
available for this element), click Automatic creation of links between
elements. For more information about linking elements, see “Link Elements”
on page 107.

Delete a Scorecard

To delete a scorecard, open the scorecard and click Scorecard » Delete.

Note: If the scorecard contains child scorecards, the child scorecards are also
deleted.

Set Default Scorecard Preferences

You can set the default display preferences for all the scorecards that you open.
You can override these preferences by customizing an individual scorecard. For
information about customizing the display of an individual scorecard, see
“Customize a Scorecard Table” on page 165.

To set default display preferences for all scorecards, complete the following
steps:

1 Click Preferences in the upper right of the SAS Strategy Management
window. The Preferences page appears.

2 Click Scorecards in the list on the left. The scorecard preferences appear.
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Preferences 9sas
General it show only required items (denoted by *)
General ® Scorecards = Table Display Options Reset to Default
Motifications * Mumber of rows to display:
Regional * 0 -
Format

Date Formats *

Currency Formats * Scorecards > Thresholds Reset to Default
Poral Show thresholds:
Personal ~
Table Display Options
Thresholds L . =
Scorecards > Additional Display Options Reset to Default

Additional Display Optians Show Trend Analysis Chart:

Tables -

Show comments:

Tables hd

3 Specify the options in the Table Display Options section, the Thresholds
section, and the Additional Display Options section.

4 When you have finished setting your preferences, click Apply. Otherwise, to
return the scorecard preferences to their default settings, click Restore
Defaults.



97

Working with Elements and Element

Attributes

Overview

Create an Element

Edit Metric Attributes

Edit Element Properties

Edit Multiple Elements

Link Elements

Change Comment Alert Settings for an Element
Copy Element Properties

Copy an Element

Move an Element

Delete an Element

Format Numbers and Fonts in Cells
Format Numbers and Fonts in Columns
Set a Global or Personal Threshold
Edit a Global or Personal Threshold
View Thresholds
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99
101
104
107
108
108
110
111
111
111
114
116
119
121

Overview

For a description of elements, element attributes, and how they relate to each

other, see Chapter 2, “How Do You Describe a Strategy?,” on page 9.

Create an Element

To create an element, you must be a scorecard modeler and have the

appropriate access permissions.

To create an element, complete the following steps in an open project:
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1 Click E.

2 From the Element type list, select a type and click Go.

Note: After you start the New Element wizard, you cannot change the type
of element created. To create a different type of element, you must cancel
the wizard, select another element type, and restart the wizard.

3 Select New Element. The New Element wizard appears.

4 On the Properties page, complete the following steps to select general
options and time settings for the element:

a In the Element name field, type a name for the element.

Note: The name cannot contain a caret (*) or vertical bar (|). If you type a
caret, it is converted to a tilde (~). If you type a vertical bar, it is converted
to a percent sign (%).

b (Optional) Type a description of the element.

c From the Period type list, select the type of period.

The period type defines the intervals at which data is collected for the
element.

d From the Start period list, select the beginning date of data collection.

The start period defines the first interval at which data is collected. For
example, if the period type is YEAR, the start period might be 1999. If you
have selected Multiyear as the period type, the only available start period
is MULTYR. FLOAT means that the start point of the period is not set.

e From the End period list, select the end date of data collection.

The end period defines the last interval at which data is collected. FLOAT
means that the end point of the period is not set.

f Click Next.

5 On the Add Element to Project/Scorecards page, specify how you want the
new element added to a project or scorecard.

Note: If you are adding the element to a project, the current project is
displayed.

If you want to add the element to a scorecard, you must specify which
scorecard by clicking one of the following options:

In current scorecard Adds the element to the scorecard that is currently
only open.

In current scorecard Adds the element to the scorecard that is currently
and all its children open and to all of its children.

In all scorecards of this Adds the element to all of the scorecards in the project
project that is currently open.

6 To change a setting, click Previous to return to a previous page. When you
are satisfied with the settings, click Finish.
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Edit Metric Attributes

Metric attributes are defined in the template that is associated with the project.
You can change the values and ranges that are associated with metric
attributes, and you can specify the time periods to which the changes apply.

To edit metric attributes for an element, complete the following steps in an open
project or scorecard:

1 Next to an element, click (=], and then click Edit Metric Attributes. The
Metric Values, Ranges, and Links page appears.

Metric Values, Ranges, and Links - Sales 9sas

Metric attribute:  Status A

Display period: May2013 -

— [ status value

Computed value: | Manually entered

Enter a value and then select a period. If a formula has been set for this element,
entering a manually entered value effectively deletes the formula.
Entered value: (Example 1.02)

Value rule: | No Rule

— [ status Text

Enter a text and then select a period.

Metric text:

Text rule: | No Rule

— [ status Link

Select the link to apply to the metric attribute.

Link: | Mone

— [ status Range
Select the range to apply to the metric attribute.

Range: |Mone

Apply changes to the following period or select a range of periods:
@ Display period:  May2013
() Start period: Jan1995

End period: Jan1995

| OK | | Cancell |Ap|:|h,r|
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2 From the Metric attribute list, select a metric attribute.

3 From the Display period list, select a period and click Go.

4 To set the value, click <metric attribute> Value, where <metric attribute> is
the selection that you made in the Metric attribute list. Then select one of
the following options from the Computed value list.

Way to Set the Value Computed Value Option

Provide a value Select Manually entered.

The Entered value field appears into
which you can type a value.

Specify a predefined formula, modify a Select Formula-based.
predefined formula, or define a new
formula to apply to the metric value

Complete the following steps for the Formula-based selection:

to specify a predefined formula:

1

2

Select a formula from the Formula list.
Select a function from the Function list.

If the function that you selected supports an attribute and metric
attribute, the Attribute and Metric Attribute lists appear from which
you can select values.

Click Insert Formula. The formula is displayed in the Formula
definition field.

— /] Status value

Computed value: Formula-based -

Formula definition:

SUM(MYATTRIBUTE([ATTR="Supported perspective”][COL="Status"][PER=current{"PER")]})
Insert Formula Advanced Formula...

—Predefined formulas

Formula: Associated from current element
Select the following options:

Function: Sum

Attribute: Supported perspective -
Metric Attribute: Status -

Override formula result:

Value rule: Mo Rule -

to define a new formula or modify a predefined formula: Click
Advanced Formula to start the Formula Editor. For more information,
see “Creating a Formula” on page 129. If you are starting the Formula
Editor for the first time, you must configure your system for Java. For
more information, see Appendix 2, “Configuring Java,” on page 399.
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TIP If you want to override the formula result with another value, select
Override formula result and enter a value.

5 To set a predefined rule for use on the value, select the rule from Value Rule
list. For more information, see Chapter 10, “Defining Rules,” on page 123.

6 To set a text, click <metric attribute> Text. Then enter text in the Metric
text field.

7 To set a predefined rule for use on the text, select the rule from Text Rule
list.

8 To set a link that opens another source of information, click <metric
attribute> Link. Then select a predefined link from the Link list. For more
information, see “Managing Link Definitions” on page 78.

9 To set arange, click <metric attribute> Range. Then select a range from
the Range list. For more information, see “Create a Range” on page 136.

10 To set the time period to the selected period in the table view, click Display
period.

11 To set the time period to a specific date range, complete the following steps:

a Select Start period.

Note: The default value of the start period is the selected period in the
table view. The default value of the end period is the last period in the
element's lifetime.

b Select a start period or end period from the lists.

12 Click OK.

Edit Element Properties

You can edit element properties such as name, attributes, and access
permissions.

To edit the properties of an element, complete the following steps in an open
project:

1 Open a scorecard table.

2 Next to an element, click [=] and click Properties. The Element Properties
page appears and the General Information section is expanded.
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Element Properties Gsas

2 General Information

—General settings

Element type: Measures
* Element name: Sales
Description: Sales element description

Internal element ID:  c210c6b7-0a15-113b-5c35-eb562052d3fc

Owner: SAS Demo User
Owner email: b @sas.com
Link: External link -

— Time settings

Time dimension: Strategy Management Time Standard (Predefined) Time hierarchy: StM Time Hierarchy
Period type: Month
Start period: Float - End period: Float A

y Attribute Options and Associations

y Permissions

3 To edit the general settings, complete the following steps.

Note: The element type setting is the element type that you have selected
to display in the scorecard.

Edit the name.

Note: The name cannot contain a caret (*) or vertical bar (]). If you type a
caret, it is converted to a tilde (~). If you type a vertical bar, it is converted
to a percent sign (%).

Edit the description, if required.

To designate the owner of the element, click Select Owner. For more
information about selecting an owner, see “Select the Owner of a
Template, Project, Scorecard, or Element” on page 147.

To specify a link that you want to associate with the element, select a link
definition from the Link list. For more information, see “Managing Link
Definitions” on page 78.

4 To edit the time settings, complete the following steps.

Note: If an element has a value, action, range, threshold, or formula that is
associated with it, you cannot edit its periodicity. If an element contains
values that are not included in the changed time settings, the values are
retained in the database and can be displayed if the time settings are
readjusted to include those values.

From the Period type list, select the type of period.

The period type defines the intervals at which data is collected for the
element.

From the Start period list, select the beginning date of data collection.
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The start period defines the first interval at which data is collected. For
example, if the period type is YEAR, the start period might be 1999. If you
have selected Multiyear as the period type, the only available start period
is MULTYR. FLOAT means that the start point of the period is not set.

c From the End period list, select the end date of data collection.

The end period defines the last interval at which data is collected. FLOAT
means that the end point of the period is not set.

5 To select associations for an element, complete the following steps.
Note:

Attributes and their associations are defined in the template on which the

project is based. For more information, see “Create a Template” on page
44,

Attribute information is not available for the elements in a KPI project.

a Expand the Attribute Options and Associations section.

4 Attribute Options and Associations

Select an attribute and then specify its information. The information is determined by the
attribute category set on the element type.

-~ MyText Options

Supported perspectiv

MyEmail Text: M d

MyDate ¥ WOTes

MyURL Link:  External link [~

b Select an attribute from the list.

c Enter or select the value for the options.

For example, if the element is a contact name and the category of the
attribute is e-mail, supply the e-mail address for the contact name.

TIP If you want to specify a link to associate with a non-metric
attribute, select a link definition from the Link list. For more information,
see “Managing Link Definitions” on page 78.

6 To assign access permissions, complete the following steps.
Note:

In order to assign access permissions to an element, you must have the
appropriate access permissions.

You can assign access permissions to an element so that only
designated individuals and groups can read or change the element.

a Expand the Permissions section.
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o Permissions

Permissions define the type of access granted to a user or group for an object.

& Name Read Write Delete Administer

& sasdemo

{3 Strategy Management Data Entry Approver Group | [ e
A strategy Management Data Entry Group ] b s

| Add Users & Groups... |

b Click Add Users & Groups. For more information, see “Add Users and
User Groups” on page 148.

c In the Permissions table, click Read, Write, Delete, or Administer
access permissions for each user or group. For more information about
access permissions, see “Working with Access Permissions” on page
150.

d To remove a user's name from the list of users who have access to the
scorecard, click ¥ to the right of the check boxes.

7 When you are finished editing the properties, click OK.

Edit Multiple Elements

You can edit the time, owner, and values of more than one element at a time.

To edit multiple elements, complete the following steps in an open project:

1 Click Edit Elements. The Edit Elements page appears.

Edit Elements gsas

— Element Selection
@ Project elements: 2013 Strategy (project elements only)

() Scorecards: All |:|

Element type: All A
Select the elements you want to change:

@ All elements
() Selected elements:

4 L

[] override properties set on an individual cell

2 To edit project elements, click Project elements. Otherwise, to edit
scorecard elements, click Scorecards.
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To edit the elements in all scorecards, click All scorecards. Otherwise, to
select the scorecard that contains the elements that you want to edit, click
Select. Then, expand the scorecard hierarchy and select the scorecards that
you want to edit.

From the Element type list, select an element type.

To edit all elements, click All elements. Otherwise, to edit specific elements,
click Selected elements and select the check boxes that are next to the
elements that you want to edit.

To override cell properties, click Override properties set on an individual
cell.

Note: To change any existing values on the selected elements, you must
select this option.

To change the time properties of the elements, complete the following steps
in the General Properties section.

CAUTION! If you change the periodicity of an element, data is lost.

— General Properties

Period type: Start period: End period:
| Element’s lifetime: Month - Float - Float -
| Owner: sasdemo Select Owner. .

¥| Comment alert: Both e-mail and alerts portlet

a Click Element's lifetime.
b Select a period type from the Period type list.

c Select a start period and an end period from the Start period and End
period lists.

Note:

Select Float in the lists to indicate that the start period or end period
for the project has not been set.

If an element contains values that are not included in the changed
time settings, the values are retained in the database and can be
displayed if the time settings are readjusted to include those values.

To change the owner of the elements, click Owner and click Select Owner.
The Owner page appears. For more information about selecting an owner,
see “Select the Owner of a Template, Project, Scorecard, or Element” on
page 147.

To specify whether you receive an alert when a comment is added, click
Comment alert and click Change. The Alerts on Comments page appears.
For more information, see “Set Alerts on Comments” on page 149.

To specify the column to which metric attribute properties are applied, select
an attribute from the Metric attribute list.
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— Metric Attribute Properties

Select a metric attribute. This indicates what column the properties are applied to.

Metric attribute:

Performance «

| Value: 85
| Value rule: Finance review -
Metric text:
Metric text rule: | Mo Rule
Range: Mo Range
Interval type: Condition: Threshold:
Global threshold:
Interval type: Condition: Threshold:
| Personal threshold:| value . 45 Change. ..
Link:
Apply any information that has been checked to the following set of periods:
@ Display period: 5/23/13
Start date: i) End date: i)

10 To change the metric attribute values for multiple elements, click Value and
click Change. Then, select one of the following options on the Values page.

Way to Set the Value Option

Provide a value Click Entered value.

Specify a predefined formula to apply to the
metric value

Click Formula definition.

Define a new formula or modify a predefined Click Formula definition.

formula to apply to the metric value

11 (For entered value) Enter a new value in the Entered value field.

12 (For formula definition specifying a predefined formula) Complete the
following steps:

a Select a formula from the Formula list.
b Select a function, attribute, and metric attribute as needed.

c Click Insert Formula. The formula appears in the Formula definition
field.

13 (For formula definition defining a new formula or modifying a predefined
formula) Click Advanced Formula. For more information, see “Creating a
Formula” on page 129. If you are starting the Formula Editor for the first
time, you must configure your system for Java. For more information, see
Appendix 2, “Configuring Java,” on page 399.

14 To set a predefined rule for use on the value, click Value rule and select a
rule from the list. For more information, see Chapter 10, “Defining Rules,” on
page 123.

15 To change or supply text, click Metric text and type the text into the field.

16 To set a predefined rule for use on the text, click Metric text rule and select
a rule from the list.



Link Elements 107

17 To change or apply a range, click Range. Then, select a range from the list
or click New to create a new range. For more information, see “Create a
Range” on page 136.

18 To change or apply a global threshold, click Global threshold and click
Change. The Global Threshold Options page appears. For more information
about editing thresholds, see “Edit a Global or Personal Threshold” on page
119.

19 To change or apply a personal threshold, click Personal threshold and click
Change. The Personal Threshold Options page appears. For more
information about editing thresholds, see “Edit a Global or Personal
Threshold” on page 119.

20 To change or apply a link, click Link and click Change. The Link page
appears. Then select a predefined link from the Link list and click OK. For
more information, see “Managing Link Definitions” on page 78.

21 To specify the current period, click Display period. Otherwise, to specify a
date range, click Start date and click [E] that is next to the Start date and
End date fields.

22 Click OK.

Link Elements

In a project that contains multiple scorecards, you can link an element to an
element of the same element type in a parent scorecard. Linked elements are
used in the following ways:

Thresholds that are crossed in a child scorecard cause a flag to appear in
linked elements in the parent and grandparent scorecards.

Parent scorecards that have a formula that uses the Current Children
function include only those child elements that are linked.

An aggregate view displays all linked elements on the same line of the
aggregate table. Elements that are not linked are displayed on separate
lines.

To link an element to an element in its parent scorecard, complete the following
steps in an open project:

1 Select a scorecard below the level of the top scorecard.

2 Next to an element, click [5] and click Link Element. The Link Element page
appears.

3 Select a parent scorecard from the Scorecard list.

4 Select an element from the Link to element list.

Note: You cannot link multiple elements in one scorecard to a single
element in a parent scorecard.

5 To unlink the element, click Unlink element.
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Change Comment Alert Settings for an
Element

You can choose to receive an alert when a comment is added to an element.
You can select one element or multiple elements and change the options for all
at one time.

To change the comment alert settings, open a project and click B,

To set the option for one element, click [5] next to that element and click
Alerts on Comments.

To set the option for multiple elements, select the elements. Then, at the top
of the last column, click [5] and click Alerts on Comments.

The Alerts on Comments page appears. For more information, see “Set Alerts
on Comments” on page 149.

Copy Element Properties

You can copy the properties of an element to other elements. Copying
properties enables you to define a set of properties for an element, such as a
value to be entered manually, a measure or a formula, a global threshold, a
personal threshold, a range, and an action. You can then copy the properties
from that element to a set of elements throughout the scorecard hierarchy for a
given set of periods.

Note: Element associations are copied only to elements that are in the same
scorecard.

To copy the properties of an element, complete the following steps in an open
project:

1 Click E.

2 Next to the element that you want to copy, click =l and click Copy
Properties To.The Copy Properties To page appears.
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Copy Properties To gsas

Element name: Revenue from existing customers with new products

—Properties to copy

Select a metric attribute (indicates what column the properties are copied from), then select the properties
you want to copy.

Metric attribute: Actual -

[¥] value: SUM(CHILDREM([ELE=current("ELE")][COL=current("COL")][PER=current("P
[[1value rule:

[ Metric text:

[[] Metric text rule:

Range:
Interval type: Condition: Threshold:
[7] Global threshold:
Interval type: Condition: Threshold:
"] Personal threshald:
[ Link:

3 From the Metric attribute list, select a metric attribute.

4 Select Value, Value rule,Metric text, Metric text rule, Range, Global
threshold, Personal threshold, or Link to copy these properties.

Note: The fields to the right of these check boxes are unavailable.
5 Complete the following steps in the Element Selection section:

a To copy the properties to a project, select Project elements. Otherwise,
to copy the properties to a scorecard, select Scorecards, and then click
Select.

To copy the properties to all scorecards, select All scorecards.
Otherwise, to select the scorecard that contains the elements that you
want to copy, click Select. Then, expand the scorecard hierarchy and
select the scorecards that you want to edit.

b From the Element type list, select an element type.

c To copy the properties to all elements in the selected project or
scorecards, select All elements. Otherwise, copy the properties only to
selected elements, select Selected elements and click on the elements
that you want to select.
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— Element Selection
Project elements: 2013 Strategy (project elements only)

@ Scorecards: All Select_..

Element type: Measure -

Select the elements you want to copy properties to:

All elements
@ Selected elements:

2EEEEworldwide &
-l % staff with incentives aligned with strategy
-l % trained on new flubberblast technology
-l Innovation product profit per employee 3
] MNumber of contributing market interviews
o] Mumber of hours new product training delivered to s&
- Mumber of innovation products delivered to new mar
|l Mumber of innovation projects based on existing pro
] Mumber of products developed with cross-functional -
] Mumber of products with advisory board feedback
[l Miimhar nf nrodicte with nsar 10% arawth i

1 m b

Override properties set on an individual cell

d To override existing properties, select Override properties set on an
individual cell.

6 Complete one of the following steps in the Period Selection section:

To copy the properties to the currently displayed period, select Display
period.

To specify the time period that you want to copy the properties to, select
Start date and click [=] that is next to the Start date and End date fields.

7 Click OK.

Copy an Element

You can copy an element to a scorecard in the same project, or in a different
project if the project is based on the same template. The copied element retains
the link and other attributes of the original element. You can copy project
elements only to other projects, and you cannot link project elements. You can
copy scorecard elements only to other scorecards.

To copy an element, complete the following steps in an open project:
1 Click F.

2 Next to the element that you want to copy, click (] and click Copy. The Copy
Element page appears.

3 Select the project and scorecard to which to copy the element.

Note: You can copy the element to more than one scorecard. An element
cannot be copied to itself.

4 To change the name of the element when it is copied, type the name in the
Element name field.
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5 Click Copy.

Move an Element

You can move an element to a scorecard in the same project, or in a different
project if the project is based on the same template.

To move an element to another scorecard, complete the following steps in an
open project:

1

2

Click .

Next to the element that you want to move, click [=] and click Move. The
Move Element page appears.

Select the project and scorecard to which to move the element.

Click Move.

Delete an Element

To delete an element, open the project and click #. In the element table,
perform one of the following actions.

To delete one item, click [=] next to the element that you want to delete and
click Delete.

To delete more than one item, click the check box to the right of each item.
Then click [=] and click Delete.

To delete all elements, click the check box at the top of the right-most
column. Then click [=] and click Delete.

Note: Deleting an element that is used in a formula renders the formula invalid.

Format Numbers and Fonts in Cells

You can change the number format and font of the cells within a scorecard
element.

To change cell format, complete the following steps in an open project:

1

Next to the element, click [=] and click Format Cells. The Format Cells page

appears.

2 To format numbers and dates in cells, expand the Number Settings section.
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Format Cells - Sales SSBS

You can format one or more cells by selecting its metric attribute. As you make your selections, click Apply to
save changes and remain on this page.

4 Number Settings

Use number formats to change the appearance of numbers, including dates.

c o c — Opti
[] |Metric Attribute| Type Preview ptions
Select the type to change the
B |status Sl selected metric type attributes. To
[ | Actual Number 1234.1 format cells as text, select
General.
Target General 1234.1
Type:  General -
[ |Performance General

y Font Settings

| oK | | Cancel| | .-‘-\pply|

3 Select the metric attributes in the table to which to apply the format, or select
the Metric Attribute check box in the column heading to select all of the
attributes.

4 In the Options section, from the Type list, select the number format to apply
to the selected attribute:

Type Description

Current Column Applies the format of each column to the cells in the
Format selected row.

General Applies a text format.

Currency Applies a currency format. An example is $1,234.10.
Number Applies a numeric format.

Percentage Applies a percentage format. An example is 100%.
Date Applies a date format. An example is 03Dec04.

5 (For the Currency type) Complete the following steps:

a To use the locale that is specified by your preferences, click Use the
locale selected in your preferences.

b To specify a different locale, click Use this locale and choose a locale
from the list.

c From the Decimal places list, select a value.

6 (For the Number type) Complete the applicable steps.
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To use a numeric format other than the SAS format along with settings
that are in your profile, click Other and click Use the settings in your
profile.

To use a numeric format other than the SAS format along with settings
different from those in your profile, click Use these settings. From the
Decimal places list, select a value. Then, choose whether to use a
comma to separate 1000s and whether to switch the 1000 separator and
the decimal separator.

To use the SAS numeric format, complete the following steps:
1 Click SAS Format.
2 From the List of formats list, select a common format.

3 From the Decimal places list, select a value.

Note: This field is unavailable for the BEST format.
4 In the Width field, type a value.

7 (For the Percentage type) Choose whether to format the percentage as a
standard percentage or to use the format from the locale. From the Decimal
places list, select a value.

8 If you selected the Date type, select a format from the Available date
formats list.

9 To view the format selection in the metric attribute table, click Preview.

10 To set the fonts that are displayed in cells, expand the Font Settings
section.

» Font Settings
To make text stand out, you can format any metric attribute.
Attributes: — Options
Metric Attribute| Type Preview Select the formatting options.
Status General Current column format
Actual Number 1234.1 ol
—alignment ¥|Bold
v | Target General 1234.1 .
Left Italic
Performance General 1234.1
Center
® Right Underline
Strikeout
Wrap
text
— Color
Text:
Blue -
Background:
White =
Preview
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11 Select the metric attributes in the table to which to apply the font or click
Metric Attribute in the column heading to select all of the attributes in the
table.

12 To apply the column format to the cells in the selected row, click Current
Column Format.

Note: The other settings in the Options section are unavailable.
13 In the Alignment section, click the alignment for the text.
14 In the Style section, click one or more styles of text formatting.

15 From the Text and Background lists, select a color for the text and
background.

16 To view the font selection in the metric attribute table, click Preview.

17 Click OK.

Format Numbers and Fonts in Columns

You can change the number format and font of the columns within a scorecard
table.

To change column format, complete the following steps in an open project:
1 Select a column in a scorecard table.

2 At the top of the column, click =] and click Format Column. The Format
Columns page appears.

3 To format numbers and dates in columns, expand the Number Settings
section.

~ Number Settings

Formats all the text in the column.

—Options
Select the type to change the selected metric type attributes. To format cells as text, select
General.

Type:  Currency -
Set the options to apply to selected type.

@ Use the currency settings from your locale preferences:
usD

“1 Use this currency setting:
ARS

Decimal places: 0~ (0 to 10)

4 From the Type list, select the number format to apply to the selected column:

Type Description

General Applies a text format.
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Type Description

Currency Applies a currency format. An example is $1,234.10.
Number Applies a numeric format.

Percentage Applies a percentage format. An example is 100%.
Date Applies a date format. An example is 03Dec04.

5 (For the Currency type) Complete the following steps:

a To use the locale that is specified by your preferences, click Use the
locale selected in your preferences.

b To specify a different locale, click Use this locale and choose a locale
from the list.

c From the Decimal places list, select a value.

6 (For the Number type) Complete the applicable steps.

To use a numeric format other than the SAS format along with settings
that are in your profile, click Other and click Use the settings in your
profile.

To use a numeric format other than the SAS format along with settings
different from those in your profile, click Use these settings. From the
Decimal places list, select a value. Then, choose whether to use a
comma to separate 1000s and whether to switch the 1000 separator and
the decimal separator.

To use the SAS numeric format, complete the following steps:
1 Click SAS Format.
2 From the List of formats list, select a common format.

3 From the Decimal places list, select a value.
Note: This field is unavailable for the BEST format.

4 In the Width field, type a value.

7 (For the Percentage type) Choose whether to format the percentage as a
standard percentage or to use the format from the locale. From the Decimal
places list, select a value.

8 If you selected the Date type, select a format from the Available date
formats list.

9 To view the format selection in the metric attribute table, click Preview.

10 To set the fonts that are displayed in cells, expand the Font Settings
section.
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4 Font Settings

Formats all the text in the column.

— Options

Selact the formatting options.

Alignment style————————— Color
O Left [¥IBold Text:
© Center [ italic Red ~
@ Right [Clundertine Background:
[Tl strikeout White  ~
DWrap text

11 In the Alignment section, click the alignment for the text.
12 In the Style section, click one or more styles of text formatting.

13 From the Text and Background lists, select a color for the text and
background.

14 To view the font selection in the metric attribute table, click Preview.

15 Click OK.

Set a Global or Personal Threshold

To set a threshold, complete the following steps in an open project:
1 Select a project or scorecard table.
2 Select the element in the table to which you want to apply a threshold.

3 Next to the element, click [=] and click the applicable action.
To set a global threshold Global Threshold Options

To set a personal threshold Personal Threshold Options

The applicable threshold page appears. The following example is the Global
Threshold Options page.
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Global Threshold Options gsas

— Threshold trigger
Threshold settings determine when a flag is displayed.

Interval type: Condition:  Threshold:
@ Set threshold: | Value < - 550
~' Remave thresholds on selected elements

! Mo change

—Motification and subscription

Motifications are sent to the list of subscribers when the alert is triggered.
) Set subscribers on selected elements
List of subscribers:

[subscrive...]
[Remove |

! Remove all subscribers on selected elements
@ Mo change

—Stored Process

Select a stored process to run when the threshold condition is met.

Stored Process: Add...

Stored Process parameter:
The format is keyword=value and multiple parameters should be separated with semicolons.

4 To view threshold information for a specified period, select a period from the
Period list and click Go. The current period is displayed by default.

5 From the Select a metric attribute list, select the metric attribute to which
you want to apply the threshold.

6 Activate the applicable threshold.

To activate a global threshold Select Enable global threshold.

To activate a personal threshold  Select Enable personal threshold.

r Enable global threshold

— Threshold trigger

Select the interval type and conditions that trigger the alert.
Interval type: Condition: Threshold:

Value - 400

Apply the threshold condition to the following period(s).
@ Period range:

Start:  May2013 ~ End: Dec2015 ~
© Current period:  May2013

7 To specify the conditions that trigger alert notifications to subscribers,
complete the following steps in the Threshold trigger section:
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a Select an interval type from the Interval type list.

If you have applied a range to the metric attribute, the list contains
intervals that are defined in the range properties.

If you have not applied a range to the metric attribute, Value is the
only item in the Interval type list.

For more information, see “Create a Range” on page 136.

b Select an operator from the Condition list. For example, if you want an
alert to be triggered when the interval falls below a certain value, select
the < (less than) operator.

c Type a value in the Threshold field or select an interval from the
Threshold list.

d To specify the period of time to which the threshold applies, perform one
of the following steps:

Select Period range and select a start period and end period from the
Start and End lists.

Note: The default value of the start period is the selected period in
the table view. The default value of the end period is the last period in
the element's lifetime.

Select Current period.

8 To identify subscribers to alert when a threshold is triggered, complete the
applicable steps in the Notification and subscription section.

|- Motification and subscription

Motifications are sent to the list of subscribers when the alert is triggered.
¥/ Enable alert notifications

List of subscribers:

SAS Demo User

Add...

| [Remove |

For global To enable alert notifications and add users to the list of

thresholds subscribers so they are notified when an alert is triggered,
select Enable alert notifications. To add a user or user group
to the list of subscribers to a global threshold, click Add. For
more information, see “Add Users and User Groups” on page
148. To remove a user from the list of subscribers to a global
threshold, click Remove.

For personal To subscribe yourself so that you are notified when an alert is
thresholds triggered, select Enable alert notifications and subscribe
me.

Note: In order for a subscriber to receive alert notifications by e-mail, the
subscriber’s portal preferences must include one of the following selections
for alert notifications:

Via e-mail

Both e-mail and alerts portlet
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For more information, see “Set Alert Preferences” on page 149.

Note: If an alert notification is triggered by a formula-based cell value, the
notification occurs only when both of the following criteria are met:

the formula-based cell value has changed

the project, scorecard, or both are recalculated

To specify a stored process to run when the threshold is met, complete the
following steps in the Stored Process section:

a Click Add, expand the hierarchy as needed, and then select a stored
process.

b If the stored process requires one or more parameters, type the
parameters in the Stored Process parameter field.

TIP Separate each parameter with a semicolon (;).

c To delete the stored process, click Remove.

10 Click OK.

Edit a Global or Personal Threshold

To edit a threshold, complete the following steps in an open project:

1

2

Click Edit Elements. The Edit Elements page appears.

In the Metric Attribute Properties section, perform the applicable step:

To edit a global Click Global Threshold and click Change.
threshold

To edit a personal Click Personal Threshold and click Change.
threshold

The applicable threshold options page appears. The following example is for
the Global Threshold Option page.
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Global Threshold Options gsas

— Threshold trigger
Threshold settings determine when a flag is displayed.

Interval type: Condition:  Threshold:
@ Set threshold: | Value < - 550
~' Remave thresholds on selected elements

! Mo change

—Motification and subscription

Motifications are sent to the list of subscribers when the alert is triggered.
) Set subscribers on selected elements
List of subscribers:

[subscrive...]
[Remove |

! Remove all subscribers on selected elements
@ Mo change

—Stored Process

Select a stored process to run when the threshold condition is met.

Stored Process: Add...

Stored Process parameter:
The format is keyword=value and multiple parameters should be separated with semicolons.

3 To edit the conditions that trigger alerts to subscribers, perform the
applicable steps in the Threshold trigger section:

To set a new threshold, complete the following steps:

1 Click Set threshold and select an interval type from the Interval type
list.

2 Select an operator from the Condition list. For example, if you want
an alert to be triggered when the interval falls below a certain value,
select the < (less than) operator.

3 Type a value in the Threshold field.

To remove all thresholds from the selected elements, click Remove
thresholds on selected elements.

Note: This choice also removes all subscribers, including your personal
subscription.

To make no change to elements with different thresholds, select No
change.

4 To edit the list of subscribers who receive alerts when a threshold is
triggered, perform the applicable step in the Notification and Subscription
section:



View Thresholds 121

For global To add a user to the list of subscribers to a global threshold,

thresholds click Set subscribers on selected elements and click
Subscribe. For more information, see “Add Users and User
Groups” on page 148.

To remove a user from the list of subscribers, click the user
and click Remove.

To remove all subscribers from the selected elements, click
Remove all subscribers on selected elements.

To make no change to elements with different notifications,
click No change.

For personal To be notified, click Enable alert notifications and
thresholds subscribe me.

To remove notification, click Remove my alert notifications
subscription on selected elements.

To make no change to elements with different notifications,
select No change.

5 To edit a stored process to run when the threshold is met, perform the
applicable step in the Stored Process section:

a Click Add, expand the hierarchy as needed, and then select a stored
process.

b If the stored process requires one or more parameters, type the
parameters in the Stored Process parameter field.

TIP Separate each parameter with a semicolon (;).

c To delete the stored process, click Remove.

6 Click OK.

View Thresholds

To view the thresholds that have been set for a table, complete the following
steps in an open project:

1 Select a project or scorecard table.

2 Customize the table so that threshold flags are displayed. For information,
see “Customize a Scorecard Table” on page 165.

3 Click one of the threshold icons (¥ or %&) in a cell. The Threshold Conditions
page appears.

The table displays the name of the scorecard, the value of the selected
element, the threshold, and the absolute difference between the threshold
and the value. The table also displays any scorecards that meet the
threshold conditions for that metric attribute, starting at the selected
scorecard and including any of its child scorecards.

Note: Click the scorecard name to display the scorecard.
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Overview of Rules

Ways to Use Rules

You can define a rule once on the Manage Rules page and then use the rule in
multiple places in a project and in its scorecards. You can select which rule
definition to use when you apply rules to one or more metric attributes. Rules are
then validated in the data-entry form.

For more information, see:
“Edit Metric Attributes” on page 99
“Edit Multiple Elements” on page 104

Types of Rules That You Can Define

The following table describes the types of rules that you can define.

Rule Type Description

Numeric The rule evaluates the cell value against a lower and upper boundary.
For example, if value is the cell value that the rule evaluates, then:

lower boundary <= value <= upper boundary

You do not have to specify both boundaries. If you do not specify both
boundaries, you can have an unlimited upper or lower boundary. For
example,

10 <= value

validates that the cell value is equal to or greater than 10.
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Rule Type Description

Text The rule evaluates the cell value against a maximum length. The cell
value must be text.

Choices This rule displays the choices that you specify in a list in the form.
Then, the user selects a choice from the list.

Formula The rule evaluates whether the value that was entered by the data-
entry user passes the criteria as defined by the formula. For more
information, see Chapter 11, “Working with Formulas,” on page 127.

Define a Rule

To define a rule, complete the following steps from the Project page:

1 Select Project » Manage Rules. The Manage Rules page appears.

2 Click [*. The Properties section appears below the Rules list.
TIP You can click Save at any time in the Properties section. Doing so
saves a draft of the rule. The draft appears in the Rules list above the
Properties section. The draft contains the selections that you made before

you clicked Save. If you continue working in the Properties section but do
not click Save, any subsequent selections can be lost.

3 Complete the following steps on the Identification tab.

Identification| Rule Properties

Enter a name and description for the new rule.

Mame: “ Mumeric rule

Description:

Required entry (3)

[] Enable users to override the rule (3

a In the Name field, enter a unique name for the rule.

b (Optional) In the Description field, enter an optional description of the
rule.

c Click Required entry if you want to require that the affected data cell be
filled in. The user can save the form, but the user cannot submit the form
without entering a value in the affected data cell.
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Note: If the form does not have a workflow, then only the Submit button
is available in the form. The form does not have a Save button.

d Click Enable users to override this rule if you want to permit your users
to enter a value that does not conform to this rule’s restrictions. Although
a warning appears, users can save and submit the form even though the
input fails validation.

4 Click the Rule Properties tab. To define the rule, select the type of rule that
you want to define and complete the applicable steps:

Rule Type Step

Numeric In the Lower boundary and Upper boundary fields, enter the
boundary values that you want the rule to use to evaluate cell
value.

Note: If value is the cell value that the rule evaluates, then lower
boundary <= value <= upper boundary. If you specify only one
boundary, the unspecified boundary is an unlimited boundary. For
example, 10 <= value validates that the cell value is equal to or
greater than 10.

Text In the Maximum length field, enter the length value that you want
the rule to use to evaluate the cell value.

Choices In the Choices field, enter the choices from which the user can
select in the affected cell. Enter each choice separated by a semi-
colon (;). For example, enter three choices by typing:

dog; cat; rabbit

Formula In the Formula field, enter the formula that you want the rule to
use to evaluate the cell value. To use the Formula Editor to define
the formula, click Advanced Formula. The Validation message
field indicates whether the formula validated correctly.

Note: In the Validation message field, you can specify a
message to display to the data-entry user. This message appears
if the data-entry user enters a value that is not valid for the
formula. You can use this message to explain the formula and its
expected values to the data-entry user.

5 Click Save to save your selections. The draft of the rule appears in the Rules
list above the Properties section. Click Cancel to exit the Properties section
without saving your selections.

Manage Rules §sas

* | % @

Select a rule to open or copy. You can also create a rule. (3

Name Description

Finance review Finance must review expenses above this value.

Note: If you click the column headings in the Rules list to sort items in the
list, the feature does not sort the items correctly in languages other than
English.
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Edit or View the Properties of a Rule

Note: If B is the only button available on the toolbar, the role and capability
settings that are associated with your user name are limited to viewing only. If
you require expanded access to SAS Strategy Management, contact your SAS
Strategy Management administrator.

To edit the properties of a rule, complete the following steps on the Manage
Rules page:

1 Double-click the rule that you want to edit. The Properties section appears
below the Rules list.

2 Change the applicable settings in the rule as described in “Define a Rule” on
page 124.

3 Click Save to save your selections. Click Cancel to exit the Properties
section without saving your selections.

Copy a Rule

To copy a rule, complete the following steps on the Manage Rules page:

1 Select the rule that you want to copy and click ¥g.

The copied rule appears in the list. A number is appended to the rule’s name.

2 To edit the copied rule, double-click its name. The Properties section
appears below the Rules list.

3 Change the applicable settings in the rule as described in “Define a Rule” on
page 124.

4 Click Save to save your selections. Click Cancel to exit the Properties
section without saving your selections.

Delete a Rule

To delete a rule, complete the following steps on the Manage Rules page:
1 Select the rule that you want to delete and click ..

2 A confirmation message appears. Click Yes to delete the rule.
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Apply a Formula to a Column

You can define and apply formulas to the columns in scorecard tables. When
applying formulas, keep the following requirements in mind:

Formulas can be applied only to columns that contain numeric values. Any
calculation that cannot be computed appears as #NUM!.

A formula on a cell always takes precedence over a column formula.
Therefore, when you apply a formula to a column, any cells that already have
a formula ignore the column formula; all other cells in the column accept the
formula. Likewise, when you remove a formula from a column, the formula is
removed only from those cells that accepted the column formula; the other
cells retain their cell formulas.

To apply a formula to a column, complete the following steps in an open project:

1

2

Open the scorecard table to which you want to apply the formula.

In a column heading, click [=] and click Apply Formula.

Note: To see the action menu, the column selection must include numeric
values. For more information, see “Create a Column Selection” on page 142.

The Apply a Formula to a Column page appears.
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Apply a Formula to a Column - Actual 9sas

Formula definition:
SUM (MYATTRIBUIE ( [ATTR="5Supported perspective”]
[COL="Actual"] [PER=current ("FER"} 1))

Insert Formula Advanced Formula...

—Predefined formulas

Formula: Associated from current element «
Select the following options:

Function: SUM ~

Attribute: Supported perspective
Metric Attribute: Actual -

Apply this formula for the following date:
@ Display date to the last date of the element's lifetime
) Start date: [E  End date: &

) Based on existing date:  5/23/13

0K Cancel

3 To apply a predefined formula to the column, complete the following steps:

a Select a formula from the Formula list.
b Select a function from the Function list.

c Click Insert Formula. The formula appears in the Formula definition
field.

4 To define or edit a formula, click Advanced Formula. For more information,
see “Creating a Formula” on page 129. If you are starting the Formula Editor
for the first time, you must configure your system for Java. For more
information, see Appendix 2, “Configuring Java,” on page 399. After you exit
the Formula Editor, continue to the following step.

5 To specify the dates to which the formula applies, complete the following
steps:

To apply the formula to periods that extend from the selected period to
the last period in the element's life time, click Display date to the last
date of the element's lifetime.

To specify a start and end date, click Start date and click =] next to the
Start date and End date fields.

To apply the formula to the date that is specified in the column selection
definition, click Based on existing date.

Note: When you apply a formula to a column selection, the current date is
the absolute date that is specified in the column selection definition, or that is
followed by an indicator of the relative period offset from the column selection
definition. For more information, see “Create a Column Selection” on page
142.
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Creating a Formula

Your First Look at the Formula Editor

Use the Formula Editor to build and edit formulas.

Formubawil be aoplied bo: &ctual mesric actribuee column, Chidl scorecard, T17Ma0 10 projec:

Expresson Tedt:

[
1
2
L [ - [ e[ o[ e [ = [ =] «] = >]>=1]_"7]iw]
3 — i o valdaa Exprasann
[ Euetons | aks seurees —y

Catmgories: Furkiors:
4 Bl Functions.

prithmetic Funcbons

e and Tina Fanctions

[romat Convert Pundions

il Functions

5t Functions

Etatistcal Functions

fitrireg Functions

[Tabk Furdiers

[Trigonaometric Functions
5

Trsct

6 | camal Hebo
1 Expression Text area.

The current formula appears in the Expression Text field. You can insert
text into the formula at the insertion marker. Before you insert text, be sure to
position the insertion marker at the correct location by clicking that location.

Symbol toolbar

To insert a symbol, use the symbol toolbar. For more information, see “Insert
a Symbol” on page 130.

Undo and Redo buttons
Functions tab

To insert a function, use the Functions tab. For more information, see “Insert
a Function” on page 130.

Data Sources tab

To insert a reference to a data source, use the Data Sources tab. For more
information, see “Insert a Data Source Reference” on page 131.

OK and Cancel buttons

Note:

The Formula Editor is also used in SAS Financial Management. For more
information about the Formula Editor, see the SAS Financial Management
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Formula Guide. However, the Data Sources tab is not provided in SAS
Financial Management and the tab is not described in its documentation.

Any calculation that cannot be computed appears as #NUM!.

Start the Formula Editor

You start the Formula Editor by clicking Advanced Formula.

Note: If you are starting the Formula Editor for the first time, you must configure
your system for Java. The Formula Editor requires the Java 2 Runtime
Environment (J2RE). For information about installing the J2RE, see Appendix 2,
“Configuring Java,” on page 399.

Close the Formula Editor

To close the Formula Editor, click OK to save and exit or click Cancel to exit
without saving your work.

Insert a Symbol

To insert a symbol, click the applicable button in the symbol toolbar. From left to
right, the buttons are in the following groups:

IENEEEEREEE Arithmetic operators

[ s [ or [ wor | Boolean operators

[ =] ~ ] <[ == [ > [ = | Comparison operators, which can be used
to compare two numeric values or two
strings

LW A miscellaneous group, which includes a

matching pair of single quotation marks
and a matching pair of parentheses.

Insert a Function

To insert a function into the formula that you are building, complete the following
steps:

1 In the Categories list, click a category that contains the function. Each
function is in the All Functions category and also in one other, more focused
category. When you select a category, all the functions in the selected
category are listed alphabetically in the Functions list.
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Eunctions | Data Sources

Categories:

Functions:

I Functions
rithmetic Functions

ate and Time Functions
ormat Convert Functions
ogical Functions

Ftatistical Functions
fitring Functions

ITable: Functions
ITrigonometric Functions

St Functions

Current
(Current Children
IForall

Forany
Forhlons

IMax Children
IMean Chidren
Min Children
Fange

i5um Children
attribute
attribLtelsMe
myattribute

Irisert

Note: One of the selections in the Categories list is StM Functions. These
are functions provided by Strategy Management. The other selections in the
Categories list are standard SAS functions. For information about Strategy

Management functions, see Appendix 1, “Strategy Management Function
Dictionary,” on page 379.

2 In the Functions list, click a function.For information about Strategy
Management functions, see Appendix 1, “Strategy Management Function
Dictionary,” on page 379.

TIP When you select a function, a brief description of the function is
displayed below the list.

3 Click Insert. A syntactic template of the function is inserted into the
Expression Text field at the insertion point.

4 In the syntactic template, replace each argument placeholder with an
appropriate argument.

Special constants enable you to account for unresolved and missing values in a
formula. The following special constants are supported by the Formula Editor:

Special Constant Description
Indicates a value that is missing.

_BLANK Indicates a value that is missing. You can use _BLANK in an IF
condition to determine whether a value is missing.

_ERROR _ Indicates an error such as divide-by-zero. You can use _ERROR
in an IF condition to determine whether a value has an error.

Insert a Data Source Reference

To insert a reference to a data source, complete the following steps:

1 Click the Data Sources tab.
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Eunctions Data Sources |

variable to add; [(COLActusl']

Data Source: [5eorocards = |

Scorecards: Tables: Metric Attribute: Time Period;

[wrimmarin | fobecive ] [acia - -

G MT17Mar L0 <Current Element> - Use Yalus From:
s Parent3 -1 Selected Scarecard (defaul) =
B, Scorscard - 1 [0z

5B Parentt 03 The value oktained will be the chosen metric attribute from the selected scorecard only.
L E oot

B chidz  fo4
BL ot

2 From the Data Source list, select a data source.

3 From the Scorecards list, select a project. The scorecards in the project
appear in the tree. Select a scorecard in the tree.

4 From the Tables list, select a table. The elements that have been defined for
each table are displayed.

Note: <Current Element> applies to the element that you select in the
scorecard table. Select <Current Element> if you are assigning the formula to
a column or if the formula will be copied to another element as part of a
scorecard or element copy operation.

5 From the Metric Attribute list, select a metric attribute.

6 From the Time Period list, select a time period.

Note: Select <Current> if you are assigning the formula to a column or if the
formula will be copied to another element as part of a scorecard or element
copy operation. The Formula Editor uses the period code, rather than the
period name, in its syntax.

7 From the Use Value From list, select a scorecard.

Note: The value of the metric attribute is the value of the attribute from the
selected scorecard.

8 Click Add to the right of the Variable to Add field. The contents of the
Variable to Add field are inserted into the formula at the insertion point.

Validate the Expression

When you have entered the formula text, click Validate Expression to verify
that the formula is valid.

Note: Numeric constants without decimal points are limited to a range between
-2,147,482,648 and 2,147,483,647. To use a numeric constant that is outside of
that range, insert a decimal point and a zero after the constant, such as —
2,147,482,649.0.
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Overview

If you have created formulas for your project, you can calculate them and display
the results in the cells that contain formulas. Any calculation that cannot be
computed appears as #NUML!.

For information about formulas for columns, see “Apply a Formula to a Column”
on page 127. For information about formulas for cells, see “Edit Metric
Attributes” on page 99 concerning the formula-based method for editing metric
attributes.

Calculate a Project

Note: The following task calculates all scorecards in a project. To calculate only
one scorecard, see “Calculate a Scorecard” on page 88.

To calculate to a project, complete the following steps in an open project:
1 Click Project » Calculate.
2 Click Calculate. The Calculate page appears.

3 You can specify a date range or a period to calculate. Complete one of the
following steps:

To calculate accordingtoa  Click Select by date range.
range of dates Note: This is the default selection.

In the Start date and End date fields, type a date or

To calculate accordingtoa  Click Select by period.

period Note: The default value is the period that is

displayed in the table view.

From the Period type list, select a period type. Then,
from the Period list, select a period.



134 Chapter 12 / Calculating a Project

4 If you have imported a project into your SAS Strategy Management
installation, you must import the formulas that are associated with the project.
To do so, click Import formulas that have been exported from previous
or current versions of SPM 2.x. For more information about importing, see
the SAS Strategy Management: System Administration Guide.

5 Click Calculate.
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Overview

For a description of ranges, see Chapter 2, “How Do You Describe a Strategy?,”
on page 9.

List Ranges

To list ranges, in an open project, click Project » Manage Ranges. The
Manage Ranges page appears.

Manage Ranges gsas
[ Mame Description =

E & Range Mot defined in current or default language [

[ % objective Range Mot defined in current or default language 1

| Mews Range. .. | | Copy Ranges. ..
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Create a Range

Note: You cannot create a range unless you have Scorecard Modeler access
permissions.

To create a range, complete the following steps:

1

2

3

List the ranges. For more information, see “List Ranges” on page 135.
Click New Range. The New Range page appears.

Expand the General Settings section.

Enter a name for the new range in the Range name field.

(Optional) Enter a description for the range in the Description field.

A range can contain several intervals, or subsets of data. To define an
interval, expand the Interval Definitions section.

4 Interval Definitions

Enter an interval, and click Add Value. Walues that are outside the lower and upper bounds are not displayed in the Dashboard view.

Boundary value: 500 £dd Walue

Narme Interval Label Grade  Mormalized Walue Color lcon Delete

Interval 1% <= 5.0 LowerBound It oo liﬁ |3
Interval2z > « &0 and <= 500.0 0.0 ,7@ |3 X
interval ¥ > ~ G000 0.0 [ & [eE X
validate *Will not display in dashboards

You can specify a value for the interval or you can create a formula to
calculate a range interval. The formula can use all of the constructs that are
normally used for formula-based metric attributes. These constructs enable
you to reference the values of other metric attributes within the same
scorecard or different scorecards, or to access the values of the current
metric attribute over time (for example, the mean of the last six periods).

Note:
Any calculation that cannot be computed appears as #NUM!.

Formula-based ranges might generate unexpected range results. The
results of formula-based ranges are not calculated when you create them.
They are calculated at run time. As a result, it is possible to create ranges
that have overlapping intervals. When this happens, SAS Strategy
Management returns the last interval that satisfies the condition.

If you reference an element or an attribute on a formula-based range, you
must provide a full reference to that element or attribute. For more
information, see “Specify a Full Reference to an Element or Attribute” on
page 397.

To create an interval, complete the applicable steps:
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For an interval Enter a value for the lower bound of the range in the

based on a specific Boundary value field and click Add Value.

value The new interval appears in the table below the Boundary
value field.

For an interval Click Add Formula and perform one of the following steps:

based on a formula In the Formula definition field, enter a formula.

Click Advanced Formula to open the Formula Editor.
For more information, see “Creating a Formula” on page
129. If you are starting the Formula Editor for the first
time, you must configure your system for Java. For more
information, see Appendix 2, “Configuring Java,” on
page 399.

8 In the Interval 1 row, enter a label in the Label field for values that fall below
the lower bound of the interval.

9 In the Grade field, enter a letter grade that represents the interval.
10 In the Normalized Value field, enter a value that represents the interval.

11 Click the icon in the Color column, and select from the palette a color to be
displayed with values that fall below the lower bound.

12 Click the icon in the lecon column, and select an icon to be displayed with
values that fall below the lower bound.

Note: If an image does not exist, no image is displayed for that interval.
Images might be missing because a previously assigned image has been
removed without updating the interval properties.

13 In the Interval 2 row, select an operator from the list in the Interval column.

14 Specify a label, grade, normalized value, color, and icon to be displayed with
the interval.

15 To add more intervals, repeat steps 7 through 10.

16 To verify that all of the intervals have values and that the boundary values of
the intervals do not conflict with each other, click Validate.

Note:

To remove an interval, click 2 in the row that contains the interval.

To display percentages within a range, specify the interval boundaries as
decimal values. For example, specify a boundary of 90% as .90.

17 Unresolved or missing values might appear in the new range. Unresolved
values (any calculation that cannot be computed) appear as #NUM!. Missing
values appear as blank cells.

To define labels for these values, expand the Special Value Definitions
section.
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2 Special Yalue Definitions

Enter optional values for unresolved or missing values in the range.

Label Grade  Normalized Walue Color lcon
Missing value | 0o _@ WE
Unresolved value [IR1] @gﬁ

18 For the Missing value and Unresolved value labels, specify a grade,
normalized value, color, and icon to be displayed with the value.

19 Click OK.

Edit a Range
Note: You cannot edit a range unless you have Scorecard Modeler access
permissions.

To edit a range, complete the following steps from the range list on the Manage
Ranges page:

1 Click the name of the range. The Range Properties page appears.

2 Modify the general information, interval definitions, and special value
definitions.

For more information, see “Create a Range” on page 136.

View Range Properties

To view properties and settings associated with an item, click =l next to the item
that you want to view, and then click Properties. The Properties window
appears. You can only view this window. You cannot edit the properties and
settings.

Note: If Properties is the only selection available on the menu, the role and
capability settings associated with your user name are limited to viewing only. If
you require expanded access to SAS Strategy Management, contact your SAS
Strategy Management administrator.

Copy a Range

To base a new range on a range that has already been created, complete the
following steps from the range list on the Manage Ranges page:

1 Click Copy Ranges. The Copy Range page appears.

2 From the Project list, select the name of the project that contains the existing
range.
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Click Go.

From the Range list, select the name of the existing range.
Click Go.

Type a name for the new range in the New range name field.
Type a description for the range in the Description field.

Modify the interval definitions and special value definitions as needed.

For more information, see “Create a Range” on page 136.

Delete a Range

To delete a range, perform one of the following steps from the range list on the
Manage Ranges page:

To delete one range, click =l next to the range that you want to delete and
click Delete.

To delete more than one range, click the check box to the right of each
range, click (=l for the column, and click Delete.

To delete all ranges, click the check box at the top of the right-most column,
click [=l for the column, and click Delete.

Apply a Range to a Column

To apply a range to a column, complete the following steps in an open project:

1

2

Click .

In a column label, click (=] and click Apply Range. The Apply a Range to a
Column page appears.

From the Range list, select a range.

Specify the dates to which the range applies by performing one of the
following steps:

To apply the range to periods that extend from the selected period to the
last period in the element's lifetime, click Display date to the last date of
the element's lifetime.

To specify a start and end date, click Start Date, and click [=] that is next
to Start Date and End Date fields.

To apply the range to the date that is specified in the column selection
definition, click Based on existing date.

Note: When you apply a range to a column selection, the existing date is the
absolute date that is specified in the column selection definition, or that is
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followed by an indicator of the relative period offset from the column selection
definition. For more information, see “Create a Column Selection” on page 142.
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Overview

For a description of column selections, see Chapter 2, “How Do You Describe a
Strategy?,” on page 9.

List Column Selections

To display the list of column selections, complete the following steps in an open
project:

1 Click Project » Manage Column Selections. The Manage Column
Selections page appears.
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2

3

Manage Column Selections 9sas
Listby:  Elementtypes -

[ hame Element Type Personal or Shared Owner =
(=] [F Al attributes For Contacts Contacts Shared sasdemo &
5l [F all Attributes For Initiative Initiative Shared sasgdemo B
Bl & &l attributes For Measure Measure shared casdermo [}
[El [ Al Attributes For Objective Objective Shared sasdemo ]
Bl G &l Mon-petric Attributes For Contacts contacts shared sasdermo )
=] [& Al Mon-Metric Attributes For Initiative Initiative Shared sasdemo ]
&l [F &l Mon-detric Attributes For Measure Measure Shared sasderno ]
El [ all Mon-petric Attributes Far Objective Objective Shared sasderno =

Hew. ..

From the List by list, select which column selections to display in aggregate
tables.

Click Go.

Create a Column Selection

To create a column selection, complete the following steps:

1

a A @ N

(-]

List column selections. For more information, see “List Column Selections”
on page 141.

Click New. The New Column Selection page appears.

Expand the General section.

Type a name for the column selection in the Column selection name field.
(Optional) Type a description in the Description field.

To make the column selection available to all users of the project, click
Share this column selection to make it available to all users. This type of
column selection is called Shared.

Note: By default, the column selection is available only to its creator. This
type of column selection is called Personal.

TIP To use a column selection in a data-entry form, the column selection
must be Shared.

Expand the Definition section.

You can apply a column selection to the elements in a table view, to the
associations in an association view, or you can create a column selection
that is not connected to element types or associations.

To specify how you want to apply the column selection, complete the
following steps:

a From the List by list, select one of the following options:
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Element Applies the column selection to elements in a table view.
Types
General Creates a column selection that is not connected to element types
or associations. The General column selection is used to display
metric attributes in aggregate tables.
b Click Go.

9 To determine the element type on which the column selection is based,
select an element type from the Selection based on list and click Go.

10 To display attributes as columns with the element type or association,

complete the following steps:

a Select attributes from the Available attributes list.

Note: The General column selection can contain only metric attributes.

b Click Add.

c (Optional) Type a label for each column in the Label field.

Note: By default, the column label is the same as the attribute name.

d To move a column, click the check box that is next to the column name,

and click Move as First, Move Left, Move Right, or Move as Last.

e To delete a column, click the check box that is next to the column name,

and click Delete.

2 Definition

List by Element types
Selection based an: | Contacts
&vailable attributes:

=& Attributes “l wiove as First *H wove Left B* wove Right B fove as Last | #€ Delete
Ermail Address 4

Attribute options:

Ermail address Phone Actual Target
Phone # L abel: # Label: # | abel: # | abel:
= &hetric Attributes Email Address Phane Actual Target
- Actual Display options: Display options:
- Target Walue - Walue
. Perfarmance Date aptions: Date options:

. @ Selected date: @ Selected date:
= ElProperties [Currently 5/23/13] [Currently 5/23/13]
Description Date: Date:
]| i
(Example 06715/03) (Example 067 15/03)
Relative period: Relative period:

(Example 1, -1] (Example 1, -1]

Performance

# Label:
Ferformance
Display options:
Walue

Date options:

@ Selected date:

(Currently 5/23/13)
Date:

i
(Example 06/15/03)
Relative period:

(Example 1, -1]

11 Click OK.

Edit Column Selection Properties

To edit the properties of a column selection, complete the following steps on the

Manage Column Selections page:

1 To the left of the row, click [ and click Properties. The Edit Column

Selection page appears.
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2 Edit the properties of the column selection. For information about column
selection properties, see “Create a Column Selection” on page 142.

View Column Selection Properties

To view properties and settings associated with an item, click =l next to the item
that you want to view, and then click Properties. The Properties window
appears. You can only view this window. You cannot edit the properties and
settings.

Note: If Properties is the only selection available on the menu, the role and
capability settings associated with your user name are limited to viewing only. If
you require expanded access to SAS Strategy Management, contact your SAS
Strategy Management administrator.

Copy a Column Selection

To copy a column selection and add it to the list of column selections, complete
the following steps in the Manage Column Selections page:

1 To the left of the row, click [ and click Copy. The Copy page appears.

2 Type a name for the copy in the Column selection name field.

Note: By default, the copy is named column-selection-namecCopy.

Delete a Column Selection

Note: To perform this task, you must have the appropriate access permissions.

To delete a column selection, on the Manage Column Selections page, click =
to the left of the row and click Delete.

Apply a Column Selection to a Table or
Aggregate Table

To display the selected columns for an element type in a table, complete the
following steps in an open project:

1 Click . The table view appears.
2 Select a project or scorecard.

3 Select an element type from the Element type list.
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Note: The list includes only column selections based on element types and
general column selections.

4 Select a column from the Column selection list.

5

Click Go.

Apply a Column Selection to an

Association

To display the selected columns for an association, complete the following steps
in an open project:

1

2

Select a scorecard.
Click %=3. The association view appears.

Select an association from the Association list.

Note: The list includes only column selections based on associations and
general column selections.

Select a column from the Column selection list.

Click Go.

Create a Column Selection for Use in a
Data-Entry Form

When you create a data-entry form, you specify a column selection to use in that
form. Before you can specify the column selection, you must create it.

To create a column selection to use in a form:

1

List column selections. For more information, see “List Column Selections”
on page 141.

Click New. The New Column Selection page appears and the General
section is expanded.

Enter a name for the column selection in the Column selection name field.
(Optional) Enter a description in the Description field.

Click Share this column selection to make it available to all users.

TIP To use a column selection in a data-entry form, the column selection
must be Shared.

Expand the Definition section.



146 Chapter 14 / Working with Column Selections

7 From the List by list, select General and click Go. To use a column selection
in a data-entry form, it must be defined as General.

8 In the Available attributes tree, select the metric attribute to use and click
Add. The settings appear in the right section.

9 Enter a label for each column in the Label field. By default, the column label
is the same as the attribute name.

TIP Itis a best practice to make each label unique. The unique label is
used in the scorecard table view because all of the elements are displayed
in this view and the elements have a mixture of period types (months,
quarters, years). However, in a data-entry form, only one period type is
displayed. In a form, the column labels consist of the metric attribute name
combined with the selected date option.

10 Select the data option.

To specify the current date, select Selected date.

To always use a specified date, select Date. Then enter a date in the field
or click [%] to choose a date from the calendar.

To specify a period relative to the current date, select Relative period
and enter a value in the field.

TIP Column selections in forms only contain one period type.
Therefore, you do not select the period type to use.

11 By default, a column selection is Read-Only when it is displayed in a form. To
enable the column selection for editing, click Allow Data Entry.

12 Click OK.
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Display the Template and Project Manager
Page

147
147
148
149
149

150
150
151
151

To display the Template and Project Manager page, perform one of the following

steps:
= If you are at the portal level, click Manage Scorecard Projects.

Note: If this task does not appear in the portal, add the task to a portlet.

= If you are using SAS Strategy Management Builder, click Project » Manage

Templates and Projects.

Select the Owner of a Template, Project,
Scorecard, or Element

One of the properties of a template, project, scorecard, or element is its owner.

To select or change the owner, open the Properties window for the template,
project, scorecard, or element, and click Select Owner. The Owner window
appears.
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Owner 9sas

Select an owner for the project.

Find:

Marne Full Mame/Description
sasdemo
stmana
stmappri
stmapprz
stimappr3
stmcontadrm
stmdatal
strdata2
strdatal
strmmod

GoBsB B Bs B Bo B> B B B

Select a user name from the list. If the list is large, you can search the list by
typing a user name in the Find field, click Search, and select a user name from
the resulting list.

Add Users and User Groups

One of the properties of a template, project, scorecard, or element is its
permissions and the users and user groups that have permission for access. To
add one or more users or user groups, open the Properties window for the
template, project, scorecard, or element, and expand the Permission section.
Click Add Users and Groups. The Add Users and Groups page appears.

Add Users & Groups

Search: | Users Gmups

To add one or more users or user groups, complete the following steps:
1 Type a search string in the Search field.
2 Choose whether to include users and user groups.

3 Click Search. A table of results is displayed.
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Add Users & Groups gsas
Search: | dash Users Groups
[ & MName Description

The rmermbers of this group are allowed to administer content for
[C] & Bl Dashboard Administrators | the SAS Bl Dashboard product. The SAS Trusted User is made a

mermber during initial deployment.

The rmermbers of this group are allowed general viewing access of
[J @ i Dashboard Users content for the 545 Bl Dashboard product.

[[] & Bl Dashboard: administration Provides SAS Bl Dashboard administration capabilities,

4 In the table of results, select the check mark next to one or more items and
click Add.

Set Alert Preferences

The SAS Information Delivery Portal lets you set preferences for receiving alerts.
In SAS Strategy Management, you might specify to receive an alert when an
action occurs, such as when a comment is added to an element. When the alert
is generated, it can be sent in any of the following ways:

E-mail
Short Message Service (SMS) text message
Via an alerts portlet that you have added to a portal page

To specify which of these ways you want to receive your alerts, complete the
following steps:

1 In SAS Information Delivery Portal, click Options » Preferences in the
banner. The Preferences page appears.

2 In the Notifications section, in the Alert notifications list, select the way
you want to receive your alerts.

3 Click Apply.

4 If you do not want to set any other preferences, click OK.

Set Alerts on Comments

You can choose to receive an alert when a comment is added to an element.
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Alerts on Comments - Sales

[~ Motification Options

Set the comment alert status to
@ on:
Delivery method: hoth e-mail and My Alerts partlet ~
My current alert notification preference is: the My Alerts portlet
Off

| (a8 | | Cancell |ﬂ\ppl\;|

Click On to enable alerts. Then select a notification method from the Delivery
method list and click OK.

Note: If you are setting the comment alert option for multiple items at once and
you want to maintain the different states of notification for multiple items, click
No change.

Otherwise, click Off to disable alerts and click OK

Working with Access Permissions

What Are Access Permissions?

Access permissions control the method that a particular user or group can use to
access a SAS Strategy Management object. More than one type of access
permission can be assigned to a user or group. The following access
permissions are available.

Read
Enables you to view or display the object. When users have Read access
permission only, they cannot move or rename the object or change any of its
information.

Write
Enables you to edit the object. Users can rename and change the properties
and contents of the object. Read access permission is automatically granted
with Write access permission.

Delete
Enables you to delete the object. Read and Write access permission is
automatically granted when users have Delete access permission.

Administer
Enables you to change all access permissions for the object. Read, Write,
and Delete access permission is automatically granted when users have
Administer access permission.

The user who creates an object receives all access permissions for the object.
Subsequent users who are added to the access permissions list for an object
are given Read access permission by default.
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A user inherits the access permissions of the group that the user belongs to. A
group does not inherit access permissions that have been assigned to a specific
user.

You assign access permissions when you perform the following tasks:

Edit the properties of a user-defined template. For more information, see
“Edit User-Defined Template Properties” on page 58.

Edit the properties of a project. For more information, see “Edit Project
Properties” on page 66.

Edit the properties of a scorecard. For more information, see “Edit Scorecard
Properties” on page 91.

Edit the properties of an element. For more information, see “Edit Element
Properties” on page 101.

You can also set access permissions for multiple objects. For more information,
see “Set Access Permissions for Multiple Objects” on page 151.

Set Access Permissions for Multiple Objects

You can set the access permissions for multiple objects from one location rather
than navigating to each object. One location enables you to set the access
permissions quickly.

To set access permissions for multiple objects, complete the following steps in
an open project:

1 Click Project » Security Administration. The Security Administration -
Project Permissions Display page appears.

2 From the Administration Selection list, select a project. The list of the
project's objects and their access permissions appears in a table.

3 Click the name of an object. The object's properties page appears.

4 Set the access permissions.

Export Access Permissions

You can export the access permissions for scorecards and elements as comma-
separated values (CSV) files with the following filenames:

Permission type Filename
Scorecard <Project-name>_Scorecard_Permissions.csv
Element <Project-name>_Element_Permissions.csv

where <Project-name> is the name of the project in which the scorecard or
element belong.

Note: Access permissions that are inherited from a project are not included in
the CSV files. If the access permissions for all of the scorecards and elements
are inherited, the CSV files are empty (except for the first row, which contains
column headings).



152 Chapter 15 / Common Tasks

To export the access permissions, complete the following steps in an open
project:

1

Click Project » Security Administration. The Security Administration -
Project Permissions Display page appears.

Click Export Permissions. The Security Administration - Specify Export
Directory Name page appears.

In the Directory name field, type the path in which to create the CSV files.

Note: The path is relative to the current working directory on the server.

Click Save.
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What Is a View?

Overview
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Aggregate 157
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Gauge (Also Called Dashboard) 159
Trend Analysis 160

SAS Strategy Management provides different ways to display and explore
strategy content and data. These are called views. Depending on your strategy,
data might be easier to understand in one type of view compared to another
type. The following views are available:

Table
Aggregate
Association
Diagram
Gauge (also called dashboard)
Trend analysis
You can use these views in the following ways:

You can navigate and explore your data using different views in SAS
Strategy Management Builder. You can use only one view at a time. Some
business users might access a view in the Builder to adjust the view, but the
Builder is primarily used by scorecard modelers. For detailed information,
see “Part 3. Navigating Data and Creating Views in SAS Strategy
Management Builder.”

You can create a portlet that is displayed on a portal page in the SAS
Information Delivery Portal. Scorecard modelers create portlet views for their
business users. Because you can have multiple portlets on a portal page,
you can display and use multiple views at a time. Also, the new Strategy
Management enhanced portlet can display one or more tiles. A tile is like a
window, but it exists within the boundaries of a portlet. In Strategy
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Table

Management, a tile displays a view. For detailed information, see “Part 4.

Creating Portlet Views for Business Users.”

Note: Strategy Management information can also be viewed in SAS Bl
Dashboard. For more information, see Appendix 3, “View SAS Strategy

Management Data in SAS Bl Dashboard,” on page 403.

The views are available in the following ways:

View Builder
Table Yes
Aggregate Yes
Association Yes
Diagram Yes
Gauge No
Trend Yes'

1 Links to the Trend Analysis page that provides the classic style dynamic analysis

features.

2 Provides the trend analysis tile with enhanced dynamic features and a static trend

chart option.

Classic-style
Portlet

Yes
Yes
Yes
Yes
Yes

Yes'

Tables display data in rows and columns.

Figure 16.1 Table Example

Revenues 2 & ausziio
Expenses 2 5 auszoio
Frofitability % 5 AUGZ0MD
Custormers g 5 auszoin
Custorner Satist B G AUGZ010

$24,655,000
¥ $16,461,750
$8,193,250

Enhanced-portlet

Tile

Yes

Yes

Yes

Yes

Yes

Yes?

P & ¢ @ P

The columns in the table are determined by the template with which the project
is associated. The elements are displayed in rows. You can create elements in a

table.

In a table, you can perform the following tasks:

Display data that is organized by element type, attribute, and date.
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Create, copy, move, and delete elements.

Customize the rows, columns, and types of links that are displayed in the
table.

Format columns and cells.

Apply formulas and ranges to columns.
Set global and personal threshold options.
Display history.

View and add comments.

Aggregate
An aggregate table shows data from the selected scorecard and all of its
children. You can choose to view the aggregated data by scorecard or by metric
attribute.
Note: If a scorecard does not contain child scorecards, the aggregate table is
not displayed.
Figure 16.2 Aggregate Example
Status
Name , : ) [ - | . | -
Asia Pacific China | Asia Pacific India China
Revenues §7,390,000 $4,500,000 $2,830,000 Fi FaN FaN
Expenses $5,118,500 $3,240,000 §1,878,500 L] @ =]
Profitability $2,271,500 $1,260,000 §1,011,500 W v ¥
Customers ag 98 28 ] ] ]
Customer Satisfa 78% 78% 78% Y Y Y
Association

An association displays relationships between scorecard element types and their
associated element type attributes in a project. The elements are displayed in a
hierarchy to reflect their association.
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Diagram

Figure 16.3 Association Example

Target | |Pem:|rman...| | Trend

v ') Guality management B |G
& Profitakility B & $8,193,250 $3,000,000 50% &

v ' Customer loyalty program B &
¥ & Revenues B & $24,655,000  $10,000,000 18% &
¥ Market share =] §45 75 59% P
¥ & Customers =NIc] 98 170 53% &
New Customers B2 & $89 150 58% a
¥ & customer Satisfaction & G 7% 87% 90% A
&Producti\riw % = §74 95 79% Ll
¥ Hours spent with cL B 45 65 £9% W

A diagram is a graphical way of representing elements, their relationships to one
another, and their respective scores. A diagram is a way to present information
found in tables, but in a more intuitive way. When you use a diagram, you can
display results in the context of the strategy and provide answers about how well
the organization is performing and why certain data or a certain relationship is
important.

A diagram enables users to see the relationship between strategy elements.
These relationships are sometimes difficult to convey in a table. You can create
diagrams that illustrate the relationships between scorecard elements or project
element types.

Note: A diagram is often used to present the strategy map, which is a layered
representation that conveys the drivers and relationships.
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Figure 16.4 Example of a Diagram View Displayed in a Classic-Style Portlet

Project: 2010 Strategy Date: 08/12/2010
Scorecard: Worldwide Zoom: OAELE
Ciagram: 2010 Strategy &
Objective Measure
Customer Satisfaction Hours spentwith customer Productivity
Actual TE% L Actual 45 Actual £75.00
£ Targat 87% [ & Targat 65 & Target a5
Status Status 5 Status s
Performance 0% Performance  69% Performance  79%
Cuslomers Mew Customers
Actual ] 3 Actual $80.00
£ Tagar 170 o Target 150
Status 2 Status .
Perfarmante  58% Performance  59%
Eqenses FTE Headcount
Actual §16,461,75000 & ¥ Actual $170.00 Actual $170.00
£ Target $5,000,000.00 & Target 170 o Target 150
Status 3 Stalus & Status .
Peformance  137% Ferformance  100% Performance  113%
[T Market share
Actual $24655000.00 Actual $44.50
& Target $10,000,000.00 o Target 75
Stalus . Status :
Performance  18% Pefformance  50%

Gauge (Also Called Dashboard)

A gauge (also called dashboard) displays ranges of data in a graphical format.
You can display key performance indicators or any SAS Strategy Management
elements by using the gauge view. Each element is represented by a gauge that
displays the data ranges that are defined. In addition to displaying ranges, you
can provide links to comments, trend data, and element properties.

Gauges can be displayed as a dial, a slider, a traffic light, a speedometer, a
thermometer, or a bullet.
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Figure 16.5 Example of a Gauge Dial

Revenues Customers Customer Satisfaction

PE e

Trend Analysis

An element's trend is its performance over time. You can view a trend analysis
that displays the trend of an element's data. SAS Strategy Management
provides different trend view implementations depending on the product feature.

Product Feature Trend Implementation

Builder When you are working in the Builder using the table or association
views, the Trend Analysis button is available. When you click this
button, the Trend Analysis page appears.

Classic-style When you are working in the table, association, or dashboard

portlet views in a classic-style portlet, the Trend Analysis button might be
available, depending on how the portlet is customized. When you
click this button, the Builder opens and the Trend Analysis page
appears.

Enhanced-portlet  The Strategy Management enhanced portlet can be customized to

tile include a trend analysis tile. You can drag a value or an element
from one or more table, aggregate, association, or gauge tiles
onto the trend analysis tile. You can manipulate the resulting
graph to further explore the trend analysis. You can also add or
remove more data from other tiles. See Figure 16.6 on page 161.

Enhanced-portlet  The enhanced-portlet tiles for the table, association, diagram, and

option gauge views provide an option to display a static trend chart. If the
tile is customized to use this option, you can click an icon that
opens a trend chart. The data is static although you can change
the date range using the date slider. See Figure 16.7 on page
162.

With the Trend Analysis page, the initial analysis uses the element whose row
you clicked to open the Trend Analysis page. However, you can dynamically add
to or change the analysis after it opens. For more information, see Chapter 22,
“Creating and Editing Trend Analysis Views,” on page 237.
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For more information about the enhanced-portlet implementations of trend
analysis, see the following sections:
“Edit the Trend Analysis Tile Properties” on page 281
Chapter 30, “Navigating and Viewing the Strategy Management Enhanced
Portlet and Its Tiles,” on page 305

Figure 16.6 Example of a Dynamic Trend Analysis in an Enhanced Portlet Tile

GHBE B E&EH -~

-

o Target- Customers dWorldwide)
@ Actual - Customers (Woarldwide)

@ Performance - Customers (Woarldwide)

160
a
150
180 o o
140
a
130
o
120
Q 115
110 o 110
@ 102 2
100
_ =1 a7
100 =} pid
a8
o
7 7
Q o
a0
wE 30% a5% 5% a2% 3% 4%
0 @ @ d d d @ @
T T T T T T T
01Jan10 01Feb10 01Mar10 31Mar10 304pr10 JMayl0 30Jun1n
BB § B B § %
|: - - - M - - - :I
01Jan10 01Feh10 01Mar10 31Mar10 30&pr10 I May10 30Jun1n

Start date: | 01/01/2010 |7 End date: |07/21/2010 7]
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Figure 16.7 Example of a Static Trend Chart in the Enhanced Portlet

Trend Chart of Customers (Worldwide)

175
140
125
100
74
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Close
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Open a Table

To open a table, complete the following steps:

1

Open a scorecard. For more information, see “Open a Scorecard” on page
88.

In the toolbar, click [ to display the table.

To display the most current updates to the data in the table, especially after
you perform a calculation, click &% in the toolbar.

Specify How to View Scorecard Table Data

To specify how to view scorecard table data, complete the following steps in an
open table:

1

To display the metric attributes by the type of element, select an element
type from the Element type list.

To display the metric attributes that belong to a specified column selection in
a scorecard table, select a column selection from the Column selection list.

Column selections are defined in the project options. For more information,
see “Create a Column Selection” on page 142.

to choose a date from the calendar.

Note: SAS Strategy Management matches the date that you specify to the
appropriate time period for each element. For example, if one element is
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based on a yearly period, and another element is based on a monthly period,
the table displays data that is valid for the year and the month that contain
the date that you specified.

4 Click Go. The table displays the data as you have specified.

Sort Rows

To sort the rows of data in a table according to the value of the column, click a
column heading in the table to sort the rows by that column. The column used to
sort the list contains either an up or down arrow in the column heading.

An up arrow ( A) indicates that the list is sorted in ascending order (A-Z).

A down arrow (V) indicates that the list is sorted in descending order (Z-A).

Change the Order of Rows in a Scorecard
Table

To change the order of rows within a table, complete the following steps in an
open table:

1 Click =] for a specific row and click Order Rows. The Order Rows page
appears.

Elements:
Sales -
Expenses
Trapining 43 sort Descending
Productivity
Other income
Profit

a ,
2 <ort &scending

e & 5 sl

2 Select an element.

3 To sort in ascending or descending alphabetic order, click Sort Ascending
or Sort Descending.

4 To move scorecards, select one or more scorecards and use the following
icons:
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Icon Action

__‘r' Moves the selected scorecard to the beginning of the list.
s Moves the selected scorecard up.

r Moves the selected scorecard down.

+ Moves the selected scorecard to the end of the list.

Customize a Scorecard Table

You can change the way in which the information in a scorecard table view is
displayed.

Note: Customized settings, except for row and column size, continue to apply to
the project after it is closed and reopened.

To customize a scorecard table, complete the following steps in an open table:

1 Click Customize in the toolbar. The Customize page appears.
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Customize

5 Customize Table

5 Row and Column Paging

Select the number of rows and columns to
display before you need to page.

) All rows and colurmns
@ Specify number of rows and columns.
R ! 10 = frin 1 - max 100)

Colurnns: 10 = [min 1 - max 20]

5 Cell Display

Select what type of information you want to see on elements,
i show formula icon
Showe threshold icon
%% personal
¥ Global
E{"E Show rule icon

5 Additional Information Columns

select what columns of information you want to see,
& Comments

& Cormrment Alert

[ Trend Analysis Chart

] Feriod

Note: The available options can vary depending on what you are
customizing.

2 Expand the Row and Column Paging section and make the applicable
selections:

To display all the rows and columns in a scorecard table, click All rows
and columns.

To specify the number of rows and columns that are displayed, click
Specify number of rows and columns. Then select the applicable
number from the Rows and Columns lists.

3 Expand the Cell Display section and make the applicable selections:

To display a formula icon when a formula is applied to the cell, click
Show formula icon.

To display thresholds, click Show threshold icon and click either
Personal or Global.
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Note: Cell display information applies only to cells that contain values.
For example, cells that display range icons do not display threshold or
formula icons.

To display a rule icon when a rule is applied to the cell, click Show rule
icon.

Expand the Additional Information Columns section and make the
applicable selections:

To display a column with links to comments, click Comments.
To display a column with links to comment alerts, click Comment Alert.

To display a column with links to a trend analysis chart, click Trend
Analysis Chart.

To display a column with period information, click Period.

Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.
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Views

Open an Aggregate Table 169
Specify How to View Aggregate Table Data 169
Sort Rows 170

Open an Aggregate Table

Note: Aggregate table can be displayed only with numerical data, that is, metric
attributes.

To open an aggregate table, complete the following steps:

1 Open the project that contains the table. For more information, see “Open a
Project” on page 65.

2 Select a parent scorecard.

3 In the toolbar, click [ to display the aggregate table.

4 Move the mouse pointer over each value, range icon, range color, or range
label to display the names of the associated element.

5 To drill-down into a child scorecard, click the name of a child scorecard.

Note: To expand and collapse the hierarchy of an aggregate table, click the
tree icon in the column heading.

6 To display the most current updates to the data in the table, especially after
you perform a calculation, click &3 in the toolbar.

Specify How to View Aggregate Table Data

To specify how to view aggregate table data, complete the following steps in an
open aggregate table:

1 To display the metric attributes by the type of element, select an element
type from the Element type list.
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Sort Rows

2

To display the metric attributes that belong to a specified column selection in
a scorecard table, select a column selection from the Column selection list.

Column selections are defined in the project options. For more information,
see “Create a Column Selection” on page 142.

To display data for a particular date, type a date in the Date field or click [&]
to choose a date from the calendar.

Note: SAS Strategy Management matches the date that you specify to the
appropriate time period for each element. For example, if one element is
based on a yearly period, and another element is based on a monthly period,
the table displays data that is valid for the year and the month that contain
the date that you specified.

Click Go. The table displays the data as you have specified.

To organize data in an aggregate table by scorecard or metric attribute, click
Scorecard or Metric Attribute.

Note: Metric attributes are defined in the template with which the project is
associated.

To sort the rows of data in a table according to the value of the column, click a
column heading in the table to sort the rows by that column. The column used to
sort the list contains either an up or down arrow in the column heading.

An up arrow ( A) indicates that the list is sorted in ascending order (A-Z).

A down arrow (V) indicates that the list is sorted in descending order (Z-A).
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List Associations

Note: To perform this task, you must have the appropriate access permissions.

To list associations, complete the following steps:
1 Open a project. For more information, see “Open a Project” on page 65.

2 Click = in the toolbar.

3 Click Manage Associations in the toolbar. The Manage Associations page
appears and displays a list of associations.

Create an Association

Note: To perform this task, you must have the appropriate access permissions.

To create an association, complete the following steps in a list of associations:

1 On the Manage Association page, click New. The New Association Wizard
appears.

2 On the Properties page, type the name of the association and, optionally, a
description.

3 Click Next.
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4 On the Select Element Type page, specify an element type to display at the
highest level in the association by selecting an element type from the
Element type list. After you select a type, an Association preview appears.

5 Click Next.

6 On the Associate Attribute page, you can use an association to display
attributes that are associated with an element type. Attributes are associated
with element types in the template on which the project is based.

a Select an attribute from the Attribute list.

b Click Add. The attribute appears in the Association preview list.

Associate Attribute

Select an attribute to add it as a new row in the association.

\What iz the linked attribute that is next in the association?
#attribute:  Objective (Objective) » | idd
association preview:

Level Element type:
1 & Measure
2 @& Measure | Objective |

¢ Add as many attributes as needed.
7 Click Next.

8 On the Subtotaling and Totaling Rows page, you can display the totals and
subtotals of rows in the association. You can also apply functions to the
totals and subtotals.

a To display row totals, click Include totals.

b To include subtotals from the selected element type, select the check
boxes that are below Include subtotals for.

c To apply a function to the total for each metric type attribute, in the Select
metric type attribute functions for group, select functions from the
metric attribute lists. The default value for each of these lists is None.

9 Click Next.

10 On the Summary page, review the association information. If you want to
make changes, click Previous to return to a previous page to change a
property.

11 When you are satisfied with your settings, click Finish. To exit the wizard
without saving changes, click Cancel.

View an Association

To view an association, complete the following steps in an open scorecard table:
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Click %3 on the toolbar.

Select an association from the Association list.

Select a column selection from the Column selection list. For more
information, see “Create a Column Selection” on page 142.

Note: Element type column selections are not included in the list. Only
association column selections and general column selections are included.

To display data for a particular date, type a date in the Date field or click [&]
to choose a date from the calendar.

Note: SAS Strategy Management matches the date that you specify to the
appropriate time period for each element. For example, if one element is
based on a yearly period, and another element is based on a monthly period,
the table displays data that is valid for the year and the month that contain
the date that you specified.

Click Go. The table displays the data as you have specified.

To display all the levels of associated attributes and subtotals, click Expand
All.

To collapse all levels, click Collapse All.

Customize an Association

You can change the way in which the information in an association is displayed.

Note: Customized settings, except for row and column size, continue to apply to
the project after it is closed and reopened.

To customize an association, complete the following steps in an open
association:

1

2

Click Customize in the toolbar. The Customize page appears.

Expand the Cell Display section. To display thresholds, click Show
threshold icon and click either Personal or Global.

Note: Cell display information applies only to cells that contain values. For
example, cells that display range icons do not display threshold icons.

Expand the Additional Information Columns section and make the
applicable selections:

To display a column with links to comments, click Comments.
To display a column with links to comment alerts, click Comment Alert.

To display a column with links to a trend analysis chart, click Trend
Analysis Chart.

Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.
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Edit Association Properties

Note: To perform this task, you must have the appropriate access permissions.

To edit the properties of an association, complete the following steps in a list of

associations:

1 On the Manage Association page, click the association name. The
Association Properties page appears.

2 In the General section, complete the following steps:

a Type a new name in the Association name field.
b (Optional) Type a new description in the Description field.

3 To change association levels, expand the Association Definition section.
a To delete a level, click X Delete that is next to the attribute name.

b To add a level, click Add Level. The Add Attribute to Association page
appears.

c Select an attribute from the Attribute list.

d Click OK to save your changes and return the Association Properties
page.

4 To change the display of totals and subtotals, and change the functions that
are applied, expand the Subtotaling and Totaling section and complete the
following steps:

a To display row totals, click Include totals.

b To include subtotals from the selected element types, select the check
boxes below Include subtotals for.

c To apply the function to the total for each metric type attribute, select
functions from the lists under Select metric type attribute functions for.

5 Click OK to save your changes and exit the page. Click Apply to apply your

changes and remain on the page. Click Cancel to exit the page without
saving changes.

Copy an Association

Note: To perform this task, you must have the appropriate access permissions.

To copy an association, complete the following steps in a list of associations:

1

On the Manage Association page, click 5| to the left of the association and
click Copy. The Copy page appears.
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2 Type the name of the copy. By default, the copy is saved with the name
Copy of association-name. You can also type a description of the
association.

Delete an Association

Note: To perform this task, you must have the appropriate access permissions.

To delete an association, in a list of associations on the Manage Association
page, click =l to the left of the association and click Delete.



176 Chapter 19 / Creating and Editing Association Views



177

Creating and Editing Diagram Views

OVerview . ... ... . 179
What Is a Diagram? ... ... ... .. 179
Diagram Layers and Their Objects . ............. ... ... ... ... ... ... ... ... 180
Data Layer Objects . . ...... ... ... . . ... 180
Shape Layer Objects . ... ... ... . . 181

Create a Diagram ... .. ... ... . .. . ... 181

About the Diagram Editor ... ...... .. ... .. . .. . . .. .. ... ... 182
Using the Diagram Editor . . ... ... .. ... .. ... 182
The Diagram Editor Interface ... ... ... ... 182
The Toolbar . ... ... . 183
Start the Diagram Editor .. .. ... ... 184
Close the Diagram Editor . .. ............ ... ... .. ... 184

Adding Diagram Objects . .. ........ ... .. ... ... .. ... ... ... ... 185
Add an Element . ... ... 185
Add and Remove DataNodes .. ........... ... ... ... ... . ... ... ... 185
Add an Association Link . ... ... 187
Add aSection ... ... 187
Addaline ... . . . 188
AddaShape .. ... . 188
Add Text . ... 189
Addanlimage ... ... ... 189

Deleting Diagram Objects .. ... ... ... .. . ... . ... .. .................... 190
Delete Objectsinthe Data Layer ............. ... .. ... ... ... .. ... . ... ... 190
Delete Objects in the Shape Layer . ................. ... ... ... ........... 191

Arranging the Layout of Diagram Objects . ........... ... ... ... ........... 191
Arranging Layout to Make a Diagram More Readable .. ............. ... .. .. 191
Use the Grid to Arrange Objects ina Diagram ............... ... ... .. .. .. 191
Zoom the Diagram View . ... ... .. 192
Hide or Show an Element ... ........ ... ... ... .. ... ... ... ... 192
Arranging Association Links ... ... ... 192
Copy and Paste a Diagram Object . .. .......... ... ... ... ... ... ... . ... .. 192
Select or Deselect Shapes, Text,orlmages . .............................. 193
Resize a Diagram Object . .. ... ... .. ... . ... 193
Move a Diagram Object . . ... ... ... .. . 193
Rotate a Polygon ... .. ... . 194
Grouping Objects .. ... ... ... 194
Arranging Lines . ... ... 198

Specify Object Appearance . ............................................... 199

About Object Appearance . ................. .. 199



178 Chapter 20 / Creating and Editing Diagram Views

Set the Font to Use for a Diagram Object ... ........... ... ... . ... ... .. .. 199
Set the Colors to Use for a Diagram Object .. ................... ... ... ... 200
Specify aBorder ... 207
Specify the Appearance of Association Links .. ....................... ... .. 208
Specify the Appearance of the Association Link Connection Points . ... ... .. 209
Specify the Position, Alignment, and Depth of an Object . .. .......... ... ... 210
Specify the Appearance of Lines ... .............. .. ... ... ... ... 211
Specify the Appearance of a Correlation .. ............... ... ... ... ... .. .. 212
Specify the Shape, Size, and BorderofaNode . ............ ... ... ... ... .. 212
Create, Edit, and Selecta StyleforaNode . .. ............. ... .. ... ... . ... 213
Displaying Labels and Other Content . ... ... ... ... . ... .. ... ... ... ........ 214
About Diagram Labels and Content . ... ......... .. .. ... ... ... ... .. 214
Specify Global Content Settings ... ............... ... . ... ... .. 214
Limiting Data Node Content .. ........... ... .. .. ... . ... ... ... .. 215
Display a Path fora Section ... ... .. ... .. 216
Interactive Features in Diagrams ... ... ... ... ... ... ... ... ................ 217
Links in Diagrams That Open New Content .. ...... ... ... ... ... ... ... ... 217
Apply a Named LinktoaNode . .............. ... ... ... ... .. .......... 217
Apply a Named Link to a Shape, Text,orlmage . ................. .. ... ... 217
Disable Element Detail Links in Diagrams . ................................ 218
Add a Hyperlink to a Shape, Text,orlmage .............. ... ... . ... ... .. 218
Remove a Hyperlink or Named Link from a Shape, Text, orImage ... ... . ... 219
Specify HTML or JavaScript for Use in a Diagram . .................. ... ... 219
Changing Data ... ...... ... ... . ... . . ... ... 220
Change Associations . . ... 220
Edit Element Properties . . .......... .. . ... 220
Select the Date foran Element .. ... .. ... .. ... .. ... ... ... .. .. 221
Set Security in Diagrams . .. .. ... ... 221
Using a Different Language in a Diagram ... ............................... 222
Diagrams and Language Settings .. .................. .. ... ... ... 222
Select a Language fora Diagram . ............ ... ... ... 222
Specify the Diagram Name in Other Languages .. ....................... .. 222
Analyzing a Diagram in Order to Validate a Strategy .. . ................. ... 223
OVEIVIEW . . 223
Create an Analysis Definition .. ............ .. ... .. ... ... 223
Runan Analysis ... ... 225
View Analysis Results .. ... ... ... . 225
View Input Data Used inthe Analysis . .............. ... ... ... ... ........ 226
Export Analysis Results ... ... .. 226
Apply an Analysistoa Diagram ............ ... 227
Edit a Correlation and Regression Definition . .............. ... .. ... ... ... .. 227
Delete a Correlation and Regression Definition .. ............ ... ... .. .. .. 227
Analyze the Correlation between Two Elements . .................. ... .. .. 227
Add an Analysis Plug-in . ... ... .. 228
Perform a Multiple Linear Regression Analysis . .................... ... ... 229
Managing a Diagram .. .. ... ... ... ... . ... ... ... ... 230
View Diagram Properties ... ... ... .. 230
Copy aDiagram ... ... 230
Save aDiagram . ... ... 230

Revert to the Saved Diagram .. ... ... 231



Overview

Overview 179

Export a Diagram 231
Delete a Diagram 231
Viewing a Diagram 231
View a Diagram 231
Change the Position of a Diagram 232
Locate Elements, Element Types, and Associations 232
View Element Attributes 233

What Is a Diagram?

A diagram is a graphical way of representing elements, their relationships to one
another, and their respective scores. A diagram is a way to present information
found in tables, but in a more intuitive way. When you use a diagram, you can
display results in the context of the strategy and provide answers about how well
the organization is performing and why certain data or a certain relationship is
important.

A diagram enables users to see the relationship between strategy elements.
These relationships are sometimes difficult to convey in a table. You can create
diagrams that illustrate the relationships between scorecard elements or project
element types.

Note: A diagram is often used to present the strategy map, which is a layered
representation that conveys the drivers and relationships.

Figure 20.1 Example of a Diagram View Displayed in a Classic-Style Portlet

Project: 2010 Strategy Date: 08/12/2010
Scorecard: Worldwide Zoom: GAEE
Ciagram: 2010 Strategy &
Objective Measure
Customer Satisfaction Hours spentwith customer Productivity
Actual TE% = Actual 45 Actual £75.00
£ Target 7% & Target 65 & Target a5
Status Status 5 Status :
Performance 0% Pearmance  69% Performance  79%
Customers Mew Customens
Actual o8 Actual $80.00
£ Tagar 170 & Target 150
Status 2 Status .
Performance  56% Performance  59%
Expenses FTE Headcount
Actual $16,461,75000 & ¥ Actual $170.00 Actual $170.00
2 Target $5,000,000.00 & Target 170 & Tanget 150
Status 3 Status g Status .
Pemormance  137% Ferformance  100% Performance  113%
LIRS Market share
Actual $24 55500000 2 Actual $44.50
& Target $10,000,000.00 & Target 75
Stalus . Status c
Performante  18% Performance  59%




180 Chapter 20 / Creating and Editing Diagram Views

Diagram Layers and Their Objects

You can create diagrams that illustrate the relationships between scorecard
elements. Diagrams can be based on project element types or scorecard
element types.

Diagrams have two layers:

data layer: The data layer can contain elements, data nodes, and
association links. These diagram objects represent the underlying data from
the project that the diagram is illustrating.

shape layer: The shape layer can contain sections, lines, shapes, text, and
images. You can use these diagram objects to group data objects and
otherwise improve the appearance of the diagram. You can use both shapes
and sections to group and contain data nodes.

Data Layer Objects

Elements

You can make changes to the scorecard data that underlies a diagram by
adding, changing, or deleting elements in the diagram. In a single diagram, you
can display any metric attribute from any scorecard, and you can display
multiple instances of the same element but with element values for different
dates.

Data Nodes

The data layer consists primarily of data nodes that represent the elements in a
scorecard or a project. A data node contains all of the data and metadata that
are associated with an element, such as its labels, attributes, associations, and
values. You can display any or all of the metric attributes of an element type in a
data node. The initial shape and background color of a data node are set in the
template for the project. For more information, see “Create a Template” on page
44,

The node properties that are specified in the project template apply across all
diagrams in all scorecards within the project. You can override these properties
and specify additional properties for a particular diagram. For example, the
scorecard master table might specify that nodes that represent strategic
objectives are ellipses, yet within a particular diagram, you can specify that
nodes that represent strategic objectives are triangles. In this case, nodes that
represent strategic objectives are generally ellipses, but in that particular
diagram, nodes that represent strategic objectives are triangles.

Data nodes can show range icons and colors for each attribute value. You can
also include icons that enable users to drill down to the following features:

trend charts
comment manager
metric attribute directives

global and personal thresholds
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Association Links

Association links depict associations between data nodes. These associations
are set in the following places:

The attribute definitions are set in the project, and the scorecard element
properties are set in the template.

The properties for each element are set in a project or scorecard.

Objects

A section is a movable and resizable rectangle that can represent an element or
a scorecard. You can use sections to organize the data in a diagram by project,
scorecard, and attribute.

You can use straight or curved lines to connect containers. A straight line can be
a single straight-line segment or a chain of two or more straight-line segments
that are connected in a zigzag arrangement. A curved line can be a single
smooth curve or a chain of two or more smooth curves that are connected at
cusp points. Single straight-line segments and single smooth curves should
meet most of your needs.

You can also include shapes (rectangles, ellipses, and polygons), text, and
images in a diagram.

Create a Diagram

To create a new diagram:
1 Open a project. For more information, see “Open a Project” on page 65.

2 Select a project or scorecard name in the hierarchy and click [gi on the
toolbar.

3 Click New Diagram. The New Diagram Wizard appears.

4 The Name page displays the project and scorecard that contain your
diagram, and the name of the diagram. In the Diagram name field, enter the
name of the new diagram. Click Next.

Note: Project diagram names must be unique within a particular project.
Scorecard diagram names must be unique within a particular scorecard.

5 On the Element Types page, click the names of the element types that you
want the diagram to display. The Element types list provides the element
types in your project and scorecard. The diagram displays all of the elements
of the element types that you select. Click Next.

TIP To select more than one item, hold down the Ctrl key and click
multiple items in the list.

6 On the Associations page, click an association name to select an association
to display in the diagram. The Associations list provides the associations
that have been established between your project or scorecard element types.
Click Next.
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Note: To select more than one item, hold down the Ctrl key and click
multiple items in the list.

7 On the Layout page, click a style for laying out the element types in the
diagram. Click Next.

8 On the Finish New Diagram page, review your selections. To change a
selection, click Previous.

9 Click Finish to save your selections and exit. Click Cancel to exit without
saving your selections.

After the diagram is created, you must use the Diagram Editor to edit and
complete your diagram. For more information, see “About the Diagram Editor’
on page 182.

About the Diagram Editor

Using the Diagram Editor
Use the Diagram Editor to edit the following kinds of diagrams:
a new diagram that you have created by using the New Diagram Wizard

an existing diagram that you created in this installation of SAS Strategy
Management

Note: You cannot import diagrams into SAS Strategy Management.

If you are starting the Diagram Editor for the first time, you must configure your
web browser to use the Java plug-in. For information about installing the J2RE,
see Appendix 2, “Configuring Java,” on page 399.

The Diagram Editor Interface

The Diagram Editor interface includes a menu bar with all its functions and a
toolbar for its commonly used functions. The following figure shows the Diagram
Editor interface and its major parts.
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Figure 20.2 Diagram Editor Interface
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183.)
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5 Progress indicator

Indicates the status or progress when opening or saving the diagram image
file.

The Toolbar

The toolbar provides buttons that you use to create your diagram.

Figure 20.3 The Toolbar
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Button  Description

[ i Saves the diagram.
[0

Creates a rectangle.

[ ]
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Button Description

|:| Creates a rectangle with rounded corners.

Creates an ellipse.

(J

Creates a line.

Creates a polygon.

Opens a list for adding text.

Adds an image to the diagram.

el (=] L] |4

Toggles the display of the grid.

F Toggles the display of the ruler.

Zoom Changes the size of the diagram view.

Start the Diagram Editor
To start the Diagram Editor:

1 Open a project. For more information, see “Open a Project” on page 65.

2 Select a project or scorecard name in the hierarchy, and click in the
toolbar.

3 Select a diagram.

4 Click =l

Close the Diagram Editor

To close the Diagram Editor, select File » Exit.
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Adding Diagram Objects

Add an Element

To add an element:

-

Select Elements » New. The New Element list appears.
2 From the Element types list, select a type.

3 From the Period types list, select a type.

4 Click OK.

An element of the selected type is added to the scorecard, and a corresponding
node appears in the diagram. The node is inserted at x, y coordinates 200, 200.
You can insert a new node under other nodes. You can rearrange the other
nodes to display the new node.

Add and Remove Data Nodes

In a new diagram, the data nodes are organized by the layout style that you
selected when you created the diagram. After you change the layout, you might
want to remove certain nodes. You can redisplay the removed nodes in their last
position. When you save the diagram, any nodes that you removed are removed
from the display.

TIP The Diagram Editor supports undo and redo when you add or remove
data nodes. You can undo or redo up to ten of these actions.

To select which data nodes are displayed in the diagram and which data nodes
are not displayed:

1 Select Elements » Add/Remove. The Add/Remove Elements window
appears.
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Add;‘Remove Elements [x]
Element bypes: W Select. ..

Select Elements:

| 1st Fictional Bank
T & Contacts
E‘E B, Scorecard - 1
=By B child:
E ﬁ Cbjective
r @Measure
[ 1) Initiative

- 4c:)n Perspective

™ % Vision
r gMission

0K | Cancel |

TIP The hierarchy icons that contain selected elements are highlighted.

2 To limit which element types are displayed in the list, click Select. The Select
Element Types window appears.

Gl
i~ Select element types:
Element bypes:
¥ & Contacts
} Initiative
&Measure
g Mission
Objective
3+ Perspective

% Vision

RO R R

oK | Cancel |

3 Select the element types to display and click OK.

4 In the Add/Remove Elements window, expand a hierarchy, and select or
clear an element.

Note: Adding or removing elements in a diagram does not affect the
underlying data.
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5 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

Add an Association Link

In addition to the associations that are displayed as links when you open a
diagram, you can also create a link between data nodes.

To create a link, hold down the Ctrl key and drag the mouse pointer from one
node to another. If the source node has an attribute of the type of the target
node, the target node allows an association and the mouse pointer changes to a
green check mark. Release the mouse button to add a link between the two
nodes.

TIP If an association is not allowed, the mouse pointer changes to a red X,
and a link is not created.

Add a Section

Add a Project Section to a Diagram

To add a section for the current project to a diagram, select Sections » Add
Project Section.

Add Scorecard Sections to a Diagram

To add scorecard sections to a diagram:

1 Select Sections » Add Scorecard Sections. The Add Scorecard Sections
window appears.

£ Edit Scorecard Sections

Select Scorecsrds (drag and drop on canvas),

B'é Corporate

':% Mew Waork
Frankfurt

Ok Cancel

2 Drag a scorecard from the list onto the diagram. A section is that has the
name of the scorecard is created. You can also drag a parent scorecard onto
a diagram to create a scorecard section for each child scorecard that is in the
parent scorecard.

3 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.
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Add Attribute Sections to a Diagram

To add attribute sections to a diagram:

1 Select Sections » Add Attribute Sections. The Add Attribute Sections

window appears. Attributes for the element types in the scorecard are
available.

B Add Attribute Sections

IDrag one or mare elements or an entire element: bype ta the canvas.

# Vision

# Contacks
# Measure
# Mission

# Perspective
# Initiative
|0) Objective

Elemenkts:

Close |

2 Drag an attribute from the list onto the diagram. A section that has the name
of the attribute is created . You can also drag an attribute category onto a
diagram to create a section for each attribute in that category.

3 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

Add a Line
To add a line to a diagram, click L1 on the toolbar. A new line appears at the
center of the diagram. The line starts as a horizontal straight line with a handle

at each end. To make the handles disappear, click anywhere in the diagram
background. To make the handles appear, click either endpoint.

Add a Shape
To add a shape, use the following buttons:
Button Description

(=] Creates a rectangle.

@ Creates a rectangle with rounded corners.
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Button Description
=] Creates an ellipse.
] Creates a polygon.

The new shape appears at the center of the diagram. Selection handles appear
around the shape.

A rectangle starts as a square. The border of a rectangle is defined by the
four points.

An ellipse starts as a circle. The border of an ellipse is defined by a rectangle
that snugly contains the ellipse.

A polygon starts as a triangle. Polygons can have any number of vertices
and can be any polygonal shape, such as triangle, pentagon, or octagon.

To add text:
1 Click [A]. The Enter Text window appears.

2 Type a single line of text. Later, you can edit the properties of the text to add
more lines of text.

The text is contained in a rectangular box that snugly contains the text. You can
move the box in the diagram as well as edit the text properties.

Add an Image

You can add images, including drawings in SVG format, to a diagram.

Note: SAS Strategy Management cannot load image files with names that
contain characters in the double-byte character set (DBCS). Make sure that your
image filenames do not contain DBCS characters.

To add an image:

1 Click [&]. The Select Image window appears.
2 Select an image file.

3 To add an image file to the list, click Upload Image, navigate to the image
file, select it, and click OK.

4 To refresh the list of images, click Refresh.
Note:

Images might be missing because a previously uploaded image was
removed.

Note: If an image file is used in a diagram, you do not receive any
warning if you delete the image file. If a diagram uses an image file that
has been deleted, a red X appears in the diagram in place of the missing
image.
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Most uncompressed image formats are supported by the Diagram Editor.
The Diagram Editor uses the Java Virtual Machine (JVM). The JVM
installed on your computer might support compressed formats. See the
documentation for your JVM for information about the image formats that
are supported.

5 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

The image is contained in a rectangular box. Images are stored in the Customer
folder on the SAS Strategy Management server. For access to other images,
contact your system administrator.

Deleting Diagram Objects

Delete Objects in the Data Layer

Element

Node

Association link

The following diagram objects are part of the data layer and represent data:
elements
nodes
association links

CAUTION! When you delete a node, an element, or an association link, you
also delete the data that underlies these objects.

The following table describes the related objects and data that you delete when
you delete these objects, and how to delete these objects.

When you delete a table element, To delete an element, select the
you also delete the following: node that represents the element
that you want to delete and select

the data node that represents Edit » Delete.

the element

the corresponding element from
the underlying table

When you delete a data node from  To delete a data node, select a
a diagram, you also delete the data node in the diagram and
following: select Edit » Delete.

the underlying element and all
values for the element that are
in the database for the
scorecard

any shapes in the diagram that
are associated with the element

When you delete an association To delete an association link, click
link, you also delete the following: the origination point or endpoint of
the association link the link, and select Link » Delete.
the data value that underlies the
link
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Delete Objects in the Shape Layer

The following diagram objects are members of the shape layer:

lines
sections

shapes, text, and images

To delete these diagram objects, select the object and then select Edit » Delete

Arranging the Layout of Diagram Objects

Arranging Layout to Make a Diagram More

Readable

When you first open a diagram that you have created, the data nodes are
organized by the layout style that you selected when you created the diagram.
To make the diagram more readable, drag the nodes so that they do not cover
other nodes or links.

If you need to improve the readability of a diagram, consider the following tips:

Use containers or sections to group data nodes.

Limit the number of data nodes, containers, and connecting arrows. One way
to do this is to focus on a limited set of relationships. Do not try to show
everything in one diagram.

Drag nodes so that nodes do not cover other nodes or arrows.

Do not make the diagram too big. The rulers in the Diagram Editor represent
screen pixels. Consider the typical screen dimensions of your users'
computers when you create a diagram.

Use the Grid to Arrange Objects in a Diagram

Every diagram has a grid that you can use to arrange objects.

To show or hide the points of the grid, select Grid » Show Grid.

To change the coarseness of the grid, select Grid » Grid Size, and select a
coarseness.

To align shapes with the grid, select Grid » Snap To Grid. Any node or
container that you drag to a new location snaps to alignment with the grid.

If you select a container, right-click on it, and select Shapes » Resize To
Grid. Each handle of the container snaps to the nearest grid point. The result
is to subtly change the size and shape of the container.

TIP If the grid is shown, performance can decrease, particularly for small grid
sizes when they are viewed in zoomed-out mode. To increase performance,



192 Chapter 20 / Creating and Editing Diagram Views

hide the grid. Even when the grid is hidden, Snap to Grid continues to be in
effect.

Zoom the Diagram View

To magnify or shrink your view of a diagram, select Grid » Zoom, and select a
percentage.

Hide or Show an Element
To hide an element, right-click on the element and select Hide.
Note: Hiding an element in a diagram does not affect the underlying data.

To display an element again, select Elements » Add/Remove. In the Add/
Remove Elements list, select the element and click OK.

Arranging Association Links

Curve an Association Link

To activate the handles of a curved link, click the origination point or the
endpoint of the link. To manipulate the curvature of a curved link, drag a handle.

Route an Association Link around Other Content

You can route an association link that exists between element nodes around
other content in the diagram so that the other content remains visible. The links
between elements are orthogonal. That is, they consist of multiple straight line
segments that can be arranged at different angles.

To route a link around other diagram content:
1 Select a link and right-click on one of the handles.
2 Select Link » Insert point. Insert as many points as you need.

3 Drag the link handles to arrange the line segments.

Copy and Paste a Diagram Object
You can copy and paste objects that are members of the shape layer:
lines
sections
shapes, text, and images
To copy, select the object and click Edit » Copy
To paste, select the object and click Edit » Paste

For information about selecting an object, see “Select or Deselect Shapes, Text,
or Images” on page 193.
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Select or Deselect Shapes, Text, or Images
To select or deselect a shape, text, or image, use the applicable step:

To select a shape, text, or image, click anywhere inside the item. Handles
appear at the points that define the item.

To deselect a shape, text, or image, click anywhere in the diagram
background. The handles disappear.

To select more than one item, hold down the Ctrl key and click each item or
drag the mouse pointer across the background to create a selection
rectangle that completely contains the items.

To select all of the shapes, text, images, lines, and sections in a diagram,
select Edit » Select All.

Resize a Diagram Object

TIP The Diagram Editor supports undo and redo when you resize a shape or
image. You can undo or redo up to ten of these actions.
You can change the dimensions of the following objects:
elements
sections
shapes and images

To change the dimensions of an object, select the object. Handles appear on the
object. Drag a handle to a new location.

Note:

When you drag a handle of a rectangle, an ellipse, or an image, two handles
on one side of the item always move together so that the item maintains its
shape. When you drag a handle of a polygon, only the selected handle
moves.

You can also edit the properties of a rectangle or an ellipse in order to
change the width and height. You cannot edit the properties of a polygon to
change its dimensions. For more information, see “Specify the Position,
Alignment, and Depth of an Object” on page 210.

Move a Diagram Object
You can move the following objects:
data nodes
elements
sections
lines

shapes, images, and text
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TIP The Diagram Editor supports undo and redo when you move objects.
You can undo or redo up to ten of these actions.

To move an object, select the object and drag it to a new location.

TIP When you drag a node, any association links that connect to that node
move, stretch, or shrink accordingly.

To move several objects together as a single unit:
1 Hold down the Citrl key.

2 Click each object or drag the mouse pointer across the background to create
a selection rectangle that completely contains the objects.

3 Drag any one of the objects in the group. The objects retain their relative
positions to each another.

TIP To move a node and all nodes that link to it or from it as a fixed
formation, hold down the Shift key and drag the unit of nodes to a new
location. Any links to or from a moved node that are not part of the unit of
nodes move, stretch, or shrink accordingly.

Rotate a Polygon

To turn a polygon upside down, select the polygon and select Shapes » Rotate
Horizontal.

To reverse the left and right sides of a polygon, select the polygon and select
Shapes » Rotate » Vertical.

Grouping Objects

About Groups

You can use a section, a shape, text, or an image to contain other objects such
as shapes and data nodes in a diagram. Such a container is useful for creating a
visual grouping of objects.

Use Sections to Group Data Nodes by Attribute
To group data nodes into sections in accordance with a selected attribute:
1 Select any node, and then select one of the following:

Elements » Sort This Node by Attribute

Elements » Sort All of This Type By Attribute

The Sort window appears.



Arranging the Layout of Diagram Objects 195

B sort [X]

Attribute

erspective
lzasure
nitiative

oK I Cancel |

2 Click the attribute or element type that you want to group the nodes by.

3 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

TIP Nodes are grouped together in the sections that you have created. If you
sort data nodes into sections and then change some of the data that affects
the result of the sort operation, the diagram is not automatically refreshed. To
align the diagram with the new data, you must repeat the sort operation.

Use Project and Scorecard Sections to Group Data Nodes

To sort data nodes into project sections and scorecard sections, select any
node, and then select one of the following:

Elements » Sort This Node by Scorecard or Project

Elements » Sort All of This Type By Scorecard or Project

TIP Nodes are grouped together in their respective sections: project nodes
are grouped into the project section and scorecard nodes into their scorecard
sections. If you sort data nodes into sections and then change some of the
data that affects the result of the sort operation, the diagram is not
automatically refreshed. To align the diagram with the new data, you must
repeat the sort operation.

Sort and Lay Out the Data Nodes in a Section

As you group data nodes in a section, the data nodes might become poorly
spaced and difficult to read. To sort and lay out the data nodes in a section:

1 Right-click on a section and select Sort and Layout Nodes. The Section
Layout window appears.
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»:1 Section Layout

iApgesiance | order |
Margins
Left margin: [0
Right margin;: 153:
Top margin: 1033
Eottom margin: 1D3:
Horizontal spacing: [0
Vertical spacing: 1 53:
Columns
Maximum number of columns: IE

oK Cancel

2 In the Margins section, specify the margins to use around each element.
3 In the Columns sections, specify the maximum number of columns.
4 Click the Order tab.

Appearance OdefI

[~ Order by slement type

Elerment types:

[~ Btart each element bype on ew rov
[~ order by name
& Ascending

" Descending

oK Cancel

5 You can order the elements by element type or by element name.

To order the elements by element type:
a Select Order by element type.

b To change the order, select a type in the Element types list and click the
arrows to the right to move the selection.

c To start each element type on a new row, select Start each element
type on a new row.

6 To order the elements by name, select Order by name, and then select the
order method.

7 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

Lock the Contents of a Section

After you arrange the contents of a section, you can lock the contents so that no
item is inadvertently moved out of the section. However, you can still add new
items to the section.
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To lock the contents, select a section and select Sections » Lock Contents.

Use a Shape, Text, or an Image to Contain Other Objects
You can capture an object within another object in either of the following ways:

Drag one item into another item (the container) so that the borders of the
container item completely surround the contained item.

Drag one item (the container) so that its borders completely surround another
item.

When you drag a container to a new location, all of the captured items within the
container move with the container in a fixed formation.

TIP To move the shape without moving the contents, hold down the Shift key
while dragging the shape.

TIP To remove a data node from a container, hold down the Shift key and
drag the node.

Use a Shape, Text, or an Image to Contain Data Nodes

You can capture data nodes inside a container by sorting the nodes. To sort
data nodes:

1 Associate a node with a container by dragging the node into the container.
2 Select any data node.

3 Right-click on the selected data node and click Sort This Node by Attribute.
The Sort list appears, showing a list of all the available attributes.

4 Select the attribute by which to group the nodes.

Nodes are captured by containers according to the following rule. Node A is
captured by container X if the node A element has the attribute that you
select, and if container X represents the first value or the only value of that
attribute for the element. For example, if you associate an employee with a
container and sort nodes by the owner attribute, then all the nodes whose
owner is a given employee are captured by the container that represents that
employee. If you sort data nodes into containers and then change some of
the data that affects the result of the sort operation, the diagram is not
automatically refreshed. To align the diagram with the new data, you must
repeat the sort operation.

5 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

TIP To remove a data node from a container, hold down the Shift key and
drag the node.
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Arranging Lines

Turn a Straight Line into a Curved Line

To turn a straight line into a curved line:
1 Click either endpoint of the straight line to display the line's handles.

2 Right-click on the line (not a handle) and click Properties. The Edit Shape
window appears.

3 From the Line Type list, select Curved.

4 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

5 The line now has four handles that define a curve. Drag the handles to curve
the line.

TIP To return to a single straight line segment, you must delete two
segments that define the curve. Right-click on an endpoint and click Delete
Point. Repeat to delete a second endpoint. The remaining segment is the
straight line.

Add and Remove Line Segments

To add a straight line segment to an existing straight line or to a chain of line
segments:

1 Click either endpoint of the line to display the line's handles.

2 Right-click on a handle and select Insert Point. The line splits into two
segments.

To remove a straight line segment from an existing chain of segments:

1 Click an endpoint of an existing segment to display handles at all of the
endpoints.

2 Right-click on a handle that marks the endpoint that you want to remove and
click Delete Point. The point is removed and the chain of segments is
redrawn without it.

Connect or Disconnect Two Containers

When you use a line to connect two containers, you typically attach each
endpoint of the line to one of the containers. When an endpoint of a line is
attached to a container, the endpoint moves with the container.

To attach one endpoint of a line to a container, hold down the Ctrl key and drag
the endpoint into the container. The endpoint takes a position near the border of
the container and is attached to the container.
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To break an attachment between an endpoint of a line and a container:

1 Click an endpoint of the line. Observe whether the end that you want to
detach is marked with a horizontal bar (end A) or a vertical bar (end Z).

2 To detach end A, right-click on the line and select Unattach A.

3 To detach end Z, right-click on the line and select Unattach Z.

Specify Object Appearance

About Object Appearance
You can specify the appearance of objects in the following ways:
fonts
colors
borders

position, alignment, and depth

Set the Font to Use for a Diagram Object
You can set the font to use for the following diagram objects:
diagrams
nodes
sections
shapes

text

TIP The Diagram Editor supports undo and redo when you set the properties
for fonts. You can undo or redo up to ten of these actions.

To set the font that is used for an object:

1 Open the Properties window for the object.
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Diagram

Node

Section

Text

Select File » Diagram Settings. The Diagram Properties window
appears and the General tab is displayed.

Note: The font properties that are located in Diagram Properties
window do not override existing node properties.

Select Elements » Element Type Properties » <element-type>.
The Element Type Properties window appears.

Click the Contents tab.

Right-click on the section and select Edit. The applicable Section
Properties window appears and the Appearance tab is displayed.

Right-click on the item and select Edit. The Shape Properties window
appears.

Click the Appearance tab.

2 Click the ellipses button (...) that is next to the Font field.

3 In the Select Font window, select a font, font style, and font size.

Note: By default, the list of fonts includes only basic fonts.

4 Toinclude all the fonts that are installed on the computer, select Include
system fonts.

Note: If the specified font does not exist on the SAS Strategy Management
server, the rendering of the font can differ when the diagram is viewed in
SAS Strategy Management.

5 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

Set the Colors to Use for a Diagram Object

Objects That Use Colors

You can set the colors to use for the following diagram objects:

association links

lines

nodes

sections

shapes and text

Set the Colors to Use for Association Links

You can set the following colors for association links:

the line color

the transparency of the line color

the color of the link connection points in a diagram



Specify Object Appearance 201

To set the color to use:

1

Open the Edit Link Properties window.

To set the color for all Select File » Link Settings.
association links

To set the color for an Right-click on the origination point or endpoint of the
individual association link link, and select Link » Properties.

The Edit Link Properties window appears.

Line color: [#a00000 s ——— | I
Line bype: IStraight -]
Line style: |solid -]
Line width: f1

End A: fvone -]
End A calor: [#a00000 s ——— | N
End z: farraw |
End Z color: [#000000 s ——— | I

oK | Cancel |

Click the button that is associated with the Line color field and select a color
from the palette.

TIP You can also enter a hexadecimal value for the color.

Click OK in the palette window to save the color setting.

To select a saturation value (transparency), move the Transparency slider
that is next to the color field .

To set the color of the link connection points in a diagram, click the button
that is associated with the End A color or End Z color field and select a
color from the palette.

TIP You can also enter a hexadecimal value for the color.

Click OK in the palette window to save the color setting.

Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.



202 Chapter 20 / Creating and Editing Diagram Views

Set the Colors to Use for a Line

You can set the following colors for a line:

the color and transparency of the line

the color for each endpoint of the line

To set the colors to use for a line:

1

2

Click an endpoint to select the line.

Right-click on a handle and select Edit. The Edit Shape window appears.

Line calor: [#000000] E — | -
Line bype: IStraight |
Line style: ISUIid =]
Line width: f1

End A: fane -]
End A calor: [#000000 [z — |
End Z: fvone -]
End Z color: [#a00000 s ———— | N
Depth: |0

oK | Cancel |

Click the button that is associated with the Line color field and select a color
from the palette, or enter a hexadecimal value for the color.

TIP To specify a black line, leave the field empty.

Click OK to save the color setting.

To select a saturation value (transparency), move the Transparency slider
that is next to the color field .

Click the button that is next to the End A color field and select a color from
the palette, or enter a hexadecimal value for the color.

TIP End A is the end whose handle is marked with a horizontal bar. The
color is applied only when the end shape is an arrowhead or a solid circle.

TIP To specify a black line, leave the field empty.

Click the button that is next to the End Z field and select a color from the
palette, or enter a hexadecimal value for the color.
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TIP End Z is the end whose handle is marked with a vertical bar. The
color is applied only when the end shape is an arrowhead or a solid circle.

TIP To specify a black line, leave the field empty.

8 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

Set the Colors to Use for a Node
You can set the following colors in a data node:
the foreground and background colors
the gradient of the background color
the background color of the text

the color of the border

TIP The Diagram Editor supports undo and redo when you edit data nodes
properties. You can undo or redo up to ten of these actions.

To set the colors to use:

1 Select Elements » Element Type Properties » <element-type>. The
Element Type Properties window appears.

2 Click the Appearance tab.

Shape
Element shape: IRectangIe ;I s |
[+ Size ta Fit
Width (mizels); I DE
Height (p\xals):l 03:
I~ owerride individual sizes
Border style: ISth ;I
Border width: I l::I
Calars
Eorder color: I#DUUUDU - Transparancy: _: IU% 3:
Foreground calor: I#DUUUDU - Transparency: J IU% 3:
Shape background color: I#ggcm D Transparency: J ID% 3:
[¥ Use shape background color For bext background
Text background calor: I#Beccfr D Transparency: _: IU% 3:
[~ Use gradient
EBackaround colorz: Transparencys B =
i | [ RS | IEH 3
Gradient:
Cancel

3 To specify the border, complete the following steps:
a From the Border style list, select a style.

b Type the number of pixels in the Border width field.
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Cc

Click the ellipses button (...) that is next to the Border color field and
select a color from the palette, or enter a hexadecimal value for the color.

Click OK to save the color setting.

To select a saturation value (transparency), move the Transparency
slider that is next to the color field.

4 To specify the foreground and background colors, complete the following
steps:

Note:

You cannot specify the background color of an image.

The Background color field is not available if Show range color as
object background is selected on the Contents tab.

Click the ellipses button (...) that is next to the Foreground color or the
Background color field and select a color from the palette, or enter a
hexadecimal value for the color.

Click OK to save the color setting.

To select a saturation value (transparency), move the Transparency
slider that is next to the color field.

5 To specify the text background color, complete one of the following steps:

To use the same background color for the text and the shape, click Use
shape background color for text background.

To specify a color, click the ellipses button (...) that is next to the Text
background color field and select a color from the palette, or enter a
hexadecimal value for the color. Click OK to save the color setting.

6 To specify a gradient in the background color, complete the following steps:

Note: You cannot specify a gradient for an image.

a

b

f

Click Use gradient.

Click the ellipses button (...) that is next to the Background color2 field
and select a color from the palette, or enter a hexadecimal value for the
color in the field.

Click OK to save the color setting.

To select a saturation value (transparency), move the Transparency
slider that is next to the color field.

Click the button that is next to Gradient. The Pick a Gradient list
appears.

Click the image of a gradient pattern to use, and then click OK.

7 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

Enable a Node Background Color Based on the Metric
Attribute

The data node can use a background color that is based on the metric attribute.
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To limit data node content, select Elements » Element Type Properties
<element-type>. In the Element Type Properties window, click the Contents
tab.

To display the range color in the background of the data node by using the color
of the metric attribute that you selected in the Base background color on
metric attribute list,

click Show range color as object background color.

Set the Colors to Use for a Section
You can set the following colors for a section:
the foreground and background colors
the gradient of the background color
the color of the section border

To set the colors to use:

1 Right-click on the section and select Edit. The applicable Section Properties
window appears and displays the Appearance tab.

2 To specify the foreground and background colors, complete the following
steps:

Note:
You cannot specify the background color of an image.

The Background color field is not available if Show range color as
object background is selected on the Contents tab.

a Click the ellipses button (...) that is next to the Foreground color or the
Background color field and select a color from the palette, or enter a
hexadecimal value for the color.

b Click OK to save the color setting.

c To select a saturation value (transparency), move the Transparency
slider that is next to the color field.

3 To specify a gradient in the background color, complete the following steps:

Note: You cannot specify a gradient for an image.
a Click Use gradient.

b Click the ellipses button (...) that is next to the Background color2 field
and select a color from the palette, or enter a hexadecimal value for the
color in the field.

c Click OK to save the color setting.

d To select a saturation value (transparency), move the Transparency
slider that is next to the color field.

e Click the button that is next to Gradient. The Pick a Gradient list
appears.

f Click the image of a gradient pattern to use, and then click OK.
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4 To specify the border, complete the following steps:

a From the Border style list, select a style.
b Type the number of pixels in the Border width field.

c Click the ellipses button (...) that is next to the Border color field and
select a color from the palette, or enter a hexadecimal value for the color.

d Click OK to save the color setting.

e To select a saturation value (transparency), move the Transparency
slider that is next to the color field.

Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

Set the Colors to Use for a Shape or Text

You can set the following colors for a shape or text:

the foreground and background colors
the gradient of the background color

the color of the shapes border

TIP The Diagram Editor supports undo and redo when you set properties for
shapes or text. You can undo or redo up to ten of these actions.

To set the colors to use:

1

Right-click on the shape or text and select Edit. The Shape Properties
window appears.

Note: Some properties might not apply to selected shape or text.
Click the Appearance tab.

To specify the foreground and background colors, complete the following
steps:

Note:
You cannot specify the background color of an image.

The Background color field is not available if Show range color as
object background is selected on the Contents tab.

a Click the ellipses button (...) that is next to the Foreground color or the
Background color field and select a color from the palette, or enter a
hexadecimal value for the color.

b Click OK to save the color setting.

c To select a saturation value (transparency), move the Transparency
slider that is next to the color field.

To specify the border, complete the following steps:
a From the Border style list, select a style.

b Type the number of pixels in the Border width field.
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Click the ellipses button (...) that is next to the Border color field and
select a color from the palette, or enter a hexadecimal value for the color.

Click OK to save the color setting.

To select a saturation value (transparency), move the Transparency
slider that is next to the color field.

5 To specify a gradient in the background color, complete the following steps:

Note: You cannot specify a gradient for an image.

b

f

Click Use gradient.

Click the ellipses button (...) that is next to the Background color2 field
and select a color from the palette, or enter a hexadecimal value for the
color in the field.

Click OK to save the color setting.

To select a saturation value (transparency), move the Transparency
slider that is next to the color field.

Click the button that is next to Gradient. The Pick a Gradient list
appears.

Click the image of a gradient pattern to use, and then click OK.

6 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

Specify a Border

You can specify the appearance of the border for the following objects:

nodes

sections

shapes and images

TIP The Diagram Editor supports undo and redo when you set border
properties. You can undo or redo up to ten of these actions.

To specify the border to use:

1 Open the Properties window for the object.

Node Select Elements » Element Type Properties » <element-type>.

The Element Type Properties window appears.
Click the Appearance tab.

Section Right-click on the section and select Edit. The applicable Section

Properties window appears and the Appearance tab is displayed.

Shapes Right-click on the object and select Edit. The Shape Properties
and window appears.

images

Click the Appearance tab.
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2 From the Border style list, select a style.
3 Enter the number of pixels in the Border width field.

4 Click the ellipses button (...) that is next to the Border color field and select
a color from the palette.

TIP You can also enter a hexadecimal value for the color.

5 Click OK to save the color setting.

6 To select a saturation value (transparency), move the Transparency slider
that is next to the color field.

7 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

Specify the Appearance of Association Links

To specify the color, type, style, and width to use:

1 Open the Edit Link Properties window.

To set the appearance for Select File » Link Settings.
all association links

To set the appearance for Right-click on the origination point or endpoint of the
an individual association link, and select Link » Properties.
link

The Edit Link Properties window appears.

Line color: [#000000 [255 | | N
Line bype: IStraight =]
Line skyle: ISUIid -]
Line width: f1

End A: fvone -]
End A calor: [#a00000 s ——— | N
End Z: |ﬂrrow LI
End Z color: [#a00000 [ss | ———— ] -

oK | Cancel |

2 To change the color, click the button that is associated with the Line color
field and select a color from the palette. Click OK in the palette window to
save the color setting.
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TIP You can also enter a hexadecimal value for the color.

3 To select a saturation value (transparency), move the Transparency slider
that is next to the color field.

4 From the Line type list, select the type of line to use.
5 From the Line style list, select the style of line to use.
6 In the Line width field, enter the width of the line, in pixels.

7 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

Specify the Appearance of the Association Link
Connection Points

An association link has two connection points: a source element data node and
a target element data node. End A is the source. End Z is the target. The source
element data node has an attribute that identifies the target element data node.
For example, a diagram contains an element called Sales and another element
called Profit. There is an association link between a Sales element data node
and a Profit element data node. The Sales element data node is End A. The
Profit element data node is End Z. The Sales element data node has an attribute
that identifies the Profit element data node as End Z.

To specify the color and appearance to use:

1 Open the Edit Link Properties window.

To set the appearance for Select File » Link Settings.
all connections points

To set the appearance for Right-click on the origination point or endpoint of the
one set of connections link, and select Link » Properties.
points

The Edit Link Properties window appears.

2 To change the color, click the button that is associated with the End A color
or End Z color field and select a color from the palette. Click OK in the
palette window to save the color setting.

TIP You can also enter a hexadecimal value for the color.

3 From the End A and End Z lists, specify how to represent the origination
point and endpoint of the link.

4 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.
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Specify the Position, Alignment, and Depth of an
Object

You can specify the position, alignment, and depth of a section, shape, text, or
image.

TIP The Diagram Editor supports undo and redo when you set these
properties. You can undo or redo up to ten of these actions.

To specify the position, alignment, and depth:

1 Right-click on the object and select Edit. The Properties window appears.
2 Click the Position tab.

3 Complete the following steps for shapes, text, or images:

a In the Left field, enter the distance, in pixels, between the left border of
the object and the left border of the diagram.

b Inthe Top field, enter the distance. in pixels. between the top border of
the object and the top border of the diagram.

4 In the Width field, enter the width of the object, in pixels.

Note: You cannot specify the width of text.

TIP You can also change the width by dragging the handles of the object.

5 In the Height field, enter the height of the object, in pixels.

Note: You cannot specify the height of text.

TIP You can also change the height by dragging the handles of the
object.

6 To specify the alignment, complete the following steps:

Note: You cannot specify the alignment of text.

a From the X alignment list, select a value to control the horizontal position
of any associated text.

b From the Y alignment list, select a value to control the vertical position of
any associated text.

c From the Text orientation list, select a value to control the orientation of
any associated text.

7 To specify the depth, enter an integer value in the Depth field.

Note: If an item overlaps another item in a diagram, then the item with the
greater depth value is covered by the item that has the lesser depth value.

8 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.
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Specify the Appearance of Lines
To specify the line type, width, style, and depth:
1 Click an endpoint to select it.
2 Right-click on a handle and select Edit. The Edit Shape window appears.
3 From the Line type list, select the type of line.
4 From the Line style list, select the style of line.
5 In the Line width field, enter the width of the line, in pixels.

6 To specify the depth, enter an integer value in the Depth field.

Note: If an item overlaps another item in a diagram, then the item with the
greater depth value is covered by the item that has the lesser depth value.

7 Specify the appearance of end A (the end whose handle is marked with a
horizontal bar):

a From the End A list, select a shape.
b Click the button that is next to the End A color field, and select a color

from the palette.

TIP You can also enter a hexadecimal value for the color. To specify
black, leave the field empty.

Note: The color is applied only when the end shape is an arrowhead or a
solid circle.

c Click OK to save the color setting.

8 Specify the appearance of end Z (the end whose handle is marked with a
vertical bar):

a From the End Z list, select a shape.

b Click the button that is next to the End Z color field, and select a color
from the palette.

TIP You can also enter a hexadecimal value for the color. To specify
black, leave the field empty.

Note: The color is applied only when the end shape is an arrowhead or a
solid circle.

c Click OK to save the color setting.

9 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.
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Specify the Appearance of a Correlation

To specify the width and color to use for a line that represents a correlation:

1

2

Select File » Diagram Settings. The Diagram Properties window appears.
Click the Analysis Style tab.

o

Generl [ Dy | Arorss St | seaey

Association importance conveyed by:
Line width (correlation is converted to a value from 1 to 10 pixelsk

[ Line colors {a color for negative and positive correlation)

I' Megative: |=fronon [I] - Transparency: ” 0o
Positive:  |=pnffog [:] - Transparency: ” 0%
|

Select Line width to specify that the line width varies according to the
correlation value. Valid correlation values are in the range -1.0-1.0. A line
that represents a value in this range would be 0-10 pixels wide.

Select Line colors to specify that the line color varies according to the
correlation value. Enter values for the negative and positive correlation
values, and set the transparency.

Note: By default, a negative correlation (-1.0) is red and a positive
correlation (+1.0) is green.

Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

Specify the Shape, Size, and Border of a Node

To specify the shape, size, and border for a node:

1

Select Elements » Element Type Properties » <element-type>. The
Element Type Properties window appears.

Click the Appearance tab.
From the Element shape list, select a shape.

To select a scalable vector graphic (SVG) drawing to display with the
element type, click . The Select Drawing window appears. You can

perform the following tasks in this window:
To select a drawing, select it from the Drawings list.

To add a drawing to the list, click Upload Drawing and navigate to the
drawing file.

To refresh the list of drawings, click Refresh.
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5 To specify that the nodes be sized to fit in the diagram display, select Size to

fit.

TIP If you select Size to fit, you can also select Override individual
sizes to specify that nodes of that element type be sized to fit the diagram
display.

To specify a different size for nodes of this element type, clear Size to fit and
enter the number of pixels in the Width (pixels) and Height (pixels) fields.

To specify the border, complete the following steps:
a From the Border style list, select a style.
b Type the number of pixels in the Border width field.

c Click the ellipses button (...) that is next to the Border color field and
select a color from the palette, or enter a hexadecimal value for the color.

d Click OK to save the color setting.

e To select a saturation value (transparency), move the Transparency
slider that is next to the color field.

Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

Create, Edit, and Select a Style for a Node

About Styles

A style is a collection of settings such as font and background color. You can
assign a style to specific element types in a diagram. Styles are stored at the
template level so that they are available to all diagrams in all projects that use
the template.

Note: The Contents and Appearance tabs are unavailable because the
settings in the style override the settings on these tabs.

Create a Style

To create a style:

1

Select Elements » Element Type Properties » <element-type>. The
Element Type Properties window appears.

On the Styles tab, click New. The Element Type Properties: New Style
window appears.

Click the Name tab and name the style.

Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.
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Edit a Style
To edit a style:

1 Select Elements » Element Type Properties » <element-type>. The
Element Type Properties window appears.

2 On the Styles tab, select a style and click Edit. The Element Type
Properties: Edit Style window appears.

Note: The Element Type Properties: Edit Style list is identical to the
Element Type Properties: New Style list.

3 Click the Name tab and name the style.

4 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

Select a Style for a Node

1 Select Elements » Element Type Properties » <element-type>. The
Element Type Properties window appears.

2 On the Styles tab, select Use style.

3 Select a style.

Note: The style is immediately applied to the element. However, no
permanent association is made between the style and the element. If you
later change the style, that change is not reflected by this element. You must
reset the style setting in order for the changed style to affect this element.

4 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

Displaying Labels and Other Content

About Diagram Labels and Content

A diagram and its objects can contain many types of content. To improve
usability or readability, you might want to control how much content appears in
an object.

You can specify whether diagram labels and information are displayed in a
diagram. To improve the readability of a diagram, carefully consider how much
information you include in a diagram.

Specify Global Content Settings

To specify global settings about the content to display:
1 Select File » Diagram Settings. The Diagram Properties window appears.

2 Click the Display tab.
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| General| Display | Analysis style | security|

Select to display:

Metric attribute values
[ Scorecard information: | Scorecard Icon with Tooltip
I' [ Link labels
Label length: S0F
||

3 (Optional) Select Indicators to specify that any data node that is associated
with a numeric value to which a range is applied shows the image for the
subrange that contains the value.

4 (Optional) Select Metric attribute values to specify that any data node that
is associated with a numeric value shows that numeric value. If no value
exists, a period (".") is displayed.

5 (Optional) Select Scorecard information to specify that certain scorecard
information is displayed. Select the information to display from the list.

6 (Optional) Select Link labels to display labels on all of the links in the
diagram.

7 (Optional) Select Label length to specify the maximum number of characters
per line of text in the nodes of the diagram.

The text is wrapped in accordance with this maximum, but the maximum can
be exceeded slightly in some cases in order to avoid splitting words. Label
length applies only to element nodes for which a width and height have not
been explicitly set.

8 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

Limiting Data Node Content

To limit data node content, select Elements » Element Type Properties
<element-type>. In the Element Type Properties window, click the Contents
tab.

To limit the length of labels in a diagram, select Override global label
length.

To keep text within the boundary lines of the data node, select Crop all text
to bounding box.

In the Show metric attributes list, select the metric attributes to display.
A diagram can display the following icons:

Element type icon: Indicates the type of element.
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Comments icon: Indicates that comments are attached to the node.
Trend icon: Indicates that a trend history is available for the node.
To control whether these icons appear:

To prevent the display of the element type icon, select Hide element type
icon.

To display the comment icon if comments exist, select Show comments
icon.

To display the trend icon if there is trend history, select Show trend icon.

TIP The Diagram Editor supports undo and redo when you edit data nodes
properties. You can undo or redo up to ten of these actions.

Display a Path for a Section

For project sections and scorecard sections, you can display a path in the
diagram so that users can distinguish duplicate items from different projects and
scorecards.

Note: This setting is available only for project sections and scorecard sections.

To display a path for the section:

1 Right-click on the section and select Edit. The applicable Section Properties
window appears and displays the Appearance tab.

& Scorecard Section Properties

Fastion |

Scorecard Label
™ Use full scorecard path

Font and colors

Font: Iiamily=DiaI0g,name=DiaIDg.plain,style=plain,size=12 . |
Foreground color, IM | - Transpatency: J| lﬁ
Background colar: W | l:l Tranzparency: JI lﬁ
I~ U=e gradiert

Eackaround calar: W | l:l TransRarency: J IE

Gradient: |

Eorder

Border style: ISDIid - l
Border wickh: I 1 3:
Border color: I#UUUUUU | - Transparency: JI

N

Ol | Cancel

2 Select Use full scorecard path.

3 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.
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Interactive Features in Diagrams

Links in Diagrams That Open New Content

Links open new content when you click on a part of a diagram. You can add
links to diagrams in the following ways:

Apply a link to a node or shape by specifying a default link for a selected
element type.

Apply a named link to a node, shape, text, or image in a diagram. The named
link must already be defined. For more information, see “Managing Link
Definitions” on page 78.

Specify a web address hyperlink to a shape, text, or image.

Apply a Named Link to a Node

You can apply a named link to all nodes of an element type or to an individual
node. When a user clicks the background of the node, the link opens. You must
define a named link before you can apply it to an object. For more information,
see “Managing Link Definitions” on page 78.

To apply a named link:

1 Select Elements » Element Type Properties » <element-type>. The
Element Type Properties window appears.

Click the Set Node Link tab.

Select Named link.

A @O DN

From the Show list, select the type of named link that you want to use.

3}

From the Link list, select the named link that you want to use.

o

Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

Apply a Named Link to a Shape, Text, or Image

You can apply a named link to a shape, text, or image in a diagram. You must
define a named link before you can apply it to an object. For more information,
see “Managing Link Definitions” on page 78.

To apply a named link:

1 Right-click on the item and select Edit. The Shape Properties window
appears.

2 Click the Named Links tab.

3 From the Named link list, select the link to apply to the node.
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4 From the Show list, select the type of named link that you want to use.
5 From the Link list, select the named link that you want to use.

6 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

Disable Element Detail Links in Diagrams

You can choose to disable element detail links for security purposes. If this
setting is disabled, element detail links do not open in a diagram. The default
setting is enabled.

Note: This setting does not affect hyperlinks that are explicitly set for a shape,
text, image.

To disable element detail links:

1 In the Diagram Editor, select File » Diagram Settings.

2 In the Diagram Properties window, click the Security tab.
3 Clear the Enable element details check box.

4 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

Add a Hyperlink to a Shape, Text, or Image

You can add a hyperlink to a shape, text, or image in a diagram. When the user
clicks on the hyperlink, a web pages opens. This hyperlink is explicitly set on the
shape, text, or image. The hyperlink definition is not reusable like named links
are.

To add a hyperlink:

1 Right-click on the item and select Properties. The Shape Properties window
appears.

2 Click the Links tab.
3 Select Hyperlink.

4 In the Web address field, enter a web address to open when the item is
clicked.

5 By default, the link opens the web address content in a new browser window.
If you want the link to open the web address content in the browser window
that contains the diagram, replacing the diagram with the web address
content, and then select Same window.

6 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.
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Remove a Hyperlink or Named Link from a Shape,
Text, or Image

To remove a hyperlink or named link:

1 Right-click on the object and select Edit. The Shape Properties window
appears.

2 Click the Links tab.
3 Select No link.

4 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

Specify HTML or JavaScript for Use in a Diagram

If you specify JavaScript, the code is active in the displayed diagram. For
example, consider the following code:

onmouseover="JavaScript: alert ('Revenue Growth')"

If you specify this code, then the following message appears in a list whenever a
user moves the mouse pointer over this shape, text, or image:

Revenue
Growth

To specify HTML or JavaScript code in a shape:

1 Right-click on the shape and select Properties. The Shape Properties
window appears.

2 Click the HTML tab.
3 In the HTML field, enter the HTML or JavaScript code.

Note: You must enclose the right side of the JavaScript expression in
double quotation marks.

4 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

To specify HTML or JavaScript code in a diagram:

1 Select File » Diagram Settings. The Diagram Properties window appears
and the General tab is displayed.

2 Inthe HTML field, enter the HTML or JavaScript code.

Note: You must enclose the right side of the JavaScript expression in
double quotation marks.

3 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.



220 Chapter 20 / Creating and Editing Diagram Views

Changing Data

Change Associations
To view and change the associations that are displayed as links in a diagram:

1 Select Elements » Associations. The Edit Associations window appears
and displays a list of all of the selectable associations.

TIP The currently selected associations are highlighted.

Edit Associations [ ]
Assaciation:
|2 Associstions

E-(3) Measurs

[+ Objective ]

0K | Cancel

2 Click any item in the Association list to select it or to deselect it.

3 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

Edit Element Properties

To edit an element:

1 Double-click the node that represents the element that you want to edit. The
Edit Element list appears, showing all the attributes of the element and their
current properties. The attributes vary according to the element. The
attributes of an objective are shown in the following figure.
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Edit Element E
Mame For language (U.. .. IObj sctive 1
Perspective I LI
Measure I LI
Initiative | |
width: f441
Height: |23?
Scorecard path: IScorecard|

oK Cancel

Note: Element type attributes are defined in the template for the project.

2 Change the value of any attribute by entering a value or by selecting a value
from a list.

3 Click OK to save your changes.

TIP The Diagram Editor supports undo and redo when you edit properties for
an element. You can undo or redo up to ten of these actions.

Select the Date for an Element

A diagram can contain the same element multiple times, but each element can
have a value for a different date.

To select the date for an element:
1 Right-click on an element and select Set Date. The Set Date list appears.

2 Complete the applicable date selection:
To specify the current date, select Current date.

To specify a specific date, select Specific date and enter a date in the
field or click [] to choose a date from the calendar.

To specify a relative period, select Relative period. Then enter or select
a positive or negative value.

Set Security in Diagrams

You can control security in diagrams in the following ways:
You can limit whether a user can view element details in a diagram.

You can disable the functionality of named links in a diagram.
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To set security:

1 Select File » Diagram Settings. The Diagram Properties window appears.

2 Click the Security tab.

3 To control whether element details are shown in the diagram, select Enable
element details.

Note: This selection affects the functionality of element detail links only.

4 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

Using a Different Language in a Diagram

Diagrams and Language Settings

Additional languages can be defined in the template. For example, a template
can specify English as the default language and Spanish as a user-defined
alternate language. When a project is created from a template that has user-
defined languages, a diagram that is based on that project can use the same
user-defined languages. For more information, see “Working with Language
Settings” on page 55.

Select a Language for a Diagram

If you have defined more than one language for a project, you can select the
language in which to display the diagram. Select Elements » User Defined
Language and select a language.

Specify the Diagram Name in Other Languages

If you have defined other languages for a project, you can specify the name of
the diagram in those other languages. A field is available for each language that
you have defined in the project. If a diagram name is not specified in the
language that is currently set for a project, the diagram name is displayed in the
default language.

To specify diagram names in other languages:

1 Select File » Diagram Settings. The Diagram Properties window appears
and the General tab is displayed.

2 In the Name for language field, enter the name of the diagram.

3 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.
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Analyzing a Diagram in Order to Validate a

Strategy

Overview

When two elements in a SAS Strategy Management model are connected by an
association (such that the first element is thought to influence the second
element, and both elements have sufficient and overlapping periodic metric
attribute data), then it might be useful to calculate the correlation coefficient
between the two elements.

The correlation coefficient (correlation analysis) can help determine whether the
first element influences the second element. A correlation coefficient is a floating
point number in the range -1-1, where 1 indicates a positive correlation and -1
means indicates a negative correlation. The value 0 indicates no correlation. The
correlation coefficient is calculated to two decimal places.

You can analyze the correlation in a diagram. To perform the analysis, you must
select an association in the diagram and a date range. For the association, you
must select two metric attributes: a "from" metric attribute and a "to" metric
attribute. The "from" metric attribute influences the "to" metric attribute. The
"from" and "to" metric attributes do not need to have the same name, but they
must be inherently related to each other and mean the same thing.

Note: The Analysis feature might not be available. See your SAS Strategy
Management administrator to determine whether this feature is enabled.

For example, it would probably not make sense to compare the metric attribute
named Actual against the metric attribute named Performance. Similarly, the
metric attributes should probably be of the same scale, such as both values
being integers or both values being percentages.

Note: The presence or absence of a correlation does not definitively state the
influence between the elements, but it merely suggests an influence. Because
the influence is merely a suggestion, do not redesign a scorecard based only on
the correlation coefficient. For example, do not assume that a negative
correlation indicates that there is no influence between the two elements. A
negative correlation between expenses and profits indicates only that as
expenses go down, profits go up. But expenses certainly have an influence on
profits.

The results of the analysis are displayed in the diagram. The results are
calculated dynamically from the input choices that you specify, and the results
are not saved after you close the editor session. However, you can export the
results. For more information, see “Export Analysis Results” on page 226.

Create an Analysis Definition

When you create an analysis definition, you specify the properties required for
the analysis.
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Before you create an analysis, the following conditions must be met:

You must select an association . Select Elements » Association. In the

Edit Association window, you must select for display the association to use in
the analysis.

You must select the metric attributes on which the analysis is going to be
based. In the Diagram Editor, right-click on the element and select Element
Type Properties. In the Properties window, click the Contents tab. In the
Show metric attributes list, make sure that the attributes that you want to
use in the analysis are selected.

To create an analysis definition:
1 Select Analysis » New The New Analysis wizard appears.

2 Enter the name of the analysis.

w

(Optional) Enter the description.

H

(Optional) Choose whether to copy another analysis to this analysis.

a

Click Next.
6 On the Association and Attribute page, select an association.
Eﬂew Analysis — Step 2 of 4 Asssociation and Attribute

Association and Atfribute

Select the Association and the To and From Attributes For this analysis.

) Associations To atkribute:
EJ Measure Actual
[ Perspective (Perspective) Target

-# Objective (Objective) Skatus

I Initiative Performance

: Lt Perspective (Perspective)
E1+) Objactive

et Perspective (Perspective)
- Measure (Measure)
- Initiative (Initiative)

From attribute:
Actual

Target

Skatus
Performance

< Back | Tkt = | Help |

7 Select a metric attribute in the To attribute section.

8 Select a metric attribute in the From attribute section. Click Next.

9 On the Date Range page, specify the start and end dates. Click Next.

TIP The longer the date range, the more accurate the correlation results.

10 On the Summary of Selections page, review your choices. To make
changes, click Back.
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11 Click Finish to save your selections and exit. Click Cancel to exit without
saving your selections.

The analysis definition is saved to the SAS Strategy Management server so that
it can be used in the future. You can now run the analysis.

TIP You can also create a new analysis definition in the Manage Correlations
and Regressions window. However, only the New Analysis wizard provides
the option to copy another analysis to the analysis that you are creating.

Run an Analysis

To run an analysis, select Analysis » Edit. The Manage Correlations and
Regressions window appears. On the Manage tab, select the definition and click
Run.

View Analysis Results

To view results after you run an analysis in the Manage Correlations and
Regressions window, click the Analysis Results tab.

x
Manage Analysis Results I Input Datal
Analysis Resulks

From Elerment | To Element | Correlation | Walue
1M1 CEIL ———|0,93452 =
2 M3 OB15 ——+—(0.0842
3 M3 CBIS ———[0.97614
4 M7 CBI7 ——-1.0
5 |Mz0 OB1L0 ——i|1l.0
& M2z CBIZ2 —————|-0.0543
7 M24 B4 ———[0,33712
8 |Mz6 OB16 ——+——[0.8313
9 |M31 CEBIL ———|0,92361
10 M35 CEIS ——+—|0,98531
11 |M37 OB17 ——————|0.75003
12 M39 CEI9 1 |-0.99664
13 M40 CEIL0 ———(0.05439
14 M4z OB1z2 ———|-0.27728
15 (M4 CBE14 —————|0,35272
16 M6 CEIG ——+—[-0,03521
17 [Meda CBIS —————[0,98011
18 Ms3 CBI3 ——+——1-0,15734 —
19 M35 OBIS ——————1(0,935805
20 |Ms7 CBI7 ———|-0,04322 ;I

[~ Advanced view
Apply |

To view more detailed information about the results, select Advanced view.
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Analysis Resulks

From Element To Element Correlation Value Linear Regression F(x) P Value ' Probt * Probk Y Skderr
1Mt (OBJL ——————1|0.93452 |691.523439 + 0,49293045 * x|2.88536E-6 |9.064E-5 |2, BE8E86E-6 |115.509517|0.
2 M3 OB13 ——————|0.0842 |-205465.0 4+ 233.659846 * x  [0.78449093(5. 1992E-7 |0.76449092|19937.4596(82
3 M3 CB1& ——————1|0.97614 |-200002.43 + 159692679 * x [1.21449E-5 |2.002E-56 |1, 21463E-8 |0,59426781|0.
4 M17 CBIT 1.0 @0000.0 + -1.0% = 0.0 0.0 0.0 0.0
N S D e AR szt N PN NN GIBNIEIN Aot N SRR P LT i NI R L ™

View Input Data Used in the Analysis

To view the input data used in the analysis in the Manage Correlations and
Regressions window, click the Input Data tab.

Manage Correlations and Regressions x|

Managel Analysis Results  Input Data I

Association Data

PeriodId | Period Mame M1 OBl
1 |85 JUNZ009 1332.79 1214.63295
2 |tes JULz009 1438.34 1263.289
3 |167 AUG2009 1564.33 1391.99544
4 |168 SEP2009 1554.31 1453.45545
5 |69 0CT2009 1576.53 1504,95735
6 |170 NOY2009 1679.95 1652.36867
7 171 DEC2009 1894.31 1654.2833
8 |177 1ANZ010 205096 1794.51272

= | =] | Table 1 of 22 = <l Export...

Apply | Close |

Export Analysis Results
You can export the following results:
all analyses results to a comma-separated value (CSV) file

the currently displayed analysis results only

TIP You must run an analysis before you can export results.
To export all analyses results to a CSV file, in the Manage Correlations and
Regressions window, on the Manage tab, click Export.

To export only the currently displayed analysis, in the Manage Correlations and
Regressions window, click the Input Data tab and click Export.
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Apply an Analysis to a Diagram

To apply the analysis to the diagram that is displayed in the editor, click Apply in
the Manage Correlations and Regressions window. The correlation is applied
and the output appears.

Fle Edt Elements Shapes Sections Grid Analysis Help
E=E=E NSNS B

=EE 100 200 300 400 500 600 0o 800 800 1000 1100 1200 1300 1400 1500 1600 1700 1800 181
4 1 1 | | | | | | | | | | 1 1 1 1 1 1 1

1 Measure
100 -

200 —i
300 —i
400 —i
500 —i

600 |

700

800 |

900

The changes made to the diagram are saved. When you exit the Diagram Editor,
the changes are retained.

Edit a Correlation and Regression Definition

To edit a definition, select Analysis » Edit. The Manage Correlations and
Regressions window appears. On the Manage tab, select the definition and click
Edit.

Delete a Correlation and Regression Definition

To delete a correlation and regression definition in the Manage Correlations and
Regressions window, select the definition on the Manage tab and click Delete.

Analyze the Correlation between Two Elements

To view the effects of the relationship between two elements:

1 In the diagram, right-click the end of the correlation arrow of the element that
you want to analyze, and then click Show regression slider. The correlation
slider appears.
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1133 1200 1266 1333 1400 1466 15633 1600 1666 1733 1
Lo b by b b b b by v By v 0 |
" Actual 2,053 .85
v M50
| o Actusl 872
0BJ10 / Perf  34.550
B ctual 313,20
4
pBJ2 y
motual 30,238.90 M40
# Actual 835
\ Perf  35.4000%
=
I
; i | i
From variable: M20 ke
To variable: OBJ10 M20
Original value: 10,66 Q & actusl 1066
\ Perf  42.6400%

2 Click on the slider and drag it to the left or right to view the effects that an
increase or decrease in the value of the From element has on the value of
the To element.

1133 1200 1266 1333 1400 1466 1533 1600 1666 1733 1
bl s b b by b b b b by v by o |
T actual 2,053 85
v M60
o # actual 872
OBJ10 t/ Perf 34880
e Actual 635.80
1%
=
0BJ2 N
Actual 30,235.90 M40
& Actusl 8.85
\ Perf  35.4000%
=
From variable: M20 I
To varisble: OBJ10 M20
Original value: 10,66 Q & actual 96,94
\ Perf  42.6400%

3 Click to view more information about the statistical relationship.

4 When you are finished, click X to remove the slider.

Add an Analysis Plug-in

You can write a plug-in to use in the Diagram Editor to meet your specific
analysis requirements. For more information, contact your SAS technical support
or consultant.

To add an analysis plug-in:

1 Specify the plug-in analysis settings by selecting a metric attribute for
analysis.
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2 Select Analysis » Add Plug-in. The Add Plug-in window appears.

Available plugins:

S
This service provides a multiple linear & |
regression analysis using the least
squares method, The service provides
a Swing plug in component that
support drag and drop of the

™ |MultiplelinearRearessionPlugin
independent and dependent wariables.

=

oK | Cancel |

3 Select the check box next to one or more analysis plug-ins.

4 Click OK. The Add Plug-in window closes, and, if needed, a list of options for
the analysis plug-in appears.

Perform a Multiple Linear Regression Analysis

Use the multiple linear regression plug-in to perform a multiple linear regression
analysis that uses the least squares method.

To perform a multiple linear regression analysis:

1 Hold down the Ctrl key and drag one or more elements into the Independent
input variables list.

2 Hold down the Ctrl key and drag one element into the Output variable list.
3 Specify the start and end dates.

4 Click Run. After the analysis runs, you can view the analysis results and the
input data that was used for the analysis.

To investigate the impact of the input variables on the output variable, click the
Explore tab. Use the controls to adjust the values of the input variables. The
impact of the changes is reflected in the output variable, which is displayed
above the inputs.
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Managing a Diagram

View Diagram Properties

To view the properties of a diagram:
1 Open a project.
2 Select a project or scorecard.

3 Select a project or scorecard name in the hierarchy and click [#j] in the
toolbar.

4 Click Manage Diagrams.

5 Click [5l that is next to a diagram name in the table, and select Properties.
The Diagram Properties page appears.

6 (Optional) Change the name of the diagram.

Copy a Diagram

You can copy a diagram to other scorecards in the same project. You can build
a diagram that serves as a master at the top level of the scorecard hierarchy,
which is comparable to a slide presentation. You can then copy that diagram to
one or more child scorecards.

If you copy a diagram to another scorecard, the diagram might not look exactly
like the original. Because diagrams contain nodes that are specific references to
elements in the source diagram, elements that have the same name in the
default language must exist in the target scorecard. If the elements do not have
the same name, that diagram node cannot be copied. Containers can be copied
unless they are bound to elements for which a copy does not already exist in the
target scorecard.

To copy a diagram:

1 Select File » Copy Diagram. The Select Scorecard for Diagram Copy list
appears.

2 In the Name field, enter the name of the copy of the diagram.

3 From the Scorecards list, select the scorecards into which you want to copy
the diagram.

4 If you want to replace an existing diagram in a scorecard, click Replace
existing.

Save a Diagram

To save the changes that you have made to a diagram, select File » Save in
the Diagram Editor.
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Revert to the Saved Diagram

If you have not saved your recent changes to a diagram, you can revert to the
last saved diagram. Click File » Revert To Saved in the Diagram Editor.

Export a Diagram

To export a diagram as a scalable vector graphic (SVG):

1

2

3

a4

Select File » Export. The Save list appears.
Navigate to a location.
Name the file.

Click Save.

TIP To quickly save an image of the diagram, you can also make a screen
capture of the diagram image.

Delete a Diagram

To delete a diagram:

1

2

Open a project.
Select a project or scorecard.

Select a project or scorecard name in the hierarchy and click [ on the
toolbar.

Click Manage Diagrams.

Click 5] that is next to a diagram name in a table and select Delete.

Viewing a Diagram

View a Diagram

To view a diagram:

1

2

Open a project.

Select a project or scorecard name in the hierarchy and click [ on the
toolbar.

Click Manage Diagrams.

Click the diagram name.
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5 To view updates such as changes to metric values click Go, which is next to
the zoom controls.

TIP Diagrams are cached on a per-user, per-date basis; each user must
update the diagram view in order to see the most current data. To update
the diagram, click &%.

Note:

1 Elements whose dates fall outside the range that is specified for the diagram
are not displayed.

2 If alabel in a diagram is not specified in the language that is currently for a
project, the label is displayed in the default language.

Change the Position of a Diagram

Note: The project options for the diagram format must be set to show diagrams
in scalable vector graphic (SVG) format. For more information, see “Customize
Project Content Displayed by Default” on page 69.

To change the position of the diagram in order to view other areas, use the scroll
bars and zoom controls provided in the editor..

Locate Elements, Element Types, and
Associations

Note: The project options for the diagram format must be set to show diagrams
in scalable vector graphic (SVG) format. For more information, see “Customize
Project Content Displayed by Default” on page 69.

To locate elements in a diagram:

1 Click . The Locate Element page appears.

« Back | Help~
Locate Element 9sas

% Revenue Growth (Measure) [Scorecard: Q1]
% of Accounts as Bad Debts (Measure) [Scorecart
3 of Staff Exceeding Performance Goals (Measur

Avg Annual Profit per Customer (Measure)
[Scorecard: Q1]

Customer Satisfaction Index (Measure) [Scoreca
Reduce Printing Waste (Objective) [Scorecard: €

=
4| | 3

Close

2 Select one or more elements.

3 Click Close. The elements are highlighted by blinking red borders.

Note: To remove the blinking red borders, open the Locate Element page,
clear the selected elements, and click Close.
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To highlight an element:

1 Click . The Highlight page appears.

| Help~

Highlight 9sas

& Element type
" associations

2 Click the element types or associations that you want to highlight.

3 From the list, select one or more items.

4 To reset the highlighting to its default state, click .

View Element Attributes

To view the attributes of elements that are represented by nodes in a diagram,

click on a diagram node. Metric attributes and non-metric attributes are listed for
the element on the Element Attributes page.

Element Attributes - Q1

Metric Attributes

Attribute name Walue
Actual

Target

Status

Perfarmance

Non-Metric Attributes

Attribute name Walue
Perspective

Measure

Initiative
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Creating and Editing Gauge (Also
Called Dashboard) Views

Creating and Editing Gauge Views 235

Creating and Editing Gauge Views

Gauge views, also called dashboard views, are not available in the Builder.
However, you can create gauge views in both classic portlets and enhanced-
portlet tiles. For more information, see the following topics:

= “Edit a Performance Dashboard Portlet” on page 293.
= “Edit the Gauge View Tile Properties” on page 277.
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Creating and Editing Trend Analysis
Views

Overview 237
Access Trend Analysis from a Table 237
Select the Metric Attributes to Analyze 238
Customize the Display of a Metric Attribute 240
Navigate a Trend Analysis 240
Customize the Trend Analysis 241

Overview

This trend analysis view uses the Trend Analysis page. This page is accessed
by views that are displayed using:

= SAS Strategy Management Builder

m  Strategy Management classic-style portlets

For information about other types of trend analysis provided by SAS Strategy
Management, see “Trend Analysis” on page 160.

Access Trend Analysis from a Table

To access a trend analysis from a scorecard table, complete the following steps:
1 Open a project. For more information, see “Open a Project” on page 65.

2 Click [ on the toolbar.

3 Click [ to the left of an element and click Show Trend Analysis. The Trend
Analysis page appears.
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| Help~
Trend Analysis Gsas

Scorecard Project § Trend Analysis
i G L% |
» By Soorecards 3,200.00
>y 4
Hzeerecar 3,000.00 114
» By Seorecards [~ -
Elemert Tyoes B . 2,500.00
140
Objective 2,500.00
i 1.08
Perspect
B Perspective 24000 o
Elemerts T 2,200.00 -
L4 i 2,000.00 1.02
o
w3 1.00
@ 1,800.00
Bt L] 098
Meric Aftriute: = 1,600.00 e
a 1,400.00 o
-]
1,200.00 092
Curert Selection G pert (v E‘B—BMF—PVD Jun2008 ALg2008 Octz008 Dec2009 Feh2010 Apr2010 Jun2010
&R Target (M in Bigjmﬂp
[«_w e, |
Wetric: Actucl
Line size: ———
Eialule]
Color: -

Note: If the table view has been customized to display the Trend Analysis
page, you can also click = on the toolbar. For information, see “Customize a
Scorecard Table” on page 165.

4 To close the Trend Analysis page, click Close in the bottom left corner.

Select the Metric Attributes to Analyze

To select one or more metric attributes to analyze, complete the following steps:

1 Expand the left pane of the Trend Analysis page.

Trend Analysis

% Trend Analysis

| CollapsaExpand |

The left pane expands.
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Trend Analysis

rds orocarda 2]
By Scorecards
B Scorecard?)

Bl Scorecardg

» Bl Scorecard2

» B Scorecardd

Element Types [ perspoctive

leasure

B Objective

Elements
Metric Attributes
Broe
&8 Duration v
Current Selection | g8 4 ctual (W1 in Christianals
o »
Metric ctual
Line size:
Graph <4 H Il 3
Color: -

In the Scorecards section, select a scorecard.
In the Element Types section, select an element type.

Complete one of the following steps:

To analyze all of the metric attributes for an element, drag an element
from the Elements section onto the graph.

= — #) Reduce Printing, Waste
< Reduce Printing Waste m

1 40.00

The metric attribute values appear on the graph.
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=)

Apr2008  Jun2008  Aug2008  Oct2008 Dec2008 Feb2009 Apr2009

To analyze specific metric attributes, drag one or more metric attributes
from the Metric Attributes section onto the graph.

Note: The Current Selection section displays the items included in the
trend analysis.

5 Toremove an item from the trend analysis, select the item in the Current
Selection section and click Delete.

Customize the Display of a Metric Attribute

To customize how a metric attribute is displayed in the graph, complete the
following steps in the left pane of the Trend Analysis page:

1 In the Current Selection section, select an attribute.

2 Below the Current Selection section, specify the line size, type of graph,
and color.

Note: As you specify each property, the display is updated.

Navigate a Trend Analysis

To navigate a trend analysis, complete the following steps in the right pane of
the Trend Analysis page:

1 To change the start and end dates displayed in the analysis, move the start
and end points on the slider below the analysis. The default date range is
specified in the project options.
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%_”} il

2 To display the underlying data for a data point, pause the mouse pointer over
the data point.

18.00

[==]

Junz2008 Aug2008 Oct2008 Dec2008 Febz2009

3 To reload data for your selected time period, click &% in the upper right corner
of the right pane.

4 To save the analysis as an image, click in the upper right corner of the
right pane.
5 To print the analysis, click & in the upper right corner of the right pane.

6 To restore the default value, click |4 in the upper right corner of the right
pane.

Customize the Trend Analysis
You can display the trend analysis data as a chart or as a grid, and you can
change the display properties.

Note: Customized settings are applied only to the current project and the
current session.

To customize the trend analysis, complete the following steps in the right pane
of the Trend Analysis page:

1 To view the chart as a grid, clickI [

TIP When you hover on the column heading in the grid, a tooltip appears
that provides the full scorecard path of the element. Use this tooltip to
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differentiate between elements that have the same name but are in
different scorecards.

2 To return the view to a chart, click b |

3 To change the properties of the display, click . The General Properties

section appears.

General Properties
Show chart legend [
lgnore missing values IZI
Drop shadow for chart series |:|
Line chart series interpolation 'm'
Date unit interval 'm'
Date lahel interval 'm'
Diate range Startdate: 072009 | End date: |oFmi12010 |EF
Update Chart

4 Choose whether to show the chart legend, ignore missing values, and
display a drop shadow for the chart series.

5 Specify values for the line chart series interpolation, date unit interval, and
the date label interval.

6 To change the date range, type a date in the field or click [Z] to select the
start and end dates.

Note: The default date range is specified in the project options.

7 Click Update Chart.

8 To reload data for the selected time period, click &%. The customizations are
displayed.
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Overview 246

Link from a Scorecard to a View 246

Link from a Scorecard to a Document 247

Specify a Default View

You can specify that a type of view be the default view for a project. When you
open the project, the specified view appears automatically. For information about
specifying the default view, see “Customize Project Content Displayed by
Default” on page 69. You can specify any of the following views to be the
default:

Table
Aggregate
Association

Diagram

Set Default Options for a View

For each type of view, you can set default options. A view automatically uses
these options when you display your data in that type of view. For information
about setting default options, see “Customize Project Content Displayed by

Default” on page 69. You can set the options for the following types of views:

Table
Aggregate
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Association
Diagram

Trend Analysis

Save a View to a Portlet
If you have a view that you want to use for a portlet, you can create a new portlet
for that view and specify the portal page on which to create the portlet.

Note: This feature does not save a data-entry form to a portlet. Instead, it saves
a link to a portlet. When clicked the link opens the form in the Strategy
Management Builder.

To save a view to a portlet, complete the following steps in that view:

1 Click ¥5. The Add to Portlet page appears.
Add to Portlet 9sas

Portlet: <Create a New Portlet= -

—Mew Portlet Details
Portlet type: Performance Table
Portlet name: Finance Results
Partlet description:

Keywords:
Add to page Home v

2 To add to an existing portlet, select the portlet from the Portlet list.

Note: The list includes only those portlets that are of the same type of view
as the current view. For example, when you add a portlet from the table view,
the Portlet list includes only Performance Table portlets.

3 To create a new portlet and add to that portlet, complete the following steps:
a Click <Create a New Portlet> from the Portlet list.
b Specify the portlet name, description, and keywords.

c To specify the page on which the portlet appears, click Add to page and
select a page from the list.

Note: If you do not click Add to page, the portlet is created but is not
added to a page. You can search for the portlet later and add it to a page.

4 Click OK.
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Set the Default Date for Views

You can set the default date for use by all the views in a project. For information
about setting the default date, see “Customize Project Content Displayed by
Default” on page 69. This setting affects all the following types of views:

Table
Aggregate
Association

Diagram

Print a View

You print a view by first displaying a preview of the page in a browser window.

To print a view in Strategy Management Builder, complete the following steps:

1 Open a project or scorecard. See “Open a Project” on page 65 or “Open a
Scorecard” on page 88.

Display a view.

Click &.. A list appears.

A O DN

Type the name and click OK. A new browser window appears.

5 Print the page as you would print any web page in your browser.

Link to a View Using a Web Address

You can display the web address for a view within SAS Strategy Management
so that you can copy the web address. You can use the web address in any
application that accepts a web address, such as a bookmark in Microsoft
Internet Explorer or a desktop shortcut.

The web address contains information that is needed to recreate the view, such
as the column selection and the date.

To copy the web address for a view, complete the following steps:

1 Open a project or scorecard. See “Open a Project” on page 65 or “Open a
Scorecard” on page 88.

2 Click [&. The Show and Copy URL window appears.

3 To use the specified date when displaying the view, click Always use this
date.
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Note: This selection adds the date information to the web address. Every
time you load the view using this web address, the specified date is used for
the view. If you want to load the view using the current date, whatever that
date might be, then do not select this option.

Click Copy & Close.

Note: If you are using the Firefox web browser, the Copy & Close function
is not supported. Instead, right-click inside the URL field, click Select All,
and then click Copy.

If a Microsoft Internet Explorer runtime error message appears, complete the
following steps.

Note: These steps might vary depending on your version of Microsoft Internet
Explorer.

1

In Microsoft Internet Explorer, click Tools » Internet Options. The Internet
Options list appears.

Click the Advanced tab.

In the Settings list, in the Browsing category, clear Disable Script
Debugging (Internet Explorer).

Click OK.

Refresh the browser window.

Linking to Information from Within a

Scorecard

Overview

You can associate links with elements in a scorecard. When these links are
clicked, they can open other information, such as documents or SAS Strategy
Management views.

Link from a Scorecard to a View

Note: Before you can link to a view, you must have the web address for the
view. For information about copying the web address for a view, see “Link to a
View Using a Web Address” on page 245.

To add a link in a scorecard that opens a view, complete the following steps:

1

Open a project or scorecard. See “Open a Project” on page 65 or “Open a
Scorecard” on page 88.

For the element that you want to include the link to the view, click [ and
click Edit Metric Attributes. The Metric Values, Ranges, and Links page
appears.

In the Metric attribute list, select the metric attribute to use.
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4 In the metric attribute Links section, click metric attribute Link.

5 From the Link list, select the predefined link that opens the web address. For
more information, see “Managing Link Definitions” on page 78.

6 Click OK.

The scorecard appears with the link to the view. When the scorecard is
displayed in a portlet, the link to the view is available for business users.

Link from a Scorecard to a Document

To add a link in a scorecard that opens a document, such as a report or
presentation, complete the following steps:

1 Open a project or scorecard. See “Open a Project” on page 65 or “Open a
Scorecard” on page 88.

2 For the element that you want to include the link to the view, click [zl and
click Edit Metric Attributes. The Metric Values, Ranges, and Links page
appears.

3 In the Metric attribute list, select the metric attribute to use.
4 |n the metric attribute Links section, click metric attribute Link.

5 From the Link list, select the predefined link that opens a document. For
more information, see “Managing Link Definitions” on page 78.

6 Click OK.

The scorecard appears with a link to the document. When the scorecard is
displayed in a portlet, the link to the document is available for business users.
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Overview of Portlet Types

Portlet Types 251

Portlet Types

SAS Strategy Management provides the following portlets:

SAS Strategy Management classic portlets, which provide features for
navigating through and viewing strategy data and other content. Classic
portlets provide limited ways for the business user to adjust view properties.

SAS Strategy Management enhanced portlets and tiles, which provide
features for navigating through and viewing strategy data and other content.
These portlets and tiles provide enhanced ways for the business user to
adjust the view properties.

Note: The trend view implementations differ between the classic and enhanced
portlets. For more information, see “Trend Analysis” on page 160.
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Overview

A SAS Information Delivery Portal page must exist before you can create a
Strategy Management portlet. For information about creating a portal page, see
“Create a Page” on page 33.

Create a Portlet

To create and add a portlet to a portal page, complete the following steps:
1 Navigate to the page on which you want to add a portlet.

2 Click Customize » Edit Page » Edit Page Content. The Edit Page Content
page appears.
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Edit Page Content » Home

Layout: @ Bycolumn  © By grid

Mumnber of columns: ) q @ 2 @ 3
Colurnn width: b0 m b0 m

Portlet layout:

Column 1 Column 2

My Collection -
Bookmarks

Finance Results

X 4 & & 9

3 Click Add Portlets. The Add Portlets to Page page appears.

4 From the Portlet type list, select the type of portlet that you want to create:

Portlet Type

Performance aggregate table
Performance association
Performance data entry
Performance diagram
Performance dashboard
Performance table

Strategy management

Description

Aggregate table (classic style)
Association (classic style)
Data entry form (classic style)
Diagram (classic style)
Dashboard (classic style)
Table (classic style)

Strategy management (enhanced style)

5 Type the name, description, and keywords, if any.
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Add Portlets to Page + Home

Paortlet type:  Performance Table -
*hame: Finance Results|
Description
Keywords:
Add

Done

6 Click Add.

Note: If you want to add more portlets to the portal page, repeat steps 4, 5,
and 6.

7 When you are finished adding portlets, click Done.

8 On the Edit Page Content page, click OK. The new portlet appears on the
page.

You must edit the portlet to customize it and make it usable.

For information about editing enhanced-style portlets, see Chapter 27,
“Editing a Strategy Management Enhanced Portlet and Its Tiles,” on page
263.

For information about editing classic-style portlets, see Chapter 28, “Editing
Classic-Style Portlets,” on page 285.

Change the Layout of Portlets

To change the layout of the portlets on the portal page, complete the following
steps:

1 Navigate to the page from which you want to delete a portlet.

2 Click Customize » Edit Page » Edit Page Content. The Edit Page Content
page appears.
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Edit Page Content » Home

Layout: @ Bycolumn O By grid
Mumnber of columns: ) q @ 2 @ 3
Colurnn width: b0 m b0 m

Portlet layout:

Column 1 Column 2
My Collection - Finance Results -
Bookmarks

X 4 & & 9

Add Portlets. ..

ﬂ Cancel

3 For the layout, click By column to lay out the portlets in columns. Click By
grid to lay out the portlets using a grid.

Note: If you use a grid, you can fit more portlets on a page, especially by
stacking a number of small portlets next to a large portlet.

4 Click the number of columns that you want to use.

5 To adjust the width of the columns, type the percentage value that you want
to use for each column.

6 Specify the portlet layout in the Portlet layout section.

If you selected By column, the layout selections appear in lists. To move
a portlet to another column list, click the portlet and click the Right and
Left arrows. If you want to move a portlet within a column, click the Up or
Down arrows. To delete a portlet, click X.

If you selected By grid, the layout selections appear in lists. Select one or
more portlets for each row. If you want a portlet to span more than one
column, select that portlet in each affected column list for that row. Click
Add Row to add more rows to the page.
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Edit Page Content - Home

Layout: © By column @ By grid
Murmber of colurns: © 4 @ 2 ® 3
Column width: 50 % 50 %
Portlet layout:
Row 1: My Collection v Bookmarks
Row2:  Emply v Empty

Portlets:
Bookmarks -

Finance Results
My Collection

Add Portlets. ..

7 Click OK. The new portlet layout is saved.

Delete a Portlet

To delete a portlet from a portal page, complete the following steps:

1 Navigate to the page from which you want to delete a portlet.

2 Click Customize

page appears.

Edit Page

Edit Page Content - Home

Layout: @ Bycolumn O By grid
Mumber of columns: 0 4 @ 2 ® 13
Colurnn width: B0 = B0 %
Portlet layout:
Column 1 Column 2
Wy Collection -~ 4 Finance Results
Bookmarks
+
=Y
&
- X
add Portlets...

Edit Page Content. The Edit Page Content
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3 In the Portlet layout section, select the portlet to delete and click .

4 Click OK. The new portlet is deleted from on the page.
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Your First Look at the SAS Strategy
Management Enhanced Portlet Interface

When you first create a SAS Strategy Management enhanced portlet, it provides
the following interface:

Figure 26.1 SAS Strategy Management Enhanced Portlet Interface

1 —[ Strategy Management Enhanced Portlet - | X

2 —[ H IE |v 10/119/2012 2 Project LE Workflow @

3 by
teqy M il view:

4 —

1

Title bar. It displays a customized portlet title and the Maximize (I:l) and
Restore ( I5) buttons.

2 Toolbar. For more information, see “The Toolbar” on page 260.

3 Help for the SAS Strategy Management enhanced portlet.

4 Content area. One or more tiles appear in this area.
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The Toolbar

You can perform the following actions on the toolbar:
Click k to save the layout configuration of the tiles within the portlet.

Click [, to edit the portlet settings. For more information, see “Edit the SAS
Strategy Management Enhanced Portlet” on page 263.

Note: This button is not available for business users.

Click # to suggest new elements to include in a project. You can customize
whether the portlet accepts element suggestions from business users.

Click [E to save the content of the portlet as a mobile Bl report.
The toolbar also provides a list of available actions.

Click B¥ to change the global date. You can enable business users to change
the date. In this example, the date feature is enabled.

A link that opens the project in Strategy Management Builder. You can
customize whether the portlet displays this link to business users.

Your First Look at a Tile

A portlet can contain one or more tiles. A tile is like a window. A tile can contain
a view. You can display the following SAS Strategy Management views in a tile:

table
aggregate
association
diagram
gauge

In the SAS Strategy Management enhanced portlet, a tile can also display the
following information:

a scorecard hierarchy, which is a hierarchical tree that displays all the
scorecards in a project

a trend analysis in which the business user can drag data from other tiles to
analyze trends in the data

When you add a tile, you can customize many of its features for use by your
business users.
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Figure 26.2 Tile Interface Example

1 {_Perfurmam:e goals |
[ TS Scorecard:  Worldwide @
2 Drate: Elementtype: | Objective | * Columns: l Range Ferformance | 'J

E
l .
I

Name Period Actual ﬁ

Revenues B & AUGZOTD $24,655,000 o
Expenses 2 5 Auezo ¥ 516,461,740 ]

3 Profitability % = AUGZNMO $28.193.240 >
Customers 7 5 AJGzOlo L] [ ]

AN

| Gustorner Satisf: % AUGZ0M0 T8%

Title bar. The title bar displays a customized tile title and the Maximize (E)
and Restore (5) buttons.

2 The tile control panel. For more information, see “The Tile Control Panel” on
page 261.

3 Content area. The tile data appears in this area.

The Tile Control Panel

You can customize whether the tile control panel is open by default. Users can
close and open the tile control panel by clicking the tile control panel arrow.
Depending on the type of tile, one or more of the following features appear in the
tile control panel:

1 2 3
Performance goals C|l
(,5 E - Scorecard;  Worldwide i
Date: Elementtype: | Ohjective [~ Columns: [ Range Pelrfgrmance | 'J

4 5 6

1 The tile toolbar. The toolbar provides the Print and Refresh icons. (The trend
analysis tile includes additional icons.) You can customize whether the
toolbar is available to business users.

2 The scorecard name. Click this link to open the scorecard in Strategy
Management Builder. You can customize whether the scorecard name link is
available to business users.

3 Information icon. Click this icon to view a short tip or other information about
the tile. This information can include which tiles are synchronized with the
scorecard hierarchy and whether the tile uses the global date.
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4

5

Date. You can enable business users to change the date. In this example,
the date feature is disabled.

Element type list. Business users can use this list to control their view of the
tile data. You customize whether this list is available for business users, what
selections are available in the list, and which selection is the default.

Columns list. Business users can use this list to control their view of the tile
data. You customize whether this list is available for business users, what
selections are available in the list, and which selection is the default.
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Edit the SAS Strategy Management
Enhanced Portlet

When you edit the SAS Strategy Management enhanced portlet, you can add
tiles to display in the portlet and specify global settings that affect the tiles. To
edit the SAS Strategy Management enhanced portlet:

1 Click [, in the portlet. The Edit Strategy Management Portlet page appears.
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Edit Strategy Management Portlet

— ldentificatian — Project and Date
Marne: #(1H2013 | Froject: 2013 Strategy | » |
Description: |Z| Dizplay project name

(O Enable the linkthat opens Strategy Managernent

Keywards: | |

(=) Disable the link that opens Strategy Managernent

Portlet height (pixels): 800 |

(=) Currentdate

- ) - - .
() Relative period: |D H Type: |Dav | *

() Use this date: I:lgg;

|Z| Enahle users to change the global date

[] Enable users to suggest elements ®

— Tiles
Ayailable tiles: Selected tiles: Default scorecard
ﬁTable R E Table View Scorecards
Hagorenate View Trend Analysis v [ 2013 Steategy
aAssnciation View &% Searecard Hierarchy v S, warldwide
:E_V .
Eall Trend Analysis
= i w05 Ameticas
) Gauge View

» B Asia
» 5 Europe

AR 4

% Scorecard Hierarchy
Diagram Wiew

Edit tile properies. ..
I

2 In the Identification section, complete the following steps:
a Edit the portlet name.

b Edit the portlet description. A description can make similar portlets easier
to identify.

c Edit the keywords. Keywords can make a portlet search successful. Make
sure you develop a list of keywords and use the keywords consistently.

d Specify the height of the portlet, in pixels.

TIP If you want the portlet to contain several tiles, be sure to provide
enough height to view the tiles easily.

3 In the Project and Date section, complete the following steps:

a In the Project list, select the project that you want to view in the portlet.

Note: You must specify the project before you can define any tiles.

b To display the name of the project in the portlet toolbar, select Display
project name. By default, the project name is a link that opens the
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project in Strategy Management Builder. To disable this link, select
Disable the link that opens Strategy Management.

c To specify the date to use in the portlet, do one of the following:
To specify the current date, select Current date.

To specify a date relative to the current date, select Relative period,
type or select a value in the field, and then select a value from the
Type list.

TIP Negative values indicate a date in the past. Positive values
indicate a date in the future. For example, if you select —1 and
specify the period type of Month, the portlet uses a date that is one
month in the past relative to the current date.

To always use a specified date, select Use this date. Then enter a
date in the field or click E8 to choose a date from the calendar.

d Select Enable users to change the global date to give business users a
way to change the global date while they are working in the portlet. The
date change does not persist from one session to the next.

e Select Enable users to suggest elements to give business users a way
to communicate suggestions to you about adding elements to the
strategy.

Note: When you select this check box, the # button appears in the
portlet control panel. This button opens the Suggest New Elements list.

Note: You must also select Allow Suggested Elements in the template
that is associated with the project that you are using to create this portlet.

4 In the Tiles section, complete the following steps to specify which tiles to
add, as well as the properties for each tile that you add.

Note: You must specify a project in the Project and Date section before you
can specify tiles.

a Select a tile from the Available tiles list, and click B to add the tile to the
Selected tiles list.

Note: To add all tile types to the portlet, click B.

Note: You can add multiple versions of the same tile type to your portlet
except for the scorecard hierarchy tile. You can add only one scorecard
hierarchy tile to a portlet.

b To change the name of a tile, double-click the tile in the Selected tiles
list, and enter the new name.

c To change the order of a tile, drag the tile up or down to its new location
in the Selected tiles list.

d If you want to delete a tile, select the tile in the Selected tiles list, and
click .

Note: To remove all the tiles in the Selected tiles list, click 4@.

e To edit the properties for a tile, select the tile in the Selected tiles list,
and select Edit Tile Properties. For more information, see the following
sections:
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Tile Section

Table “Edit the Table View Tile Properties” on page 267
Aggregate “Edit the Aggregate View Tile Properties” on page 270
Association “Edit the Association View Tile Properties” on page 273
Diagram “Edit the Diagram View Tile Properties” on page 275
Gauge “Edit the Gauge View Tile Properties” on page 277

Trend analysis  “Edit the Trend Analysis Tile Properties” on page 281

Scorecard “The Scorecard Hierarchy Tile and Synchronization” on page
hierarchy 267

Note: The scorecard hierarchy tile does not have any
properties that can be edited. The Edit Tile Properties
button is unavailable.

f From the Default scorecard tree, select the scorecard that you want to
use as the default.

5 Click Save to save the changes to the portlet properties and exit the page.
Click Cancel to exit the page without saving any changes, including any
changes to the tile properties.

You can make additional changes to the SAS Strategy Management enhanced
portlet from within the portlet itself. For more information, see “Configure the Tile
Layout in the Enhanced Portlet” on page 283.

Edit Tiles for the SAS Strategy
Management Enhanced Portlet

Overview
When you edit tile properties, you can configure the following tile features:

whether table, aggregate, or association tile data is synchronized with any
selections that users make when they are navigating in the scorecard
hierarchy tile

the date that is used by the tile

the exploration controls that are available for your business user, as well as
whether the tile control panel and toolbar are displayed

which buttons are displayed in the tile data
other tile-specific features

To understand what you can configure and customize, you must understand the
features of a tile. For detailed descriptions, see “Your First Look at a Tile” on
page 260.
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Global Date and Local Date Options

You can customize whether a tile uses its own local date setting or the global
date setting from the portlet. If you set a tile to use the global date setting, all
other date settings for that tile are disabled and business users cannot change
the date setting when they are exploring the data in that tile.

The Scorecard Hierarchy Tile and
Synchronization

If you add a scorecard hierarchy tile to the SAS Strategy Management portlet,
you can customize any table tile, aggregate tile, association tile, or gauge tile to
dynamically synchronize its data with the current selection in the scorecard
hierarchy tile. For example, suppose you have a table that displays the data for
Distribution, but you want to view data for another scorecard. In the following
scorecard hierarchy tile, click Retailers to automatically display the data for
Retailers:

Scorecard Hierarchy =]
v [ 2013 Strategy
v ) Worldwide
w5 Americas
w5 Asia
v B5, Europe
f5 Western Europe

In order for a tile to synchronize with the scorecard hierarchy tile, you must add
a scorecard hierarchy tile to the portlet. The scorecard hierarchy tile does not
have any properties to edit so the Edit Tile Properties button is unavailable.
However, you must edit the properties for each tile that you want to be
synchronized with the scorecard hierarchy tile. For example, if you want a table
tile to synchronize with the scorecard hierarchy, you must edit the table tile
properties. In the tile properties, click Synchronize this tile with the scorecard
hierarchy tile.

Note: This option is available only for table tiles, aggregate tiles, association
tiles, and gauge tiles.

Note: A portlet can include only one scorecard hierarchy tile.

TIP You can create two identical tiles with the same data, but then customize
only one to synchronize. If you synchronize only one tile, business users have
a way to compare data between two scorecards.

Edit the Table View Tile Properties

Note: To edit tile properties, you must edit the Strategy Management enhanced
portlet properties. Select the tile to edit in the Selected tiles list, and click Edit
Tile Properties.
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E Synchronize this tile with the scorecard hierarchy tile @

Table View x
— Scorecard — Exploration Controls
If you want users to explore their data, specify the controls to display in the tile bar and the default settings.
[ 2013 Strateqy Default element type Perspective | »
F& worldwide [¥] Display element type control
f%, Americas
- Default column selection: | Default (none) |*
e Asia
r'.'E', Europe E’I Display column selection contral
Define Choices..

E Display scorecard name — Additional Display tems

(=) Enable the link that opens Strategy Management

() Disable the link that opens Strategy Management Thresholds: Global and personal | v

Other; [¥] Trend chart
— Date
[] Period
Current date [¥] Comments
elative period: | Type: | D
Relative period: |0 =] yp Day [¥] Comment alerts
Use this date E Lock columns in view: @
Enable users to change the date Tile control panel: [] Display an open tile control panel by default
V] Use global date settings ® [¥] Display the toolbar in the tile control panel

To edit the table view tile:

1 In the Scorecard section, specify the applicable options:

If you do not want the data in this tile to be synchronized with the
scorecard hierarchy tile, select the scorecard that you want to view in this

tile from the Scorecard tree.

If you do want the data in this tile to be synchronized with any tiles that
you selected in the scorecard hierarchy tile, select Synchronize this tile
with the scorecard hierarchy tile. For more information, see “The
Scorecard Hierarchy Tile and Synchronization” on page 267.

If you want the scorecard name to appear in the tile control panel, select
Display scorecard name. By default, the scorecard name is a link that
opens the scorecard in the Strategy Management Builder. To disable this
link, select Disable the link that opens Strategy Management.

2 In the Date section, specify the applicable options:

To specify the current date, select Current date.

To specify a date relative to the current date, select Relative period,
enter or select a value in the field, and then select a value from the Type

list.

To always use a specified date, select Use this date. Then enter a date

in the field or click f to choose a date from the calendar.

To give business users a way to change the date while they are working
in the tile, select Enable users to change the date. The date change

does not persist from one session to the next.
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If you want the tile to use the date settings that you specified on the
Strategy Management portlet Properties page, select Use global date
settings.

Note: If you select this option, all other date settings for this tile are
disabled. For more information, see “Global Date and Local Date Options”
on page 267.

3 In the Exploration Controls section, you can specify whether lists of
selections are available for business users to control their view of the tile
data. The lists appear in the tile control panel.

In the Default element type list, select the element type that you want to
appear as the default selection in the Element type list in the tile control
panel.

Note: If you do not select the Display element type control option, the
default element type selection is the only element type that is available for
this tile.

Select Display element type control to display the Element type list in
the tile control panel.

In the Default column selection list, select the column that you want to
appear as the default selection in the Columns list in the tile control
panel.

Note: If you do not select the Display column selection control option,
the default column selection is the only column selection that is available
for this tile.

If you want the Columns list to appear in the tile control panel for
business users, select Display column selection control.

Click Define Choices to open the Define Choices window. Expand the
element types to view the columns that are available for you to select. In
the tree, you can select the choices that you want the lists to provide to
your business user.

4 In the Additional Display Items section, specify the applicable options:

In the Thresholds list, select whether you want global threshold
indicators, personal threshold indicators, both indicators, or no indicators
to appear in the tile content.

In the Other group, select any other indicators that you want to appear in

the tile.

Indicator Icon Description

Trend chart i Opens a noninteractive trend chart view of the
data. This option uses the date range that is
specified in the project options.
Note: Do not confuse the noninteractive trend
chart with the interactive trend analysis tile.

Period None Displays the period of time for which the element
data was collected.

Comments %J Provides a way for users to make comments about

action the data.
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Indicator Icon Description
Comments Eﬂ If comment alerts are set, indicates that comments
alerts are available about the data.

If you want to lock one or more columns so that they remain in view when
the table scrolls to the right, make a selection from the Lock columns in
view list. This setting is useful for very wide tables. The number that you
select indicates how many columns are locked, beginning with column 1.
For example, if you select 3, then columns 1, 2, and 3 are locked. To
remove the lock, select 0.

If you want the tile control panel open by default, select Display an open
tile control panel by default. Business users can collapse the tile control
panel if they do not want to view it.

If you want the toolbar to appear in the tile control panel, select Display
the toolbar in the tile control panel.

Note: If you do not display the toolbar, business users do not have
access to these tools, including the ability to print.

5 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

Edit the Aggregate View Tile Properties

Note: To edit tile properties, you must edit the Strategy Management enhanced
portlet properties. Select the tile to edit in the Selected tiles list, and click Edit
Tile Properties.
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Aggregate View

— Scorecard

[\ 2012 Strateqgy
fi5 Worldwide
I3, Americas
g Asia

% Europe

— Exploration Controls

Default element type: Perspective | w

[] Display element type contral

Default column selection: |Defau|t (none) | » |

[] Display column selection contral

Define Choices...

[+] Synchronize this tile with the scorecard hierarchy tile ®
[v] Display scorecard name
(=) Enable the link that opens Strategy Management

(O Disable the link that opens Strategy Management

— Additional Display ltems

Thresholds: |[n0ne} | v |

Lock columns in view: (©)

— Date

Current date

Relative period: |0

Use this date:

i View by: (&) Metric atfribute () Scorecard
Enable users to change the date

[] Use global date settings @

Tile control panel: [] Display an open tile control panel by default

[] Display the toolbar in the tile control panel

P |

To edit the aggregate view tile:

In the Scorecard section, specify the applicable options:

If you do not want the data in this tile to be synchronized with the
scorecard hierarchy tile, select the scorecard that you want to view in this
tile from the Scorecard tree.

If you do want the data in this tile to be synchronized with any tiles that
you selected in the scorecard hierarchy tile, select Synchronize this tile
with the scorecard hierarchy tile. For more information, see “The
Scorecard Hierarchy Tile and Synchronization” on page 267.

If you want the scorecard name to appear in the tile control panel, select
Display scorecard name. By default, the scorecard name is a link that
opens the scorecard in the Strategy Management Builder. To disable this
link, select Disable the link that opens Strategy Management.

In the Date section, specify the applicable options:

To specify the current date, select Current date.

To specify a date relative to the current date, select Relative period,
enter or select a value in the field, and then select a value from the Type
list.

To always use a specified date, select Use this date. Then enter a date
in the field or click f# to choose a date from the calendar.
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To give business users a way to change the date while they are working
in the tile, select Enable users to change the date. The date change
does not persist from one session to the next.

If you want the tile to use the date settings that you specified on the
Strategy Management portlet Properties page, select Use global date
settings.

Note: If you select this option, all other date settings for this tile are
disabled. For more information, see “Global Date and Local Date Options”
on page 267.

3 In the Exploration Controls section, you can specify whether lists of
selections are available for business users to control their view of the tile
data. The lists appear in the tile control panel.

In the Default element type list, select the element type that you want to
appear as the default selection in the Element type list in the tile control
panel.

Note: If you do not select the Display element type control option, the
default element type selection is the only element type that is available for
this tile.

Select Display element type control to display the Element type list in
the tile control panel.

In the Default column selection list, select the column that you want to
appear as the default selection in the Columns list in the tile control
panel.

Note: If you do not select the Display column selection control option,
the default column selection is the only column selection that is available
for this tile.

If you want the Columns list to appear in the tile control panel for
business users, select Display column selection control.

Click Define Choices to open the Define Choices window. Expand the
element types to view the columns that are available for you to select. In
the tree, you can select the choices that you want the lists to provide to
your business user.

4 In the Additional Display Items section, specify the applicable options:

In the Thresholds list, select whether you want global threshold
indicators, personal threshold indicators, both indicators, or no indicators
to appear in the tile content.

If you want to lock one or more columns so that they remain in view when
the table scrolls to the right, make a selection from the Lock columns in
view list. This setting is useful for very wide tables. The number that you
select indicates how many columns are locked, beginning with column 1.
For example, if you select 3, then columns 1, 2, and 3 are locked. To
remove the lock, select 0.

Note: For aggregate tables that contain grouped columns, the value that
you select identifies the columns to lock by the top-level group. The
subgroup columns are locked with the affected top-level columns, but you
cannot lock subgroup columns individually.
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If you want the tile control panel open by default, select Display an open
tile control panel by default. Business users can collapse the tile control
panel if they do not want to view it.

If you want the toolbar to appear in the tile control panel, select Display
the toolbar in the tile control panel.

Note: If you do not display the toolbar, business users do not have
access to these tools, including the ability to print.

Select whether the default view of the aggregate data is displayed by
metric attribute or scorecard.

5 Click OK to save your changes and exit. Click Cancel to exit without saving

any changes.

Edit the Association View Tile Properties

Note: To edit tile properties, you must edit the Strategy Management enhanced
portlet properties. Select the tile to edit in the Selected tiles list, and click Edit

Tile Properties.
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To edit the association view tile:

1 Inthe Scorecard section, specify the applicable options:
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If you do not want the data in this tile to be synchronized with the
scorecard hierarchy tile, select the scorecard that you want to view in this
tile from the Scorecard tree.

If you do want the data in this tile to be synchronized with any tiles that
you selected in the scorecard hierarchy tile, select Synchronize this tile
with the scorecard hierarchy tile. For more information, see “The
Scorecard Hierarchy Tile and Synchronization” on page 267.

If you want the scorecard name to appear in the tile control panel, select
Display scorecard name. By default, the scorecard name is a link that
opens the scorecard in the Strategy Management Builder. To disable this
link, select Disable the link that opens Strategy Management.

2 In the Date section, specify the applicable options:
To specify the current date, select Current date.

To specify a date relative to the current date, select Relative period,
enter or select a value in the field, and then select a value from the Type
list.

To always use a specified date, select Use this date. Then enter a date
in the field or click fi#] to choose a date from the calendar.

To give business users a way to change the date while they are working
in the tile, select Enable users to change the date. The date change
does not persist from one session to the next.

If you want the tile to use the date settings that you specified on the
Strategy Management portlet Properties page, select Use global date
settings.

Note: If you select this option, all other date settings for this tile are
disabled. For more information, see “Global Date and Local Date Options”
on page 267.

3 In the Exploration Controls section, you can specify whether lists of
selections are available for business users to control their view of the tile
data. The lists appear in the tile control panel.

In the Association list, select the association that you want to appear as
the default selection in the Association list in the tile control panel.

Click Display association control to display the Association list in the
tile control panel.

In the Default column selection list, select the column that you want to
appear as the default selection in the Columns list in the tile control
panel.

Note: If you do not select the Display column selection control option,
the default column selection is the only column selection that is available
for this tile.

If you want the Columns list to appear in the tile control panel for
business users, select Display column selection control.

Click Define Choices to open the Define Choices window. Expand the
element types to view the columns that are available for you to select. In
the tree, you can select the choices that you want the lists to provide to
your business user.

4 In the Additional Display Items section, specify the applicable options:
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In the Thresholds list, select whether you want global threshold
indicators, personal threshold indicators, both indicators, or no indicators
to appear in the tile content.

In the Other group, select any other indicators that you want to appear in

the tile.

Indicator Icon Description

Trend chart i Opens a noninteractive trend chart view of the
data. This option uses the date range that is
specified in the project options.
Note: Do not confuse the noninteractive trend
chart with the interactive trend analysis tile.

Comments C%,} Provides a way for users to make comments about

action the data.

Comments C.Eﬂ If comment alerts are set, indicates that comments

alerts are available about the data.

If you want to lock one or more columns so that they remain in view when
the table scrolls to the right, make a selection from the Lock columns in
view list. This setting is useful for very wide tables. The number that you
select indicates how many columns are locked, beginning with column 1.
For example, if you select 3, then columns 1, 2, and 3 are locked. To
remove the lock, select 0.

If you want the tile control panel open by default, select Display an open
tile control panel by default. Business users can collapse the tile control
panel if they do not want to view it.

If you want the toolbar to appear in the tile control panel, select Display
the toolbar in the tile control panel.

Note: If you do not display the toolbar, business users do not have
access to these tools, including the ability to print.

5 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

Edit the Diagram View Tile Properties

Note: To edit tile properties, you must edit the Strategy Management enhanced
portlet properties. Select the tile to edit in the Selected tiles list, and click Edit
Tile Properties.
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Diagram View x
— Scorecard — Date
Scorecards (=) Current date
v i@y Worldwide I o
se this date:

»E5 Americas O |:|

hr';:"', Asia E] Enable users to change the date

» B35, Eurape

[ ] Use global date settings @

|:| Synchronize this tile with the scorecard hierarchy tile @
|:| Display scorecard name
Enable the link that opens Strategy Management

Disable the link that opens Strategy Management

[] Enable users to select the diagram to view

Diagram: | Strategy |
Zoom: 100% |+

To edit the Diagram View tile:

1 In the Scorecard section, specify the applicable options:

If you do not want the data in this tile to be synchronized with the
scorecard hierarchy tile, select the scorecard that you want to view in this
tile from the Scorecard tree.

If you do want the data in this tile to be synchronized with any tiles that
you selected in the scorecard hierarchy tile, select Synchronize this tile
with the scorecard hierarchy tile. For more information, see “The
Scorecard Hierarchy Tile and Synchronization” on page 267.

If you want the scorecard name to appear in the tile control panel, select
Display scorecard name. By default, the scorecard name is a link that
opens the scorecard in the Strategy Management Builder. To disable this
link, select Disable the link that opens Strategy Management.

2 In the Date section, specify the applicable options:
To specify the current date, select Current date.

To specify a date relative to the current date, select Relative period,
enter or select a value in the field, and then select a value from the Type
list.

To always use a specified date, select Use this date. Then enter a date
in the field or click f# to choose a date from the calendar.
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To give business users a way to change the date while they are working
in the tile, select Enable users to change the date. The date change
does not persist from one session to the next.

If you want the tile to use the date settings that you specified on the

Strategy Management portlet Properties page, select Use global date
settings.

Note: If you select this option, all other date settings for this tile are
disabled. For more information, see “Global Date and Local Date Options”
on page 267.

3 In the Diagram section, specify the applicable options:

To give business users a way to change the diagram while they are
working in the tile, select Enable users to select the diagram to view.
The diagram selection does not persist from one session to the next.

In the Diagram list, select the diagram that you want to display in the tile.

In the Zoom list, select the percentage of magnification that you want to
use when the diagram appears in the tile.

4 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

Edit the Gauge View Tile Properties

Note: To edit tile properties, you must edit the Strategy Management enhanced

portlet properties. Select the tile to edit in the Selected tiles list, and click Edit
Tile Properties.
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Gauge View x
— Date — Element type
@ Current date Element type: |F'erspe|:1ive Iv |
() Relative period: |U I%' Type: |Day |~ | Group by attribute: |[n0ne} | = |
O Use this date: I:IE Default attribute value: |[n0ne} | - |
lz‘ S R G TR TI R TR 6 D Show only the default attribute value
(] Use dlobal date setings ® Threshold filter: [N fitter I+]
— Gauges — Additional Display ltems
Gauge type: & Bullet | A | Specify whether to display the following options:
Size: |Sma|l |+ | Thresholds: |(n0ne} | v |
Display: |H0rimnta| | - | Other: D Range values
Primary indicator: |_*\|:1ua| |+ | [] Metricvalues
Secondary indicator: |[n0ne} |~ | [] Comments
Skin: |[none} |+ | [ Trend chart
[] Append scorecard name to element name
Display scorecard name
Enable the link that opens Strategy Management
Disable the link that opens Strategy Management
Tile control panel: D Display an open tile control panel by default
|:| Display the toolbar in the tile control panel
— Elements
D Show all elements and synchronize this tile with the scorecard hierarchy tile @ | Remove Selected Elements |
Scorecard Element Type Element []
Worldwide Perspective Finance []
Waorldwide Perspective Customer ]

To edit the gauge view tile:

1 In the Date section, specify the applicable options:
To specify the current date, select Current date.

To specify a date relative to the current date, select Relative period,
enter or select a value in the field, and then select a value from the Type
list.

To always use a specified date, select Use this date. Then enter a date
in the field or click f] to choose a date from the calendar.

To give business users a way to change the date while they are working
in the tile, select Enable users to change the date. The date change
does not persist from one session to the next.
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If you want the tile to use the date settings that you specified on the
Strategy Management portlet Properties page, select Use global date
settings.

Note: If you select this option, all other date settings for this tile are
disabled. For more information, see “Global Date and Local Date Options”
on page 267.

In the Element type section, complete the following steps:

d

e

In the Element type list, select the element type that you want the gauge
to use.

(Optional) In the Group by attribute list, select the attribute to use for
grouping your gauge data.

Note: If you have specified an association between the element type that
you selected in step 2a and another element type, then the second
element type is called an attribute of the first element type. You can
choose to display your gauge data by this attribute.

(Optional) In the Default attribute value list, select the default value to
use for the attribute that you selected in the previous step.

Note: The attribute that you selected in step 2b is an element type. The
values in the Default attribute value list are elements that are defined by
this element type.

(Optional) Click Show only the default attribute value.

In the Threshold filter list, specify how you want to filter the thresholds.

In the Gauges section, complete the following steps:

In the Gauge type list, select the type of gauge that you want to display in
the tile.

Note: The options that are available in this section vary depending on the
gauge type that you selected.

In the Size list, select whether you want the gauge to be small, medium,
or large in size.

In the Display list, further refine how you want the gauges to appear in
the tile.

Note: The available selections vary depending on the gauge type that
you selected. For example, for most gauge types, you can select whether
the gauges appear in vertical or horizontal layout. However, for
speedometers, this selection controls whether the speedometer is a
quarter circle, half circle, three-quarter circle, or full circle.

In the Primary indicator list, select the element that you want to display
as the primary indicator.

Note: The primary and secondary indicators must match the range
definitions that you set when you created a range in Strategy
Management Builder.

In the Secondary indicator list, select the element that you want to
display as the secondary indicator.
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f In the Skin list, select the skin or display theme that you want the gauge
to use.

4 In the Additional Display Items section, specify the applicable options:

In the Thresholds list, select whether you want global threshold
indicators, personal threshold indicators, both indicators, or no indicators
to appear in the tile content.

If you want the gauge to display the lower and upper range values of the
gauge, select Range values.

Note: You define these values in Strategy Management Builder when
you define the range.

If you want the primary indicator value to appear with the gauge, select
Metric values.

If you want users to view comments and make comments about the
gauge, select Comments.

If you want to provide a noninteractive trend chart view of the data, select
Trend chart. This option uses the date range that is specified in the
project options.

Note: Do not confuse the noninteractive trend chart with the interactive
trend analysis tile.

If you want the scorecard and element names to be appended in the
gauge, select Append scorecard name to element name.

If you want the tile control panel to be open by default, select Display an
open tile control panel by default. The user can collapse the tile control
panel if they do not want to view it.

If you want the tile toolbar to appear in the tile, click Display the toolbar
in the tile control panel.

Note: If you do not display the toolbar, business users do not have
access to these tools, including the ability to print.

If you want the scorecard name to appear in the tile control panel, select
Display scorecard name. By default, the scorecard name is a link that
opens the scorecard in Strategy Management Builder. To disable this link,
select Disable the link that opens Strategy Management.

5 In the Elements section, make the applicable selections:

If you want all elements to appear in the tile, and you want the tile to
synchronize data to synchronize with the scorecard hierarchy tile, select
Show all elements and synchronize this tile with the scorecard
hierarchy tile.

If you want only some elements to appear in the tile, click Select
Elements. In the Select Elements window, make your selections and
click OK.

To remove an element, select the check box in the element row and click
Remove Selected Elements. To remove all elements from the table,
click the check box in the table heading.

6 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.
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Edit the Trend Analysis Tile Properties

Note: To edit tile properties, you must edit the Strategy Management enhanced
portlet properties. Select the tile to edit in the Selected tiles list, and click Edit
Tile Properties.

Trend Analysis x
— Date Range — Global Options

Start date: |05/24/2012 | End date: |05/24/2013 |8} [] Gridlines

E] Enable users to change the date E] Display legend

(*) Across () Down

Location: |Upperright | » |

— Additional Display ltems

Tile control panel: |:| Display an open tile control panel by default

|:| Dizsplay the toolbar in the tile control panel

— Graph Options

Graph type: Color: ]

Style: Curve | [¥] Show markers
Dash type: |30|id | = | Marker: |.&sterisk | » |
[[] Break line drawing for missing data values in line graphs Line weight E

[] Show data labels

[] Show data tips

A

To edit the trend analysis tile:
1 In the Date Range section, specify the start date and end date of the trend.

a To specify the start date, type a date in the Start date field or click # to
choose a date from the calendar.

b To specify the end date, type a date in the End date field or click f# to
choose a date from the calendar.

c (Optional) To give business users a way to change the date while they
are working in the tile, select Enable users to change the date. The
date change does not persist from one session to the next.

2 In the Additional Display Items section, specify the applicable options:
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3

4

If you want the tile control panel to be open by default, select Display an
open tile control panel by default. The user can collapse the tile control
panel if they do not want to view it.

If you want the tile toolbar to appear in the tile, select Display the toolbar
in the tile control panel.

Note: If you do not display the toolbar, business users do not have
access to these tools, including the ability to print.

In the Graph Options section, specify how you want the graph to be drawn:

In the Graph type list, select the type of graph that you want to display in
the trend analysis. Available selections are Line, Band, Bar, and Scatter.

Select the applicable options for the graph type that you chose. Options
vary depending on the graph type that you selected.

Graph

Type Available Options

All Click the Color icon to select the color of the graph type.
types

If you want each data value to be labeled in the graph, select
Show data labels.

Line In the Style list, select the style of line that you want to use.

In the Dash type list, select the type of dash that you want to use
to form the line.

If you want the line that is drawn in the graph to break each time a
data value is missing, select Break line drawing for missing
data values in line graphs.

In the Line weight list, select the line thickness to use for the line
graph.

If you want data tips to appear in the line graph, select Show data
tips.

If you want markers to appear in the graph, select Show markers.
You can select the type of marker that you want the graph to use
from the Marker list.

Scatter In the Marker list, select the type of marker that you want the graph
to use.

In the Global Options section, specify the applicable options:

If you want grid lines to appear in the trend analysis, select Grid lines.

If you want to display the legend in the trend analysis, select Display
legend. When you choose to display the legend, you can also specify
whether the legend appears across the width of the tile or is displayed
along the height of the tile. In the Location list, select the location in the
tile to display the legend.

5 Click OK to save your changes and exit. Click Cancel to exit without saving

any changes.
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Configure the Tile Layout in the Enhanced
Portlet

After you create the Strategy Management enhanced portlet and its tiles, you
can refine the tile layout in the following ways:

Resize a tile. Hover on the tile border to display handles. Click a handle and
drag to resize the tile.

Rearrange the tiles in columns or rows. Click the title bar of a tile and drag it
within the portlet. A movement icon appears with the mouse pointer, which
indicates that you are dragging a tile within the portlet. The following partial
display shows the mouse pointer and the accompanying movement icon:

L

As you drag the tile, gray boxes guide you to rows and columns into which
you can drop the tile. When you drop the tile, the other tiles in the portlet
automatically accommodate the dropped tile.

For example, if you want to move a tile to create a column on the left side of
the portlet, drag the tile left border of the portlet.

b

Trend Analysis (=]

A W‘

Drop the tile near the border, with the mouse pointer hovering within the tile
that is currently located in that area. The affected tiles are rearranged to
create a column.

Aggregate View (=] Scoreca rd Hierarchy o Table View a
- wi] sdr_BMF_Project_52_a & Dol T —
i E | Daw: [@  Elemen
sdr_BMF_. | |sar BMF_.. | |sdr_BMF_Project...| -
(19
Trend Analysis ]
w:] — pr——— |
20

TIP If you drag the tile too close to the portlet border or outside the
border, the movement icon disappears, which indicates that you cannot
drop the tile in that location. If you drag the tile into the portlet toolbar, an X
in a red circle appears on the movement icon.
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Resize a column. Hover between two columns to display handles. Resize the
column width for optimal display of strategy content.

Maximize a tile. Click the Maximize button on the title bar. The tile is sized to
be as large as possible to fill the portlet, and the other tiles disappear. To
return all of the tiles to their previous sizes and locations, click the Restore
button in the tile that you maximized.

When your tile layout is complete, click H to save the layout configuration. The
configured layout is used the next time the portlet is viewed.

Delete a Tile

To delete a tile in the SAS Strategy Management enhanced portlet:

1

2

Click [, in the portlet. The Edit Strategy Management Portlet page appears.

In the Tiles section, select the tile to delete in the Selected tiles list and click

"

Note: To remove all the tiles in the Selected tiles list, click 4.

Click Save to save the changes to the portlet properties and exit the page.
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Editing Classic-Style Portlets

Overview

Edit a Performance Table Portlet

Edit a Performance Aggregate Table Portlet
Edit a Performance Association Portlet
Edit a Performance Dashboard Portlet

Edit a Performance Data-Entry Portlet

Edit a Performance Diagram Portlet

Overview

285
285
288
291
293
297
299

The Strategy Management enhanced portlet provides tiles that have the same

functionality as the classic-style portlets described in this section. The tiles

provide enhanced functionality and interactive features for business users. For

more information about the enhanced portlet, its tiles, and their enhanced
features, see Chapter 27, “Editing a Strategy Management Enhanced Portlet
and lts Tiles,” on page 263.

Edit a Performance Table Portlet

To edit the properties of a Performance Table portlet, complete the following
steps:

1 In the portlet, click . The Edit Performance Table Portlet page appears
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Edit Performance Table Portlet + 1H2013 gsas
General
* Portlet name: 1H2013
Description:
Keywords: [T] Allow Suggested Elements

View Selection

Template: Strategy M
Project: 2013 Strategy M
Scorecard: =44 2013 Strategy

“B canada

B4 Latin America
B United States
"%Asia

"%Europe

Element type: Initiative -

Column selection:  All Metric Attributes -

Other Options

—Rows and Columns —lcons
vZ Specify number of rows and columns. i F Select those icons you want to display.
Rows: 10 (min 1 - max 100) Threshold icon: Mane -
Columns: & (min 1 - max 20) O] Trend Analysis
Period
[T comments
FUER [ comment Alert
h:{) Select the date.
@ Current date —Project and Scorecard Link
~ Relative period: (Example: 1, -1)
Use relative period type: Display project name
= Always show this date: © Enable the link that opens Strategy Management
") Disable the link that opens Strategy Management
—Portlet Height Display scorecard name

@ Enable the link that opens Strategy Management

i, % Specify the vertical size of the portlet. _ . .
1 ! Disable the link that opens Strategy Management

Height: 100 (100 to 1500 pixels)

2 In the General section, complete the following steps:
a Edit the portlet name, description, or keywords.

b Click Allow Suggested Elements to give business users a way to
communicate to you any suggestions about adding elements to the
strategy. For information about this setting, see “Create a Template” on
page 44.

3 In the View Selection section, complete the following steps to specify the
parameters that define the table to display:

a From the Template list, select a template.

b From the Project list, select a project.
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c From the Scorecard list, select a scorecard or a project.

d From the Element type list, select an element type.

e From the Column selection list, select a column selection.
4 In the Other Options section, complete the following steps:

a To specify the number of rows and columns to display in the portlet, in the
Rows and Columns section, type values in the Rows field and the
Columns field

b To specify the date, in the Date section, complete one of the following
steps:

To specify the current date, click Current date.

To specify a date relative to the current date, click Relative period,
type a value in the field, and then select a value from the Use relative
period type list.

To always show a specified date, click Always show this date. Then
type a date in the field or click [&] to choose a date from the calendar.

5 In the Icons section, complete the following steps to specify which threshold
icons appear in the aggregate table:

a Select an icon from the Threshold icon list.

b (Optional) Select one or more additional icon to display.

Note: Selections vary depending on the portlet type.

Icon Description

Trend analysis Opens a noninteractive trend chart view of the data.
This option uses the date range that is specified in the
project options.

Note: Do not confuse the noninteractive trend chart
with the interactive trend analysis tile.

Comment Provides a way for users to make comments about the
data.
Comment alert If comment alerts are set, indicates that comments are

available about the data.

Period Displays the period of time for which the element data
was collected.

6 To specify whether to link to the affected project or scorecard, in the Project
and Scorecard Link section, complete the following steps:

To display the name of the affected project, click Display project name.
By default, the project name is a link that opens the project in the Strategy
Management Builder. To disable this link, click Disable the link that
opens Strategy Management.

To display the name of the affected scorecard, click Display scorecard
name. By default, the scorecard name is a link that opens the scorecard
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in the Strategy Management Builder. To disable this link, click Disable
the link that opens Strategy Management.

7 Inthe Portlet Height section, enter the height that you want to use for the
portlet.

TIP The Firefox web browser cannot automatically resize the height of the
portlet. Make sure that you specify a height that accommodates the height
of the content that you want to display in this portlet.

8 Click Save to save your changes and exit. Click Cancel to exit without saving
any changes.

Edit a Performance Aggregate Table
Portlet

To edit the properties of a Performance Aggregate Table portlet, complete the
following steps:

1 In the portlet, click @ The Edit Performance Aggregate Table Portlet page

appears.
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General
# portlet name: 1H2013

Description:

Keywords:

View Selection

Edit a Performance Aggregate Table Portlet 289

[7] Allow Suggested Elements

Template: Strategy -
Project: 2013 Strategy -

Scorecard: E832013 Strategy

=-Eguro pe

Element type: Initiative

Column selection:  Actual

Other Options

—Rows and Columns

&4 Specify number of rows and columns.
Rows: 10 {min 1 - max 100)

Columns: 5 (min 1 - max 20)

§sas

—View By

i 2 Determine how you want to view the aggregate table.
) View by scorecard
@ View by metric attributes

—Date

h:‘.-) Select the date.
@ Current date
= Relative period: (Example: 1, -1)
Use relative period type:

@ Always show this date: 6/3/13

— Thresholds

Threshold icon: MNone -

2 Select those threshold icons you want to display in the aggregate
v table.

— Portlet Height

Specify the vertical size of the portlet.

-z
® Height: 100

(100 to 1500 pixels)

—Project and Scorecard Link

Display project name
@ Enable the link that opens Strategy Management
") Disable the link that opens Strategy Management
Display scorecard name
@ Enable the link that opens Strategy Management
) Disable the link that opens Strategy Management

2 In the General section, complete the following steps:

a Edit the portlet name, description, or keywords.

b Click Allow Suggested Elements to give business users a way to

communicate to you any suggestions about adding elements to the
strategy. For information about this setting, see “Create a Template” on

page 44.

3 In the View Selection section, complete the following steps to specify the
parameters that define the information to display in the aggregate table:

a From the Template list, select a template.
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b From the Project list, select a project.

c From the Scorecard list, select a scorecard.

Note: You must select a scorecard that contains child scorecards.
d From the Element type list, select an element type.
e From the Column selection list, select a column selection.
4 In the Other section, complete the following steps:

a To specify the number of rows and columns to display in the portlet, in the
Rows and Columns section, type values in the Rows field and the
Columns field

b To specify the date, in the Date section, complete one of the following
steps:

To specify the current date, click Current date.

To specify a date relative to the current date, click Relative period,
type a value in the field, and then select a value from the Use relative
period type list.

To always show a specified date, click Always show this date. Then
type a date in the field or click [&] to choose a date from the calendar.

c To specify how to view the aggregate table, in the View By section,
complete one of the following steps:

To display the scorecards as the column headings and the metric
attributes as the rows, select View by scorecard.

To display the metric attributes as the columns headings and the
scorecards as the rows, select View by metric attributes.

d To specify which threshold icons appear in the aggregate table, in the
Threshold section, select the icon from the Threshold icon list.

5 To specify whether to link to the affected project or scorecard, in the Project
and Scorecard Link section, complete the following steps:

To display the name of the affected project, click Display project name.
By default, the project name is a link that opens the project in the Strategy
Management Builder. To disable this link, click Disable the link that
opens Strategy Management.

To display the name of the affected scorecard, click Display scorecard
name. By default, the scorecard name is a link that opens the scorecard
in the Strategy Management Builder. To disable this link, click Disable
the link that opens Strategy Management.

6 In the Portlet Height section, enter the height that you want to use for the
portlet.

TIP The Firefox web browser cannot automatically resize the height of the
portlet. Make sure that you specify a height that accommodates the height
of the content that you want to display in this portlet.

7 Click Save to save your changes and exit. Click Cancel to exit without saving
any changes.
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Edit a Performance Association Portlet

To edit the properties of a Performance Association portlet, complete the

following steps:

1 In the portlet, click @ The Edit Performance Association Portlet page

appears.

Edit Performance Association Portlet -+ Finance Results

General
* Portlet name: Finance Results

Description:

Keywords:

View Selection

Template: Strategy -
Project: 2013 Strategy -
Scorecard:

[T] Allow Suggested Elements

2492013 strategy

Association name:
Column selection:

Other Options
—Date

"':9 Select the date.
@ Current date
) Relative period: (Example: 1, -1)

Use relative period type:
) Always show this date:

—Project and Scorecard Link

Display project name
@ Enable the link that opens Strategy Management
Disable the link that opens Strategy Management
Display scorecard name
@ Enable the link that opens Strategy Management
) Disable the link that opens Strategy Management

— lcons

i i Select those icons you want to display.
Threshold icon: None A
[T Trend Analysis
[ comments
[ comment Alert

—Portlet Height

"':9 Specify the vertical size of the portlet.
Height: 100 (100 to 1500 pixels)
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2 In the General section, complete the following steps:

a

b

Edit the portlet name, description, or keywords.

Click Allow Suggested Elements to give business users a way to
communicate to you any suggestions about adding elements to the
strategy. For information about this setting, see “Create a Template” on
page 44.

3 In the View Selection section, complete the following steps to specify the
parameters that define the table that contains associations to display:

b

e

From the Template list, select a template.
From the Project list, select a project.
From the Scorecard list, select a scorecard.

From the Association name list, select an association.

Note: Associations are not available at the project level.

From the Column selection list, select a column selection.

4 In the Icons section, complete the following steps to specify which threshold
icons appear in the aggregate table:

b

Select an icon from the Threshold icon list.

(Optional) Select one or more additional icon to display.

Note: Selections vary depending on the portlet type.

Icon Description

Trend analysis Opens a noninteractive trend chart view of the data.
This option uses the date range that is specified in the
project options.

Note: Do not confuse the noninteractive trend chart
with the interactive trend analysis tile.

Comment Provides a way for users to make comments about the
data.
Comment alert If comment alerts are set, indicates that comments are

available about the data.

Period Displays the period of time for which the element data
was collected.

5 To specify the date, in the Date section, complete one of the following steps:

To specify the current date, click Current date.

To specify a date relative to the current date, click Relative period, type
a value in the field, and then select a value from the Use relative period
type list.

To always show a specified date, click Always show this date. Then
type a date in the field or click [ to choose a date from the calendar.
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6 To specify whether to link to the affected project or scorecard, in the Project
and Scorecard Link section, complete the following steps:

To display the name of the affected project, click Display project name.
By default, the project name is a link that opens the project in the Strategy
Management Builder. To disable this link, click Disable the link that
opens Strategy Management.

To display the name of the affected scorecard, click Display scorecard
name. By default, the scorecard name is a link that opens the scorecard
in the Strategy Management Builder. To disable this link, click Disable
the link that opens Strategy Management.

7 In the Portlet Height section, enter the height that you want to use for the
portlet.

TIP The Firefox web browser cannot automatically resize the height of the
portlet. Make sure that you specify a height that accommodates the height
of the content that you want to display in this portlet.

8 Click Save to save your changes and exit. Click Cancel to exit without saving
any changes.

Edit a Performance Dashboard Portlet

To edit the properties of a Performance Dashboard portlet, complete the
following steps:

1 In the portlet, click . The Edit Performance Dashboard Portlet page

appears. The size and style for metric attributes and element names,
whether to append scorecard names to element names, and whether to
display metric attributes are set on this page.
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Edit Performance Dashboard Portlet - Finance Results gsas
General

* portlet name: Finance Results

Description:

Keywords: [T] Allow Suggested Elements

View Selection

Template: Strategy -
Element type:  Initiative -

Items to display in portlet: Total=10
MName Project Scorecard

Element Filter
Show: Met Personal Thresholds -

Graph Display Options
—Graph Type — Text

. Specify how you want to display the information. &4 Element name display options:

@ Dial Text size: Medium -

) Slider [ pold

Stoplight [T Append scorecard name to element name

) SpesiTIEGEy Metric attribute display options:

dEullctEay Display metric attribute
Size:  Small - [T pisplay range values
Text size: Medium -
Bold
—Rows and Columns
B4 Specify number of rows and columns. s
Rows: 2 (min 1 - max 100)
Columns: 4 {min 1 - max 20) m* Select those icons you want to display.
Threshold icon: MNone -
indicators [ Trend Analysis
[ comments
g Select the metric attributes that display as indicators.
- Primary indicator: Actual - —Language

Show secondary
indicator: Actual &4 Select the language you want to display.

@ Use the default project and template languages

Use this language: | English

—Date

Select the date.
@ current date
) Relative period: (Example: 1, -1)

e

Use relative period type:
) Always show this date: =

— Portlet Height

Specify the vertical size of the portlet.

%
~ Height: 100 (100 to 1500 pixels)

2 In the General section, complete the following steps:
a Edit the portlet name, description, or keywords.

b Click Allow Suggested Elements to give business users a way to
communicate to you any suggestions about adding elements to the
strategy. For information about this setting, see “Create a Template” on
page 44.
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You can display many scorecard elements from multiple projects within the
same template. In the View Selection section, complete the following steps
to select a template and element type:

a Click Add. The Add Items to Portlet page appears.

b In the Project name list, select a project. The list contains all of the
projects that are associated with the selected template.

c Select the scorecard that contains the elements that you want to add.
d Select the check box for each element to be displayed in the portlet.

e Click Save. The Edit Performance Dashboard Portlet page appears. The
elements that you have selected are displayed in the Items to display in
portlet table.

To remove an item from the table, select the item check box and click
Remove. To remove all of the items from the table, select the check box
at the top of the column and click Remove. If you select elements that
have a different element type, all elements of the previous element type
are removed from the Performance Dashboard portlet.

In the Element Filter section, you can set a filter that displays elements that
have or have not met global or personal threshold conditions. For more
information about setting thresholds, see “Set a Global or Personal
Threshold” on page 116.

To specify the threshold condition, select a filter from the Show list.

In the Graph Type section, select the type of graph to display and its size.
Available graph types are dials, sliders, or stoplights.

To specify the number of rows and columns to display in the portlet, in the
Rows and Columns section, type values in the Rows field and the
Columns field

In the Indicators section, complete the following steps to change the metric
attributes that you use as indicators:

a Select an indicator from the Primary indicator list.

b If you want to display a secondary indicator, click Show secondary
indicator and select an indicator from the list.

Note:

Displaying a secondary indicator is useful only if the secondary
indicator is on the same scale as the primary indicator.

Stoplights do not display secondary indicators.

To specify the date, in the Date section, complete one of the following steps:
To specify the current date, click Current date.

To specify a date relative to the current date, click Relative period, type
a value in the field, and then select a value from the Use relative period
type list.

To always show a specified date, click Always show this date. Then
type a date in the field or click [E] to choose a date from the calendar.
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9 In the Text section, complete the following steps to specify how text is
displayed:

a From the Text size list, select a text size for the element name.
b (Optional) Click Bold to display the element name as bold text.

c (Optional) Click Append scorecard name to element name to append
the scorecard name to the element name.

d (Optional) To display the metric attribute or range values, click Display
metric attribute or Display range values.

e From the Text size list, select a text size for the metric attribute.
f (Optional) Click Bold to display the element name as bold text.

10 In the Icons section, complete the following steps to specify which threshold
icons appear in the aggregate table:

a Select an icon from the Threshold icon list.

b (Optional) Select one or more additional icon to display.

Note: Selections vary depending on the portlet type.

Icon Description

Trend analysis Opens a noninteractive trend chart view of the data.
This option uses the date range that is specified in the
project options.

Note: Do not confuse the noninteractive trend chart
with the interactive trend analysis tile.

Comment Provides a way for users to make comments about the
data.
Comment alert If comment alerts are set, indicates that comments are

available about the data.

Period Displays the period of time for which the element data
was collected.

11 In the Language section, select to use a specific language or the default
language. For more information, see “Working with Language Settings” on
page 55.

12 In the Portlet Height section, enter the height that you want to use for the
portlet.

TIP The Firefox web browser cannot automatically resize the height of the
portlet. Make sure that you specify a height that accommodates the height
of the content that you want to display in this portlet.

13 Click Save to save your changes and exit. Click Cancel to exit without saving
any changes.
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Edit a Performance Data-Entry Portlet

To edit the properties of a Performance Data-Entry portlet:

1 In the portlet, click [s]. The Edit Performance Data-Entry Portlet page
appears.

Edit Strategy Management Data Entry Portlet « Weekly Gsas

General Date

MName: Weekly

Description: rorm description

Keywords: Keyvwoards

Project: 2013 Strategy l|:| Display project name
Data entry form: Data Entry .

Portlet height: | 300 (100 to 1500 pixels)

[ ] Enable the portal administrator to view this portlet and its form

[] Share this data entry form on the SAS Visual Analytics homepage

Location:| /Shared Data/SAS Strategy Management

On the General tab, enter the portlet name, description, and keywords.

From the Project list, select a project.

A O DN

Click Display project name if you want the name displayed in the form.

5 From the Data entry form list, select a form.

Note: You must first create the form in Strategy Management Builder. For
more information, see Chapter 33, “Creating and Managing Forms,” on page
329.

6 In the Portlet height field, enter the height to use for the portlet, in pixels.

7 If you want to enable the SAS Information Delivery Portal administrator to
view the portlet and its form, click Enable the portal administrator to view
this portlet and its form.

Note: Because of the way security is implemented, the portal administrator
might not have the required access permissions to view the portlet. If the
administrator must be able to view the portlet and form, make this selection.
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8 If you want this form to appear on the SAS Visual Analytics home page, click
Share this data entry form on the SAS Visual Analytics home page.
Then specify the location in which to share the form in the Location field.

9 Click the Date tab.

Edit Strategy Management Data Entry Portlet - Weekly Gsas

General Date

Set the default date that should be displayed in the data entry form when it is opened.

@ Current date

(@ Relative period: {1-,1)Period type:

(@ Always show this date:| 2/4/2014
|:| Enable users to change the date

Restrict the start and end dates that the user can navigate to in the form. If you do not restrict the date, the start and
end dates of the project are used.

[] Restrict the dates that are available in the form

Start:| 2/4/2014 End: | 2/4/2014

10 To specify the date that the form uses when opened, complete one of the
following steps:

To specify the current date, click Current date.

To specify a date relative to the current date, click Relative period, enter
a value in the field, and then select a value from the Period type list.

To always show a specified date, click Always show this date. Then,
enter a date in the field or click the list box arrow to choose a date from
the calendar.

11 To give data-entry form users a way to change the date while they are
working in the form, click Enable users to change the date. The data
change does not persist from one session to the next.

12 To restrict the dates that the data-entry user can navigate, click Restrict the
dates available in the form and then make your selections in the Start and

End fields.

TIP By default, the dates are restricted by the start and end dates of the
project.

13 Click Save to save your changes and exit. Click Cancel to exit without saving
any changes.
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Edit a Performance Diagram Portlet

To edit the properties of a Performance Diagram portlet, complete the following
steps:

1 In the portlet, click [s]. The Edit Performance Diagram Portlet page appears.

Edit Performance Diagram Portlet - Subsidiary View

General
# portlet name: Subsidiary View

Description:

Keywords: Allow Suggested Elements

View Selection
Template:  Strategy -

Project: 2013 Strategy -

Scorecard: |24 2012 Strategy

= EsEyrope

Diagram: Strategy -

Other Options

—Date —Project, Scorecard and Diagram Link
"'fg SgLect the date. Display project name
@ _
Curr’elnt datel @ Enable the link that opens Strategy Management
) Relative period: (Example: 1, -1)
Use relative period type: () Disable the link that opens Strategy Management
- Always show this date: Di_splay scorecard name
@ Enable the link that opens Strategy Management
) Disable the link that opens Strategy Management
—Portlet Height
s Display diagram name
"'fg Specify the vertical size of the portlet. © Enable the link that opens Strategy Management
Height: 500 (100 to 1500 pixels) ) Disable the link that opens Strategy Management

2 In the General section, complete the following steps:
a Edit the portlet name, description, or keywords.

b Click Allow Suggested Elements to give business users a way to
communicate to you any suggestions about adding elements to the
strategy. For information about this setting, see “Create a Template” on
page 44.
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3 Inthe View Selection section, complete the following steps to specify the
diagram to display in the portlet:

a From the Template list, select a template.
b From the Project list, select a project.
c From the Scorecard list, select a scorecard or a project.
d From the Diagram list, select a diagram.
4 In the Other Options section, complete the following steps:

a To specify the date, in the Date section, complete one of the following
steps:

To specify the current date, click Current date.

To specify a date relative to the current date, click Relative period,
type a value in the field, and then select a value from the Use relative
period type list.

To always show a specified date, click Always show this date. Then
type a date in the field or click [&] to choose a date from the calendar.

b To specify the diagram height, type the height in the Height field.

5 To specify whether to link to the affected project, scorecard, or diagram, in
the Project, Scorecard and Diagram Link section, complete the following
steps:

To display the name of the affected project, click Display project name.
By default, the project name is a link that opens the project in the Strategy
Management Builder. To disable this link, click Disable the link that
opens Strategy Management.

To display the name of the affected scorecard, click Display scorecard
name. By default, the scorecard name is a link that opens the scorecard
in the Strategy Management Builder. To disable this link, click Disable
the link that opens Strategy Management.

To display the name of the affected diagram, click Display diagram
name. By default, the diagram name is a link that opens the diagram in
the Strategy Management Builder. To disable this link, click Disable the
link that opens Strategy Management.

6 Click Save to save your changes and exit. Click Cancel to exit without saving
any changes.



301

Part 5

Viewing and Navigating Content in
Portlets

Chapter 29
Access Your Strategy Management Portlets . .. .. .. ... ... ... ... ... .. 303

Chapter 30

Navigating and Viewing the Strategy Management
Enhanced Portlet and Its Tiles . . .. ... ... ... ... .. .. ... .. .. .. .. .. 305

Chapter 31
Navigating and Viewing Classic-Style Portlets . .. ... ... ... ... ... ... .. 321



302



303

Access Your Strategy Management
Portlets

Log On to the SAS Information Delivery Portal 303
Log Off from the SAS Information Delivery Portal 304

Log On to the SAS Information Delivery
Portal

To access your SAS Strategy Management portlets:

1 Open your browser and type the web address for the SAS Information
Delivery Portal.

Note: To obtain the web address, contact your portal administrator.

The Log On page appears.

Log On

Copyright & 20 2013 by SAS Institute Inc., Cary, NC USA

2 Enter your user ID and password.
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3 Click Log On. Your personal portal appears. Your portal might have multiple
pages. Click the page tabs to view the pages in your portal. Each page can
contain one or more portlets, including SAS Strategy Management portlets.

Log Off from the SAS Information Delivery
Portal

To log off from your SAS Strategy Management portlets, click Log Off in the
upper right corner of the user interface.

Note: If your session is inactive longer than the SAS Information Delivery Portal
time-out value, you are automatically logged off.
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View Information Provided for a Gauge
View Details about an Element in a Diagram
Change the Diagram to View

Reset the Zoom for a Diagram

Save the Portlet as a Mobile Report

Your First Look at the SAS Strategy
Management Enhanced Portlet

318
318
318
318
318

The SAS Strategy Management enhanced portlet appears on your portal page.

Figure 30.1 SAS Strategy Management Enhanced Portlet
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1 Title bar. Click the X to remove the portlet from the page or click the Minimize
button to minimize the portlet.

2 Toolbar. The portlet toolbar provides the = and ¢ buttons. For more
information, see “Suggest a New Element to Add to the Strategy” on page
310.

The toolbar also provides the Help icon. Click @ to view the SAS Strategy
Management: Enhanced Portlet Quick Start Guide.

3 Portlet content area

A SAS Strategy Management portlet can contain one or more tiles. A scorecard
modeler can customize the interface of each tile. The following example
describes the available features for a tile. However, due to customization, your
tiles might not have all of these features.
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Figure 30.2 Tile Interface Example
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The tile title bar provides the Maximize (D) and Restore (5') buttons.

The tile control panel. For more information, see “Open and Close the Tile
Control Panel” on page 309.

The tile toolbar. Due to customization, the tile might not display the toolbar.
Date. For more information, see “Change the Date” on page 310.

The scorecard name. For more information, see “View the Scorecard in
Strategy Management Builder” on page 311.

Element type list. For more information, see “Change the Element Type” on
page 311.

Columns list. For more information, see “Change the Column Selection” on
page 311.

Information icon. Click this icon to view a short tip or other information about
the tile. This information can include which tiles are synchronized with the
scorecard hierarchy and whether the tile uses global date.

Content area. The tile data appears in this area.

10 Icons. Depending on how the tile is customized, one or more of the following

icons might be available:

Trend chart & =. For more information, see “Display a Trend Chart” on
page 315.

Note: Do not confuse the noninteractive trend chart with the interactive
analysis tile.

Threshold (either global ¥ or personal ¥&). Click this icon to view the
threshold conditions for an element. For more information, see “View
Threshold Conditions” on page 313.

Comments action 3. Click this icon to make comments about the
information. For more information, see “View and Create Comments” on
page 313.

Comment alerts G. This icon indicates that comments are available.
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Access Help

The toolbar provides the Help icon @.

1H2013

- %
H R [ [0s242013)8  Project 2013 Straleqy ( @

Click @ to view the SAS Strategy Management: Enhanced Portlet Quick Start
Guide.

Change the Layout of the Tiles

When you view a SAS Strategy Management enhanced portlet and its tiles, you
can change their layout in the following ways:

Resize a tile. Hover on the tile border to display handles. Click a handle and
drag to resize the tile.

Rearrange the tiles in columns or rows. Click the title bar of a tile and drag it
within the portlet. A movement icon appears with the mouse pointer, which
indicates that you are dragging a tile within the portlet. The following partial
display shows the mouse pointer and the accompanying movement icon:

As you drag the tile, gray boxes guide you to rows and columns into which
you can drop the tile. When you drop the tile, the other tiles in the portlet
automatically accommodate the dropped tile.

For example, if you want to move a tile to create a column on the left side of
the portlet, drag the tile left border of the portlet.

Trend Analysis (=]

A e e ‘
ZUJ

Drop the tile near the border, with the mouse pointer hovering within the tile
that is currently located in that area. The affected tiles are rearranged to
create a column.
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TIP If you drag the tile too close to the portlet border or outside the
border, the movement icon disappears, which indicates that you cannot
drop the tile in that location. If you drag the tile into the portlet toolbar, an X
in a red circle appears on the movement icon.

Resize a column. Hover between two columns to display handles. Resize the
column width for optimal display of strategy content.

Maximize a tile. Click the Maximize button on the title bar. The tile is sized to
be as large as possible to fill the portlet, and the other tiles disappear. To
return all of the tiles to their previous sizes and locations, click the Restore
button in the tile that you maximized.

When your tile layout is complete, click H to save the layout configuration. The
configured layout is used the next time the portlet is viewed.

Open and Close the Tile Control Panel

To close the tile control bar, click &. The tile control bar closes.

Table View =}

To open the tile control bar, click . The tile control bar opens.

Table View o

[ 3r=A Scorscard. Worldwide ©
Date: |05/24/2012 m Element type: Perspective Columns: Default (none) {T

-

Print a Tile

Note: Due to customization, a tile might not display a toolbar. In this case, the
Print button is not available.

To print a tile:
1 Click & in the tile toolbar. The Print Tile window appears.
2 (Optional) Type the header text to use on the printed page.

3 (Optional) Adjust the margin settings.
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4 If you do not want to print the tile control bar and its buttons and controls,
select Do not print tile control bar.

5 If you want to print information identifying the scorecard, select Print the
scorecard header information.

6 Click OK to save your changes and exit. Click Cancel to exit without saving
any changes.

Reset Tile Data

To reset the tile data to its initial setting when you opened the portlet, click &% in
the tile toolbar.

Note: Due to customization, a tile might not display a toolbar. In this case, the

4% button is not available. To refresh your data, click your web browser Refresh
button.

Suggest a New Element to Add to the

Strategy

Note: Due to customization, a tile might not display a toolbar. In this case, the
# button is not available. Also, the tile might be customized to not accept
element suggestions.

You can suggest that new elements be added to the strategy. Your suggestions
are implemented by the scorecard modeler. To suggest that one or more new
elements be added to a strategy:

1 In the tile toolbar, click ¥ .
2 Inthe Suggest New Elements list, type a name. A description is optional.

Select the scorecards in which to include the element.

h @

Select the type of period, the start period, and the end period.

a

Click =£. A new row is added to the table.

o

To suggest more elements, repeat steps 2 through 5.

Change the Date

Depending on how your portlet and tiles are customized, you can change the
date for the portlet or the tile. The portlet date setting is called the global date
setting. The tile date setting is called the local date setting. If a tile has its own
Date field, the tile, or local, date setting is independent of the global date setting.
Tiles that do not have their own date setting use the global date setting.
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To change the global date setting, type a date in the Date field or click F& in
the portlet toolbar. Any tiles that use the global date setting update their data
to reflect the new date. Tiles that have their own local date setting do not
change.

To change the local date setting that a tile uses, type a date in the Date field
or click ¥ in the tile control bar. The data for only that tile is updated to
reflect the new date.

Note: The date selections do not persist after you close the portal session.

Note: Due to customization, the Date field might not be enabled in the portlet or
in a tile.

Change the Element Type

To change the element type selection, click the Element type list to make a new
selection.

Note: Due to customization, the Element type list might not be available.

Change the Column Selection

To change the column selection, click the Column list to make a new selection.

Note: Due to customization, the Column list might not be available.

Change the Association

To change the association in an association tile, click the Association list to
make a new selection.

Note: Due to customization, the Association list might not be available.

View the Scorecard in Strategy
Management Builder

The tile control bar provides a link to the scorecard.

HE B [oszazo3)H @13@ o

When you click the scorecard name in the tile control bar, the scorecard opens
in Strategy Management Builder.
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Scorecard - Worldwide
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To return to the portal and your portlet view, click Portal in the upper left corner
of Strategy Management Builder.

Note: Due to customization, the scorecard name link might not be available.

Sort Columns

When a tile displays its data in columns, you can click the column headings to
sort the data.

Rearrange Columns

You can change the order of the columns in a table. Click a column heading,
drag the column to the new location, and then drop the column.

Synchronize Tile Data with the Scorecard
Hierarchy Tile

The scorecard hierarchy tile provides a way to dynamically change the
scorecard data in one or more tiles. This feature is called synchronization.

Scorecard Hierarchy (=]
v [ 2013 Strategy
v FZ, Worldwide
rﬁ Americas
bﬁ Asia
rﬁ Europe

E, Western Europe
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For example, suppose a table tile displays data for Distribution. If you click
Retailers in the scorecard hierarchy tile, the table tile displays data for Retailers.

If a portlet contains a scorecard hierarchy tile, remember the following
considerations:

You can synchronize only table tiles, aggregate tiles, association tiles, and
gauge tiles with the scorecard hierarchy tile. Synchronization does not affect
analysis tiles.

Synchronization is a customizable feature. A tile might not be customized to
synchronize its data with the scorecard hierarchy tile.

View Threshold Conditions

Note: Due to customization, threshold icons might not be available.

If a global ¥ or personal V& threshold is set and the threshold conditions are met
or exceeded, the applicable threshold icon appears in the tile data.

To view the threshold conditions for an element, click the threshold icon. The
Threshold window appears.

Personal Threshold

Scorecard Threshold Difference (Absolu|
child_a 5.00 =1.00 4.00

x
te)
Close
(S

If the scorecard in which the threshold flag is set is available in a scorecard
tile, you can click the scorecard name to view the scorecard in the tile.

The threshold flag is set on a specific metric attribute. A defined link can be
assigned to a metric attribute. If the metric attribute has a defined link, you
can click the metric attribute in the Threshold window andthe link opens.

To close the Threshold window, click Close.
Note: Thresholds can also generate alerts. You can receive alerts as individual

e-mail, as a compiled digest of alerts in an e-mail, as Short Message Service
(SMS) text messages, or in a shared alert portlet on a portal page.

View and Create Comments

Note: Due to customization, the comment feature and comment alerts might not
be available.

Note: You cannot delete comments. If a comment requires deleting, contact
your SAS administrator.

If the & icon appears in the tile content, you can make a comment about that
data. When a new comment or a reply is posted, a comment alert @ icon
appears with the affected data.

To make a comment:
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1 In the applicable row, click 2. The Comments window appears.

Sales & & Oct2012 s 7
Otherincome iy G Comments: Sales x 51
Productivity G |G ® 36
Profit b G 30
Expenses G | ‘ 95
Training % = * Sales strategy working ag

SAS Demo User Oct 19, 2012 10:11 AM

How can we apply the new strategy to other regions?

SAS Demo User Oct 19, 2012 10012 AM

We need to identify a different promotion for the strategy to ...

If this element has existing comments, the comments appear in this
window. By default, only one line of the comment is displayed. Double-
click the comment to expand the entire comment. To collapse the
comment, double-click it again.

If a topic contains many comments, Show All Comments appears below
the topic name. Click Show All Comments to display all of the comments
in the topic. To collapse the view, click Minimize View.

If a comment belongs to you, you can click [%, to edit the comment.

2 To make a comment about a new topic, enter the name of the topic in the
field above the comments. The comment field appears below topic field.

3 Enter your comment in the comment field.

4 (Optional) Click [ to attach a file to the comment. Select one or more files to
attach and click Open. The attachment appears below the comment.

Note: To delete the attachment from the comment, click ¥ next to the
attachment.

5 Click Post to save and post your comment. When you post a comment, it is
added to a topic thread of comments about that element. After you post a
comment, other users can reply to it. Their comments are also added to the
topic thread of comments.
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Reply to a Comment

Note: Due to customization, the comment feature might not be available.

Note: You cannot delete comments. If a comment requires deleting, contact
your SAS administrator.

To reply to a comment:

1 In the applicable row, click G2.

2 In the Comments window, expand the topic thread of comments.
3 Enter your reply in the comment field at the bottom of the thread.

4 (Optional) Click [ to attach a file to the comment. Select one or more files to
attach and click Open. The attachment appears below the comment.

Note: To delete the attachment from the comment, click % next to the
attachment.

5 Click Post to save and post your reply. The reply is added to the thread of
comments.

Search Comments

Note: Due to customization, the comment feature might not be available.

Note: You cannot delete comments. If a comment requires deleting, contact
your SAS administrator.

To search comments:
1 In the Comments window, type one or more characters in the Search field.
2 Click /®. Any comments that include the search string appear in a results list.

3 To view the Comments window again, click the X in the Search field.

Display a Trend Chart

Note: Due to customization, trend charts might not be available.

The trend chart is a noninteractive chart of historical trend data. The data that is
displayed in the chart is specified by your scorecard modeler. The trend chart

icon B appears in a tile when this view is available in a tile.
To view the trend chart, click Fd .

To close trend charts, click Close.
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Select Data for a Trend Analysis

To select data for a trend analysis, click an element and drag it onto the trend
analysis tile. You can select data in a table view tile, aggregate view tile,
association view tile, or gauge view tile for use in a trend analysis.

Remove Data from a Trend Analysis

To remove an element from a trend analysis, in the tile control bar, click B
Note: Due to customization, a tile might not display a toolbar.

In the Graph Properties window, the top section lists the elements in the trend

analysis. Click M next to the element that you want to remove from the trend
analysis.

Reset the Data

To reset the data to its initial setting, click I in the tile toolbar.

Note: Due to customization, a tile might not display a toolbar.

Save the Trend Analysis as an Image

To save the trend analysis using the image format PNG:

1 Click I2' in the tile toolbar.

Note: Due to customization, a tile might not display a toolbar.
2 A Save list appears. Navigate to the location where you want to save the file.
3 Type a name in the File name field.

4 Click Save.

Change Trend Analysis Property Settings

To change the style setting in a trend analysis tile:

1 In the tile control bar, click . The Graph Properties window appears.

Note: Due to customization, a tile might not display a toolbar.
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2 In the list at the top of the window, click the value that you want to edit. Any
changes that you make are applied to this value.

Note: You can also delete the value by clicking .
3 In the Graph Options section, specify how you want the graph to be drawn:

a In the Graph type list, select the type of graph that you want to display in
the trend analysis. Available selections are Line, Band, Bar, and Scatter.

b Select the applicable options for the graph type that you chose. Options
vary depending on the graph type that you selected.

Graph

Type Available Options

All Click the Color icon to select the color of the graph type.
types

If you want each data value to be labeled in the graph, select
Show data labels.

Line In the Style list, select the style of line that you want to use.

In the Dash type list, select the type of dash that you want to use
to form the line.

If you want the line that is drawn in the graph to break each time a
data value is missing, select Break line drawing for missing
data values in line graphs.

In the Line weight list, select the line thickness to use for the line
graph.

If you want data tips to appear in the line graph, select Show data
tips.

If you want markers to appear in the graph, select Show markers.
You can select the type of marker that you want the graph to use
from the Marker list.

Scatter In the Marker list, select the type of marker that you want the graph
to use.

4 In the Global Options section, specify the applicable options:
If you want grid lines to appear in the trend analysis, select Grid lines.

If you want to display the legend in the trend analysis, select Display
legend. When you choose to display the legend, you can also specify
whether the legend appears across the width of the tile or is displayed
along the height of the tile. In the Location list, select the location in the
tile to display the legend.

5 Click Apply to save and apply the new settings.

Note: If you do not click Apply, the settings are not saved.

6 Edit the properties for another value or click Close to exit.
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View and Filter Gauges

In a gauge tile, every element is represented as a gauge. In the tile control bar,
you can filter the gauges by their relationship to each other as defined by
associations. From the Supported perspective list, select an association.

View Information Provided for a Gauge

If the element name of a gauge is linked, you can click the link to view
information provided for that element.

View Details about an Element in a
Diagram
To view element details in a diagram, expand the Element Details pane to the

right of the diagram. Then, click an element in the diagram. The details for the
element appear in the Element Details pane.

Change the Diagram to View

Note: Due to customization, the Diagram list might not provide other selections.

To view another diagram, select a new diagram from the Diagram list.

Reset the Zoom for a Diagram

To reset the zoom for a diagram, select the Reset Zoom check box.

Save the Portlet as a Mobile Report

You can save the content of the Strategy Management enhanced portlet and its
tiles as a mobile report. You can view these reports in the following ways:

In the SAS Mobile Bl app: You can view a mobile report by using a mobile
device such as an iPad or an Android tablet. The SAS Mobile Bl app must be
installed on the tablet. For information about this app, see the SAS Visual
Analytics product page at http://support.sas.com/software/
products/va/index.html.


http://support.sas.com/software/products/va/index.html
http://support.sas.com/software/products/va/index.html

To
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Note: Some features of the content in the tiles might not display the same
way on a tablet. Some features can also appear differently on different types
of tablets.

In Microsoft Office: By using the SAS Add-In for Microsoft Office plug-in,
you can view a mobile report in Microsoft Office. The tiles are displayed
sequentially from top to bottom in the selected Microsoft Office view. If the
mobile report uses the Strategy Management report type, the Refresh button
is activated when the report has been updated. The user clicks Refresh to
update the view. For more information, see Chapter 37, “Viewing Strategy
Management Reports in Microsoft Office,” on page 373.

save the portlet content as a mobile report:
Click [E in the portlet toolbar.

In the Create Mobile Report window, in the Name field, enter a name for the
report.

In the Description field, enter a description for the report.

TIP The SAS Mobile Bl app displays the description as part of the
subscription information for the report. A thoughtfully written description
can help users decide whether to subscribe to the report.

Select the layout to be used when you are creating the mobile report.

Note: A report contains one or more sections. Sections are like pages in a
book.

All tiles in one section with portlet layout preserved: Creates one
section in the report. In that section, the tiles are displayed in the layout in
which they appear in the portlet.

All tiles in one section without portlet layout preserved: Creates one
section in the report. In that section, the tiles are displayed in a horizontal
layout. The user must swipe right and left to view the tiles.

Note: The Contents bar in the app displays one thumbnail for the
section.

One tile per section in the report: Assigns each tile to its own section in
the report.

Note: The Contents bar in the app displays a thumbnail for each
section.

If you want to preserve cell-level formatting of metric values, select Enable
cell-level formatting of metric values (table view tiles only).

Note: This option affects only table view tiles, not aggregate or association
views.

Navigate to the location where you want to save the report.

In the Type list, select the report type that you want to use.

SAS 2G (static): A static report. You must save the report again to apply
any changes.
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Strategy Management: Supports dynamic updates of the report. You do
not have to save the report again to apply changes. In the app portfolio,
the Updated badge appears on the report thumbnail.

Note: Changes to metric values or the layout trigger the Updated badge.
Formatting and style changes do not.

8 Click OK to save the report.
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Overview

Depending on how a portlet is customized, the following options might be
available in classic-style portlets.

Link to Other Documents, Web Addresses,
or Views

Values in tables or diagrams can be customized to provide a link to documents,
web addresses, or other views. Click the link to display the information.

View a Trend Analysis

If the k=1 icon appears in a view, you can click the icon to display the Trend
Analysis page in the SAS Strategy Management Builder. For more information
about the Trend Analysis page, see Chapter 22, “Creating and Editing Trend
Analysis Views,” on page 237.

Note: This option is supported in the table, association, and dashboard views.
However, the Trend Analysis icon might not be available in a view. The
scorecard modeler specifies whether to display these icons when customizing
the view.
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Viewing and Making Comments

If the 5 icon appears in a view, you can click the icon to open the Comment
Manager page.

| HE!|_|:|v

| Back Log Off chlyca | Preferences

Comments - Profitability gsas

Browse EEEIg)]
%

) New Comment Refrazh

R erformance &

Performance
Author: chlyca
Date: 08Jun10:13:04:41

We need to work on this! Revenues are up, let's get control of the
expenses!

On this page you can:
View comments about the data.
Make comments about the data.
Respond to comments about the data.

To learn more about the Comment Manager, click Help » Help on This Page to
display the Comment Manager help.

Note: This option is supported in the table, association, and dashboard views.
However, the icon might not be available in a view. The scorecard modeler
specifies whether to display these icons when customizing the view.

View Threshold Data

If the ¥ or & icons appear in a view, you can click the icon to open the
Threshold Condition page.

Note: This option is supported in the table, aggregate, association, and
dashboard views. However, the threshold icons might not be available in a view.
The scorecard modeler specifies whether to display these icons when
customizing the view.
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View Underlying Data (Dashboard View

Only)

If the element contains data for the specified time period, a graph is displayed in
the Performance Dashboard Portlet for each element that is specified in the
portlet properties. Click on the link in each graph to view the underlying data

table.
Note: If the range for the element contains fewer than two intervals, a graph for
the element is not displayed.
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Data-Entry Methods

SAS Strategy Management provides different ways to enter data depending on
the quantity of data that you want to enter.

When your organization needs to manually enter data or your data-entry
process requires workflow control, create a data-entry form in SAS Strategy
Management Builder and display the form in the data-entry portlet. By
entering data in this way, you can control the workflow of the data-entry
process. For more information, see Chapter 33, “Creating and Managing
Forms,” on page 329. For information about entering and approving data,
see Chapter 34, “Entering Data Manually,” on page 339.

To create data in SAS Strategy Management by using Microsoft Excel
spreadsheets or SAS data sets, use the Import wizard. For information, see
Chapter 35, “Importing Data into a Strategy Management Project,” on page
343.

To enter an existing project and its data, export and import a SAS package
from one SAS Strategy Management installation to another. You can use this
method to copy a project, migrate a project, or back up a project. For more
information, see the SAS Strategy Management: System Administration
Guide.
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Forms and Workflow

Designing Forms

You can create a form in which data-entry users enter data into a SAS Strategy
Management project. Users access the form by using a data-entry portlet on a
portal page. Forms are a useful way to enter data that does not exist in your
SAS Strategy Management project.

Designing the Workflow of a Form

Specifying a workflow for a data-entry form is a way to guarantee that the data
that is entered is accurate before the data is published to the production system.

The workflow of a form affects two groups of users: data-entry users and
approvers. In the workflow, the form is assigned to a data-entry user who is
responsible for entering some or all of the data into the form. You can specify
one or more data-entry users to enter data.

After the data is entered and the data-entry user submits the form, the data can
be approved. In the workflow, you specify an approver who is responsible for
reviewing and approving the data that was entered into the form. You can
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specify one or more approvers. You can also specify the order in which
approvers must approve the form.

When you specify a workflow, you get the following benefits:
Collaboration is ensured when everyone agrees on the submitted data.
Mistakes are reduced before the data is generally available.
Consistent business processes are enforced.

Efficiency and productivity can be improved by automating and tracking the
process within the SAS Strategy Management software.

Prerequisites
Before you create a data-entry form, consider the following prerequisites:

You can design a form such that the value that is entered into a cell is
evaluated by a rule. You can define a rule and then associate the rule with
metric attributes. You select the metric attribute when you create the column
selection.For more information, see Chapter 10, “Defining Rules,” on page
123.

When you create a data-entry form, you specify a column selection to use in
that form. Before you can specify the column selection, you must create it.
For more information, see “Create a Column Selection for Use in a Data-
Entry Form” on page 145.

You can specify that a link be available in a form. Before you can specify the
link, you must create the link definition. For more information, see “Managing
Link Definitions” on page 78.

For information about the user roles and capabilities required for creating a
form, entering data, and approving data, see the SAS Strategy Management:
System Administration Guide.

For information about customizing the workflow, see the SAS Strategy
Management: System Administration Guide.

Create a Form and Workflow

On the Project page, complete the following steps:

1 Select Project » Manage Data Entry Forms. The Manage Data Entry
Forms page appears.

2 Click [*. The Properties section appears below the Forms list.
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1 - Identification " 2- Elements “ 3 - Columns " 4 - Workflow |

Enter a name and description for the new form.

MName: *‘travel EXpenses

Review and approve travel expenses to
conferences.

Description:

Link: - | O]

3 On the Identification tab, complete the following steps:
a In the Name field, enter a unique name for the form.

b (Optional) In the Description field, enter an optional description of the
form.

c (Optional) From the Link list, select a link that will appear at the top of the
form in the portlet. The link that you select is associated with the form.

Note: For more information, see “Managing Link Definitions” on page 78.

TIP You can click Save at any time in the Properties section. Doing so
saves a draft of the form. The draft appears in the Forms list above the
Properties section. The draft contains the selections that you made before
you clicked Save. If you continue working in the Properties section but do
not click Save, any subsequent settings can be lost.

4 Click the Elements tab.

1 - Identification | 2 - Elements " 3 - Columns " 4 - Workflow

Select the element type to use in the form. A form can have only one element type. Then, select one or more elements for
which you want to collect data.

Element type: |F'erspective - |

- 1[0 & Worldwide

+[0 F& Americas

+|[O BG, Asia

+[] Bs Europe
[ Finance
[ O customer
[ O Process
[ Learning & Growth

Elements:
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To select the elements for which you want to collect data, complete the
following steps:

a From the Element type list, select the element type.

Note: A form can have only one element type.

b Inthe Elements tree, expand the tree and select one or more elements
for which you want to collect data. To select all of the elements in a
scorecard, click the check box next to the scorecard.

TIP When you click the check box next to the scorecard, you also
enable the form to automatically use any elements that are added to
the scorecard in the future. If you do not want this behavior, you must
clear the scorecard check box and individually select each element.

Note: The order in which the scorecards and elements are displayed is
determined by the order that is set in the SAS Strategy Management
Builder. If an order has not been set, then no specific order is used on this
page. See “Change the Order of Scorecards” on page 90.

5 Click the Columns tab.

1 - Identification "2 - Elements ” 3-Columns "4 - Workflow

Specify the column selection to use in the form. Use the Preview table to confirm your selection.

Column selection: |AH Metric Attributes| - |
Actual Target Performance
Label Actual Target Performance
Preview: Display Options Value Value Value
Date Options Current date Current date Current date
Allow Data Entry No No No

Column selections are collections of predefined columns to use in the form.
Read-Write and Read-Only controls for each column are also defined in
column selections. For more information, see “Create a Column Selection for
Use in a Data-Entry Form” on page 145.

TIP When columns are Read-Only, data-entry users cannot enter data in
the cells. Read-Only columns are useful when a user needs to see
historical or forecasted values or needs some information for data entry,
but should not need to change the values.

To specify column selections for inclusion in the form:

a From the Column selection list, select the column selection that you
want to use in the form.
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b View the Preview table to make sure that your selection is correct for the
form.

6 Click the Workflow tab.

1 - Identification " 2 - Elements " 3 - Columns || 4 - Workflow |

*ou can define a workflow that is assodiated with this form. (@)

—Workflow

To define a workflow for this form, clear the No Workflow required check box. By default, the workflow occurs only
once.

] Mo workflow required

] Repeat this workflow each time the workflow is completed

m

a In the Workflow section, specify whether you want a workflow and how
you want the workflow to repeat.

By default, a form does not have a workflow. To specify a workflow,
clear the No workflow required check box.

To specify that a workflow repeat, click Repeat this workflow each
time the workflow is completed.

b In the Assignees section, specify the behavior of the form for those users
who are assigned to enter data into the form in the workflow.

—Assignees
You can choose one or more users to enter data into the form.

Send a notification that a form is available for data entry

From the list, select one or more users to enter data into the form and click Add.

|STMdata2 - | m @ All users must submit the form () Any user can submit the form
[ Name
[] sTmdataz K

m

To notify the users that a form is available for work, click Send
notification that a form is available.

Note: If you want a user to receive e-mail notifications, the user name
must have e-mail enabled. This user name setting must be set in SAS
Management Console. Also, these users must be members of the
SAS Strategy Management Users Group and the SAS Strategy
Management Data Entry Group.

From the Assignees list, select a user and click Add. The selected
user is added to the Assignees table below the list.

If you want to remove a user, click the X next to the user in the table.
To remove all users from the table, click the X next to the table
heading.
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Specify whether one or all of the users must submit the form for the
workflow to proceed. If one user is sufficient, click Any user can
submit the form. Otherwise, click All users must submit the form.

c In the Approvers section, specify the behavior of the form for those users
that approve the form in the workflow.

—Approvers

You can choose one or more users to approve the form after data is entered. You can also specify the order in which the
users approve the form.

(©) Each approver must approve the form in the assigned order

@ Any approver can approve the form

Send a netification that a form is available for approva

From the list, select one or more users to approve the data into the form and click Add.

|STrﬂappm - ‘ m

[] order Name
[0 1 STMappr

Remove

m

Specify whether one or all of the users must approve the form. If one
user is sufficient, click Any approver can approve the form.
Otherwise, click Each approver must approve the form in the
assigned order.

To notify the approvers that a form is available, click Send
notification that a form is available for approval.

Note: If you want a user to receive e-mail notifications, the user name
must have e-mail enabled. This user name setting must be set in SAS
Management Console. Also, these users must be members of the
SAS Strategy Management Users Group and the SAS Strategy
Management Data Entry Approver Group.

From the Approvers list, select a user and click Add. The selected
user is added to the Approvers table below the list.

If you want to remove a user, click the X next to the user in the table.
To remove all users from the table, click the X next to the table
heading.

TIP To change the order of users in the table, drag a row and drop
it in a new location in the table.

7 Click Save to save your selections. The form appears in the Forms list
above the Properties section. Click Cancel to exit the Properties section
without saving your selections.
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Manage Data Entry Forms Gsas

* | | | ©

Select a form to open or copy. You can also create a form. (3)

Name Last Entered Status Approver Owner
travel expenses 5/22/13 12:26 PM Workflow not started ~ STMappr1 SAS Demo User a

Note: If you click the column headings in the Forms list to sort items in the
list, the feature does not sort the items correctly in languages other than
English.

Edit or View the Properties of a Form

Note: If X and %3 are the only buttons available on the toolbar, the role and
capability settings that are associated with your user name are limited to viewing
only. If you require expanded access to SAS Strategy Management, contact
your SAS Strategy Management administrator.

To edit the properties of a form, complete the following steps on the Manage
Data Entry Forms page:

1

Copy a Form

Double-click the form that you want to edit. The Properties section appears
below the Forms list.

Change the applicable settings in the form as described in “Create a Form
and Workflow” on page 330.

Click Save to save your selections. Click Cancel to exit the Properties
section without saving your selections.

To copy a form, complete the following steps on the Manage Data Entry Forms
page:

1

Select the form that you want to copy and click ¥g.

The copied form appears in the list. A number is appended to the form’s
name.

To edit the copied form, double-click its name. The Properties section
appears below the Forms list.

Change the applicable settings in the form as described in “Create a Form
and Workflow” on page 330.

Click Save to save your selections. Click Cancel to exit the Properties
section without saving your selections.
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Delete a Form

To delete a form, complete the following steps on the Manage Data Entry Forms
page:

1 Select the form that you want to delete and click T .

Note: If you want to delete multiple forms at once, use the Shift key or the
Ctrl key when you click your selections.

2 A confirmation message appears. Click Yes to delete the form.

Refresh the Forms List

To refresh the list of available forms, click ¥ on the Manage Data Entry Forms
page.

Start a Workflow

After you create a data-entry form and define its workflow, you can start the
workflow process for the form.

To start the workflow for a form, complete the following steps on the Manage
Data Entry Forms page:

1 Select the form that contains the workflow that you want to start and click ».

2 A confirmation message appears. Click Start to start the workflow. The
status for the form changes to Awaiting data entry.

For the workflow to continue, the users that you specified as assigneesmust
enter the applicable data into the form and then submit their changes.

Set the Workflow to Stop After the Cycle

Completes

You can set a data-entry form to stop its workflow cycle after the form has been
submitted and approved by all of the applicable users.

To set the workflow to stop at the end of a cycle, complete the following steps on
the Manage Data Entry Forms page:

1 Select the form that contains the workflow that you want to stop and click =.

2 A confirmation message appears. Click Stop. When the form has been
submitted and approved by all of the applicable users, the workflow stops.
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You must click ® to start the form’s workflow again.

Immediately Stop the Workflow and Delete
All Work

You can stop the workflow of a data-entry form immediately. All of the data that
has been entered and submitted, as well as any approvals, are deleted.

CAUTION! You cannot undo an immediate workflow stoppage. All of the work
that has been submitted or approved in the workflow is permanently deleted.

To immediately stop the workflow, complete the following steps on the Manage
Data Entry Forms page:

1 Select the form that contains the workflow that you want to stop and click & .

2 A confirmation message appears. Click Stop. The workflow stops and the
status for the form changes to Workflow not started.

You must click ® to start the form’s workflow again.

Create and Edit a Performance Data-Entry
Portlet

For users to access the data-entry form, you must create a Performance Data-
Entry portlet. To create a portlet, see Chapter 25, “Creating a Portlet,” on page
253.

For information about editing and customizing the portlet, see “Edit a
Performance Data-Entry Portlet” on page 297.
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Data-Entry Form Considerations

When you are using a data-entry portlet, remember the following considerations:
It is possible to have multiple data-entry portlets on a portlet page.
The same data entry form can appear in multiple portlets on a portal page.

Data entered in one instance of the portlet might not be immediately reflected
in another instance of the portlet.

Enter Data in a Form without a Workflow

You can use the data-entry portlet to enter scorecard data for a date or for
period of time.

To enter data in a data-entry portlet:
1 Access the portal page that includes the data-entry portlet.

2 In the Date field, select the date for which you want to enter data.

Note: Due to customization, this field might not be enabled.
3 From the Period type list, select the period type for which you want to enter
data.

TIP This list provides only the period types that are valid for the elements
in the form.

4 From the Scorecard list, select the scorecard for which you want to enter
data.
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5 Click ® to enter comments about the form. For more information about
making comments, see the SAS Information Delivery Portal help.

6 Enter values in the cells in the form. When you enter data, remember the
following considerations:

The column headings indicate whether its cells are text or numeric.
When you click in a Read-Only cell, the text in the cell appears gray.

Cells that require an entry display This cell is required. You
cannot submit the form without entering data in these cells.

Percentages, commas, inline formulas, currency, or any other notation
are not supported in data-entry forms.

The form might have rules assigned in order to validate data that is
entered into the form. If a value fails validation, a warning is displayed for
the affected cells. Typically, you must correct these values before you can
submit the form. However, depending on how a form is customized, a
form might permit you to submit an invalid value.

7 To save the data entered into a form, click Submit.

Enter Data in a Form with a Defined

Workflow

If a form has a defined workflow, all of the affected data-entry users must enter
and submit the data in the form. To enter data:

1 Access the portal page that includes the data-entry portlet.

2 In the Date field, select the date for which you want to enter data.

Note: Due to customization, this field might not be enabled.

3 From the Period type list, select the period type for which you want to enter
data.

4 From the Scorecard list, select the scorecard for which you want to enter
data.

5 Enter values in the fields in the data-entry table.

6 If you want to enter comments about the form, click %®. For more information
about making comments, see the SAS Information Delivery Portal help.

7 If you want to clear the form of any unsaved changes, click Discard
Changes.

8 To save the data entered into a form, click Save. You can return to the form
and make further updates.

9 When your work in the form is complete, click Submit.

Note: You can no longer access the form after you submit it. To access the
form again, the workflow must start again.
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Approve Data

If a form has a defined workflow, the form is submitted by the data-entry users
after all of the data is entered. Then, the workflow starts the approval process.
Depending on how the workflow is defined, one or more approvers must review
and approve the data. Also, approvers might have to approve the data in a
specified order.

To approve data that was entered by one or more data-entry users:
1 Access the portal page that includes the data-entry portlet.

2 If you want to approve the data that was submitted only by a specific data-
entry user, make sure that the user is selected in the Submitter list.

Otherwise, if you want to approve the data that was submitted by all of the
data-entry users, make sure that (all) is selected in the Submitter list.

3 Click Approve.

4 A confirmation message appears. Click Approve again. The data is stored in
the system and is available for viewing.

If the form has completed the specified workflow process, the following message
appears: The form has completed the approval process. The
form does not require any further actions.

If the form has not completed the specified workflow process, the following
message appears: The form is partially approved. Other
approvers must complete the approval process. You have
completed your actions for this form.

Reject Data

To reject data that was entered by one or more data-entry users:
1 Access the portal page that includes the data-entry portlet.

2 If you want to reject the data that was submitted by a specific data-entry
user, make sure that the user is selected in the Submitter list.

Otherwise, if you want to reject the data that was submitted by all of the data-
entry users, make sure that (all) is selected in the Submitter list.

3 Click Reject.

4 A confirmation message appears. You can enter comments to the data-entry
user in the text field.

5 Click Reject. The form is made available to the affected user so that the user
can make corrections.
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SAS Strategy Management provides an Import wizard that you can use to import
data into a SAS Strategy Management project. The project and its template must
already exist in SAS Strategy Management. You can define the project by using
either Strategy Management Builder or the Batch Maintenance Facility (BMF).

After you define the project, you can use the Import wizard to define how to

import your data:
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You can import a scorecard hierarchy, but you cannot import content for the
scorecards at the same time.

You can import metric content into a pre-existing scorecard hierarchy.
You can import non-metric content into a pre-existing scorecard hierarchy.

In the wizard, you select the source data file to use. Then, you specify how the
columns of data in the source file map to the new hierarchy or to columns in
SAS Strategy Management scorecards.

For more information about SAS Strategy Management Builder, see “Part 2.
Describing and Building Your Strategy” in this User's Guide. For more
information about the BMF, see the SAS Strategy Management: System
Administration Guide.

Types of Imports
You can import data in the following ways:
use a hierarchy configuration that creates the scorecard hierarchies only.

When you run the hierarchy configuration, the hierarchy that is specified in
the source data file is imported into the SAS Strategy Management project as
scorecards. You can populate the scorecard hierarchy by using the content
configuration or the Batch Maintenance Facility.

use a content configuration that creates element data and cell data for the
scorecards. For each element, the cell data includes a specific metric
attribute and time period.

The content configuration requires that a scorecard hierarchy already exist in
the project. The hierarchy might contain other data as well. When you run the
content configuration, the data in the source data file is imported into the
SAS Strategy Management scorecards as element and cell data, or as
project-level elements.

use a content configuration that creates element data and cell data for the
scorecards. For each element, the cell data includes one or more of the five
types of non-metric attributes.

The non-metric content configuration requires that a scorecard hierarchy
already exist in the project. The hierarchy might contain other data as well.
When you run the non-metric content configuration, the data in the source
data file is imported into the SAS Strategy Management scorecards as
element and cell data, or as project-level elements.

Supported Source Data Files
You can import data from the following types of source files:
SAS data sets

Microsoft Excel files
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These data source files must be either registered or unregistered.

Type Description Data Supported

Unregistered Indicates that the file is located on Excel spreadsheet files
a file system that is accessible to
the middle tier. For more
information, see “Local Microsoft
Excel Files and Shared Directories”
on page 346.

Registered Indicates that the file is registered Excel spreadsheet files
in the SAS Metadata Repository.
To register a file, contact your SAS SAS data sets
Strategy Management
administrator. For more
information, see “Registering Files”
in the SAS Strategy Management:
System Administration Guide.

Remember the following limitations when you use Excel spreadsheet files:
Excel files from version 2007 or later are supported.

SAS Strategy Management cannot read an Excel spreadsheet if that
spreadsheet is currently open in Excel. Excel locks the file when the file is
open.

You cannot register or read an Excel spreadsheet that is located on a server
that is running UNIX. Excel spreadsheets use a data structure that is specific
to Microsoft. The Import wizard uses Microsoft technology to read the
spreadsheet. This technology does not currently exist on UNIX. However,
you can register and read SAS data sets that are located on servers that are
running UNIX.

SAS Strategy Management cannot read Excel spreadsheets that are located
on a different network domain than the domain where the middle tier is
located. This limitation applies to registered and unregistered spreadsheets.

Registering Source Data Files

To import data that is located in SAS data sets, the data sets must be registered.
Excel files can be registered also. Contact your SAS system administrator to
determine whether a SAS data set or Excel spreadsheet is registered. For more
information, see “Registering Files” in the SAS Strategy Management: System
Administration Guide.
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Local Microsoft Excel Files and Shared

Directories

If you want to use unregistered Excel spreadsheet files, the files must be located
where the middle-tier server can access them. That is, the files must be local
and must be in a shared directory.

The spreadsheet file location must meet the following criteria:
The file must be on a Windows system (not UNIX).

The file must be in a directory whose permissions grant Read access to the
Java Virtual Machine on the middle-tier server.

Note: Your system administrator can confirm that these permissions are set.
The file must be on the same network domain as the middle-tier server.

Typically, the file system of the middle-tier server satisfies these requirements. If
you locate the spreadsheet file on a different file server, you must provide the full
Universal Naming Convention (UNC) file path to the spreadsheet file when you
specify your local Excel source data.

Source Data Organization

Overview

In order to successfully import your data into SAS Strategy Management, the
data must meet certain criteria.

SAS data sets and Microsoft Excel spreadsheets store data in different ways:

SAS organizes data into variables and stores the variable as either character
or numeric data only.

Excel organizes data into cells that you can format by using a variety of data
types. To see these data types, right-click in a cell and select Format cells.

You can express any item as a character string in both SAS and Excel data. In
SAS, you can store the numeric value 64.35 as the character value 64 .35 in a
SAS data set:

data temp;

input value $8;

cards;

64.35
In Excel, you can create a worksheet, type 64 .35 in a cell, and then format the
cell as character data by using the General cell format provided by Excel. Both
of these formatting techniques affect how SAS Strategy Management imports
the data.
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The two formatting techniques especially affect date values. The following
sections describe both data file types, SAS and Excel, and what to consider
when you create them.

Data-Column Naming Requirements for Microsoft

Excel Files

The Import wizard views the input data as a table (a series of rows and columns
of values). The rows are referred to by number. The first row of data values is
row 1. Each column has a name. SAS software and Excel assign names
differently:

SAS software automatically bases the name of each column on the name of
the variable with which the column is associated.

Excel automatically uses ascending letters of the alphabet to name each
column.

The Import wizard cannot use the Excel method of naming columns. For Excel
files, you must create column names in row 1.

CAUTION! If you omit this change, the Import wizard uses the first row of
data as the column names.

When the Import wizard displays the data columns in the Preview fields or lists,
you might notice that the column names differ from the actual text values that
you specified. For example, if you used the underscore character, it is converted
to a blank. This type of change does not affect the way the Import wizard

processes the column names.

Scorecard ldentification Requirements

The Import wizard requires that you identify the scorecard in which to import the
source data. You can identify scorecards using either of the following ways:

the hierarchy data includes one or more columns that contain the name of
each scorecard.

1 leveln level2 leve3 element_name start_period end_peried metric_attribute wvalue period
2 Worldwide Sales 2013 2013-12-01  2013-12-30 target 46000.00 2013-12-01
3 Worldwide Sales 2013 2013-12-01  2013-12-30 actual 32000.00 2013-12-01
4 Worldwide Europe Sales 2013 2013-12-01  2013-12-30 target 13000.00 2013-12-01
5 Worldwide Europe Sales 2013 2013-12-01  2013-12-30 actual 9000.00 2013-12-01
6 Worldwide Europe  France  Sales 2013 2013-12-01  2013-12-30 target 55000.00 2013-12-01
7 Worldwide Europe  France  Sales 2013 2013-12-01  2013-12-30 actual 19000.00 2013-12-01
8§ Worldwide Europe  Germany Sales 2013 2013-12-01  2013-12-30 target 7000.00 2013-12-01

| 9 Worldwide Europe  Germany Sales 2013 2013-12-01  2013-12-30 actual 3000.00 2013-12-01

each scorecard is saved with a unique identifier called a scorecard identifier.

'_l code element_name start_period end_period metric_attribute value period
2 SC W Sales 2013 2013-12-01 2013-12-30 target 4a6000.00 2013-12-01
3 SC_W Sales 2013 2013-12-01  2013-12-30 actual 32000.00 2013-12-01
4 SC_WI Sales 2013 2013-12-01 2013-12-30 target 13000.00 2013-12-01
5 SC_WI Sales 2013 2013-12-01  2013-12-30 actual 9000.00 2013-12-01
6 SC_WEF Sales2013 2013-12-01 2013-12-30 target 55000.00 2013-12-01
7 SC_WEF  Sales 2013 2013-12-01  2013-12-30 actual 19000.00 2013-12-01
5 SC_WEG Sales2013 2013-12-01 2013-12-30 target 7000.00 2013-12-01

| 9 SC_WEG Sales 2013 2013-12-01  2013-12-30 actual 3000.00 2013-12-01
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Date Representation Considerations

Default Date Format

By default, the Import wizard expects date values to be stored in one of the
following ways:

SAS data sets: As numeric values that are associated with a SAS date
format

Microsoft Excel: As date-formatted cells

When you select Use as defined in source, you accept this default way that the
Import wizard expects SAS and Excel to create date values. The Use as
defined in source selection is located in the Source date format list in the
Import wizard.

Note: When you specify a date format to use for numeric dates in SAS, ensure
that you use a date format that is supported for your locale. See the SAS
documentation about locale and national language considerations.

Numeric Dates in SAS
The following code is an example of a SAS program:

data dsets.measuresdates;

input sccode $ element $ startperiod : mmddyy8. endperiod : mmddyy8. value period : mmddyy8.;
cards;

codel elementl 11-01-11 11-30-11 36.3 11-01-11

code2 element?2 12-01-11 12-31-11 43.2 12-01-11

I

The variables startperiod, endperiod, and period are numeric variables.
The SAS informat mmddyy8. is associated with each them. If you run this
program and invoke the PRINT procedure on the results, you receive the
following output:

The SAS System

Obs sccode | elememt | startperiod | endperiod | value  period

1| codet 18961 |3 1883

2 | code? 185962 18992 | 432 18962

The date value 11-01-11 appears as the numeric value 18932. This is the date
value when SAS stores it as a numeric value.

Date-Formatted Cells in Microsoft Excel

In an Excel spreadsheet, you can type a date value in the first cell, and then
right-click the cell and select Format Cells. The following figure shows that
Excel has applied a date format to the value by default.

Note: You can also manually specify Date in this window.
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Dates as Character Values in SAS and Microsoft Excel

The following SAS program reads the date value as a character string:
data dsets.measuresdates;

input sccode $ element $ startperiod $ endperiod $ value period $;
cards;

codel elementl 11-01-11 11-30-11 36.3 11-01-11
code2 element2 12-01-11 12-31-11 43.2 12-01-11

1

The variables startperiod, endperiod, and period are character variables.

If you run this program and invoke the PRINT procedure on the results, you
receive the following output:

The SAS System

Obs sccode | element | startperiod | endperiod wvalue  period

1 codel elemer-ﬂ a1 B3 10111

2 code2  element? 120111 12-31-11 432 12-01-11

The date value 11-01-11 appears as the character value 11-01-11. This is the
date value when SAS stores it as a character value.

On the Number tab in the Format Cells window in Excel, you can select
General as the format of the cell.
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Both of these methods create a date value as a character string. The Import
wizard cannot read these values correctly by using the default setting. Instead,
you must select a source date format in the Import wizard that matches the
format that you used to create the date value. For the Excel example, select the
MM/dd/yyyy format.

Ifthe source data containg start and end dates for the elements, specify the date format and =el

gource date form@l | 19042011 M |~ 7

T b
Start date column: || Float (#
110472011 (MM Py
End date calumn: | Endperiod [+ i._, Float

Changing Source Data Files and Its
Consequences

After you create an import configuration, an association exists between the
configuration and your source data file. Because of this association, you must
avoid making certain changes to the source data file.

Change Affects Data Structure or

Change Affects Only Data Values Mapping Associations
The following changes affect the data The following changes affect the structure
values, but not the structure of the data: of the data or the data mapping

. associations between the source data file
adding rows of data and the import configuration:
deleting rows of data .

adding columns
changing values in a cell deleting columns

renaming column headings
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You cannot make structural changes to the source data file without updating the
configuration. If the source data file is registered, you must update the metadata
of the source data file by using SAS Management Console.

For example, suppose you define a configuration that uses an unregistered
Excel spreadsheet and a worksheet called MySheet$. Then, you edit the Excel
spreadsheet and rename the worksheet to DifferentSheet$. Because of this
change, you must edit the content configuration. On the Select Source Data
page, you must select the new worksheet name.

Note: This correction does not work for a registered Excel spreadsheet.
Instead, in the SAS Management Console Data Library Manager, you must
delete the old table named MySheet$ and register the renamed worksheet.

As another example, suppose a SAS data set is associated with a configuration
and you add a new column to the data set. After you save the changes, you
must delete the old table and register the changed data set in the SAS
Management Console Data Library Manager.

TIP If the file does not successfully import after you reregister it, consider
creating a new import configuration.

Define How to Import Metric Data from a

Source File

The content configuration requires that a scorecard hierarchy already exist in the
project. The hierarchy might contain other data as well. When you run the
content configuration, the data in the source data file is imported into the SAS
Strategy Management scorecards as element and cell data, or as project-level
elements.

To define how SAS Strategy Management imports metric data from a source file:

CAUTION! In the following procedure, do not select the same column from
your source data more than once. The column mappings must be one-to-one.
Otherwise, the import configuration fails when you run it.

1 In an open scorecard, select Project » Manage Import Options. The Import
page appears.
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G§sas

Log OfF

: : :
| Name | Owner | Last Run | Status @

2 In the toolbar, click [# and then click New Content Import Configuration.
The Import Content wizard appears.

3 On the Identification page, type a name that is unique within this SAS
Strategy Management project. A description is optional.

4 Click Next.

5 On the Select Source Data page, select the type of data that you want to
import.

Local source If your source file is located on your local system, select Local
data Excel source data. Typically, you select this option if you are
importing a Microsoft Excel file that is unregistered.

In the File path field, type the file path and click Retrieve.

Note: The file path must include the computer name. In the
following example, the system is called MYCOMPUTER. If the
file is located on a system that is running Windows, an
example file path is
\\MYCOMPUTER\spreadsheets\monthly
reports.xlsx. For more information, see “Local Microsoft
Excel Files and Shared Directories” on page 346.

From the Worksheet list, select the Excel worksheet that
contains the data that you want to use.

SAS server If you want to import a SAS data set or Excel spreadsheet,
source data select SAS server source data.

Note: SAS data sets or Excel spreadsheets must be
registered before you can use them. For more information,
see “Registering Source Data Files” on page 345.

In the Select window, navigate to the table that you want to
import and select it. Then, click OK.
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6 A preview table appears in the wizard. In this table, view the data that is
contained in the file that you selected.

§sas
Log Off
Select Source Data Step 2 of 8
Steps 4 Selectthe source data file that you wantto import. (3

Identification Local Excel source data SAS server source data

Select Source Data

Map Element Types
Currently selected source data: /Products/SAS Intelligence Platform/Samples/ODSSTYLE
Display Value | Style Name |
Analysis Styles Analysis ol
Astronomy ..| Styles Astronomy

Banker ..| Styles.Banker _
BarrettsBlue .. Styles.BarrettsBlue )
blockPrint ..| Styles.blockPrint
Curve .. Styles.Curve B
Default ... Styles.Default
Diree ..| Slyles.Diree
Education .. Styles Education
EGDefault .. Styles.EGDefault
Electronics .. Styles.Flectronics -
|Saveas Draftl |Previ0||s || Next || Cancel | Finish
7 Click Next.

8 On the Map Element Types page, select the element type name to use when
the source data is imported.

Element type If you want to import all of the data by using the same element
type name or if the source data does not include the element
type name to use, select the element type from the Element
type list.

Note: The selections in this list are the element types that are
already defined in the current SAS Strategy Management
template.

Note: If you want to create elements that are all of the same
type, use this option.

Element type If your source data includes the element type information,

column select the column that provides the element type information.
The data that the column contains appears in the Preview
field so that you can verify your selection.

Note: The selections in this list are the columns that are in
the source data. This option enables you to create a new
element in the project when you import the source data.
Select the column name that contains the elements to import.

Note: If you want to create elements that are of different
types, use this option. It enables you to specify a different type
for each element that you create.

Note: Element type names in the source data must match the element type
names that are defined in the Strategy Management template.
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9 Click Next.

10 On the Map to Hierarchy page, map the content in the source data to an
existing scorecard in a SAS Strategy Management project. When you define
this mapping, you implicitly map your data to the hierarchy in which the
scorecard exists in the project. For an example, see “Scorecard Identification
Requirements” on page 347. Alternatively, you can map the content to
elements of a project.

TIP A hierarchy represents the levels in your scorecard tree. You can
have a root level, parent levels, and child levels. The following hierarchy of
scorecards is an example: worldwide, division, department, and group.
Worldwide is the root level. Division is a child of worldwide and a parent of
department, and so on.

TIP Scroll down the page to view all of the available selections.

Identifier column These selections are the columns that are in the source data.
Select the column name that contains the unique scorecard
identifiers that are already defined in the SAS Strategy
Management project. The data that the column contains
appears in the Preview field so that you can verify your
selection.

Note: If you have already selected a column in the Import
wizard, do not select it again.

Hierarchy levels  From the Available items list, select columns from the source
data to map to the scorecard hierarchy in your SAS Strategy
Management project. You can change the order of the levels
in the Selected items list.

Note: A best practice is to map the same number of levels
that you are importing. For example, if you are importing two
levels of data, then map only two levels of the hierarchy.

Note: If you have already selected a column in the Import
wizard, do not select it again.

Import as If the project has project-level element types defined, use this
project-level selection to create project-level elements from your source
elements data.

11 Click Next.

12 On the Map Elements page, map the element column in the source data to
the elements that are in the scorecards of the SAS Strategy Management
project. If the source data contains elements that are not in the project, you
can create them.

TIP Scroll down the page to view all of the available selections.

Complete the following steps:

a If you want the import process to create elements that exist in the source
data but that do not exist in the project, click Create elements that do
not exist.
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From the Element column list, select the column name in the source
data that contains the elements to import. The data that the column
contains appears in the Preview field so that you can verify your
selection.

Note: If you have already selected a column in the Import wizard, do not
select it again.

If the source data contains start dates and end dates for the elements,
specify the date format and select the applicable columns from the source
data. For more information, see “Date Representation Considerations” on
page 348.

From the Source date format list, make the applicable selection:

If the date values are stored as numeric values in your source data,
select Use as defined in source.

If the date values are stored as character values in your source data,
select the format that matches the format of your date character
values.

From the Start date column list, select the column to use for the start
dates. From the End date column list, select the column to use for the
end dates.

TIP Select Float to specify that the affected dates are always valid for
that selection.

Note: If you have already selected a column in the Import wizard, do not
select it again.

13 Click Next.

14 On the Map Attributes page, map the source data to the metric attributes
content that is defined in SAS Strategy Management.

TIP Scroll down the page to view all of the available selections.

Complete the following steps:

a

If you are importing source data into scorecards that contain metric
attributes that already contain manually entered values, click Overwrite
cells that contain manually-entered values. Selecting this option
ensures that the imported data overwrites the pre-existing data in the
scorecards. Otherwise, the imported data for the affected metric attributes
is ignored.

If you are importing source data into scorecards that contain metric
attributes that already contain formulas, click Overwrite cells that
contain formulas. Selecting this option ensures that the imported data
overwrites the pre-existing formulas in the scorecards. Otherwise, the
imported data for the affected metric attributes is ignored.

Choose the mapping option that matches the organization of your source
data:
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Metric attributes The source data typically has only one row for each

are in one row

Each metric
attribute is in its
own row

element. An element might have one or more metric
attributes, such as Actual and Target. The row contains
columns that describe the value, text, and link for one or
more metric attributes. The following table provides an
example:

element actual target Link actual Link target
grow 1 2 finance numbers| future
prosper 1 2 goole finance future

The Available items list contains all of the column names
in the source data. The Selected items list contains
attributes and their element types that you mapped on the
Map Element Types page of this wizard. From the
Available items list, drag an attribute column onto its
attribute in the Selected items list.

The source data has multiple rows for an element. Each
row can define the value, text, link, or rule for one metric
attribute. For example, one row defines the value, text, or
link for the metric attribute called Actual, and another row
defines the value, text, or link for the metric attribute called
Target. The following table provides an example:

element | metric attribute| value Link
grow actual 1 finance numbers
grow target . future
prosper actual 1 goole finance
prosper target 2 future

Make the applicable selections from the lists.

Note: To use rules with the Import wizard, the rule
definitions must already exist in the project. Then the
Import wizard can apply the rules to the metric attributes.
For more information, see Chapter 10, “Defining Rules,” on
page 123.

For more information, see “Source Data Organization” on page 346.

15 Click Next.

16 On the Map Time page, map the column in the source data that contains
date values. The date values must map to time periods that are defined in
SAS Strategy Management. The metric attribute value, text, and link are
associated with these date values. Complete the following steps:

a From the Time period column list, select the column that provides the
time period for your data. The data that the column contains appears in
the Preview field so that you can verify your selection.

Note: If you have already selected a column in the Import wizard, do not

select it again.

b From the Period type list, select the type of time period (for example,
month or year) that the date values use.

17 Click Next.

18 On the Preview Mappings page, preview a sample of the specified mappings
that you want to use for your data. When you are satisfied, click Finish to
save and run the import configuration.
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Gsas
Log Off
Preview Mappings Step 8 of 8
Steps 4 Preview a sample ofthe specified mappings. When you are satisfied, click Finish to save and run the import configuration. If you do notwantto run
the import configuration, click Save as Draft.
|dentification
Select Source Data Source table:
Map Element Types Name [ Type [ Date [ Attribute Name [
Map to Hirarchy Styles.Analysis Measures Analysis .. Styles.Analysis -
Map Elements Styles.Astronomy Measures Astronomy .. Styles Astronomy
lMap Attributes Styles.Banker Measures Banker .| Styles.Banker
Map Time Styles BarrettsBlue Measures BarrettsBlue Styles BarrettsBlue B
Preview Mappings Styles.blockPrint Measures blockPrint . Styles.blockPrint -
Styles.Curve Measures Curve ..| Styles.Curve
Styles.Default Measures Default .| Styles Default
Styles.Dtree Measures Dtree . Styles Dtree 3
Styles.Education Measures Education .. Styles Education
Styles.EGDefault Measures EGDefault .. Styles EGDefault
Styles.Electronics Measures Electronics .. Styles Electronics
Styles.fancyPrinter Measures fancyPrinter ... Styles fancyPrinter
Styles. Festival Measures Festival .| Styles Festival -
| Save as Draft| | Previous | Next Cancel Finish

TIP If you want to save the import configuration but you do not want to run
it, click Save as Draft. The import configuration is saved to the selection
list. When you want to run it, select the import configuration and click 4.

The Import selection list appears and includes the new import configuration.
The Status column indicates whether the configuration ran successfully. If the
status icon indicates that errors occurred, click that icon to view the error log.

Define How to Import Non-metric Data from
a Source File

The non-metric content configuration requires that a scorecard hierarchy already
exist in the project. The hierarchy might contain other data as well. When you
run the non-metric content configuration, the data in the source data file is
imported into the SAS Strategy Management scorecards as element and cell
data, or as project-level elements.

Note: If attributes that are specified in the configuration already exist in the
project, the attributes’ values are replaced when the import is invoked.

To define how SAS Strategy Management imports non-metric data from a
source file:

CAUTION! In the following procedure, do not select the same column from
your source data more than once. The column mappings must be one-to-one.
Otherwise, the import configuration fails when you run it.

1 In an open scorecard, select Project » Manage Import Options. The Import
page appears.
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2 In the toolbar, click [# and then click New Non-metric Content Import
Configuration. The Import Content wizard appears.

3 On the Identification page, type a name that is unique within this SAS
Strategy Management project. A description is optional.

4 Click Next.

5 On the Select Source Data page, select the type of data that you want to
import.

Local source If your source file is located on your local system, select Local
data Excel source data. Typically, you select this option if you are
importing a Microsoft Excel file that is unregistered.

In the File path field, type the file path and click Retrieve.

Note: The file path must include the computer name. In the
following example, the system is called MYCOMPUTER. If the
file is located on a system that is running Windows, an
example file path is
\\MYCOMPUTER\spreadsheets\monthly
reports.xlsx. For more information, see “Local Microsoft
Excel Files and Shared Directories” on page 346.

From the Worksheet list, select the Excel worksheet that
contains the data that you want to use.

SAS server If you want to import a SAS data set or Excel spreadsheet,
source data select SAS server source data.

Note: SAS data sets or Excel spreadsheets must be
registered before you can use them. For more information,
see “Registering Source Data Files” on page 345.

In the Select window, navigate to the table that you want to
import and select it. Then, click OK.

6 A preview table appears in the wizard. In this table, view the data that is
contained in the file that you selected.

7 Click Next.

8 On the Map Element Types page, select the element type name to use when
the source data is imported.

Element type If you want to import all of the data by using the same element
type name or if the source data does not include the element
type name to use, select the element type from the Element
type list.

Note: The selections in this list are the element types that are
already defined in the current SAS Strategy Management
template.

Note: If you want to create elements that are all of the same
type, use this option.
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Element type If your source data includes the element type information,

column select the column that provides the element type information.
The data that the column contains appears in the Preview
field so that you can verify your selection.

Note: The selections in this list are the columns that are in
the source data. This option enables you to create a new
element in the project when you import the source data.
Select the column name that contains the elements to import.

Note: If you want to create elements that are of different
types, use this option. It enables you to specify a different type
for each element that you create.

Note: Element type names in the source data must match the element type
names that are defined in the Strategy Management template.

9 Click Next.

10 On the Map to Hierarchy page, map the content in the source data to an
existing scorecard in a SAS Strategy Management project. When you define
this mapping, you implicitly map your data to the hierarchy in which the
scorecard exists in the project. For an example, see “Scorecard Identification
Requirements” on page 347. Alternatively, you can map the content to
elements of a project.

TIP A hierarchy represents the levels in your scorecard tree. You can
have a root level, parent levels, and child levels. The following hierarchy of
scorecards is an example: worldwide, division, department, and group.
Worldwide is the root level. Division is a child of worldwide and a parent of
department, and so on.

TIP Scroll down the page to view all of the available selections.

Identifier column These selections are the columns that are in the source data.
Select the column name that contains the unique scorecard
identifiers that are already defined in the SAS Strategy
Management project. The data that the column contains
appears in the Preview field so that you can verify your
selection.

Note: If you have already selected a column in the Import
wizard, do not select it again.

Hierarchy levels From the Available items list, select columns from the source
data to map to the scorecard hierarchy in your SAS Strategy
Management project. You can change the order of the levels
in the Selected items list.

Note: A best practice is to map the same number of levels
that you are importing. For example, if you are importing two
levels of data, then map only two levels of the hierarchy.

Note: If you have already selected a column in the Import
wizard, do not select it again.

Import as If the project has project-level element types defined, use this
project-level selection to create project-level elements from your source
elements data.
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11 Click Next.

12 On the Map Elements page, map the element column in the source data to
the elements that are in the scorecards of the SAS Strategy Management
project. If the source data contains elements that are not in the project, you
can create them.

TIP Scroll down the page to view all of the available selections.

Complete the following steps:

If you want to emphasize the relationship between the two elements,
select Link element. For example, you might link the Sales elements in
different scorecards. This relationship is helpful when you are creating
formulas or when you are setting and reviewing alerts in scorecards that
directly descend from a scorecard that is located higher up in the
hierarchy.

Note: The Link element option in the Import wizard links only elements
that meet the following criteria:

The two elements must be the same element type.
Both of the elements must be named identically.

The scorecard of one of the elements must be a direct descendant of
the other element’s scorecard.

Neither element can exist until the import configuration is invoked by
the Import wizard. You cannot link to an element that pre-exists in the
project.

TIP If you want to link to a pre-existing element, you must use the Link
element option in the SAS Strategy Management Builder. You can also
use the Builder to link elements that are not named identically. For
more information, see “Link Elements” on page 107.

If you want the import process to create elements that exist in the source
data but that do not exist in the project, click Create elements that do
not exist.

Make the following selections to map the element.

Note: If you have already selected a column in the Import wizard, do not
select it again.

From the Element column list, select the column name in the source
data that contains the elements to import. The data that the column
contains appears in the Preview field so that you can verify your
selection.

(Optional) From the Element owner list, select the column name in
the source data that contains the element owner data to import.

(Optional) From the Element description list, select the column name
in the source data that contains the element description data to import.

(Optional) From the Element link list, select the column name in the
source data that contains the element named link data to import.
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d If the source data contains start dates and end dates for the elements,
specify the date format and select the applicable columns from the source
data. For more information, see “Date Representation Considerations” on
page 348.

From the Source date format list, make the applicable selection:

If the date values are stored as numeric values in your source data,
select Use as defined in source.

If the date values are stored as character values in your source data,
select the format that matches the format of your date character
values.

From the Start date column list, select the column to use for the start
dates. From the End date column list, select the column to use for the
end dates.

TIP Select Float to specify that the affected dates are always valid for
that selection.

Note: If you have already selected a column in the Import wizard, do not
select it again.

e When an element is defined, it is assigned a period type. If you are
creating a new element in the project, you must specify that element’s
period type to enable the Import wizard to map the element.

Note: This setting affects only the newly created elements in the project.
The setting does not affect the period type of existing elements.

If the source data has a column that contains the period type
information, select the Choose a period type column list and then
select that column for the wizard to use.

If you want to select a single, specific period type to use, make a
selection from the Choose a single period type list.

13 Click Next.

14 On the Map Attributes page, map the source data to the non-metric attributes
content that is defined in SAS Strategy Management.

a Specify the date format that is used by the date for the non-metric date
attribute. From the Source date format list, make the applicable
selection:

If the date values are stored as numeric values in your source data,
select Use as defined in source.

If the date values are stored as character values in your source data,
select the format that matches the format of your date character
values.

b Choose the mapping option that matches the organization of your source
data:
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Non-metric
attributes are in
one row

Each non-
metric attribute
is in its own row

The source data typically has only one row for each
element. An element might have one or more non-metric
attributes. The row contains columns that describe the
value, text, and link for one or more non-metric attributes.
The following table provides an example:

element_name element_type MyText MyDate MyLink MyElement
Sales 2013 Objective Some text... 11/31/2013 wwawv.sas.com Revenue 2013

The Available items list contains all of the column names
that are in the source data. The Selected items list
contains attributes and their element types that you
mapped on the Map Element Types page of this wizard.
From the Available items list, drag an attribute column
onto its attribute in the Selected items list. In the
preceding example, you would drag the MyText column
onto the Objective:MyText:value attribute in the Selected
items list.

Note: An element type does not appear in the Selected
items list if that element type does not have any non-metric
attributes. To include non-metric attributes, update the
element type definition in the SAS Strategy Management
template.

The source data has multiple rows for an element. Each
row can define the value, text, or link for one non-metric
attribute. For example, one row defines the value, text, or
link for the non-metric attribute called MyLink, and another
row defines the value, text, or link for the non-metric
attribute called MyDate. The following table provides an
example:

element_name attribute value

Sales 2013 My Text Some text..
Sales 2013 MyDate 11/31/2013
Sales 2013 ey Lirk WYL S35, COMM
Sales 2013 MyElement Revenue 2013

Make the applicable selections from the lists.

For more information, see “Source Data Organization” on page 346.

15 Click Next.

16 On the Preview Mappings page, preview a sample of the specified mappings
that you want to use for your data. When you are satisfied, click Finish to
save and run the import configuration.

TIP If you want to save the import configuration but you do not want to run
it, click Save as Draft. The import configuration is saved to the selection
list. When you want to run it, select the import configuration and click 4.

The Import selection list appears and includes the new import configuration.
The Status column indicates whether the configuration ran successfully. If the
status icon indicates that errors occurred, click that icon to view the error log.
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Define How to Import a Hierarchy from a
Source File

When you run the hierarchy configuration, the hierarchy that is specified in the
source data file is imported into the SAS Strategy Management project as
scorecards. You can populate the scorecard hierarchy by using the content
configuration or the Batch Maintenance Facility. To define how SAS Strategy
Management imports data from a source file:

1 In an open scorecard, select Project » Manage Import Options. The Import
page appears.

Gsas

Log Off

Select an import configuration to open or copy. You can also create a new import configuration. To view tutorials about creating impoert configurations, click Help » Video. @

[ Owner [ Last Run [ Status @

2 In the toolbar, click [# and then click New Hierarchy Import Configuration.
The Import wizard appears.
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§sas

Log Off

Identification

Specify a name that is unique within this Strategy Management project.

Mame: #[klm-2

Description: Enter a description

Owner: sasdemo

I Select Source Data I
Map to Hierarchy

| Cancel || Save |

3 In the Identification section, type a name that is unique within this SAS
Strategy Management project. A description is optional.

4 Expand the Select Source Data section.

5 Select the type of data that you want to import.

Local source If your source file is located on your local system, select Local
data Excel source data. Typically, you select this option if you are
importing a Microsoft Excel file that is unregistered.

In the File path field, type the file path and click Retrieve.

Note: The file path must include the computer name. In the
following example, the system is called MYCOMPUTER. If the
file is located on a system that is running Windows, an
example file path is
\\MYCOMPUTER\spreadsheets\monthly
reports.xlsx. For more information, see “Local Microsoft
Excel Files and Shared Directories” on page 346.

From the Worksheet list, select the Excel worksheet that
contains the data that you want to use.

SAS server If you want to import a SAS data set or Excel spreadsheet,
source data select SAS server source data.

Note: SAS data sets or Excel spreadsheets must be
registered before you can use them. For more information,
see “Registering Source Data Files” on page 345.

In the Select window, navigate to the table that you want to
import and select it. Then, click OK.

6 A preview table appears in the wizard. In this table, view the data contained
in the file that you selected.
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Identification
Select Source Data

Selectthe source data file that you want to impaort @

Local Excel source data SAS server source data

Currently selected source data: /Products/SAS Intelligence Platform/Samples/ODSSTYLE

' Style Name

Display Value

Analysis .. Btyles Analysis

Astronomy .| Btyles Astronomy

Banker ..| Styles.Banker =
BarrettsBlue .. Styles.BarrettsBlue

blockPrint ..| Styles.blockPrint 5
Curve .. Styles.Curve

Default Styles Default

Diree ... Styles Diree

Education ... Btyles Education

EGDefault .. Styles. EGDefault

Map to Hierarchy

Cancel | |

7 Expand the Map to Hierarchy section.

Identification

Select Source Data

Map to Hierarchy

To build the scorecard hierarchy in a Strategy Management project, define the order @ L=~
ofthe hierarchy levels in the source data and specify their relationship for use in
scorecards.
Hierarchy levels: Available items: Selected items: @
Style Name
Display Value o
& ~ =
H <§§] 4

Optionally, you can select a column from the source data that provides unique scorecard identifiers.

Unigue scorecard identifiers: | seject a column -

Preview:

| Cancel || Save

8 Define the order of the hierarchy levels in the source data and specify their
relationship for use in scorecards. SAS Strategy Management uses this
information to build the scorecard hierarchy in the project.

From the Available items list, select columns from the source data to map to
the scorecard hierarchy in your SAS Strategy Management project. You can
change the order of the levels in the Selected items list.

TIP A best practice is to map the same number of levels that you are
importing. For example, if you are importing two levels of data, then map
only two levels of the hierarchy.
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TIP A hierarchy represents the levels in your scorecard tree. You can
have a root level, parent levels, and child levels. The following hierarchy of
scorecards is an example: worldwide, division, department, and group.
Worldwide is the root level. Division is a child of worldwide and a parent of
department, and so on.

9 (Optional) From the Unique scorecard identifiers list, select a column from
the source data that provides unique scorecard identifiers. The data that the
column contains appears in the Preview field so that you can verify your
selection.

10 Click Save to save the import configuration. The Import selection list
appears and includes the new import configuration.

Open an Import Configuration

To open an import configuration, double-click the configuration in the selection
list or select the configuration from the selection list and then click Open.

Run an Import Configuration

To run an import configuration, select the configuration from the selection list

and then click di. The configuration runs, and its status is reported in the Status
column of the selection list.

Note: Do not run more than one configuration at a time. This is especially true if
a content configuration requires that its hierarchy already be created by a
hierarchy configuration.

View the Import Configuration Error Log

If a configuration did not run successfully, you can view its error log. Double-click
the status icon in the Status column of the selection list.

Copy an Import Configuration

To copy an import configuration, select the configuration from the Import

selection list and then click IfIi. A copy of the import configuration is created,
which you can then edit.
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Delete an Import Configuration

To delete an import configuration, select the configuration from the Import
selection list and then click M. The import configuration is deleted.
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Creating Reports Using SAS Information Maps 371

Creating Reports Using SAS Information
Maps
You can create reports using SAS Information Maps. Information maps can be
used in many SAS products, including the following:
B SAS Information Map Studio
m  SAS Bl Dashboard
= SAS Web Report Studio

For more information, see the documentation for these products. For information
about saving a scorecard as a SAS Information Map, see “Save a Scorecard as
a SAS Information Map” on page 89.
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Overview

By using the SAS Add-In for Microsoft Office plug-in with SAS Strategy
Management, you can view SAS Strategy Management reports in the following
Microsoft applications:

Microsoft Excel
Microsoft Outlook
Microsoft PowerPoint
Microsoft Word

To determine whether SAS Add-in for Microsoft Office is installed, open any of
these Microsoft Office applications. If the tabs for the ribbon bar across at the
top of the window include a SAS tab, the plug-in is installed. For information
about installation, see the SAS Add-in for Microsoft Office documentation at
http://support.sas.com/documentation/onlinedoc/addin/
index.html.

Creating a SAS Strategy Management
Report

To create a SAS Strategy Management report that you can view in Microsoft
Office, see “Save the Portlet as a Mobile Report” on page 318.


http://support.sas.com/documentation/onlinedoc/addin/index.html
http://support.sas.com/documentation/onlinedoc/addin/index.html
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Viewing a SAS Strategy Management

Report

For information about using SAS Add-in for Microsoft Office to view SAS reports,
including SAS Strategy Management reports, see the SAS Add-in for Microsoft
Office documentation at: http://support.sas.com/documentation/
onlinedoc/addin/index.html.

The following restrictions apply to the specified Microsoft Office applications:

(PowerPoint only) You cannot view SAS Strategy Management diagrams or
icons that were included with diagrams by using PowerPoint. An error
message appears if you attempt to do so.

(Excel only) Columns that contain time periods do not display the time
periods the same as in Outlook or in the Strategy Management Builder.

(Excel, PowerPoint, and Word only) Columns that contain e-mail addresses
and web addresses do not provide active links. The links are active in
Outlook.

(Excel, PowerPoint, and Word only) Reports that are generated from a SAS
Strategy Management enhanced portlet might not include a title. Also,
columns in aggregate tables might not include some formatting, such as
percentage and currency.

(All Microsoft Office applications) Links that are specified for metric attributes
are not active when you view SAS Strategy Management reports in any
Microsoft Office application.

Enable Colors for Ranges

Reports that include range icons and colors might fail to display the colors. To
enable the color display in ranges:

1

a h @ N

(-]

On the Microsoft Office application Ribbon, select SAS » Tools » Options.
The SAS Options window appears.

Click the Results tab.

In the Format list, select SAS Report.

Select Always apply the SAS style to the results.
Select sasweb from the style list.

Click OK to save the settings.


http://support.sas.com/documentation/onlinedoc/addin/index.html
http://support.sas.com/documentation/onlinedoc/addin/index.html
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Accessing Strategy Management Data from
Microsoft Excel

You can access the value of a scorecard element metric attribute from within
Microsoft Excel. Using the following function, you can place the value directly
into a cell or use the value as part of a formula.

Note:

To access the data in SAS Strategy Management, you must be logged on to
SAS Strategy Management, and have Read access permission to the
numeric attribute.

Each name in an argument must match the name that is used with the
default language for the template.

No validation is performed on the values of the arguments. If any problems
arise with the values, the function returns an empty string.

The function uses the following syntax:

GETSPMCELLVALUE(Template, Project, Scorecard, Element-Type, Element,
Metric-Attribute, Date)

This function uses the following arguments:
Template is a quoted string that represents the template name.
Project is a quoted string that represents the project name.
Scorecard is a quoted string that represents the scorecard name.
Element-Type is a quoted string that represents the element type name.
Element is a quoted string that represents the element name.
Metric-Attribute is a quoted string that represents the metric attribute name.

Date is a quoted string that represents a valid date. This is the specific date
for which to return the value of the metric attribute. The format can be any
recognizable date format.
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Functions for Use in Formulas

The following functions are specific to SAS Strategy Management. These
functions are available for selection on the Functions tab of the Formula Editor.

Note:

B The case that you choose to use for a function does not affect that function in
a formula. Uppercase, lowercase, and mixed case are all valid.

©  Both parentheses and square brackets are valid in formulas. The examples
in the following table use parentheses.
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Get the Value of an Element

Several functions require as input the value of an element. This value is the
intersection of an element, its metric attribute, and a point in time. The
combination of these arguments identifies a specific value of an element. To
specify this value in a function, use either of the following syntaxes:

Short form VAL ( “CURRENT”, “CURRENT”, “CURRENT”)

Note: For more information about the VAL function, see its entry in
“Functions for Use in Formulas” on page 379.

Long form [ELEMENT=CURRENT (“element”) ]
[COLUMN=CURRENT (“column”) ]
[PERIOD=CURRENT (“period”) ]

element is an element.
column is a metric attribute associated with the element.

period indicates the specific period of time associated with the
element and its attribute. For more information, see “Specify a
Current or Relative Period in a Function” on page 396.

Specify a Current or Relative Period in a
Function

You can specify the current period by using the following function:

current ('PER')

You can also specify a relative period by using a numeric offset, for example:
current ('PER') -1

If the current period is June, this example returns May.

Specify a Range in a Function

When using the MAX, MEAN, MIN, and SUM functions, you can specify a range
of location values by using a colon (:) as in the following example:

SUM ( [ELE="'Interest'] [COL='Actual'] [PER='JAN2005'] : [ELE="'Interest']
[COL="'Actual'] [PER="'JUN2005"'])

When specifying a range of locations, the following requirements must be met:

The first and last periods must be at the same level in the hierarchy of
variation

The elements and columns must be the same
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The first period must be before the second period

The specified range in the above example includes only periods at that one
level, in order to avoid double counting. The example also specifies a six-period
range at the month level of a time hierarchy.

Also, you can exclude certain numbers—for example, EXCLUDE (-4, 4, 2.3).

Specify a Full Reference to an Element or

Attribute

When you specify a formula for a formula-based range, you must refer to
elements and attributes in the formula by using a full reference. Because a
range is created at the project level, the range has no context for a scorecard or
element type. The full reference acts like a path for the range, and provides the
missing context.

For example, if you want to reference the element Pers1, you must enter the full
reference to that element in the formula:

[ELE="'Basketball |Basketball Scorecard”1974 Scorecard|Perspectives|Persl']
[COL="'Actual'] [PER='NOV2008 Default']

When you use the ATTRIBUTE function, you must specify the element type by
using a full reference to the attribute. For example, if you want to reference the
Start Date attribute value for elements of the Task element type, you must also
reference the Task element type in the formula:

attribute( [ELE=current ('ELE')] [ATTR:‘Task|Start Date'] )

Example: Using the MIXPER Function

By using the MIXPER function, you can calculate elements from one type of time
period to another. In the following example, months are calculated from
fortnights.

The example uses the following data:

Element Period ID Start Date End Date Actual
Hours drill Fortnight1 1sep13 14sep13 30
Hours Fortnight1 1sep13 14sep13 40
classroom

Hours pt Fortnight1 1sep13 14sep13 10
Hours drill Fortnight2 15sep13 28sep13 20
Hours Fortnight2 15sep13 28sep13 55
classroom

Hours pt Fortnight2 15sep13 28sep13 15



398 Appendix 1 / Strategy Management Function Dictionary

Element Period ID Start Date End Date Actual
Hours drill Fortnight3 30sep13 140ct13 25
Hours Fortnight3 30sep13 140ct13 44
classroom

Hours pt Fortnight3 30sep13 140ct13 42
Readiness Month1 1sep13 30sep13 Fl

(Hours trained)

To calculate the monthly value of Readiness (Hours trained) from the
Fortnight values, use the following formula:

Fl1 = SUM( MIXPER(“Hours drill”, “actual”, current (“PER”), 1) ),
SUM( MIXPER (“Hours classroom”, “actual”, current (“PER”), 1) ),
SUM( MIXPER (“Hours pt”, “actual”, current (“PER”), 1) )

Therefore, Readiness = SUM(30, 20, 40, 55, 10, 15).
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Appendix 2

Configuring Java

Configure Java for Use with SAS Strategy Management 399
Install the Java 2 Runtime Environment 399
Delete the Java Plug-In Cache 400
Delete Temporary Internet Files 400
Enable Java in the Web Browser 401

Enable Java in Firefox 401

Enable Java in Microsoft Explorer 401

Configure Java for Use with SAS Strategy
Management

When you first use the Classic Diagram Editor or the Formula Editor, you must
configure your system to run Java. SAS Strategy Management requires the Java
2 Runtime Environment (J2RE) version 1.5 or later. The configuration steps vary
depending on your installation:

For version 1.5 1 “Delete the Java Plug-In Cache” on page 400

or later
2 “Delete Temporary Internet Files” on page 400

Any earlier 1 “Install the Java 2 Runtime Environment” on page 399

versions or no
JRE installed 2 “Delete the Java Plug-In Cache” on page 400

3 “Delete Temporary Internet Files” on page 400

Install the Java 2 Runtime Environment

SAS Strategy Management requires the Java 2 Runtime Environment (J2RE)
version 1.5 or later. If you do not have version 1.5 installed, complete one of the
following steps:
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For JRE 1.6 or later If you have a version of the JRE installed that is later than the

required version, a message might appear asking if you want
to use your version. Click Yes.

Note: The following security message might appear:Java
has discovered application components that
could indicate a security concern. Click No to

continue.
For versions earlier If you do not have the required version of the JRE installed, a
than JRE 1.5 or no message prompts you to install it. After the installation is
JRE installed complete, restart your computer.

Delete the Java Plug-In Cache

To delete the Java plug-in cache, complete the following steps:

Note: The names of the controls in the Java Control Panel might differ from the
names shown here. Also, these steps might vary depending on your operating
system installation.

1

2

Open the Windows Control Panel.
Double-click Java to open the Java Control Panel.

On the General tab, in the Temporary Internet Files section, click Settings.
The Temporary Files Settings list appears.

Click Delete Files. The Delete Temporary Files list appears.
Click Applications and Applets and Trace and Log Files.

Click OK. Then click OK to exit the Temporary Files Settings list. Click OK to
exit the Java Control Panel.

Delete Temporary Internet Files

If you are using SAS Strategy Management on more than one server, you must
delete the temporary Internet files in Internet Explorer to ensure correct
installation and operation of the editor. To do so, complete the following steps.

Note: These steps might vary depending on your version of Microsoft Internet
Explorer.

1

In Internet Explorer, click Tools » Delete Browsing History. The Delete
Browsing History list appears.

Click Preserve Favorites website data.
Click Temporary Internet files.

Click Delete.
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Enable Java in the Web Browser

Enable Java in Firefox
You must ensure that Java is enabled for use in your web browser.
Note: These steps might vary depending on your version of Firefox.

To enable your web browser to use Java:
1 Click Tools » Add-ons. The Add-ons page opens.
2 Click Plug-ins.

3 Locate the entry for your Java plug-in and click Enable.

Enable Java in Microsoft Explorer
You must ensure that Java is enabled for use in your web browser.
Note: These steps might vary depending on your version of Microsoft Explorer.

To enable your web browser to use Java:

1 Click Tools » Add-ons. The Add-ons window appears.
2 Click Toolbars and Extensions.

3 Locate and select the entry for your Java plug-in.

4 Click Enable.

5 Click Close to exit the window.
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View SAS Strategy Management
Data in SAS Bl Dashboard

You can view SAS Strategy Management data by creating and using a
dashboard in SAS Bl Dashboard. For detailed information about using SAS Bl
Dashboard, see the SAS Bl Dashboard 4.31 User's Guide, Second Edition.

To create new SAS Strategy Management indicator data in SAS Bl Dashboard:

1

2

Open the SAS BI Dashboard designer.
Select Manage Dashboards.
In the workspace, click New Indicator Data.

In the Create Indicator Data window, enter a name to use for the indicator
data in the Name field.

Click OK. A tab with the specified name appears in the workspace.

From the Data source list, select SAS Strategy Management 5.x.

CAUTION! The default maximum number of rows returned by any data
source is 10,000. If the source data contains more than 10,000 rows, an error
message about making an adjustment appears. If possible, aggregate the data in
order to reduce the number of rows to return.

In the Scorecard Server URL field, enter the host name and port name for
the server running the SAS Strategy Management web application.

Note: The resulting web address points to the location of the SAS Strategy
Management web application.

Click Set Server.
Select the template, project, and scorecard for your data.

a From the Scorecard Template list, select the template that you want to
use.

b From the Scorecard Project list, select the project that you want to use.
The scorecard hierarchy appears.

c In the Scorecard hierarchy, select the scorecard that you want to use.

10 Select the element type, elements, and attributes that you want to display in

the dashboard.

a From the Element Type list, select the element type that you want to use.
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b From the Element list, select one or more elements that you want to use.

c From the Attributes list, select one or more attributes that you want to
use.

11 Define the formatting that you want to use in the dashboard.

a Specify the start date and end date.

Date Option Description

No selection Enables you to specify a start or end date by clicking
.

Any date Returns all data for the element start date or end date.

Today Displays the current date.

The following examples show how the date options interact:

If Start Date is set to Any date and End Date is set to Today, the
system returns all past data and today’s results.

If Start Date is set to Today and End Date is set to Any date, the
system returns today's results and any data that is defined for the
future.

If Start Date and End Date are both set to Any date, the system
returns all available data for the selection.

b In the Name Format field, define a label for your dashboard artifact.

Note: SAS Strategy Management keywords are used to define the
format. When these keywords are displayed, the keywords are replaced
with actual values from the strategy, which ensures that labels contain
meaningful information.

c In the Value Format field, call metric values and set SAS formats for
display in the dashboard.

TIP Use Metric Value to substitute the actual metric value for a
measure.

12 Click Submit. In the Preview Dashboard window, the specified SAS Strategy
Management data appears.

13 To save the SAS Strategy Management indicator data, click the Save icon in
the toolbar.

The following additional steps are required to complete setting up a dashboard:
Set up a new range.
Create a new indicator.
Create a new dashboard.

For information about these steps, see the SAS Bl Dashboard 4.31 User's
Guide, Second Edition.
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alert
an automatic notification of an electronic event that is of interest to the
recipient.

Alerts portlet
a portlet that lists alert messages that have been issued to the user.

attribute
a property of an object, component, or other entity. Examples of attributes
include name, size, or color.

audit
the formal examination and evaluation of an organization's controls to ensure
organizational compliance.

dashboard
a view that displays ranges of data in a graphical format. Key performance
indicators (KPIs) or any element can be displayed in a dashboard. Each
element is represented by a gauge that displays the data ranges that are
defined. Links to comments, trend data, and element properties can also be
provided.

data node
a diagram component that contains all the data and metadata that are
associated with an element, such as its labels, attributes, associations, and
values.

data tier
in a SAS business intelligence system, the architectural layer in which SAS
runs data-handling programs (including the logical servers for workspace and
stored process servers). The data tier includes transformations, error tables,
and jobs.

dimension
a data element that categorizes values in a data set into non-overlapping
categories that can be used to group, filter, and label the data in meaningful
ways. Hierarchies within a dimension typically represent different groupings
of information that pertains to a single concept. For example, a Time
dimension might consist of two hierarchies: (1) Year, Month, and Date, and
(2) Year, Week, and Day.

element
a unit of data that is represented in a row in a scorecard table. Each element
belongs to an element type. For example, the element type "Objective" might
contain the elements "Expenses", "Create New Products", and "Profitability".
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group
See user group

identity
See metadata identity

information map
a collection of data items and filters that provides a user-friendly view of a
data source. When you use an information map to query data for business
needs, you do not have to understand the structure of the underlying data
source or know how to program in a query language.

key performance indicator
a measurement that shows whether an organization is progressing toward its
stated goals. Short form: KPI.

KPI
See key performance indicator

locale
a setting that reflects the language, local conventions, and culture for a
geographic region. Local conventions can include specific formatting rules for
paper sizes, dates, times, and numbers, and a currency symbol for the
country or region. Some examples of locale values are
French_Canada,Portuguese_Brazil, and Chinese_Singapore.

metadata
descriptive data about data that is stored and managed in a database, in
order to facilitate access to captured and archived data for further use.

metadata identity
a metadata object that represents an individual user or a group of users in a
SAS metadata environment. Each individual and group that accesses
secured resources on a SAS Metadata Server should have a unique
metadata identity within that server.

metadata repository
a collection of related metadata objects, such as the metadata for a set of
tables and columns that are maintained by an application.

metadata server
a server that provides metadata management services to one or more client
applications.

metric
any standard of measurement that is used as a basis for evaluation or
comparison. For example, ROI (return on investment) is a metric that is
commonly used by businesses as a basis for making decisions, and bytes
per second throughput is a common performance metric.

metric attribute
a value type that measures, groups, or tracks strategy results. A strategy
uses metric attributes as a basis for evaluation and comparison of results.
Actual, Target, and Status are examples of metric attributes.
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middle tier
in a SAS business intelligence system, the architectural layer in which Web
applications and related services execute. The middle tier receives user
requests, applies business logic and business rules, interacts with
processing servers and data servers, and returns information to users.

performance management framework
a management system that is supported by measures of performance. The
framework can combine financial and nonfinancial measures of performance,
as well as leading and lagging indicators. The framework enables
optimization and testing of strategies, and evaluation of results.

permission
the type of access that a user or group has to a resource. The permission
defines what the user or group can do with the resource. Examples of
permissions are ReadMetadata and WriteMetadata.

portal
a Web application that enables users to access Web sites, data, documents,
applications, and other digital content from a single, easily accessible user
interface. A portal's personalization features enable each user to configure
and organize the interface to meet individual or role-based needs.

role
a set of capabilities. In some applications, certain actions are available only
to users or groups that have a particular role.

rollback
a data recovery process that restores a database after a hardware or
software failure, or that returns it to a state before changes were made.

SAS Stored Process
a SAS program that is stored on a server and defined in metadata, and which
can be executed by client applications. Short form: stored process.

scorecard
a collection of content or information about a specific topic, such as a
business unit or product. A scorecard tracks internal business processes and
external outcomes as an aid to planning a strategy for an organization.

source system
the type of database from which operational loss data originates or to which it
is being exported.

stored process
See SAS Stored Process

template
a collection of information that describes the key parts of a strategy. A
template consists of element types, metric attributes, and a language setting.
A template can be associated with one or more projects.

Time dimension
a dimension that divides time into levels such as Year, Quarter, Month, and
Day.
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time period level
a grouping of one or more time periods. For example, the time period level
Day consists of the time periods Monday, Tuesday, Wednesday, Thursday,
Friday, Saturday, and Sunday.

time period set
in a template or project, a grouping of one or more time period levels.

trend
a long-term consistent change, as measured by time series values.

Unicode Transformation Format 8
See UTF-8

universal unique identifier
a number that is used to uniquely identify information in distributed systems
without significant central coordination. There are 32 hexadecimal digits in a
UUID, and these are divided into five groups with hyphens between them as
follows: 8-4-4-4-12. Altogether the 16-byte (128 bit) canonical UUID has 32
digits and 4 hyphens, or 36 characters.

user group
an organization of user roles within an entity organization. User groups
contain the roles and access rights for the individuals assigned to the group.

user role
See role

UTF-8
a method for converting 16-bit Unicode characters to 8-bit characters. This
format supports all of the world's languages, including those that use non-
Latin 1 characters. Short form: UTF-8.

UuID
See universal unique identifier
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Special Characters

_BLANK _ (special constant in
formulas) 131

_ERROR _ (special constant in
formulas) 131

. (special constant in formulas) 131

#NUM! 127, 130, 133, 136, 137

A

ABS function 380
access permissions

administer 150

set for multiple objects 150
ACOS function 380
address

copy address of a view 245
administer access permissions 150
aggregate tables

and column selections 142

column selections 144

customize view 72

definition of 23, 157

metric attributes 72, 73

opening 169

sorting rows 170

viewing data by metric attribute 170

viewing data by scorecard 170
analysis

correlation 223

create definition 223
ASIN function 380
associated projects 9

listing with templates 57
association links

adding to a diagram 187

definition of 181

deleting 190

in diagrams 181
association tables

customize view 73
association views

customizing 165
associations

and analysis 223

column selections 145
copying 174
creating 171
customizing 173
definition of 23, 157
deleting 175
editing properties of 174
listing 171
locating in diagrams 232
viewing 172
ATAN function 380
attribute function 381
attributelsMe function 381

Balanced Scorecard template 11
Batch Maintenance Facility
Import wizard 343
links 78
blank cells 137

C

cache
diagram 74
CEIL function 381
Children function 382
collection portlet
adding links 35
column selections
and aggregate tables 142, 144
and associations 145
and tables 144
copying 144
creating 142, 145
deleting 144
editing properties of 143
forms 145
in scorecard tables 163, 170
listing 141
columns
formatting 114
COMPRESS function 382
copying and pasting
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diagram objects 192
correlation analysis 223
COS function 382
CURRENT function 382
curved lines 198
customizing

for many users at once 69

Dashboard View

definition of 25, 159
dashboards

displaying in Performance

Dashboard Portlet 323

data layer 180
data nodes

adding and removing 185

definition of 180

deleting 190

grouping 197

grouping with sections 194, 195

in diagrams 180

moving 193

showing and hiding 185
data-entry forms

column selections 142, 145

links 78

using to enter data 339
data-entry portlet

See Performance Data-Entry Portlet
DATE function 382
dates

default in project views 71

in scorecard tables 163, 170, 173
DATETIME function 383
DAV content 78, 84

See also import a document
DAV server 74
DAYOFMONTH function 383
DAYOFWEEK function 383
DAYOFYEAR function 383
DBCS character limitations 189
delete access permission 150
deleting

diagram objects 190
Diagram Editor

named links 78
diagram objects

copying and pasting 192

deleting 190
diagrams

adding association links 187

adding objects 185

analyze 223
association links 181
cache 74
changing position of 232
copying 230
creating 181
customize view 73
data layer 180
data node properties 180
data nodes 180
definition of 24, 158, 179
deleting 231
deleting association links 190
deleting data nodes 190
deleting elements 190
deleting images 191
deleting lines 191
deleting sections 191
deleting shapes 191
deleting text 191
dividing into sections 187, 188
editing 182
editing links 220
editing scorecards with 180
exporting as SVG drawings 231
grids 191
image location 190
lines 181
locating associations in 232
locating element types in 232
locating elements in 232
moving data nodes 193
panning 232
properties 230
reverting to saved 231
saving 230
sections 181
shape layer 180
shapes, text, images 181
showing and hiding data nodes 185
viewing 231
viewing properties 230
zooming 192
Directive 78
Document Management
See import a document
documents, importing 84

element details 78

element types
changing order in a project 50
locating in diagrams 232



elements
adding to a diagram 185
comment notification 149
copying 110
copying properties of 108
creating 97
definition of 15
deleting 111, 190
editing metric attributes 99
editing multiple 104
editing properties of 101
in enhanced gauge tile 25, 159
in Performance Dashboard Portlet

25, 159

linking 107, 360
linking from 107
links 78
locating in diagrams 232
manage suggested new 68
moving 111, 193
resizing 193
suggest new 67
unlinking 107

ellipse
See shapes

enhanced portlet
help 308
SAS Strategy Management reports

318, 373

user interface 306

EXP function 383

F

files

importing 84

registered in SAS 78
Firefox web browser

and portlets 288, 290, 293, 296

Copy Web Address 246
FLOOR function 383
font

of table cells 111

of table columns 114
ForAll function 383
ForAny function 384
format

of table cells 111

of table columns 114
forms

column selections 145

entering data with 339

Numeric icon 339

Texticon 339
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Formula Editor functions

See functions

formula icon 72
formulas

_BLANK _ (special constant) 131
_ERROR _ (special constant) 131
. (special constant) 131

#NUM! 127, 130, 133, 136, 137
applying to columns 127
calculating for projects 133

cell reference 394

editing 129

ranges based on 136, 137

ForNone function 384
functions 379

ABS 380

ACOS 380
ASIN 380

ATAN 380
attribute 381
attributelsMe 381
CEIL 381
Children 382
COMPRESS 382
COS 382
CURRENT 382
DATE 382
DATETIME 383
DAYOFMONTH 383
DAYOFWEEK 383
DAYOFYEAR 383
EXP 383
FLOOR 383
ForAll 383
ForAny 384
ForNone 384

IF 384

INDEX 384
INDEXC 385
INPUTVALUE 385
LEFT 385
LENGTH 385
LOG 386
LOWCASE 386
MAX 386

MEAN 386

MIN 387
MIXPER 387
MOD 388
myAttribute 388
NESTIF 389
POW 389

PUTC 390
PUTN 390
Range 390
REPEAT 390
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REVERSE 391 Import wizard 343
RIGHT 391 links 78
ROUND 391 INDEX function 384
SCAN 391 INDEXC function 385
SIN 391 information maps 78
SQRT 392 INPUTVALUE function 385
SUBSTR 392 internationalization 189
SUM 392
TABLEC 392
TABLEN 393 K
TAN 393
TIME 393 -
TODAY 393 key performance indicators
TRANSLATE 393 in enhanced gauge tile 25, 159
TRIM 394 in Performance Dashboard Portlet
UPCASE 394 25,159
VAL 394 KPI template 11
VERIFY 395
YTD 395

L
G languages

creating a user defined 55

Gauge View ge}‘irl@tion_ o]: 9 s &
definition of 25, 159 eleting in templates

getSPMCellValue function 375 listing in templates 56
global thresholds renaming in templates 57

setting the default 56

editing 119 4 ot
in Performance Dashboard Portlet used in a projec
295 LEFT function 385
setting 116 LENGTH function 385
grids lines

adding and removing segments 198
adding to a diagram 188
copying and pasting 192
definition of 181
H deleting 191
in diagrams 181
historical trends moving 193
customizing 241 straight and curved 198
linking elements 107, 360
links
I applied to elements 107
applied to metric attributes 101
definitions 79

arranging objects with 191

IF function 384

. editing 220
images . in scorecards 78
addlng toa dlagrgm 189 to SAS Stored process 83
copying and pasting 192 to web pages 82
deleting 191 types 78
n dlggrams 181 LOG function 386
moving 193 log off 38, 304
resizing 193 log on 33, 303
selecting and deselecting 193 LOWCASiE function 386

to contain other items 197
import a document 84
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M Performance Data-Entry Portlet
editing properties of 297
Performance Diagram Portlet
editing properties of 299
Performance Table Portlet
editing properties of 285
period-based text
editing metric attributes 101
editing multiple elements 106

MAX function 386

MEAN function 386

metric attributes
definition of 9
deleting in templates 55
displayed in aggregated tables 72,

d't'73 o in forms 339
%;Igngregate ables 170 personal column selections (definition)
n a 142
:::::Isn%gom 101 personal thresholds
inks 7 editing 119
Ll::g?n :: J?rr]ng?ntsg ti‘sl . in Performance Dashboard Portlet
2
return value to Microsoft Excel 375 settir?gS 116
Microsoft Excel polygon

accessing the value of a metric
attribute 375

Microsoft Office

creating reports 318, 373

troubleshooting 374

view reports 319

viewing reports 318, 374
missing values

in ranges 137
MIXPER function 387
mobile support 60, 318
MOD function 388
myAttribute function 388

See also shapes
rotating 194
portal pages 78
POW function 389
predefined templates
editing properties of 59
project element types
changing order 50
copying in templates 50
definition of 9
deleting in templates 50
editing properties of 47
listing in templates 47

projects
access permissions 67
N associated 9
calculate 133
NESTIF function 389 copying 75
nodes creating 64

See also data nodes

grouping with sections 194, 195
number format

of table cells 111

Numeric icon

in forms 339

P

Performance Aggregate Table Portlet
editing properties of 288
Performance Association Portlet
editing properties of 291
Performance Dashboard Portlet
editing properties of 293

threshold conditions 295

viewing 323

default date for views 71
default language 71
default scorecard 70
default trend chart 74, 75
default view 70
definition of 12
deleting 77
manage suggested new elements
68
name 66, 76
opening 65
opening by using a link 78
options 69
printing 245
properties 66
registering 65
suggest new element 67
PUTC function 390
PUTN function 390



range colors
in Microsoft Office 374
Range function 390
ranges
#NUM! 137
applying to columns 139
blank cells 137
copying 138
creating 136
definition of 17
deleting 139
editing 138
formula-based 136, 137
intervals 136
missing values 137
unresolved values 137
read access permission 150
rectangle
See shapes
REPEAT function 390
reports 60, 318
REVERSE function 391
RIGHT function 391
ROUND function 391
rows
sorting in aggregate tables 170
sorting in scorecard tables 164
rules 385

S

SAS Add-In for Microsoft Office 318,
319, 373
SAS Content Server 78, 84
SAS Financial Management 78
SAS Information Delivery Portal
log off 38, 304
log on 33, 303
SAS Information Map
create from scorecard 89
SAS Mobile Bl app 60, 318
SAS Strategy Management reports
318, 373
SAS Strategy Management server
images for diagrams 190

SAS Visual Analytics 37, 60, 298, 318

SAS Web Report Studio 78
SCAN function 391
scorecard
calculate 88
linking from 78
save as SAS Information Map 89

scorecard element types
copying in templates 50, 54
definition of 9
deleting in templates 54
editing properties of 51
listing in templates 51
scorecard tables
customizing 165
definition of 22, 156
opening 163
sorting rows 164
trend analysis 237
viewing data by column selection
163, 170
viewing data by date 163, 170, 173
scorecards
adding to a portlet 77, 92
changing order 90
copying 93
creating 87
default displayed in project 70
definition of 13
deleting 95
editing in a diagram 180
moving 93
opening 88
printing 245
setting default preferences 95
sections
copying and pasting 192
definition of 181
deleting 191
dividing diagrams 187, 188
grouping data nodes 194, 195
in diagrams 181
moving 193
resizing 193
shape layer 180
shapes
adding to a diagram 188
connecting 198
copying and pasting 192
deleting 191
disconnecting 199
grouping nodes 197
in diagrams 181
moving 193
resizing 193
selecting and deselecting 193
to contain other items 197
shared column selections (definition)
142
SIN function 391
SQRT function 392
Stored Process
linking to 83



stored processes 78
Strategy Management Portlet
editing properties of 263

SUBSTR function 392
SUM function 392
SVG 189
SVG drawings
exporting diagrams as 231

T

TABLEC function 392

TABLEN function 393

tables
cell format 111
column format 114
column selections 144
customize view 71
customizing 165
definition of 22, 156
opening 163
sorting rows 164, 170

tablet support
See mobile support

TAN function 393

templates
associated projects 9
Balanced Scorecard 11
copying 60
copying element types 50
copying projects 75
copying scorecard element types 54
creating 44
creating user-defined language 55
definition of 9
deleting 60
deleting languages 57
deleting metric attributes 55
deleting project element types 50
deleting scorecard element types 54
editing 47
editing project element type

properties 47
editing properties of predefined 59
editing properties of user-defined 58
editing scorecard element type
properties 51

KPI 11
listing associated projects 57
listing languages 56
listing metric attributes 54
listing project element types 47
listing scorecard element types 51
metric attributes 9
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predefined 11
project element types 9
properties in diagrams 180
renaming languages 57
renaming metric attributes 55
scorecard element types 9
setting the default language 56
viewing 47
text
adding to a diagram 189
copying and pasting 192
deleting 191
in diagrams 181
moving 193
selecting and deselecting 193
to contain other items 197
Text icon
in forms 339
thresholds
editing global 119
editing personal 119
in Performance Dashboard Portlet
295
setting global 116
setting personal 116
viewing 121
thresholds, global 72
thresholds, personal 72
TIME function 393
TODAY function 393
TRANSLATE function 393
trend analysis 237
definition of 26, 160
trend charts
date range 75
default content 74
Y-axis labels 74
trends
analyzing 237
TRIM function 394

U

unlinking elements 107
unresolved values

in ranges 137
UPCASE function 394
URL

copy for a view 245
user-defined templates

editing properties of 58
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VAL function 394

VERIFY function 395

view
copy address of 245

views
adding to a portlet 244
aggregate 72
association table 73
customizing 71
default date 71
default displayed in project 70
diagram 73
setting default options 243
setting the default date 245
specifying a default 243
table 71

trend 74,75
Visual Analytics
See SAS Visual Analytics

W
web page
linking to 82
web pages 78
write access permission 150

Y

YTD function 395
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